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Welcome to MicroEJ developer documentation. Browse the following chapters to familiarize yourself with MicroEJ
Technology and understand the principles of app and platform development with MicroEJ.

The Glossary chapter describes MicroEJ terminology.
The Overview chapter introduces MicroEJ products and technology.
The Application Developer Guide presents Java applications development and debugging tools.

The Platform Developer Guide teaches you how to integrate a C Board Support as well as simulation config-
urations.

The Kernel Developer Guide introduces you to advanced concepts, such as partial updates and dynamic app
life cycle workflows.

The Tutorials chapter covers a variety of topics related to developing with the MicroEJ ecosystem.
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CHAPTER

ONE

MICROEJ GLOSSARY

This glossary defines the technical terms upon which the MicroEJ Virtual Execution Environment is built.

Add-On Library A MicroEJ Add-On Libraryis a pure managed code (Java) library. It runs over one or more MicroEJ
Foundation Libraries.

Application A MicroEJ Application is a software program that runs on a Powered by MicroEJ device.

Standalone Application MicroEJ Standalone Application is a MicroEJ Application that is directly
linked to the C code to produce a MicroEJ Mono-Sandbox Firmware. It is edited using MicroEJ
SDK.

Sandboxed Application A MicroEJ Sandboxed Application is a MicroEJ Application that can run
over a MicroEJ Multi-Sandbox Firmware. It can be linked either statically or dynamically.

System Application A MicroEJ System Application is a MicroEJ Sandboxed Application that is
statically linked to a MicroEJ Multi-Sandbox Firmware, as it is part of the initial image and
cannot be removed.

Kernel Application AMicroEJ Kernel Application is a MicroEJ Standalone Application that imple-
ments the ability to be extended to produce a MicroEJ Multi-Sandbox Firmware.

Architecture A MicroEJ Architecture is a software package that includes the MicroEJ Core Engine port to a target
instruction set and a C compiler, core MicroEJ Foundation Libraries (EDC, [BON], [SN/], [KF]) and the MicroEJ
Simulator. MicroEJ Architectures are distributed either as evaluation or production version.

Core Engine MicroEJ Core Engine is a scalable runtime for resource-constrained embedded devices running on
32-bit microcontrollers or microprocessors. MicroEJ Core Engine allows devices to run multiple and mixed
Java and C software applications.

Firmware A MicroEJ Firmware is the result of the binary link of a MicroEJ Standalone Application with a MicroEJ
Platform. The firmware is a binary program that can be programmed into the flash memory of a device.

Mono-Sandbox Firmware A MicroEJ Mono-Sandbox Firmware is a MicroEJ Firmware thatimple-
ments an unmodifiable set of functions. (previously MicroEJ Single-app Firmware)

Multi-Sandbox Firmware A MicroEJ Multi-Sandbox Firmware is a MicroEJ Firmware that imple-
ments the ability to be extended, by exposing a set of APIs and a memory space to link MicroEJ
Sandboxed Applications. (previously MicroEJ Multi-app Firmware)

Foundation Library AMicroEJ Foundation Libraryisa library that provides core or hardware-dependent function-
alities. A Foundation Library combines managed code (Java) and low-level APIs (C) implemented by one or
more Abstraction Layers through a native interface (SN/).

Mock A MicroEJ Mock is a mockup of a Board Support Package capability that mimics an hardware functionality
for the MicroEJ Simulator.
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Module Manager MicroEJ Module Manager downloads, installs and controls the consistency of all the dependen-
cies and versions required to build and publish a MicroEJ asset. It is based on Semantic Versioning specifi-
cation.

Platform A MicroEJ Platform integrates a MicroEJ Architecture, one or more Foundation Libraries with their re-
spective Abstraction Layers and the board support package (BSP) for the target Device. It also includes asso-
ciated MicroEJ Mocks for the MicroEJ Simulator.

SDK MicroEJ SDK allows MicroEJ Firmware developers to build a MicroEJ-ready device, by integrating a MicroEJ
Architecture with both Java and C software on their device.

Simulator MicroEJ Simulator allows running MicroEJ Applications on a target hardware simulator on the devel-
oper’s desktop computer. The MicroEJ Simulator runs one or more MicrokEJ mock that mimics the hardware
functionality. It enables developers to develop their MicroEJ Applications without the need of hardware.

Studio MicroEJ Studio allows application developers to write a MicroEJ Sandboxed Application, run it on a Virtual
Device, deploy it on a MicroEJ-ready device, and publish it to a MicroEJ Forge instance.

Virtual Device A MicroEJ Virtual Device is a software package that includes the simulation part of a MicroEJ
Firmware: runtime, libraries and application(s). It can be run on any PC without the need of MicroEJ Stu-
dio. In case a MicroEJ Multi-Sandbox Firmware, it is also used for testing a MicroEJ Sandboxed Application
in MicroEJ Studio.
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CHAPTER

TWO

OVERVIEW

2.1 MicroEJ Editions

2.1.1 Introduction
MicroEJ offers a comprehensive toolset to build the embedded software of a device. The toolset covers two levels
in device software development:

+ MicroEJ SDK for device firmware development

+ MicroEJ Studio for application development

The firmware will generally be produced by the device OEM, it includes all device drivers and a specific set of Mi-
croEJ functionalities useful for application developers targeting this device.

QA Platform Firmware @ Application | ;1 ulator
Sources

Sources
MICROEJ. 5DK MICROEJ Studic
Firmware Developer Host Application Developer Host
Import Build
Virtual
Device
Build
I
Target Local Deploy
- MICROEJ
- irmware | ——— APPLICATION
Build Flash — (7) —
L7 Install N Publish

MICROEJ.Forge

Fig. 1: MicroEJ Development Tools Overview

Using the MicroEJ SDK tool, a firmware developer will produce two versions of the MicroEJ binary, each one able
to run applications created with the MicroEJ Studio tool:

+ A MicroEJ Firmware binary to be flashed on OEM devices;
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« AVirtual Device which will be used as a device simulator by application developers.
Using the MicroEJ Studio tool, an application developer will be able to:

« Import Virtual Devices matching his target hardware in order to develop and test applications on the Simu-
lator;

« Deploy the application locally on an hardware device equipped with the MicroEJ Firmware;

« Package and publish the application on a MicroEJ Forge Instance, enabling remote end users to install it on
their devices. For more information about MicroEJ Forge, please consult https://www.microej.com/product/
forge.

2.1.2 Determine the MicroEJ Studio/SDK Version

In MicroEJ Studio/SDK, go to Help > About MicroEJ SDK menu.

In case of MicroEJ SDK 4.1 .x, the MicroEJ SDK version is directly displayed, suchas 4.1.5:

A About MicroEl® SDK

MicroEl® SDE

Version 4.1.5

Copyright ©2016-2018 1527 5.4, All Rights Reserved.

Use of this program is subject to Microk) License Agreement.

MicroE)® SDK is built on Eclipse, licensed under the terms of the Commen Public
License (CPL).

MicroEl® 50K and the MicreEl) logos are tradernarks of MicroE) 5.4,

CSEHOFPFS I EBwEDF

3 . .
@ Installation Details

In case of MicroEJ SDK 5. x , the value displayed is the MicroEJ SDK distribution, suchas 19.05 or 20.07:

2.1. MicroEJ Editions 5
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= About MicroEl

Copyright ©2018-2020 Microb) Corp. All Rights Reserved.

Use of this program is subject to MicroE) License Agreement.

MicroE)® SDK is built on Eclipse, licensed under the terms of the Common
r Public License (CPL).

MicroEl® 5DK and the MicrokE) logos are trademarks of MicroB) Corp.

CSEOFPF O JE WS

® Installation Details

To retrieve the MicroEJ SDK version that is currently installed in this distribution, proceed with the following steps:
o Clickonthe Installation Details button,
o Clickonthe Installed Software tab,

+ Retrieve the version of entry named MicroEJ SDK (or MicroEJ Studio).

K Installation Details

Installed Software |nstallation History Features Plug-ins Coenfiguration

Name Version Id Provider
@= C/C++ Development Tools SDK 9.4.3.201802261533  org.eclipse.cdt.sdk.feature.group Eclipse COT
[k C/C++ GCC Cross Compiler Support 9.4.3.201802261533  org.eclipse.cdt.build.crossgec.feature.group  Eclipse COT
[ C/C++ GDB Hardware Debugging 9.4.3.201802261533  org.eclipse.cdt.debug.gdbjtag.feature.gro... Eclipse COT
[{f- Eclipse Checkstyle Plug-in 6.8.0.201507251301  net.sf.eclipsecs.feature.group http:/Yeclipse-cs.sfu
@ Eclipse Runner Feature 1.34 com.eclipserunnerfeature feature.group Eclipse Runner Tean
@: Eclipse SDK 4.7.3.M20180330-06... org.eclipse.sdk.ide Eclipse.org
@: Eclipse XML Editors and Tools 3.9.2,:201803221834  erg.eclipse.wstxml_uifeaturefeature.group Eclipse Web Tools P
@: Git integration for Eclipse 4.9.2.201712130930-r  org.eclipse.egit.feature.group Eclipse EGit
@: JAutodoc 1.13.0 net.sf,jautodec.feature feature.group Martin Kesting
(= Markdown Editor 0.2.3 markdown.editor.feature.feature.group Winterwell
i i Joldeded?00728-1506  com.is2t.microej.mpp-feature feature.gro...  MicroEl
5.2.0 com.is2t.microej.sdk.feature.feature.group  MicroEJ
- LLUZ0I00728-1306  com.is2t.microgj.mpp.product.feature.fea.. MicroE)
@ Mylyn WikiText 3.0.792001711172000  erg.eclipse.mylynwikitext_featurefeature.... Eclipse Mylyn
@: PMD Plug-in 4.0.5720141105-1906  net.sourceforge.pmd.eclipsefeature.group PMD Project
@: Sonarlint for Eclipse 4.0.0.201810170711  org.sonarlint.eclipse featurefeature.group  SonarSource

2.1. MicroEJ Editions 6
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2.2 Licenses

2.2.1 Overview

MicroEJ Architectures are distributed in two different versions:

« Evaluation Architectures, associated with a software license key. Can be downloaded at https://repository.
microej.com/architectures/.

+ Production Architectures, associated with an hardware license key stored on a USB dongle. Can be requested
to MicroEJ support team support@microej.com.

Licenses list is available in MicroEJ SDK preferences dialog pagein Window > Preferences > MicroEJ :

= Preferences l (S S

type filter text MicroEJ =T - -

Checkstyle -
Copyright

> Data Management MicroEl repository
Easyant4Eclipse

: Help

> IceTea

> Install/Update
Instant Messaging

> Ivy

> Java

4 MicroE)
Architectures

Naming Convention
Platforms

General settings for MicroE) development:

CAP\runtime-New_configuration'repo Browse... ] I Refresh

Licenses

m

License Id Edition License Tags Expiration Date Packs Add...

. xFRYs-32Msn-Y3MAS-RBK4s | STD  IS2TJSFSC ' 2020-12-31 P

Platforms in workspace

[ Restore Defaultsl [ Apply ]

Updates

@ [ ok [ canca |

Fig. 2: MicroEJ Licenses View

2.2.2 License Manager

The license manager is provided with MicroEJ Architectures and this then integrated to Platforms, consequently:

« Evaluation licenses will be shown only if at least one Evaluation Architecture or Platform built from an Eval-
uation Architecture has been imported in MicroEJ SDK.

« Production licenses will be shown only if at least one Production Architecture or Platform built from a Pro-
duction Architecture has been imported in MicroEJ SDK.

See sections MicroEJ Architecture Import and Download and Install a MicroEJ Platform for more information.

2.2.3 Evaluation Licenses

This section should be considered when using Evaluation Architectures, which use software license keys.

Get your Machine UID

To activate an Evaluation Architecture, a machine UID needs to be provided to the key server.

2.2. Licenses 7
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This information is available from the preferences page:
« Goto Window > Preferences > MicroEJ ,
« Select either Architectures or Platforms ,

« Click on one of the available Architectures or Platforms,

+ Pressthe GetUID button to get the machine UID.

Note: To access this Get UID option, at least one Evaluation Architecture must have been imported before (see
License Manager).

Copy the UID. It will be needed when requesting a license.

& UID successfully generated Iﬁ

'0' Your UID was successfully generated.

Your UID is:  |A856470297673E28

Fig. 3: Machine UID for Evaluation License

Request your Activation Key

« Go to https://license.microej.com.
« Clickon Create a new account link.

« Create your account with a valid email address. You will receive a confirmation email a few minutes after.
Click on the confirmation link in the email and login with your new account.

 Clickon Activate a License .
« Set Product P/N: to 9PEVNLDBU6IJ.
« Set UID: tothe UID you copied before.

« Clickon Activate .

+ The license is being activated. You should receive your activation by email in less than 5 minutes. If not,
please contact support@microej.com.

« Once received by email, save the attached zip file that contains your activation key.

Install the License Key

« Go back to MicroEJ SDK.

« Selectthe Window > Preferences > MicroEJ menu.

2.2. Licenses 8
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+ Press Add... .

« Browse the previously downloaded activation key archive file.

« Press OK. A new license is successfully installed.

+ Go to Architectures sub-menu and check that all Architectures are now activated (green check).
« Your MicroEJ SDK is successfully activated.

If an error message appears, the license key could not be installed. (see section Troubleshooting). A license key can
be removed from key-store by selecting it and by clickingon Remove button.

Troubleshooting
Consider this section when an error message appears while adding the Evaluation license key. Before contacting
MicroEJ support, please check the following conditions:

+ Key is corrupted (wrong copy/paste, missing characters or extra characters)

+ Key has not been generated for the installed environment

+ Key has not been generated with the machine UID

« Machine UID has changed since submitting license request and no longer matches license key

+ Keyhasnotbeen generated for one of the installed Architectures (no license manager able to load this license)

= Invalid activation key &J

| The key could not be installed in this environment. Possible reasons are:

Sl® - keyis corrupted,

- key is valid but does not match any available license manager(s). (Works for an
other edition),

- key has not been generated for this machine,

- old key version,

Fig. 4: Invalid License Key Error Message

2.2.4 Production Licenses

This section should be considered when using Production Architectures, which use hardware license keys stored
on an USB dongle.

2.2. Licenses 9
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ys\a 12345678

Fig. 5: MicroEJ USB Dongle

Note: If your USB dongle has been provided to you by your sales representative and you don’t have received an
activation certificate by email, it may be a pre-activated dongle. Then you can skip the activation steps and directly
jump to Check Activation on MicroEJ SDK section.

Request your Activation Key

Go to license.microej.com.
Click on Create a new account link.

Create your account with a valid email address. You will receive a confirmation email a few minutes after.
Click on the confirmation link in the email and login with your new account.

Click on Activate a License .

Set Product P/N: to The P/N on the activation certificate.

Enter your UID: serial number printed on the USB dongle label (8 alphanumeric char.).
Clickon Activate and check confirmation message.

Click on Confirm your registration .

Enter the Registration Code provided on the activation certificate.

Clickon Submit .

Your Activation Key will be sent to you by email as soon as it is available (12 business hours max.).

Note: You can check the My Products page to verify your product registration status, the Activation Key avail-
ability and to download the Activation Key when available.

Once the Activation Key is available, download and save the Activation Key ZIP file to a local directory.

Activate your USB Dongle

This section contains instructions that will allow to flash your USB dongle with the proper activation key.

You shall ensure that the following prerequisites are met :

2.2. Licenses 10
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+ The USB dongle is plugged and recognized by your operating system (see Troubleshooting section)
« No more than one USB dongle is plugged to the computer while running the update tool

« The update tool is not launched from a Network drive or from a USB key

The activation key you downloaded is the one for the dongle UID on the sticker attached to the dongle (each
activation key is tied to the unique hardware ID of the dongle).

You can then proceed to the USB dongle update:
« Unzipthe Activation Key file to a local directory
+ Enter the directory just created by your ZIP extraction tool.

+ Launch the executable program.

+ Clickonthe Update button (no password needed)

2

%] Update Tool

K.eplcharacter string]

ey

|lpdate Cancel

Fig. 6: Dongle Update Tool

+ On success, an Update successfully message shall appear. On failure, an Error key or no proper
rockey message may appear.

update_E24C0785

I, Update successfully

oK

Fig. 7: Successful dongle update

2.2. Licenses 1
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Check Activation on MicroEJ SDK

Note: Production licenses will be shown only if at least one Production Architecture has been imported before (see

License Manager).

« Go back to MicroEJ SDK,

« Goto Window > Preferences > MicroEJ ,

« Goto Architectures or Platforms sub-menuand checkthatall Production Architectures or Platforms are

now activated (green check).

type filter text Platforms
BasyantdEclipse " Add or remove platforms.
> Help
. lceTea Platforms, Virtual Devices and Architectures:
> Install/Update ) Narne Version  Lic...
:”Sta”tmessag'”g [} FRDM-KL467 Jakarta Kickstart 125
> vy
. Java g me_ L‘\rchitect:.'re:CMD
4 Microfl [16¥ STM: Hardware Part Number: Jakarta
. [1€¥ STM3 Compilation Toolchain: CMO_ARMCC
Architectures (1€} sTM: Name: KickStart
MNaming Conventior 143 sTm: Provider: [52T
& eny Version: 1.35
; O 7 Core Engine Architecture: 14
Platforms in worksp ]
Updates (14} STM: Usage Level:Fer ]
P 143 STM: Technology Version: 1.6
> Mylyn 143 vLCD License Tag{ISZT_JBFSC
Planning 143 vico Build Label: 20130407-1647
» Plug-in Development Path: .microejrepositories\Full\1.64sd002
Fig. 8: Platform License Status OK
Troubleshooting

Select All
Deselect All
Import...
Uninstall

Get UID

This section contains instructions to check that your USB dongle is correctly recognized by your operating system.

GNU/Linux Troubleshooting

For GNU/Linux Users (Ubuntu at least), by default, the dongle access has not been granted to the user, you have to

modify udev rules. Please create a /etc/udev/rules.d/91-usbhdongle.rules file with the following contents:

ACTION!="add", GOTO="usbdongle_end”
SUBSYSTEM=="usb", GOTO="usbdongle_start”
SUBSYSTEMS=="usb", GOTO="usbdongle_start"”
GOTO="usbdongle_end"
LABEL="usbdongle_start”
ATTRS{idVendor}=="096e" , ATTRS{idProduct}=="0006" , MODE="0666"

LABEL="usbdongle_end"

Then, restart udev: /etc/init.d/udev restart

2.2. Licenses
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You can check that the device is recognized by running the 1susb command. The output of the command should
contain a line similar to the one below for each dongle : Bus 002 Device 003: ID 096e:0006 Feitian
Technologies, Inc.

Windows Troubleshooting

For Windows users, each dongle shall be recognized with the following hardware ID :

HID\VID_0Q96E&PID_0006&REV_0109

On Windows 8.1, go to Device Manager > Human Interface Devices and check amongthe USB Input Device
entries that the Details > Hardware Ids property match the ID mentioned before.

VirtualBox Troubleshooting

In a VirtualBox virtual machine, USB drives must be enabled to be recognized correctly. So make sure to enable the
USB dongle by clicking on it in the VirtualBox menu Devices > USB.

In order to make this setting persistent, go to Devices > USB > USB Settings... and add the USB donglein the
USB Devices Filters list.

2.3 MicroEJ Runtime

2.3.1 Language

MicroEJ is compatible with the Java language version 7.

Java source code is compiled by the Java compiler' into the binary format specified in the JVM specification’. This
binary code needs to be linked before execution: .class files and some other application-related files (see MicroEJ
Classpath) are compiled to produce the final application that the MicroEJ Runtime can execute.

MicroEJ complies with the deterministic class initialization (<clinit>) order specified in [BON]. The application is
statically analyzed from its entry points in order to generate a clinit dependency graph. The computed clinit se-
quence is the result of the topological sort of the dependency graph. An error is thrown if the clinit dependency
graph contains cycles.

2.3.2 Scheduler
The MicroEJ Architecture features a green thread platform that can interact with the C world [SNI]. The (green)
thread policy is as follows:

« preemptive for different priorities,

« round-robin for same priorities,

« “priority inheritance protocol” when priority inversion occurs.”

MicroEJ stacks (associated with the threads) automatically adapt their sizes according to the thread requirements:
Once the thread has finished, its associated stack is reclaimed, freeing the corresponding RAM memory.

! The JDT compiler from the Eclipse IDE.
2 Tim Lindholm & Frank Yellin, The Java™ Virtual Machine Specification, Second Edition, 1999
3 This protocol raises the priority of a thread (that is holding a resource needed by a higher priority task) to the priority of that task.

2.3. MicroEJ Runtime 13
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2.3.3 Garbage Collector

The MicroEJ Architecture includes a state-of-the-art memory management system, the Garbage Collector (GC).
It manages a bounded piece of RAM memory, devoted to the Java world. The GC automatically frees dead Java
objects, and defragments the memory in order to optimize RAM usage. This is done transparently while the MicroEJ
Applications keep running.

2.3.4 Foundation Libraries

Embedded Device Configuration (EDC)
The Embedded Device Configuration specification defines the minimal standard runtime environment for embed-
ded devices. It defines all default API packages:

« java.io

+ java.lang

+ java.lang.annotation

« java.lang.ref

+ java.lang.reflect

« java.util

Beyond Profile (BON)

[BON] defines a suitable and flexible way to fully control both memory usage and start-up sequences on devices
with limited memory resources. It does so within the boundaries of Java semantics. More precisely, it allows:

+ Controlling the initialization sequence in a deterministic way.

« Defining persistent, immutable, read-only objects (that may be placed into non-volatile memory areas), and
which do not require copies to be made in RAM to be manipulated.

« Defining immortal, read-write objects that are always alive.

+ Defining and accessing compile-time constants.

2.4 MicroEJ Libraries

A MicroEJ Foundation Library is a MicroEJ Core library that provides core runtime APIs or hardware-dependent
functionality. A Foundation library is divided into an APl and an implementation. A Foundation library APl is com-
posed of a name and a 2 digits version (e.g. EDC-1.3) and follows the semantic versioning (http://semver.org)
specification. A Foundation Library API only contains prototypes without code. Foundation Library implementa-
tions are provided by MicroEJ Platforms. From a MicroEJ Classpath, Foundation Library APIs dependencies are
automatically mapped to the associated implementations provided by the Platform or the Virtual Device on which
the application is being executed.

A MicroEJ Add-On Library is a MicroEJ library that is implemented on top of MicroEJ Foundation Libraries (100%
full Java code). A MicroEJ Add-On Library is distributed in a single JAR file, with a 3 digits version and provides its
associated source code.

Foundation and Add-On Libraries are added to MicroEJ Classpath by the application developer as module depen-
dencies (see MicroEJ Module Manager).

2.4. MicroEJ Libraries 14
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YOUR APPLICATION

ADD-ON LIBRARIES

FOUNDATION LIBRARIES

JAVA CODE

Fig. 9: MicroEJ Foundation Libraries and Add-On Libraries

MicroEJ Corp. provides a large number of libraries through the MicroEJ Central Repository. To consult its libraries
APIs documentation, please visit https://developer.microej.com/microej-apis/.

2.5 MicroEJ Central Repository

The MicroEJ Central Repository is the binary repository maintained by MicroEJ Corp. It contains Foundation Library
APIs and numerous Add-On Libraries. Foundation Libraries APIs are distributed under the organization ej.api and
com.microej.api . All other artifacts are Add-On Libraries.

By default, MicroEJ SDKis configured to connect online MicroEJ Central Repository. The MicroEJ Central Repository
can be downloaded locally for offline use. Please follow the steps described at https://developer.microej.com/
central-repository/.

To consult its libraries APls documentation, please visit https://developer.microej.com/microej-apis/.

2.6 Embedded Specification Requests

MicroEJ implements the following ESR Consortium specifications:

[BON] | http://e-s-r.net/download/specification/ESR-SPE-0001-BON-1.2-F.pdf

[SNI] http://e-s-r.net/download/specification/ESR-SPE-0012-SNI_GT-1.2-H.pdf
[SP] http://e-s-r.net/download/specification/ESR-SPE-0014-SP-2.0-A.pdf

[MUI] | http://e-s-r.net/download/specification/ESR-SPE-0002-MICROUI-2.0-B.pdf
[KF] http://e-s-r.net/download/specification/ESR-SPE-0020-KF-1.4-F.pdf

2.7 MicroEJ Firmware

2.7.1 Bootable Binary with Core Services
A MicroEJ Firmware is a binary software program that can be programmed into the flash memory of a device. A
MicroEJ Firmware includes an instance of a MicroEJ runtime linked to:

+ underlying native libraries and BSP + RTOS,

« MicroEJ libraries and application code (C and Java code).

2.5. MicroEJ Central Repository 15
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Fig. 10: MicroEJ Firmware Architecture

2.7.2 Specification

The set of libraries included in the firmware and its dimensioning limitations (maximum number of simulta-
neous threads, open connections, ...) are firmware specific. Please refer to https://developer.microej.com/5/
getting-started-studio.html for evaluation firmware release notes.

2.8 Introducing MicroEJ SDK

MicroEJ SDK provides tools based on Eclipse to develop software applications for MicroEJ-ready devices. MicroEJ
SDK allows application developers to write MicroEJ Applications and run them on a virtual (simulated) or real de-
vice.

This document is a step-by-step introduction to application development with MicroEJ SDK. The purpose of
MicroEJ SDK is to develop for targeted MCU/MPU computers (loT, wearable, etc.) and it is therefore a cross-
development tool.

Unlike standard low-level cross-development tools, MicroEJ SDK offers unique services like hardware simulation
and local deployment to the target hardware.

Application development is based on the following elements:

+ MicroEJ SDK, the integrated development environment for writing applications. It is based on Eclipse and is
relies on the integrated Java compiler (JDT). It also provides a dependency manager for managing MicroEJ
Libraries (see MicroEJ Module Manager). The current distribution of MicroEJ SDK ( 20.10 ) is built on top of
Eclipse 2020-06.

+ MicroEJ Platform, a software package including the resources and tools required for building and testing an
application for a specific MicroEJ-ready device. MicroEJ Platforms are imported into MicroEJ SDK within a
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local folder called MicroEJ Platforms repository. Once a MicroEJ Platform is imported, an application can be
launched and tested on Simulator. It also provides a mean to locally deploy the application on a MicroEJ-
ready device.

+ MicroEJ-ready device, an hardware device that will be programmed with a MicroEJ Firmware. A MicroEJ
Firmware is a binary instance of MicroEJ runtime for a target hardware board.

Starting from scratch, the steps to go through the whole process are detailed in the following sections of this chapter

« Download and install a MicroEJ Platform

« Build and run your first application on Simulator

« Build and run your first application on target hardware

2.9 Introducing MicroEJ Studio and Virtual Devices

MicroEJ Studio provides tools based on Eclipse to develop software applications for MicroEJ-ready devices. Mi-
croEJ Studio allows application developers to write MicroEJ Applications, run them on a virtual (simulated) or real
device, and publish them to a MicroEJ Forge instance.

This document is an introduction to application development with MicroEJ Studio. The purpose of MicroEJ Studio
is to develop for targeted MCU/MPU computers (loT, wearable, etc.) and it is therefore a cross-development tool.

Unlike standard low-level cross-development tools, MicroEJ Studio offers unique services like hardware simula-
tion, deployment to the target hardware and final publication to a MicroEJ Forge instance.

Application development is based on the following elements:

+ MicroEJ Studio, the integrated development environment for writing applications. It is based on Eclipse and
relies on the integrated Java compiler (JDT). It also provides a dependency manager for managing MicroEJ
Libraries (see MicroEJ Module Manager). The current distribution of MicroEJ Studio (19.05) is built on top of
Eclipse Oxygen (https://www.eclipse.org/oxygen/).

+ MicroEJ Virtual Device, a software package including the resources and tools required for building and test-
ing an application for a specific MicroEJ-ready device. A Virtual Device will simulate all capabilities of the
corresponding hardware board:

Computation and Memory,

Communication channels (e.g. Network, USB ...),

Display,

User interaction.

Virtual Devices are imported into MicroEJ Studio within a local folder called MicroEJ Repository. Once a Vir-
tual Device is imported, an application can be launched and tested on Simulator. It also provides a mean to
locally deploy the application on a MicroEJ-ready device.

+ MicroEJ-ready device, a hardware device that has been previously programmed with a MicroEJ Firmware. A
MicroEJ Firmware is a binary instance of MicroEJ runtime for a target hardware board. MicroEJ-ready devices
are built using MicroEJ SDK. MicroEJ Virtual Devices and MicroEJ Firmwares share the same version (there is
a1:1 mapping).

The following figure gives an overview of MicroEJ Studio possibilities:
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Fig. 11: MicroEJ Application Development Overview

2.10 Perform Online Getting Started

MicroEJ Studio Getting Started is available on https://developer.microej.com/5/getting-started-studio.html.
Starting from scratch, the steps to go through the whole process are:
1. Setup a board and test a MicroEJ Firmware:
« Select between one of the available boards;
« Download and install a MicroEJ Firmware on the target hardware;
« Deploy and run a MicroEJ demo on board.
2. Setup and learn to use development tools:
» Download and install MicroEJ Studio;
« Download and install the corresponding Virtual Device for the target hardware;
« Download, build and run your first application on Simulator;

« Build and run your first application on target hardware.

The following figure gives an overview of the MicroEJ software components required for both host computer and

target hardware:

2.10. Perform Online Getting Started


https://developer.microej.com/5/getting-started-studio.html

MicroEJ Documentation, Revision bd708584

MicroEJ - MicroEJ
Virtual Device Firmware
(.vde)

Q Software

MICROEJ Studio (-exe) (binary)
l Install I Install I Flash
$
. —
Your Workstation Local Target
with Simulator Deploy
Download
& Install
» | @ MICROEJ forge
Publish [ 2~

Fig. 12: MicroEJ Studio Development Imported Elements

2.11 GitHub Repositories

Alarge number of examples, libraries, demos and tools are shared on MicroEJ GitHub account: https://github.com/
MicroEJ.

Most of these GitHub repositories contain projects ready to be imported in MicroEJ SDK. This section explains the
steps to import them in MicroEJ SDK, using the MWT Examples repository.

Note: MicroEJ SDK Distribution includes the Eclipse plugin for Git.

First, from the GitHub page, copy the repository URI (HTTP address) from the dedicated field in the right menu
(highlighted in red):
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O Why GitHub? ~~ Team Enterprise Explore Marketplace Pricing Sign in ‘ Sign up |
& MicroE) / ExampleJava-MWT ®Watch | 2 TrStar | 1 Yok 0
<> Code Issues Pull requests Actions Projects Security Insights

$ master - P 1branch  © 2 tags Go to file About

These projects provide examples
Q privron Merge branch ‘develop’ into ‘master’ .. BJ Clone @ for MWT

HTTPS  GitHub CLI
: - e e (FF [ Readme
com.microej.example.mwt.basic ix api minor version @ignc https://github.con/MicroEl/Exanplela | 7]
com.microej.example.mwtbutt..  Fix api minor version @ignc  Use Git or checkout with SVN using the web URL. BB View license
com.microej.example.mwt.hello...  Fix api minor version @ignc
Et] Open with GitHub Desktop
. Releases
com.microej.example.mwt.mvc Fix api minor version @ignc
: - o - X B D load ZIP @ 2 tags
com.microej.example.mwtslidi..  Fix api minor version @igne & ownloa
[ .gh-copyright.template Move mwt example from foundation libraries @ignore_branc... 3 years ago
N e AT e A 1 e e o e e . Packages

In MicroEJ SDK, to clone and import the project from the remote Git repository into the MicroEJ workspace, select
File > Import > Git > Projectsfrom Git wizard.
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® |mport

Select

Import one or more projects from a Git Repository. Iﬁ

Select an import wizard:

type filter text

= General

= C/C++

= CV5
v = Git

S0 Projects from Git

= Install
= MicroEl
= Plug-in Development
[= Run/Debug
= Tasks
= Teamn
= XML

® < Back Finish Cancel

Click Next , select CloneURI ,click Next and paste the remote repository address in the URI field. For
this repository, the address is https://github.com/MicroEJ/ExampleJava-MWT.git. If the HTTP address is a valid
repository, the other fields are filed automatically.
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® |mport Projects from Git
Source Git Repository GIT
Enter the location of the source repository. :_‘:n‘
Location
URJ: ?| https:.-"fgithul:l.cum.-"MicrDElexampI&lava-M‘."H"T.giﬂ | Lacal File...
Host: | github.com |
Repository path: | /Microbl/Examplelava-MWT.git |
Connection
Protocol: | https
Authentication
User | |
Password: | |
[ ]5tore in Secure Store
® = Back Finish Cancel

Click Next , selectthe master branch, click Next and acceptthe proposed Local Destination by clicking Next

once again.

2.11. GitHub Repositories
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® |mport Projects from Git

Local Destination

GIT

Configure the local storage location for Examplelava-MWT. E‘
Destination

Directory: | IC:\Users\user\git\Examplelava-MWT | Browse
Initial branch: K master v

[]Clene submodules

Configuration

Remote name: | crigin

® < Back Finish Cancel

Click Next once more and finally Finish . The Package Explorer view now contains the imported projects.

£ Package Explorer &2 ‘Eg Type Hierarchy % ™

w '[c‘.gl- com.microgj.example.mwt.basic [Examplelava-MWT master]
& src/main/java
B\ Module Dependencies module.ivy [*]
[ src
[%} CHANGELOG.md
5 LICEMSE.txt
ke moduleivy
[#} README.md
'[c".gl- com.microgj.example.mwt.button [Examplelava-MWT master]
'_,fé com.microg).example.rmwt.helloworld [Examplelava-MWT master]
'[;_—'é com.microgj.example.mwt.mve [Examplelava-MWT master]

1—.;‘- com.microg).example.mwt.slidingwidget [Examplelava-MWT master]
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If you want to import projects from another (GitHub) repository, you simply have to do the same procedure using
the Git URL of the desired repository.

2.12 System Requirements

MicroEJ SDK and MicroEJ Studio

+ Intel x64 PC with minimum :
- Dual-core Core i5 processor
- 4GB RAM
- 2GB Disk

« Operating Systems :

Windows 10, Windows 8.1 or Windows 8

Linux distributions (tested on Ubuntu 18.04 and 20.04) - As of SDK 20.10 (based on Eclipse 2020-06),
Ubuntu 16.04 is not supported.

Mac OS X (tested on version 10.13 High Sierra, 10.14 Mojave)

« Java:

JRE or JDK 8 (OpenJDK or Oracle JDK)
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CHAPTER

THREE

APPLICATION DEVELOPER GUIDE

3.1 Introduction

The following sections of this document shall prove useful as a reference when developing applications for MicroEJ.
They cover concepts essential to MicroEJ Applications design.

In addition to these sections, by going to https://developer.microej.com/, you can access a number of helpful re-
sources such as:

« Libraries from the MicroEJ Central Repository (https://developer.microej.com/central-repository/);
« Application Examples as source code from MicroEJ Github Repositories (https://github.com/MicroEJ);
« Documentation (HOWTOs, Reference Manuals, APIs javadoc...).

MicroEJ Applications are developed as standard Java applications on Eclipse JDT, using Foundation Libraries. Mi-
croEJ SDK allows you to run / debug / deploy MicroEJ Applications on a MicroEJ Platform.

Two kinds of applications can be developed on MicroEJ: MicroEJ Standalone Applications and MicroEJ Sanboxed
Applications.

A MicroEJ Standalone Application is a MicroEJ Application that is directly linked to the C code to produce a Mi-
croEJ Firmware. Such application must define a main entry point, i.e. a class containing a public static void
main(String[]) method. MicroEJ Standalone Applications are developed using MicroEJ SDK.

A MicroEJ Sandboxed Application is a MicroEJ Application that can run over a Multi-Sandbox Firmware. It can be
linked either statically or dynamically. If it is statically linked, it is then called a System Application as it is part of
the initial image and cannot be removed. MicroEJ Sandboxed Applications are developed using MicroEJ Studio.

3.2 Local Workspaces and Repositories

When starting MicroEJ SDK, it prompts you to select the last used workspace or a default workspace on the first
run. A workspace is a main folder where to find a set of projects containing MicroEJ source code.

When loading a new workspace, MicroEJ SDK prompts for the location of the MicroEJ repository, where the Mi-
croEJ Architectures, Platforms or Virtual Devices will be imported. By default, MicroEJ SDK suggests to point to
the default MicroEJ repository on your operating system, located at ${user.home}/.microej/repositories/
[version]. You can select an alternative location. Another common practice is to define a local repository relative
to the workspace, so that the workspace is self-contained, without external file system links and can be shared
within a zip file.
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3.3 Standalone Application

3.3.1 Download and Install a MicroEJ Platform

MicroEJ SDK being a cross development tool, it does not build software targeted to your host desktop platform.
In order to run MicroEJ Applications, a target hardware is required. Several commercial targets boards from main
MCU/MPU chip manufacturers can be prepared to run MicrokJ Applications, you can also run your applications
without one of these boards with the help of a MicroEJ Simulator.

A MicroEJ Platform is a software package including the resources and tools required for building and testing an
application for a specific MicroEJ-ready device. MicroEJ Platforms are available at https://developer.microej.com/
5/getting-started-sdk.html.

After downloading the MicroEJ Platform, launch MicroEJ SDK on your desktop to start the process of Platform in-
stallation :

« Open the Platform view in MicroEJ SDK, select Window > Preferences > MicroEJ > Platforms . The
view should be empty on a fresh install of the tool

O Preferences = n
type filter text Platforms = v -
 General . Add or remove platforms.
. Ant
. CfC++ Platforms, Virtual Devices and Architectures:
Checkstyle Name WVersion Lic... Select All
EasyantdEclipse
- Help Deselect All
- Install/Update
Import...
. |W
- Java Uninstall
4 Microb)

Architectures Get UID
Maming Convention

Platforms in workspace
Updates

- Mylyn

- Plug-in Development

- PMD

@
Fig. 1: MicroEJ Platform Import

« Press Import... button.

» Choose SelectFile... andusethe Browse option to navigate tothe .jpf file containing your MicroEJ
Platform, then read and accept the license agreement to proceed.
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- oS

('} Import Platforms, Virtual Devices and Architectures

Import Platforms, ¥irtual Devices and Architectures

Select a directory/file to search for available platforms, virtual devices and architectures.

(") Select directory: Browse...
(®) Select file: Ch\Usersh, MicroEJPlatform jpof Browse...
Platforms, Yirtual Devices and Architectures:
Mame Yersion Select All
L} MicroE Platform 2.1.1 Deselect Al

MICROE) LICEMSE AGREEMENT

PREAMELE

THIS SOFTWARE LICEMNSE AGREEMENT (THE « AGREEMENT ») APPLIES TO PRODUCTS LICEMSE
On purchase of any Licensed Product from 52T or an 52T Partner or an [52T Distributor, the relz
THE LICEMSEE, AS A USER OF THE LICEMSED PRODUCTS REFERRED TO ABOVE AND OM THE REI

1 DEFIMITIONS

€ >

[+]1 agree and accept the above terms and conditions and | want to install the copyrighted Software

Fig. 2: MicroEJ Platform Selection

+ The MicroEJ Platform should now appear in the Platforms view, with a green valid mark.

3.3. Standalone Application
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O

ty

Preferences = n

rpe filter text Platforms =1 v w

» General ~
» Ant
s CfC++ Platforms, Virtual Devices and Architectures:

Checkstyle MName Version  Lic.. Select All

EasyantdEclipse ;
211 >
. Help L} MicroEJ Piatform o Deselect Al

+ Install/Update
> Iy

. Java

Add or remove platforms.

Import...

Uninstall

4 Microk)

<

Architectures Get UID
Maming Conventicon
Platforms in workspace
Updates

» Mylyn

» Plug-in Development

> PMD

noom Restare Defaults Apply

3.3

Fig. 3: MicroEJ Platform List

.2 Build and Run an Application

Create a MicroEJ Standalone Application

« Create a project in your workspace. Select File > New > MicroEJ Standalone Application Project .

File | Edit Source Refactor Mavigate Search Project Run  Window Help
Mew Alt+Shift+N » | (22 MicroE) Standalone Application Project -
Open File... \g MicroE) Standalone Example Project
Cloze Ctrl+W ‘3 ST
Close Al CtrlShift+ W R
£ MicroE) Sandboxed Application Project
Sav |+ 5
Save Ctrl+5 |=<3 T
Save Az
FE¥  MirrnFl Eant
Fig. 4: New MicroEJ Standalone Application Project
« Fillin the application template fields, the Project name field will automatically duplicate in the following
fields. Click on Finish . A template project is automatically created and ready to use, this project already
contains all folders wherein developers need to put content:
- src/main/java: Folder for future sources
- src/main/resources : Folder for future resources (images, fonts, etc.)
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- META-INF : Sandboxed Application configuration and resources

- module.ivy: lvyinput file, dependencies description for the current project

+ Rightclickonthesourcefolder src/main/java andselect New > Package . Giveaname: com.mycompany
. Clickon Finish .

0 Mew Java Package - 0 n
Java Package

Create a new Java package.

Creates folders corresponding to packages.

Source folder: | MyTest/src Browse...

Mame: COM.Mmycompany

[ | Create package-info.java

Fig. 5: New Package

+ The package com.mycompany is available under src/main/java folder. Right click on this package and
select New > Class . Give a name: Test and check the box public static void main(String[]

args) . Clickon Finish .
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0 Mew Java Class - B n

Jawva Class —=
Create a8 new Java class, @

Source folder: MyTest/src Browse...

Package: COM.mMycompany Browse...

[ Enclosing type: Browse...

Mame: Test

Modifiers: (@) public () package private protected

[ ]abstract [ ]final ctatic

Superclass: java.lang.Object Browse...

Interfaces: Add...
Bemowve

Which method stubs would you like to create?
[#]ipublic static void main(String[] args);

[ ] Constructors from superclass
Inherited abstract methods
Do you want to add comments? (Configure templates and default value here

|:| Generate comments

Fig. 6: New Class

+ The new class has been created with an empty main() method. Fill the method body with the following
lines:

System.out.println("hello world!");
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by module.ivy [J] Testjava &3

package com.mycompany;

public class Test {

-
“

public =s=tatic void main(String[] args) {1
System.out.println("hello world!"™});

Fig. 7: MicroEJ Application Content
The test application is now ready to be executed. See next sections.

Run on the Simulator

To run the sample project on Simulator, select it in the left panel then right-click and select Run > Runas >

MicroEJ Application .
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package com.mycompany;

4 Go Into public class Test {

Open in New Window public static void main

Open Type Hierarchy F4 System.out.println/

Show In Alt+Shift+W »

0

=
= {2 | Copy Ctrl+C
¥ | BS

w —

Copy Qualified Mame
[ Paste Ctrl+V
. Delete Delete

Build Path »
Source Alt+Shift+5 ¥
Refactor Alt+Shift+T »

Import...
Export...

EE

wit  Refresh F5
Close Project
Close Unrelated Projects

Assign Warking Sets..,

Run As »
Debug As *
Profile As »
Validate

@ Ruild with Faswlnt

1 lava Applet Alt+5hift+X, A
2 Java Application Alt+Shift+X, J
3 Microk) Application Alt+Shift+X, M

MM A

Run Cenfigurations..,

"

Fig. 8: MicroEJ Development Tools Overview

MicroEJ SDK console will display Launch steps messages.

=============== [ Initialization Stage ) =
=== eI Launchj_ng on Simulator ] ===============

SUCCESS

Run on the Hardware Device

Compile an application, connect the hardware device and deploy on it is hardware dependant. These steps are
described in dedicated documentation available inside the MicroEJ Platform. This documentation is accessible
from the MicroEJ Resources Center view.

Note: MicroEJ Resources Center view may have been closed. Click on Help > MicroEJ Resources Center to
reopen it.
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Open the menu Manual and select the documentation [hardware device] MicroEJ Platform, where
[hardware device] is the name of the hardware device. This documentation features a guide to run a built-in
application on MicroEJ Simulator and on hardware device.

MicroE) Resource Center 23
type filter text
. &2 Javadoc

6 Manual

[l Hardware Device MicroE] Platform

Fig. 9: MicroEJ Platform Guide

3.3.3 Build Output Files
When building a MicroEJ Application, multiple files are generated next to the ELF file. These files are generated in a
folder which is named like the main type and which is located in the output folder specified in the run configuration.

The following image shows an example of output folder:

v [ com.microg).demo.widget.common.Mavigation
= bon
[= cC
[ externalResources
= fonts
= heapDump
= Images
= logs
= platform
= resourceBuffer
w [—- soar
=| com.microgj.demowidget.common.Mavigation.clinitrap
com.micreel.demo.widget.common.MNavigation.o
Ei com.micreel.demo.widget.common.Mavigation.s3infos
|X| com.microg.demowidget.commen.Mavigation.xml
L] sni_intern.h
[ SOAR.map

SOAR.o

Fig. 10: Build Output Files
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The SOAR Map File

The SOAR.map file lists every embedded symbol of the application (section, Java class or method, etc.) and its size
in ROM or RAM. This file can be opened using the Memory Map Analyzer.

The embedded symbols are grouped into multiple categories. For example, the Object class and its methods are
grouped inthe LibFoundationEDC category. For each symbol or each category, you can see its size in ROM ( Image
Size)and RAM (Runtime Size).

The SOAR groups all the Java strings in the same section, which appearsinthe ApplicationStrings category. The
same appliesto the staticfields (Statics category), thetypes (Types category), and the class names (ClassNames
category).

The SOAR Information File

The soar/<main class>.xml file can be opened using any XML editor.
This file contains the list of the following embedded elements:

« method (in selected_methods tag)

« resource (in selected_resources tag)

« system property (in java_properties tag)

« string (in selected_internStrings tag)

« type (in selected_types tag)

« immutable (in selected_immutables tag)

3.3.4 MicroEJ Launch

The MicroEJ launch configuration sets up the MicroEJ Applications environment (main class, resources, target plat-
form, and platform-specific options), and then launches a MicroEJ launch script for execution.

Execution is done on either the MicroEJ Platform or the MicroEJ Simulator. The launch operation is platform-
specific. It may depend on external tools that the platform requires (such as target memory programming). Refer
to the platform-specific documentation for more information about available launch settings.

Main Tab

The Main tab allows you to setin order:
1. The main project of the application.
2. The main class of the application containing the main method.

3. Types required in your application that are not statically embedded from the main class entry point. Most
required types are those that may be loaded dynamically by the application, using the Class.forName()
method.

4. Binary resources that need to be embedded by the application. These are usually loaded by the application
using the Class.getResourceAsStream() method.

5. Immutable objects’ description files. See the [BON 1.2] ESR documentation for use of immutable objects.
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0 Run Configurations n
Create. manage. and run configurations ;—I
- —*|,
= x| H 5 Name: | HelloWerld
type filter text 3] Main s Execution| 8§ Configuration | g, JRE E Source | [[] Commen
E C/C++ Application Praject ~
Ju JUnit
BI;I La::'1ch Group MyHelloWorld5ample Browse...
4 [7] MicroE) Application Main type, Required types
31 HelloWarld
& MicroE Tool com.is2t.examples.edc.helle. HelloWorld Select Main type...
Add types...
Extra types...
Remove
Resources
Add...
Remove
Immutables v
Revert Apply

Filter matched 6 of 11 items

Fig. 11: MicroEJ Launch Application Main Tab

Execution Tab

The next tab is the Execution tab. Here the target needs to be selected. Choose between execution on a MicroEJ
Platform or on a MicroEJ Simulator. Each of them may provide multiple launch settings. This page also allows you
to keep generated, intermediate files and to print verbose options (advanced debug purpose options).
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G— Run Cenfigurations

Create, manage, and run configurations

)

CEX B3P~

type filter text

] C/C++ Application
Ju JUnit

Name: | Widget Demo (SIM)

3] Main | = Execution

A Configuratioﬂ B JRE} E_/ Source\l i=| Qommoﬂ

Target

Platfarm: | STM32F746G-DISCO SingleApp Production [K1AU3] (4.0.0-RC202007301413) | Browse...
L Launch Group
w [T MicroE) Application Execution
& W!dget Demo (EMB) (®) Execute on Simulator () Execute on Device
[3] Widget Demo (SIM])
» g MicroE! Tool Core Engine Mode: MDefanl ~
Settings: | Default ~ | Seftings: | Build & Deploy w
The Application is simulated
Cptions
Output folder: | S{project_loc:com.microej.demouwidget} Browse...
Clean intermediate files [ Verbose
Opticns Files
Y project_loc:com.microe].demo.widget}/build/commeoen.properties Add...
Y project_loc:com.microgj.demo.widgetl/build/sim/sim.properties
Remove
Up
Down
Revert Appl
Filter matched 8 of 21 items = e
@

Configuration Tab

Fig. 12: MicroEJ Launch Application Execution Tab

The next tabis the Configuration tab. Thistab contains all platform-specific options.

3.3. Standalone Application
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ﬂ Run Configurations n

Create. manage. and run configurations -
w,

S X B2 Name: | HelloWorld

type filter text 37 Main | s Execution | ifif Configuration g, JRE E Source | [[] Commen
[E] C/C++ Application 4 Debug
Ju JUnit Code Coverage
[ Launch Group Heap Dumper
4 [7] MicroE) Application 1Dwe
Logs
@ MicroE) Tool 4 Simulator
Com Port
F5
HAL
4 Target
Memory

Specify debug options

4 Libraries
EDC
Shielded Plug
. ECOM
FS
> Microll
Met
MNLS
S5L

. . Revert Apply
Filter matched 6 of 11 items

Fig. 13: Configuration Tab

JRE Tab

The next tabisthe JRE tab. Thistab allows you to configure the Java Runtime Environment used for running the
underlying launch script. It does not configure the MicroEJ Application execution. The VM Arguments text field
allows you to set vm-specific options, which are typically used to increase memory spaces:

« To modify heap space to 1024MB, set the -Xmx1024M option.

« To modify string space (also called PermGen space) to 256MB, set the -XX:PermSize=256M
-XX:MaxPermSize=256M options.

« To set thread stack space to 512MB, set the -Xss512M option.

Other Tabs

The next tabs ( Source and Common tabs) are the default Eclipse launch tabs. Refer to Eclipse help for more
details on how to use these launch tabs.
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3.3.5 Application Options
Introduction
To run a MicroEJ Standalone Application on a MicroEJ Platform, a set of options must be defined. Options can be
of different types:
« Memory Allocation options (e.g set the Java Heap size). These options are usually called link-time options.
« Simulator & Debug options (e.g. enable periodic Java Heap dump).
+ Deployment options (e.g. copy microejapp.o to a suitable BSP location).
« Foundation Library specific options (e.g. embed UTF-8 encoding).

The following section describes options provided by MicroEJ Architecture. Please consult the appropriate MicroEJ
Pack documentation for options related to other Foundation Libraries (MicroUl, NET, SSL, FS, ...) integrated to the
Platform.

Notice that some options may not be available, in the following cases:

« Option is specific to the MicroEJ Core Engine capability (tiny/single/multi) which is integrated in the targeted
Platform.

+ Option is specific to the target (MicroEJ Core Engine on Device or Simulator).

« Option has been introduced in a newer version of the MicroEJ Architecture which is integrated in the targeted
Platform.

+ Options related to Board Support Package (BSP) connection.

Defining an Option

A MicroEJ Standalone Application option can be defined either from a launcher or from a properties file. It is also
possible to use both together. Each MicroEJ Architecture and MicroEJ Pack option comes with a default value,
which is used if the option has not been set by the user.

Using a Launcher

To set an option in a launcher, perform the following steps:

1. In MicroEJ Studio/SDK, select Run > Run Configurations... menu,
2. Select the launcher of the application under MicroEJ Application or create a new one,

3. Select the Configuration tab,

4. Find the desired option and set it to the desired value.

It is recommended to index the launcher configuration to your version control system. To export launcher options
to the filesystem, perform the following steps:

1. Selectthe Common tab,
2. Selectthe Shared file: option and browse the desired export folder,

3. Pressthe Apply button. Afile named [launcher_configuration_name].launch is generated in the ex-
port folder.
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Using a Properties File

Options can be also be defined in properties files.

When a MicroEJ Standalone Application is built using the firmware-singleapp skeleton, options are loaded from
properties files located in the build folder at the root of the project.

The properties files are loaded in the following order:

1. Every file matching build/sim/x.properties, for Simulator options only (Virtual Device build). These files
are optional.

2. Every file matching build/emb/x.properties, for Device options only (Firmware build). These files are
optional.

3. Everyfile matching build/*.properties, bothfor Simulatorand Device options. At least one fileis required.
Usually, the build folder contains a single file named common.properties.

In case an option is defined in multiple properties files, the option of the first loaded file is taken into account and
the same option defined in the other files is ignored (a loaded option cannot be overridden).

The figure below shows the expected tree of the build folder:

v [ build
v [ emb
=| emb.properties
W [ sim
=| sim.properties
5 common.properties

Fig. 14: Build Options Folder

Itis recommended to index the properties files to your version control system.

To set an option in a properties file, open the file in a text editor and add a line to set the desired option to the
desired value. For example: soar.generate.classnames=false.

To use the options declared in properties files in a launcher, perform the following steps:
1. In MicroEJ Studio/SDK, select Run > Run Configurations... ,
2. Select the launcher of the application,
3. Selectthe Execution tab,
4. Under Option Files , pressthe Add... button,

5. Browse the sim.properties file for Simulator or the emb.properties file for Device (if any) and press
Open button,

6. Add the common.properties file and pressthe Open button.

Note: An option setin a properties file can not be modified in the Configuration tab. Options are loaded in the
order the properties files are added (you can use Up and Down buttons to change thefile order). In Configuration
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tab, hovering the pointer over an option field will show the location of the properties file that defines the option.

Generating a Properties File

In order to export options defined ina . launch file to a properties file, perform the following steps:

1. Selectthe [launcher_configuration_name].launch file,

2. Select File > Export > MicroEJ > Launcher as Properties File ,
3. Browse the desired output .properties file,
4. Pressthe Finish button.

Category: Runtime

w Device T
es
v CoreEngine P
Kernel [JEmbed all type names
Watchdog
Deploy
v Feature [] Execute assertions on Simulator
Dynamic Download
~ Libraries [] Execute assertions on Device
v ECOM
Comm Connection
EDC [ Enable execution traces
External Resources Loader
Shielded Plug [ start execution traces automatically

Assertions

Trace

~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Types
Option(checkbox): Embed all type names

Option Name: soar.generate.classnames
Default value: true
Description:

Embed the name of all types. When this option is disabled, only names of declared required types are embedded.
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Group: Assertions
Option(checkbox): Execute assertions on Simulator

Option Name: core.assertions.sim.enabled
Default value: false
Description:

When this option is enabled, assert statements are executed. Please note that the executed code may produce
side effects or throw java.lang.AssertionError.

Option(checkbox): Execute assertions on Device

Option Name: core.assertions.emb.enabled
Default value: false
Description:

When this option is enabled, assert statements are executed. Please note that the executed code may produce
side effects or throw java.lang.AssertionError.

Group: Trace
Option(checkbox): Enable execution traces

Option Name: core.trace.enabled

Default value: false

Option(checkbox): Start execution traces automatically

Option Name: core.trace.autostart

Default value: false
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Category: Memory

w Device Heaps

v CoreEngine L
Kernel Java heap size (in bytes) | |
Watchdog
Deploy
w Feature

Immortal heap size (in bytes) | |

Dynamic Download Threads

w Libraries Number of threads | |
v ECOM
Comm Connection Number of blocks in pool | |

EDC
External Resources Loader Block size (in bytes) | |
Shielded Plug

w Runtime Maximum size of thread stack (in blocks) | |
Memory

Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Heaps
Option(text): Java heap size (in bytes)

Option Name: core.memory. javaheap.size
Default value: 65536

Description:

Specifies the Java heap size in bytes.

A Java heap contains live Java objects. An OutOfMemory error can occur if the heap is too small.

Option(text): Immortal heap size (in bytes)

Option Name: core.memory.immortal.size
Default value: 4096

Description:

Specifies the Immortal heap size in bytes.

The Immortal heap contains allocated Immortal objects. An OutOfMemory error can occur if the heap is too small.

Group: Threads

Description:
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This group allows the configuration of application and library thread(s). A thread needs a stack to run. This stack
is allocated from a pool and this pool contains several blocks. Each block has the same size. At thread startup the
thread uses only one block for its stack. When the first block is full it uses another block. The maximum number of
blocks per thread must be specified. When the maximum number of blocks for a thread is reached or when there
is no free block in the pool, a StackOverflow error is thrown. When a thread terminates all associated blocks are
freed. These blocks can then be used by other threads.

Option(text): Number of threads

Option Name: core.memory.threads.size
Default value: 5
Description:

Specifies the number of threads the application will be able to use at the same time.

Option(text): Number of blocks in pool

Option Name: core.memory.threads.pool.size
Default value: 15
Description:

Specifies the number of blocks in the stacks pool.

Option(text): Block size (in bytes)

Option Name: core.memory.thread.block.size
Default value: 512
Description:

Specifies the thread stack block size (in bytes).

Option(text): Maximum size of thread stack (in blocks)

Option Name: core.memory.thread.max.size
Default value: 4
Description:

Specifies the maximum number of blocks a thread can use. If a thread requires more blocks a StackOverflow error
will occur.
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Category: Simulator

~ Device Options
v CoreEngine

Kernel [[]Use target characteristics

Watchdog Slowing factor (0 means disabled): | 0
Deploy
v Feature . HIL Connectien
Dynamic Download
w Libraries [ Specify a port
w ECOM
Comm Connection 8001
EDC
External Resources Loader HIL connection timeout: | 10 |
Shielded Plug
~ Runtime Shielded Plug server configuration
. Memory Server socket port: | 10082 |
w Simulator

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Options

Description:

This group specifies options for MicroEJ Simulator.

Option(checkbox): Use target characteristics

Option Name: s3.board.compliant
Default value: false
Description:

When selected, this option forces the MicroEJ Simulator to use the MicroEJ Platform exact characteristics. It sets
the MicroEJ Simulator scheduling policy according to the MicroEJ Platform one. It forces resources to be explicitly
specified. It enables log trace and gives information about the RAM memory size the MicroEJ Platform uses.

Option(text): Slowing factor (0 means disabled)

Option Name: s3.slow
Default value: 0
Description:

Format: Positive integer

This option allows the MicroEJ Simulator to be slowed down in order to match the MicroEJ Platform execution
speed. The greater the slowing factor, the slower the MicroEJ Simulator runs.
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Group: HIL Connection

Description:

This group enables the control of HIL (Hardware In the Loop) connection parameters (connection between MicroEJ
Simulator and the Mocks).

Option(checkbox): Specify a port

Option Name: s3.hil.use.port
Default value: false
Description:

When selected allows the use of a specific HIL connection port, otherwise a random free port is used.

Option(text): HIL connection port

Option Name: s3.hil.port
Default value: 8001
Description:

Format: Positive integer
Values: [1024-65535]

It specifies the port used by the MicroEJ Simulator to accept HIL connections.

Option(text): HIL connection timeout

Option Name: s3.hil.timeout
Default value: 10

Description:

Format: Positive integer

It specifies the time the MicroEJ Simulator should wait before failing when it invokes native methods.

Group: Shielded Plug server configuration

Description:

This group allows configuration of the Shielded Plug database.

Option(text): Server socket port

Option Name: sp.server.port
Default value: 10082

Description:
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Set the Shielded Plug server socket port.

Category: Code Coverage

~ Device Code Coverage
w CoreEngine
Kernel
Watchdog
Deploy
w Feature

[ Activate code coverage analysis

Dynamic Download
w Libraries
v ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Code Coverage

Description:

This group is used to set parameters of the code coverage analysis tool.

Option(checkbox): Activate code coverage analysis

Option Name: s3.cc.activated
Default value: false
Description:

When selected it enables the code coverage analysis by the MicroEJ Simulator. Resulting files are output in the cc
directory inside the output directory.

Option(text): Saving coverage information period (in sec.)

Option Name: s3.cc.thread.period
Default value: 15
Description:

It specifies the period between the generation of .cc files.
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Category: Debug

v Device Remote Debug
v CoreEngine
Kernel Debug port: | 12000
Watchdog
Deploy
w Feature

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Remote Debug
Option(text): Debug port

Option Name: debug.port
Default value: 12000
Description:

Configures the JDWP debug port.
Format: Positive integer

Values: [1024-65535]
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Category: Heap Dumper

~ Device Heap Inspection

v CoreEngine i
Kernel [] Activate heap dumper
Watchdog
Deploy
w Feature
Dynamic Download
~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Heap Inspection

Description:

This group is used to specify heap inspection properties.

Option(checkbox): Activate heap dumper

Option Name: s3.inspect.heap
Default value: false

Description:

When selected, this option enables a dump of the heap each time the System.gc() method is called by the MicroEJ

Application.
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Category: Logs

w Device

Logs
v CoreEngine L
system thread maonitoring
Kernel 2
Watchdog memory schedule monitors
Deploy
w Feature 2

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Logs

Description:

This group defines parameters for MicroEJ Simulator log activity. Note that logs can only be generated if the
Simulator > Use target characteristics optionis selected.

Some logs are sent when the platform executes some specific action (such as start thread, start GC, etc), other logs
are sent periodically (according to defined log level and the log periodicity).

Option(checkbox): system

Option Name: console.logs.level.low

Default value: false

Description:

When selected, System logs are sent when the platform executes the following actions:
start and terminate a thread

start and terminate a GC

exit

Option(checkbox): thread

Option Name: console.logs.level.thread
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Default value: false
Description:

When selected, thread information is sent periodically. It gives information about alive threads (status, memory
allocation, stack size).

Option(checkbox): monitoring

Option Name: console.logs.level .monitoring
Default value: false
Description:

When selected, thread monitoring logs are sent periodically. It gives information about time execution of threads.

Option(checkbox): memory

Option Name: console.logs.level .memory
Default value: false
Description:

When selected, memory allocation logs are sent periodically. This level allows to supervise memory allocation.

Option(checkbox): schedule

Option Name: console.logs.level.schedule
Default value: false
Description:

When selected, a log is sent when the platform schedules a thread.

Option(checkbox): monitors

Option Name: console.logs.level .monitors
Default value: false
Description:

When selected, monitors information is sent periodically. This level permits tracing of all thread state by tracing
monitor operations.

Option(text): period (in sec.)

Option Name: console.logs.period
Default value: 2
Description:

Format: Positive integer
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Values: [0-60]

Defines the periodicity of periodical logs.

Category: Device

w Device Device Architecture
w CoreEngine
Kernel
Watchdog
Deploy

[] Use a custom device architecture

~ Feature
Device Uni D
Dynamic Download evice Lnique

w Libraries [ Use a custom device unique ID
w ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Device Architecture

Option(checkbox): Use a custom device architecture

Option Name: s3.mock.device.architecture.option.use

Default value: false

Option(text): Architecture Name

Option Name: s3.mock.device.architecture.option

Default value: (empty)

Group: Device Unique ID

Option(checkbox): Use a custom device unique ID

Option Name: s3.mock.device.id.option.use

Default value: false
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Option(text): Unique ID (hexadecimal value)

Option Name: s3.mock.device.id.option

Default value: (empty)

Category: Com Port

w Device
w CoreEngine
Kernel
Watchdog
Deploy
w Feature
Dynamic Download
w Libraries
v ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs
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Category: Libraries

w Device
w CoreEngine
Kernel
Watchdog
Deploy
w Feature
Dynamic Download
w Libraries
v ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Category: EDC

w Device Java System.out

v Cor;:rr;gewlne [ Use a custom Java output stream
Watchdog
Deploy
w Feature

Runti ti
Dynamic Download B

~ Libraries Embed UTF-8 enceding
v ECOM .
Comm Connection []Enable SecurityManager checks
EDC
External Resources Loader
Shielded Plug

~ Runtime
Memary

w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Java System.out
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Option(checkbox): Use a custom Java output stream

Option Name: core.outputstream.disable.uart

Default value: false

Description:

Select this option to specify another Java System.out print stream.

If selected, the default Java output stream is not used by the Java application. the JPF will not use the default Java
output stream at startup.

Option(text): Class

Option Name: core.outputstream.class

Default value: (empty)

Description:

Format: Java class like packageA.packageB.className
Defines the Java class used to manage System.out.

At startup the JPF will try to load this class using the Class.forName() method. If the given class is not available,
the JPF will use the default Java output stream as usual. The specified class must be available in the application
classpath.

Group: Runtime options

Description:

Specifies the additional classes to embed at runtime.

Option(checkbox): Embed UTF-8 encoding

Option Name: cldc.encoding.utf8.included
Default value: true
Description:

Embed UTF-8 encoding.

Option(checkbox): Enable SecurityManager checks

Option Name: com.microej.library.edc.securitymanager.enabled
Default value: false
Description:

Enable the security manager runtime checks.
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Category: Shielded Plug

v Device Shielded Plug configuration
v CoreEngine
Kernel Database definition: Browse...
Watchdog
Deploy
w Feature

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Shielded Plug configuration

Description:

Choose the database XML definition.

Option(browse): Database definition

Option Name: sp.database.definition
Default value: (empty)
Description:

Choose the database XML definition.
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Category: ECOM

w Device Device Management

v CoreEngine ] ) -
Kernel [ Enable registration event notifications
Watchdog
Deploy
w Feature
Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Device Management
Option(checkbox): Enable registration event notifications

Option Name: com.is2t.ecom.eventpump.enabled
Default value: false
Description:

Enables notification of listeners when devices are registered or unregistered. When a device is registered or un-
registered, a new ej.ecom.io.RegistrationEvent isadded to an event queue. Then events are processed by a
dedicated thread that notifies registered listeners.

Option(text): Registration events queue size

Option Name: com.is2t.ecom.eventpump.size
Default value: 5
Description:

Specifies the size (in number of events) of the registration events queue.
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Category: Comm Connection

w Device Comm Connection Options

w CoreEngine

Kernel []Enable comm connections

Watchdog
Deploy Device Management

v Feature Enable dynamic comm ports registration
Dynamic Download
~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Comm Connection Options

Description:

This group allows comm connections to be enabled and application-platform mappings set.

Option(checkbox): Enable comm connections

Option Name: use.comm.connection
Default value: false
Description:

When checked application is able to open a CommConnection.

Group: Device Management
Option(checkbox): Enable dynamic comm ports registration

Option Name: com.is2t.ecom.comm.registryPump.enabled
Default value: false
Description:

Enables registration (or unregistration) of ports dynamically added (or removed) by the platform. A dedicated
thread listens for ports dynamically added (or removed) by the platform and adds (or removes) their CommPort
representation to the ECOM DeviceManager .
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Category: External Resources Loader

<

Device External Resources Loader

v CoreEngine

Kernel Folder where are stored the resources which will be pregrammed outside CPU address
space range (storage media like SD card, serial NOR flash, EEPROM).
Watchdog The resources which will be linked into the CPU address space range (internal
Deploy device memeories, external parallel memories) must be listed in the Resources box
w Feature of Main tab.

Dynamic Download

~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime

Browse...

Memory

w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: External Resources Loader

Description:

This group allows to specify the external resources input folder. The content of this folder will be copied in an
application output folder and used by SOAR and the Simulator. If empty, the default location will be [output
folder]/externalResources, where [output folder] is the location defined in Execution tab.

Option(browse):

Option Name: ej.externalResources.input.dir
Default value: (empty)
Description:

Browse to specify the external resources folder..
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Category: Device

w Device
w CoreEngine
Kernel
Watchdog
Deploy
w Feature
Dynamic Download
w Libraries
v ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Category: Core Engine

v Device
v CoreEngine
Kernel
Watchdog
Deploy
w Feature
Dynamic Download
~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memary
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Memory

Specify target options

Memory

Maximum number of monitors per thread

Maximum number of frames dumped on OutOfMemoryError
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Option(text):

Option Name: core.memory.thread.max.nb.monitors
Default value: 8
Description:

Specifies the maximum number of monitors a thread can own at the same time.

Option(text):

Option Name: core.memory.oome.nb.frames
Default value: 5
Description:

Specifies the maximum number of stack frames that can be dumped to the standard output when Core Engine
throws an OutOfMemoryError.

Category: Kernel

Device

<

[] Check APIs allowed by Kernel
v CoreEngine

Kernel Threads
Watchdog
Deploy
~ Feature

Maximum number of threads per Feature | |

Installed Features
Dynamic Download

w Libraries Maximum number of installed Features | |
v ECOM
Comm Connection Code Size (in bytes) | |
EDC
External Resources Loader Runtime Size (in bytes) | |
Shielded Plug
~ Runtime

Memary

w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Option(checkbox): Check APIs allowed by Kernel

Option Name: apis.check.enable

Default value: true
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Group: Threads
Option(text):

Option Name: core.memory.feature.max.threads
Default value: 5
Description:

Specifies the maximum number of threads a Feature is allowed to use at the same time.

Group: Installed Features
Option(text):

Option Name: core.memory.installed.features.max
Default value: 0
Description:

Specifies the maximum number of installed Features that can be added to this Kernel.

Option(text):

Option Name: core.memory.installed.features.text.size
Default value: ©
Description:

Specifies the size in bytes reserved for installed Features code.

Option(text):

Option Name: core.memory.installed.features.bss.size
Default value: ©
Description:

Specifies the size in bytes reserved for installed Features runtime memory.
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Category: Watchdog

v Device
+ CoreEngine [ Enable watchdog support

Kernel Watchdog
Watchdog Mazximum number of active watchdogs
Deploy

w Feature
Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Option(checkbox): Enable watchdog support

Option Name: enable.watchdog. support

Default value: true

Group: Watchdog
Option(text):

Option Name: maximum.active.watchdogs
Default value: 4

Description:

Specifies the maximum number of active watchdogs at the same time.
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Category: Deploy

~ Device Configuration

v CoreEngine
Kemgel [ Deploy the compiled MicroE) application in a folder in MicroE) application main class project
Watchdog
Deploy
w Feature

Output file: | Browse...

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Description:

Configures the output location where store the MicroEJ Application, the MicroEJ platform libraries and header files.

Group: Configuration

Option(checkbox): Deploy the compiled MicroEJ Application in a folder in MicroEJ Application main class
project

Default value: true
Description:

Deploy the compiled MicroEJ Application in a folder in MicroEJ Application’s main class project.

Option(browse): Output file

Option Name: deploy.copy.filename
Default value: (empty)
Description:

Choose an output file location where copy the compiled MicroEJ Application.
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Category: Feature

e [‘J'ewcc:re Engine Specify Feature options
Kernel
Watchdog
Deploy
~ Feature
Dynamic Download
w Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Description:

Specify Feature options
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Category: Dynamic Download

v Device Dynamic Download
v CoreEngine
Kernel Output Name: |
Watchdog
Deploy Kernel: | F—
w Feature

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Dynamic Download
Option(text): Output Name

Option Name: feature.output.basename

Default value: application

Option(browse): Kernel

Option Name: kernel.filename

Default value: (empty)

3.3.6 SOAR

SOAR complies with the deterministic class initialization ( <clinit>) order specified in /[BON]. The application is
statically analyzed from its entry points in order to generate a clinit dependency graph. The computed clinit se-
quence is the result of the topological sort of the dependency graph. An error is thrown if the clinit dependency
graph contains cycles.

An explicit clinit dependency can be declared by creating an XML file with the .clinitdesc extension in the ap-
plication classpath. The file has the following format:

<?xml version='1.0' encoding='UTF-8'?>
<clinit>
(continues on next page)
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(continued from previous page)

<type name="T1" depends="T2"/>
</clinit>

where T1 and T2 are fully qualified names on the form a.b.C. This explicitly forces SOAR to create a dependency
from T1 to T2, and therefore cuts a potentially detected dependency from T2 to T1.

Aclinit map file (ending with extension .clinitmap)is generated beside the SOAR object file. It describes for each
clinit dependency:

+ the typesinvolved
« the kind of dependency

« the stack calls between the two types

3.4 Sandboxed Application

3.4.1 Sandboxed Application Structure

Application Skeleton Creation

The first step to explore a Sandboxed Application structure is to create a new project.

Firstselect File > New > MicroEJ Sandboxed Application Project :

Fillin the application template fields, the Project name field will automatically duplicate in the following fields.

A template project is automatically created and ready to use, this project already contains all folders wherein de-
velopers need to put content:

src/main/java Folder for future sources;
src/main/resources Folder for future resources (images, fonts, etc.);
META-INF Sandboxed Application configuration and resources;

module.ivy Ivyinput file, dependencies description for the current project.

Sources Folder

The project source folder ( src/main) contains two subfolders: java and resources. java folder will contain all
*. java files of the project, whereas resources folder will contain elements that the application needs at runtime
like raw resources, images or character fonts.

META-INF Folder

The META-INF folder contains several folders and a manifest file. They are described hereafter.
certificate (folder) Contains certificate information used during the application deployment.

libraries (folder) Contains a list of additional libraries useful to the application and not resolved through the
regular transitive dependency check.

properties (folder) Containsan application.properties file which contains application specific properties
that can be accessed at runtime.
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services (folder) Contains a list of files that describe local services provided by the application. Each file name
represents a service class fully qualified name, and each file contains the fully qualified name of the provided
service implementation.

wpk (folder) Contains a set of applications ( .wpk files) that will be started when the application is executed on
the Simulator.

MANIFEST.MF (file) Containsthe information given at project creation, extra information can be added to this file
to declare the entry points of the application.

module.ivy File

The module.ivy file describes all the libraries required by the application at runtime. The lvy classpath container
lists all the modules that have been automatically resolved from the content of module.ivy . See MicroEJ Module
Manager for more informations about MicroEJ Module Manager.

3.4.2 Application Publication

Build the WPK

When the application is ready for deployment, the last step in MicroEJ Studio is to create the WPK (Wadapps Pack-
age) file that is intended to be published on a MicroEJ Forge instance for end users.

In MicroEJ Studio, right-click on the Sandboxed Application project name and select Build Module.

The WPK build process will display messages in MicroEJ console, ending up the following message:

[echo] project hello published locally with version 0.1.0-RC201907091602
BUILD SUCCESSFUL

Total time: 1 minute 6 seconds

Publish on a MicroEJ Forge Instance

The WPK file produced by the build process is located in a dedicated target~/artifacts folderin the project.

The .wpk fileis ready to be uploaded to a MicroEJ Forge instance. Please consult https://community.microej.com
for more information.

3.4.3 Shared Interfaces
Principle

The Shared Interface mechanism provided by MicroEJ Core Engine is an object communication bus based on plain
Java interfaces where method calls are allowed to cross MicroEJ Sandboxed Applications boundaries. The Shared
Interface mechanism is the cornerstone for designing reliable Service Oriented Architectures on top of MicroEJ.
Communication is based on the sharing of interfaces defining APIs (Contract Oriented Programming).

The basic schema:
« Aprovider application publishes an implementation for a shared interface into a system registry.

+ Auser application retrieves the implementation from the system registry and directly calls the methods de-
fined by the shared interface.
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USER APPLICATION PROVIDER APPLICATION

Shared Interface Call

AA.mm() > mm() {
//code

}

MICROEJ CORE ENGINE

Fig. 15: Shared Interface Call Mechanism

Shared Interface Creation

Creation of a shared interface follows three steps:
« Interface definition,
« Proxy implementation,

+ Interface registration.

Interface Definition

The definition of a shared interface starts by defining a standard Java interface.

package mypackage;

public interface MyInterface(
void foo();

3

To declare an interface as a shared interface, it must be registered in a shared interfaces identification file. A shared
interface identification file is an XML file with the .si suffix with the following format:

<sharedInterfaces>
<sharedInterface name="mypackage.MyInterface"/>
</sharedInterfaces>

Shared interface identification files must be placed at the root of a path of the application classpath. For a MicroEJ
Sandboxed Application project, it is typically placed in src/main/resources folder.
Some restrictions apply to shared interface compared to standard java interfaces:

+ Types for parameters and return values must be transferable types;

« Thrown exceptions must be classes owned by the MicroEJ Firmware.

Transferable Types

In the process of a cross-application method call, parameters and return value of methods declared in a shared
interface must be transferred back and forth between application boundaries.
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USER APPLICATION Shared Interface Transfer [FHMSALCSS AR IREL.

R = AA.mm(P1, P2)

Fig. 16: Shared Interface Parameters Transfer

Shared Interface Types Transfer Rules describes the rules applied depending on the element to be transferred.

Table 1: Shared Interface Types Transfer Rules

Type Owner Instance Rule
Owner

Base type N/A N/A Passing by value. (boolean, byte, short
, char, int, long, double, float)

Any Class, Array or Inter- | Kernel Kernel Passing by reference

face

Any Class, Array or Inter- | Kernel Application Kernel specific or forbidden

face

Array of base types Any Application Clone by copy

Arrays of references Any Application | Clone and transfer rules applied again on
each element

Shared Interface Application Application Passing by indirect reference (Proxy cre-
ation)

Any Class, Array or Inter- | Application Application Forbidden

face

Objects created by an application which class is owned by the Kernel can be transferred to another application
if this has been authorized by the Kernel. The list of eligible types that can be transferred is Kernel specific, so
you have to consult the firmware specification. MicroEJ Evaluation Firmware Example of Transfer Types lists Kernel
types allowed to be transferred through a shared interface call. When an argument transfer is forbidden, the call is
abruptly stopped and a java.lang.IllegalAccessError isthrown by MicroEJ Core Engine.

Table 2: MicroEJ Evaluation Firmware Example of Transfer Types

Type Rule
Clone by copy

java.lang.String

. . Proxy reference creation
java.io.InputStream

Clone by deep copy

java.util.Map<String,String>

Proxy Class Implementation

The Shared Interface mechanism is based on automatic proxy objects created by the underlying MicroEJ Core En-
gine, so that each application can still be dynamically stopped and uninstalled. This offers a reliable way for users
and providers to handle the relationship in case of a broken link.

Once a Java interface has been declared as Shared Interface, a dedicated implementation is required (called the
Proxy class implementation). Its main goal is to perform the remote invocation and provide a reliable implemen-
tation regarding the interface contract even if the remote application fails to fulfill its contract (unexpected excep-
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tions, application killed...). The MicroEJ Core Engine will allocate instances of this class when an implementation
owned by another application is being transferred to this application.

USER APPLICATION PROVIDER APPLICATION

R = AA.mm(P1, P2

Proxy Class

MICROEJ CORE ENGINE

Transfer

Shared Interfaces Binding

Fig. 17: Shared Interfaces Proxy Overview

A proxy class is implemented and executed on the client side, each method of the implemented interface must be
defined according to the following pattern:

package mypackage;
public class MyInterfaceProxy extends Proxy<MyInterface> implements MyInterface {

@0verride
public void foo(){
try {
invoke(); // perform remote invocation
} catch (Throwable e) {
e.printStackTrace();

b
3

Each implemented method of the proxy class is responsible for performing the remote call and catching all errors
from the server side and to provide an appropriate answer to the client application call according to the interface
method specification (contract). Remote invocation methods are defined in the super class ej.kf.Proxy and are
named invokeXXX() where XXX is the kind of return type. As this class is part of the application, the application
developer has the full control on the Proxy implementation and is free to insert additional code such as logging
calls and errors for example.

Table 3: Proxy Remote Invocation Built-in Methods

Invocation Method Usage
void invoke() Remote invocation for a proxy method that returns void
Object invokeRef() Remote invocation for a proxy method that returns a reference

boolean invokeBoolean(), byte invokeByte(), | Remote invocation for a proxy method that returns a base type
char invokeChar(), short invokeShort(), int in-
vokelnt(), long invokeLong(), double invoke-
Double(), float invokeFloat()
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3.5 Virtual Device

3.5.1 Using a Virtual Device for Simulation

The Virtual Device includes the same custom MicroEJ Core, libraries and System Applications as the real device.
The Virtual Device allows developers to run their applications either on the Simulator, or directly on the real device
through local deployment.

The Simulator runs a mockup board support package (BSP Mock) that mimics the hardware functionality. An ap-
plication on the Simulator is run as a Standalone Application.

Before an application is locally deployed on device, MicroEJ Studio ensures that it does not depend on any API that
is unavailable on the device.

YOUR APPLICATION

L

8 ADD-ON LIBRARIES

(@)

<

= FOUNDATION LIBRARIES

)
Graphical Low Level API

w © MEJ S (Abstrac. Layeb

o LLLLRRLE]

o

()

E - -

2 Linux/Windows

\C)‘ Your Lib

YOUR HARDWARE

Fig. 18: MicroEJ Virtual Device Architecture

3.5.2 Runtime Environment

The set of MicroEJ APIs exposed by a Virtual Device (and therefore provided by its associated firwmare) is docu-
mented in Javadoc format in the MicroEJ Resource Center ( Window > Show View > MicroEJ Resource Center

).
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type filter text

4 | 2] Javadoc
[ MICROEJ-DEVELOPER-RUNTIME 1.0

- @2 Online Resources

Fig. 19: MicroEJ Resource Center APIs

3.6 MicroEJ Module Manager

3.6.1 Introduction

Modern electronic device design involves many parts and teams to collaborate to finally obtain a product to be sold
on its market. MicroEJ encourages modular design which involves various stake holders: hardware engineers, UX
designers, graphic designers, drivers/BSP engineers, software engineers, etc.

Modular design is a design technique that emphasizes separating the functionality of an application into inde-
pendent, interchangeable modules. Each module contains everything necessary to execute only one aspect of
the desired functionality. In order to have team members collaborate internally within their team and with other
teams, MicroEJ provides a powerful modular design concept, with smart module dependencies, controlled by the
MicroEJ Module Manager (MMM). MMM frees engineers from the difficult task of computing module dependencies.
Engineers specify the bare minimum description of the module requirements.

The following schema introduces the main concepts detailed in this chapter.
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Fig. 20: MMM Overview

MMM is based on the following tools:
« Apache lvy (http://ant.apache.org/ivy) for dependencies resolution and module publication;

« Apache EasyAnt (https://ant.apache.org/easyant/history/trunk/reference.html) for module build from
source code.

3.6.2 Specification

MMM provides a non ambiguous semantic for dependencies resolution. Please consult the MMM specification
available on https://developer.microej.com/packages/documentation/TLT-0831-SPE-MicroEJModuleManager-2.
0-E.pdf.

3.6.3 Module Project Skeleton

In MicroEJ SDK, a new MicroEJ module project is created as following:

+ Select File > New > Project... ,

« Select MicroEJ > MicroEJ Module Project ',

« Fill the module information (project name, module organization, name and revision),
+ Select one of the suggested skeletons depending on the desired module nature,

« Clickon Finish .

11f using MicroEJ SDK versions lower than 5.2.0, please refer to the following section.
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The project is created and a set of files and directories are generated from the selected skeleton.

Note: When an empty Eclipse project already exists or when the skeleton has to be created within an existing
directory, the MicroEJ module is created as following:

« In the Package Explorer, click on the parent project or directory,

« Select File > New > Other... ,

+ Select EasyAnt > EasyAnt Skeleton .

3.6.4 Module Description File

Amodule descriptionfileis an Ivy configuration file named module. ivy, located at the root of each MicroEJ module
project. It describes the module nature (also called build type) and dependencies to other modules.

<ivy-module version="2.0" xmlns:ea="http://www.easyant.org” xmlns:m="http://ant.apache.org/ivy/extra”
xmlns:ej="https://developer.microej.com” ej:version="2.0.0">
<info organisation="[organisation]” module="[name]" status="integration” revision="[version]">
<ea:build organisation="com.is2t.easyant.buildtypes” module="[buildtype_name]” revision=
—"[buildtype_version]">
<ea:property name="[buildoption_name]"” value="[buildoption_value]"/>
</ea:build>
</info>

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="default” visibility="public"/>
<conf name="provided" visibility="public"/>
<conf name="documentation” visibility="public"/>
<conf name="source" visibility="public"/>
<conf name="dist"” visibility="public"/>
<conf name="test"” visibility="private"/>
</configurations>

<publications>
</publications>

<dependencies>
<dependency org="[dep_organisation]” name="[dep_name]” rev="[dep_version]"/>

</dependencies>
</ivy-module>

Enable MMM Semantic

The MMM semantic is enabled in a module by adding the MicroEJ XML namespace and the ej:version attribute
inthe ivy-module node:

<ivy-module xmlns:ej="https://developer.microej.com” ej:version="2.0.0">

Note: Multiple namespaces can be declared in the ivy-module node.

MMM semantic is enabled in the module created with the Module Project Skeleton.
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Module Dependency

Module dependencies are added to the dependencies node as follow:

<dependencies>
<dependency org="[dep_organisation]” name="[dep_name]"” rev="[dep_version]"/>
</dependencies>

When no matching rule is specified, the default matching rule is compatible.

Dependency Matching Rule

The following matching rules are specified by MMM:

Name Range Notation Semantic

compatible [M.m.p-RC, (M+1).0.0-RC][ Equal or up to next major version. Default if
not set.

equivalent [M.m.p-RC, M.(m+1).0-RC [ Equal or up to next minor version

greaterOrEqual [M.m.p-RC, oo Equal or greater versions

perfect [M.m.p-RC, M.m.(p+1)-RC[ Exact match (strong dependency)

Set the matching rule of a given dependency with ej:match="matching rule”.Forexample:

<dependency org="[dep_organisation]” name="[dep_name]” rev="[dep_version]" ej:match="perfect” />

Dependency Visibility

« Adependency declared public is transitively resolved by upper modules. The default when not set.
« Adependency declared private isonly used by the module itself, typically for:

- Bundling the content into the module

- Testing the module

The visibility is set by the configurations declared in the configurations node. For example:

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="[conf_name]” visibility="private"/>
</configurations>

The configuration of a dependency is specified by setting the conf attribute, for example:

<dependency org="[dep_organisation]” name="[dep_name]"” rev="[dep_version]"” conf="[conf_name]->x" />

Automatic Update Before Resolution

The Easyant plugin ivy-update can be used to automatically update the version (attribute rev ) of every module
dependencies declared.

<info organisation="[organisation]” module="[name]"” status="integration” revision="[version]">
<ea:plugin org="com.is2t.easyant.plugins” name="ivy-update"” revision="1.+" />
</info>
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When the plugin is enabled, for each module dependency, MMM will check the version declared in the module file
and update it to the highest version available which satisfies the matching rule of the dependency.

Build Options

MMM Build Options can be set with:
<ea:property name="[buildoption_name]” value="[buildoption_value]"/>

The following build options are globally available:

Table 4: Build Options

Property | Description Default Value
Name

Path to the build directory target~.
target ${basedir}/target~

Refer to the documentation of Module Natures for specific build options.

3.6.5 MicroEJ Module Manager Configuration

By default, when starting an empty workspace, MicroEJ SDK is configured to import dependencies from
MicroEJ Central Repository and to publish built modules to a local folder. The repository configura-
tion is stored in a settings file ( ivysettings.xml ), and the default one is located at $USER_HOME\.
microej\microej-ivysettings-[VERSION].xml

Preferences Page

The MMM preferences page is available at Window > Preferences > MicroEJ > Module Manager .
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& Preferences
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Mybyn own
Plug-in Development Build Repoci
PMD uild Repaository
Run/Debug 3 [ Use Module repository as Build repository
Senarlint (4) Settings File: | C:\Program Files\MicroEl\MicroE)-SDK-20.0T\rcpl\configuration'org.eclipse.osgi\9\data\repositories\microej-build-repositony\ivysettings.xml Browse...
Team
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< 5 Restore Defaults Apply
® Apply and Close Cancel

Fig. 21: MMM Preferences Page

This page allows to configure the following elements:

1.
2.
3.

Settings File: the file describing how to connect module repositories. See the settings file section.

Options: files declaring MMM options. See the Options section.

Use Module repository as Build repository:thesettings file for connecting the build repositoryin place
of the one bundled in MicroEJ SDK. This option shall not be enabled by default and is reserved for advanced
configuration.

Build repository Settings File:the settings file for connecting the build repository in place of the one
bundled in MicroEJ SDK. This option is automatically initialized the first time MicroEJ SDK is launched. It
shall not be modified by default and is reserved for advanced configuration.

Set verbose mode : to enable advanced debug traces when building a module.
Runtime JRE :the Java Runtime Environment that executes the build process.
Max build history size:the maximum number of previous builds available in Build Module shortcut

list:

3

File Refactor Mavigate Search  Project  Run
cruoiv[@]Jeis-0-a-i@e-

4 Package Explorer 33 | ) Build Selected Module (Ctrl+Alt-C, E)

workspaceRepository -

Edit Source
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Settings File

The settings file is an XML file that describes how MMM connects local or online module repositories. The file format
is described in Apache lvy documentation.

To configure MMM to a custom settings file (usually from an offline repository):

1. Set Settings file toacustom ivysettings.xml settings file',

2. Clickon Apply and Close button

If the workspace is not empty, it is recommended to trigger a full resolution and rebuild all the projects using this
new repository configuration:

1. Clean caches

« In the Package Explorer, right-click on a project;
« Select Ivy > Cleanallcaches .
2. Resolve projects using the new repository

To resolve all the workspace projects, click on the Resolve All button in the toolbar:

'® workspaceRepository -

File Edit Source Refactor Mavigate Searc

A | B4~ (

To only resolve a subset of the workspace projects:

« In the Package Explorer, select the desired projects,
+ Right-click on a project and select lvy > Clean all caches .
3. Trigger Add-On Library processors for automatically generated source code

+ Select Project > Clean... ,
+ Select Clean all projects |,

o Clickon Clean button.

Options

Options can be used to parameterize a module description file or a settings file. Options are declared as key/value
pairsin a standard Java properties file, and are expanded using the ${my_property} notation.

Atypical usage in a settings file is for extracting repository server credentials, such as HTTP Basic access authenti-
cation:

1. Declare options in a properties file
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[E| credentials.properties &

1# User specific credentials
2 artifactory.username=myusername
3 artifactory.password=AKCKLzp2JHRLDyFvmTPMXocXiiU1Cnad7eidUcCO1ERSUdgIrIu24ZTYieXaCwuMaIWykjCD9

4

2. Register this property file to MMM options

Options

Property files: | Sfworkspace_loctest/credentials.properties}

3. Usethis option in a settings file

38
39 <credentials host="artifactory.corp” realm="Artifactory Realm” username="${artifactory.username}” passwd="$§{artifactory.password}” />
4/

Atypical usage in a module description file is for factorizing dependency versions across multiple modules projects:

1. Declare an option in a properties file

=| versions.properties &3

=l
14# Specify the EDC wersion used in this workspace
2 edc.version=1.3.8

pu

2. Register this property file to MMM options

Options

Property files: | S{workspace_loc:test/versions.properties)

3. Use this option in a module description file

22 <dependencies:

23 ol--

24 Use the EDC version defined by MMM configuration

25 -

26 <dependency org="ej.api" name="edc" rev="%{edc.version}" /»
27 </dependencies:

28 ¢/ivy-module:
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3.6.6 Build Kit

The Module Manager build kit is the consistent set of tools and scripts required for building modules.

It is bundled with MicroEJ SDK and can be exported to run in headless mode using the following steps:'

+ Select File > Export > MicroEJ > Module Manager Build Kit ,
+ Choose an empty Target directory ,

+ Clickonthe Finish button.
Once the build kit is fully exported, the directory content shall look like:

v [ = sdlk_5.2.0_build_kit
w [ ant
= lib
microg)-build-repositony.zip

To go further with headless builds, please consult Tool-CommandLineBuild for command line builds, and this tu-
torial to setup MicroEJ modules build in continuous integration environments).

3.6.7 Former MicroEJ SDK Versions

This section describes MMM configuration elements for MicroEJ SDK versions lower than 5.2.0.

New MicroEJ Module Project

The New MicroEJ Module Project wizard is availableat File > New > Project... , EasyAnt > EasyAnt Project

Preferences Pages

MMM Preferences Pages are located in two dedicated pages. The following pictures show the options mapping
using the same options numbers declared in Preferences Page.

lvy Preferences Page

The lvy Preferences Page is available at Window > Preferences > Ivy > Settings .
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® preferences

type filter text Settings le=T 4 - -
General A
Ant [ reload the settings only on demand
C/C++
Checkstyle
Copyright Default | Workspace... | | File System... | Variables...
EasyantdEclipse

(l) Ivy settings path: | CA\Users\user\. microgj\microej-ivysettings-3xml |

Help Ivy user dir: ‘ |
lceTea
Install/Update

Workspace... | | File System... | Variables...

Instant Messaging .
v vy (2) Property files: | S{workspace_loc:easyant-build-component/ivy/ivyDE.properties} Edit
Ad d S{workspace_loc:easyant-build-component/ivy/ivyDE_windows.properties}
vancet
Add
Classpath Container
Security Remove
Settings
Source/Javadoc Map Up
Workspace Resolver
D
XML Editor o
Java
JavaScript
< i > v Restore Defaults Apply

@ Apply and Close Cancel

Easyant Preferences Page

The Easyant Preferences Page is available at Window > Preferences > EasyAnt4Eclipse .

® preferences

type filter text Easyant4Eclipse e T

G 1
Ae: era Set preferences for EasyAntdEclipse.
n

CiCes (5) [[]5et verbose mode
Checkstyle (3) [] Use lvyDE preferences for lvy settings path
Copyright (4) Ivy settings path: | C:\Program Files\MicroEN\MicroE)-SDK-19.05\rep\configuration\org.eclipse.osgi\ 346\0\.cp\repositories\ivysettings.xml Browse..,
Easyant4Eclipse
Help (7) Max build history size: I 5
(6) Runtime JRE jre180.221 v

lceTea
Install/Update
Instant Messaging
v vy
Advanced
Classpath Container
Security
Settings v
< >

® Apply and Close Cancel

Restore Defaults Apply

Export the Build Kit

« Create an empty directory (e.g. mmm_sdk_[version]_build_kit),

+ Locate your SDK installation plugins directory (by default, C:\Program Files\MicroEJ\MicroEJ
SDK-[version]\rcp\plugins on Windows OS),

« Openthefile com.is2t.eclipse.plugin.easyant4e_[version].jar with anarchive manager,
« Extract the directory 1ib to the target directory,

« Openthefile com.is2t.eclipse.plugin.easyant4e.offlinerepo_[version].jar with an archive man-
ager,

+ Navigate to directory repositories,
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« Extractthefilenamed microej-build-repository.zip forMicroEJSDK 5.x or is2t_repo.zip for MicroEJ
SDK 4.1.x to the target directory.

3.7 Module Natures

The following table describes the project skeleton name for most common MicroEJ Module Natures.

Table 5: MicroEJ Module Natures Summary

Module Nature Skeleton Direct Wizard
Name
Add-On Library microej- File > New > MicroEJ Add-On Library Project
javalib
Mock microej-
mock
Module Repository artifact-
repository
Sandboxed Application application | File > New > MicroEJ Sandboxed Application Project
Standalone Application firmware- File > New > MicroEJ Standalone Application Project
singleapp

3.7.1 Module Repository

A module repository is a module that bundles a set of modules in a portable ZIP file. It is a tree structure where
modules organizations and names are mapped to folders.
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Fig. 22: Example of MicroEJ Module Repository Tree

A module repository takes its input modules from other repositories, usually the MicroEJ Central Repository which
is itself built by MicroEJ Corp. as a module repository.
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A module repository is often called an offline repository as it includes the settings file for a local configuration in
MicroEJ SDK. It can also be imported in MicroEJ Forge.

Create a Repository Project

In MicroEJ SDK, first create a new module project using the artifact-repository skeleton.

« The ivysettings.xml settings file describes how to import the modules of this repository when it is ex-
tracted locally on file system. This file will be packaged at the root of the zip file and does not need to be
modified.

« The module.ivy file describes how to build repository and lists the module dependencies that will be in-
cluded in this repository.

Configure Resolver for Input Modules

MicroEJ Module Manager (MMM) needs to import dependencies to build the module repository. The location
fetched by MMM is defined by a resolver. The resolver is configured with the parameter bar.populate.from.
resolver . The preset value is the resolver provided by default in MicroEJ SDK configuration, which is connected
to MicroEJ Central Repository.

<ea:property name="bar.populate.from.resolver” value="MicroEJChainResolver"/>

The MicroEJChainResolver is a URL resolver  defined in $USER_HOME\ .
microej\microej-ivysettings-[VERSION].xml that pointsto MicroEJ Central Repository.

To ensure the repository will be compliant with the MMM specification, add the following option:

<ea:property name="bar.check.as.v2.module” value="true"/>

There are other advanced options that do not need to be modified by default. These options are described in the
module.ivy generated by the skeleton.

Include Modules

Modules bundled into the module repository must be declared in the dependencies element of the module.ivy
file.

Include a Single Module

To add a module, declare the module dependency using the artifacts configuration:
<dependencies>
<dependency conf="artifacts->*" transitive="false"” org="[module_orgl” name="[module_name]"” rev=

—"[module_version]"” />

<!-- ... other dependencies ... -->
</dependencies>

For example, to add the ej.api.edc libraryversion 1.2.3, write the following line:

<dependency conf="artifacts->x" transitive="false" org="ej.api" name="edc" rev="1.2.3" />
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Note: We recommended to manually describe each dependency of the module repository, in order to keep full
controloftheincluded modules as well asincluded modules versions. Module dependencies can still be transitively
included by setting the dependency attribute transitive to true. In this case, the included module versions are
those that have been resolved when the module was built.

Multiple versions of the same module can be included by declaring each dependency using a different configura-
tion. The artifacts configuration has to be derived with a new name as many times as there are different versions
toinclude.

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="artifacts"” visibility="private"/>
<conf name="artifacts_1" visibility="private"/>
<conf name="artifacts_2" visibility="private"/>

<!-- ... other configurations ... -->
</configurations>

<dependencies>

<dependency conf="artifacts->x" transitive="false"” org="[module_orgl]" name="[module_name]"” rev=
—"[module_version_1]1" />

<dependency conf="artifacts_1->*" transitive="false"” org="[module_org]"” name="[module_namel" rev=
—"[module_version_2]" />

<dependency conf="artifacts_2->*" transitive="false"” org="[module_org]"” name="[module_name]" rev=
—"[module_version_3]1" />

<!-- ... other dependencies ... -->
</dependencies>

Include a Module Repository

To add all the modules already included in an other module repository, declare the module repository dependency
using the repository configuration:

<dependencies>
<dependency conf="repository->*" transitive="false"” org="[repository_orgl" name="[repository_namel]”_
—rev="[repository_version]" />

<!-- ... other dependencies ... -->
</dependencies>

Build the Repository

In the Package Explorer, right-click on the repository project and select Build Module.
The build consists of two steps:

1. Gathers all module dependencies. The whole repository content is created under target~/
mergedArtifactsRepository folder.

2. Checks the repository consistency. For each module, it tries to import it from this repository and fails the
build if at least one of the dependencies cannot be resolved.

The module repository .zip fileisbuiltinthe target~/artifacts/ folder. This file may be published along with
a CHANGELOG.md, LICENSE. txt and README.md.
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Use the Offline Repository

By default, when starting an empty workspace, MicroEJ SDK is configured to import dependencies from MicroEJ
Central Repository.

To configure MicroEJ SDK to import dependencies from a local module repository:
1. Unzip the module repository .zip file to the folder of your choice,

2. Configure MMM settings file using the ivysettings.xml file located at the root of the folder where the repos-
itory has been extracted.

3.8 MicroEJ Classpath

MicroEJ Applications run on a target device and their footprint is optimized to fulfill embedded constraints. The
final execution context is an embedded device that may not even have a file system. Files required by the appli-
cation at runtime are not directly copied to the target device, they are compiled to produce the application binary
code which will be executed by MicroEJ Core Engine.

As a part of the compile-time trimming process, all types not required by the embedded application are eliminated
from the final binary.

MicroEJ Classpath is a developer defined list of all places containing files to be embedded in the final application
binary. MicroEJ Classpath is made up of an ordered list of paths. A path is either a folder or a zip file, called a JAR
file (JAR stands for Java ARchive).

« Application Classpath explains how the MicroEJ Classpath is built from a MicroEJ Application project.

« Classpath Load Model explains how the application contents is loaded from MicroEJ Classpath.

« Classpath Elements specifies the different elements that can be declared in MicroEJ Classpath to describe
the application contents.

3.8.1 Application Classpath

The following schema shows the classpath mapping from a MicroEJ Application project to the MicroEJ Classpath
ordered list of folders and JAR files. The classpath resolution order (left to right) follows the project appearance
order (top to bottom).
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v ‘_‘fp" MyApplication

(® src/main/java Compiled code and copied resources
® src/main/resources located in folder MyApplication/bin
v B vy module.ivy [*]
> (9 framework-1.10.0,jar - C:\caché\gj.library.wadapps\framework\jars
> (9 property-loader-3.1.0jar - C:\cache\gj library.runtime\property-loader\jars
> (9 observable-1.0.2jar - C:\caché\gj library.util\observable\jars
> [ progress-1.0.3jar - C:\cache\gj.library.util\progress\jars
> [ components-3.3.0ar - C:\cache\gj.library.runtime\components\jars .
> A properties-1.1.0,jar - C:\cache\ej.library.eclasspath\properties\jars L\Ily tra rc:ISItIV.e
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> g"lj logging-1.1.0,jar - C:\cache\ej.library.eclasspath\logging\jars Ivy cache folder
> (9 basictool-1.2.2,jar - C:\cache\gj.library.runtime\basictool\jars
> (m annotation-1.0.0ar - C:\cache\ejlibrary.runtime\annotation\jars
> (s bon-1.3.0jar - C:\cache\gj.api\bon\jars
> [ kf-1.44jar - C\cache\gj.apitkf\jars
> {8 edc-1.23jar - C:\cache\g.apitedcijars _
v B\ Referenced Libraries Additionnal JAR file located in
> (03 extrajar —_— }MyApplication/METAfINF/libraries/extra .jar
> [ src-adpgenerated/wadapps/java
v (= META-INF
» [= certificate
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&' MANIFEST.MF
v [ src
&= main
» [ src-adpgenerated
[%] CHANGELOG.md
= LICENSE.tdt
ko module.ivy
[¥] README.md

Fig. 23: MicroEJ Application Classpath Mapping

3.8.2 Classpath Load Model

A MicroEJ Application classpath is created via the loading of :

+ an entry point type,

« all . [extension].list files declaredin a MicroEJ Classpath.
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The different elements that constitute an application are described in Classpath Elements. They are searched within
MicroEJ Classpath from left to right (the first file found is loaded). Types referenced by previously loaded MicroEJ
Classpath elements are loaded transitively.
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Fig. 24: Classpath Load Principle

3.8.3 Classpath Elements

The MicroEJ Classpath contains the following elements:

« An entrypoint described in section Application Entry Points;

« Typesin .class files, described in section Types;
« Raw resources, described in section Raw Resources;

« Immutables Object data files, described in Section Immutable Objects;

+ Images, Fonts and Native Language Support (NLS) resources, described in Application Resources;

« x.[extension].list files, declaring contents to load. Supported list file extensions and format is specific
to declared application contents and is described in the appropriate section.

At source level, Java types are stored in src/main/java folder of the module project, any other kind of resources
and list files are stored in the src/main/resources folder.

Application Entry Points

MicroEJ Application entry point declaration differs depending on the application kind:

« In case of a MicroEJ Standalone Application, it is a class that contains a public static void
main(String[]) method, declared using the option application.main.class.
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« In case of a MicroEJ Sandboxed Application, it is a class that implements ej.kf.FeatureEntryPoint , de-
clared inthe Application-EntryPoint entryin META-INF/MANIFEST.MF file.

Types
MicroEJ types (classes, interfaces) are compiled from source code ( . java) to classfiles ( .class ). When a type is
loaded, all types dependencies found in the classfile are loaded (transitively).
Atype can be declared as a Required type in order to enable the following usages:
+ to be dynamically loaded from its name (with a call to Class.forName(String) );
« to retrieve its fully qualified name (with a call to Class.getName() ).

A type that is not declared as a Required type may not have its fully qualified name (FQN) embedded. Its FQN can
be retrieved using the stack trace reader tool (see Stack Trace Reader).

Required Types are declared in MicroEJ Classpath using *.types.list files. The file format is a standard Java
properties file, each line listing the fully qualified name of a type. Example:

# The following types are marked as MicroEJ Required Types
com.mycompany .MyImplementation
java.util.Vector

Raw Resources

Raw resources are binary files that need to be embedded by the application so that they may be dynamically re-
trieved with a call to Class.getResourceAsStream(java.io.InputStream) . Raw Resources are declared in Mi-
croEJ Classpath using *.resources.list files. The file format is a standard Java properties file, each line is a
relative / separated name of a file in MicroEJ Classpath to be embedded as a resource. Example:

# The following resource is embedded as a raw resource
com/mycompany/MyResource. txt

Others resources types are supported in MicrokJ Classpath, see Application Resources for more details.

Immutable Objects

Immutables objects are regular read-only objects that can be retrieved with a call to ej.bon.Immutables.
get(String) . Immutables objects are declared in files called immutable objects data files, which format is de-
scribed in the [BON] specification. Immutables objects data files are declared in MicroEJ Classpath using *.
immutables.list files. The file format is a standard Java properties file, each lineis a / separated name of a
relative file in MicroEJ Classpath to be loaded as an Immutable objects data file. Example:

# The following file is loaded as an Immutable objects data files
com/mycompany/MyImmutables.data

System Properties
System Properties are key/value string pairs that can be accessed with a call to System.getProperty(String) .

System properties are declared in MicroEJ Classpath *.properties.list files. The file formatis a standard Java
properties file. Example:

3.8. MicroEJ Classpath 89



MicroEJ Documentation, Revision bd708584

Listing 1: Example of Contents of a MicroEJ Properties File

# The following property is embedded as a System property
com.mycompany . key=com.mycompany . value
microedition.encoding=I1S0-8859-1

System Properties are resolved at runtime, and all declared keys and values are embedded as intern Strings.

System Properties can also be defined using Applications Options. This can be done by setting the option with a
specific prefix in their name:

« Properties for both the MicroEJ Core Engine and the MicroEJ Simulator : name starts with microej. java.
property.x*

« Properties for the MicroEJ Simulator : name starts with sim. java.property.*
« Properties for the MicroEJ Core Engine : name starts with emb. java.property.*

For example, to define the property myProp with the value theValue, set the following option :
Listing 2: Example of MicroEJ Property Definition in Launch Configura-
tion

microej.java.property.myProp=theValue

Option can also be setinthe VM arguments field of the JRE tab of the launch using the -D option (e.g. -Dmicroej.
java.property.myProp=theValue).

Constants

Note: This feature require [BON] version 1.4 which is available in MicroEJ Runtime starting from MicroEJ Archi-
tecture version 7.11.0.

Constants are key/value string pairs that can be accessed with a call to ej.bon.Constants.get[Type](String),
where Type if one of:

« Boolean,
» Byte,

« Char,

« Class,

« Double,
« Float,

o Int,
 Long,

« Short,

« String.

Constants are declared in MicroEJ Classpath *.constants.list files. Thefile formatis a standard Java properties
file. Example:
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Listing 3: Example of Contents of a BON constants File

# The following property is embedded as a constant
com.mycompany .myconstantkey=com.mycompany.myconstantvalue
Constants are resolved at binary level without having to recompile the sources.
At link time, constants are directly inlined at the place of Constants.get[Type] method calls with no cost.
The String key parameter must be resolved as an inlined String:

« either a String literal "com.mycompany.myconstantkey"”

« ora static final String field resolved as a String constant
The String value is converted to the desired type using conversion rules described by the [BON] API.

A boolean constant declared in an if statement condition can be used to fully remove portions of code. This
feature is similar to C pre-processors #ifdef directive with the difference that this optimization is performed at
binary level without having to recompile the sources.

Listing 4: Example of if code removal using a BON boolean constant

if (Constants.getBoolean("”com.mycompany.myconstantkey”)) {
System.out.println(”this code and the constant string will be fully removed when the constant is.
—resolved to 'false'"”)

}

Note: In Multi-Sandbox environment, constants are processed locally within each context. In particular, constants
defined in the Kernel are not propagated to Sandboxed Applications.

3.9 Application Resources

Application resources are the following Classpath Elements:

» Images
 Fonts

« Native Lanqguage Support

3.9.1 Images
Overview

Images are graphical resources that can be accessed with a call to ej.microui.display.Image.createlmage()
. To be displayed, these images have to be converted from their source format to the display raw format. The
conversion can either be done at :

« build-time (using the image generator tool),
+ run-time (using the relevant decoder library).

Images that must be processed by the image generator tool are declared in MicroEJ Classpath *. images. list files.
The file format is a standard Java properties file, each line representing a / separated resource path relative to the
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MicroEJ classpath root referring to a standard image file (e.g. .png, .Jjpg). The resource may be followed by an
optional parameter (separated by a : ) which defines and/or describes the image output file format (raw format).
When no option is specified, the image is embedded as-is and will be decoded at run-time (although listing files
without format specifier has no impact on the image generator processing, it is advised to specify them in the *.
images.list files anyway, as it makes the run-time processing behavior explicit). Example:

# The following image is embedded
# as a PNG resource (decoded at run-time)
com/mycompany/MyImagel.png

# The following image is embedded
# as a 16 bits format without transparency (decoded at build-time)
com/mycompany/MyImage?2.png:RGB565

# The following image is embedded
# as a 16 bits format with transparency (decoded at build-time)
com/mycompany/MyImage3.png:ARGB1555

3.9.2 Fonts

Overview

Fonts are graphical resources that can be accessed with a call to ej.microui.display.Font.getFont() . To be
displayed, these fonts have to be converted at build-time from their source format to the display raw format by the
font generator tool. Fonts that must be processed by the font generator tool are declared in MicroEJ Classpath *.
fonts.list files. The file format is a standard Java properties file, each line representing a / separated resource
path relative to the MicroEJ classpath root referring to a MicroEJ font file (usually with a .ejf file extension). The
resource may be followed by optional parameters which define :

« some ranges of characters to embed in the final raw file;
« the required pixel depth for transparency.

By default, all characters available in the input font file are embedded, and the pixel depthis 1 (i.e 1 bit-per-pixel).
Example:

# The following font is embedded with all characters
# without transparency
com/mycompany/MyFont1.ejf

# The following font is embedded with only the latin
# unicode range without transparency
com/mycompany/MyFont2.ejf:latin

# The following font is embedded with all characters
# with 2 levels of transparency
com/mycompany/MyFont2.ejf::2

MicroEJ font files conventionally end with the .ejf suffix and are created using the Font Designer (see Font De-
signer).

Font Range

The first parameter is for specifying the font ranges to embed. Selecting only a specific set of characters to embed
reduces the memory footprint. Several ranges can be specified, separated by ; . There are two ways to specify a
character range: the custom range and the known range.
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Custom Range

Allows the selection of raw Unicode character ranges.
Examples:
o myfont:0x21-0x49 : Embed all characters from 0x21 to 0x49 (included);
o myfont:0x21-0x49,0x55 : Embed all characters from 0x21to 0x49 and character 0x55;

« myfont:0x21-0x49;0x55: Same as previous, but done by declaring two ranges.

Known Range

A known range is a range defined by the “Unicode Character Database” version 9.0.0 available on https://home.
unicode.org/. Each range is composed of sub ranges that have a unique id.

« myfont:basic_latin: Embed all Basic Latin characters;

« myfont:basic_latin;arabic:Embed all Basic Latin characters, and all Arabic characters.

Transparency

The second parameter is for specifying the font transparency level (1, 2, 4 or 8).
Examples:
« myfont:latin:4:Embed all latin characters with 4 levels of transparency

« myfont::2:Embed all characters with 2 levels of transparency

3.9.3 Native Language Support

Native Language Support (NLS) allows the application to facilitate internationalization. It provides support to ma-
nipulate messages and translate them in different languages. Each message to be internationalized is referenced
by a key, which can be used in the application code instead of using the message directly.

Messages must be defined in PO files in the MicroEJ Classpath of the application. Here is an example:

msgid ""

msgstr "

"Language: en_US\n"

"Language-Team: English\n"

"MIME-Version: 1.0\n"

"Content-Type: text/plain; charset=UTF-8\n"

msgid "Labell”
msgstr "My label 1"

msgid "Label2”
msgstr "My label 2"

These PO files have to be converted to be usable by the application. In order to let the build system know which PO
files to process, they must be referenced in MicroEJ Classpath *.nls.list files. The file format of these *.nls.
list files is a standard Java properties file. Each line represents the Full Qualified Name of a Java interface that
will be generated and used in the application. Here is an example, let’s call it i18n.nls.list:
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com.mycompany .myapp.Labels
com.mycompany . myapp.Messages

For each line, PO files whose name starts with the interface name ( Messages and Labels in the example) are
retrieved from the MicroEJ Classpath and used to generate:

+ aJava interface with the given FQN, containing a field for each msgid of the PO files

+ a NLS binary file containing the translations

So, in the example, the generated interface com.mycompany.myapp.Labels will gather all the translations from
files named Labels*.po and located in the MicroEJ Classpath. PO files are generally suffixed by their locale (
Labels_en_US.po ) but it is only for convenience since the suffix is not used, the locale is extracted from the PO
file’s metadata.

Once the generation is done, the application can use the Java interfaces to get internationalized messages, for
example:

import com.mycompany.myapp.Labels;
public class MyClass {

String label = Labels.lLabell;

The generation is triggered when building the application or after a change done in any PO or *.nls.1list files.
This allows to always have the Java interfaces up-to-date with the translations and to use them immediately.

The NLS APl module must be added to the module.ivy of the MicroEJ Application project, in order to allow access
to the NLS library.

<dependency org="ej.library.runtime” name="nls" rev="3.0.1"/>

3.10 Development Tools

MicroEJ provides a number of tools to assist with various aspects of development. Some of these tools are run using
MicroEJ Tool configurations, and created using the Run Configurations dialog of the MicroEJ SDK. A configuration
must be created for the tool before it can be used.
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{'} Run Configurations “
Create, manage, and run configurations ;—I
= R | =R Mame: | MyToolConfig
type filter text i Execution 1N} Configuration | =, JRE ] Common
[E] C/C++ Application Target
Ju JUnit
b Platform: | 5STM32F746GDI5CO-example- CMThardfp_ARMCCS (2.1.0-RC201604072037) Browse...
@ Launch Group
- 7] MicroE) Application Execution
a [ Microkl Tool
Settings: | MicroElavah w

@ MyToolConfig
Generate C headers and implementation skeletons of Java native methods

Options
Output folder: | ${workspace_locl/MyHelloWerldSample Browse...
[#] Clean intermediate files [verbose
. . Revert Apply
Filter matched 7 of 12 items
':?:' Run Close

Fig. 25: MicroEJ Tool Configuration

The above figure shows a tool configuration being created. In the figure, the MicroEJ Platform has been selected,
but the selection of which tool to run has not yet been made. That selection is made in the Execution Settings...
box. The Configuration tab then contains the options relevant to the selected tool.

3.10.1 Testsuite with JUnit

MicroEJ allows to run unit tests using the standard JUnit API during the build process of a MicroEJ library or a
MicroEJ Application. The Testsuite Engine runs tests on a target Platform and outputs a JUnit XML report.

Principle

JUnit testing can be enabled when using the microej-javalib (MicroEJ Add-On Library) or the
microej-application (MicroEJ Applications) build type. JUnit test cases processing is automatically enabled
when the following dependency is declared in the module. ivy file of the project.

<dependency conf="test->*" org="ej.library.test” name="junit" rev="1.5.0"/>
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When a new JUnit test case class is created inthe src/test/java folder, a JUnit processor generates MicroEJ com-
pliant classes into a specific source folder named src-adpgenerated/junit/java. These files are automatically
managed and must not be edited manually.

JUnit Compliance
MicroEJ is compliant with a subset of JUnit version 4. MicroEJ JUnit processor supports the following annotations:
@After, @AfterClass, @efore, @BeforeClass, @Ignore, @Test.

Each test case entry point must be declared using the org. junit.Test annotation (@Test before a method dec-
laration). Please refer to JUnit documentation to get details on usage of other annotations.

Setup a Platform for Tests
Before running tests, a target platform must be configured in the MicroEJ workspace. The following steps assume

that a platform has been previously imported into the MicroEJ Platform repository.

Goto Window > Preferences > MicroEJ > Platforms and selectthe desired platform on which to run the
tests.

Press F2 to expand the details.
Select the the platform path and copy it to the clipboard.
Goto Window > Preferences > Ant > Runtime and selectthe Properties tab.

Click on 'Add Property... button and set a new property named target.platform.dir with the platform path
pasted from the clipboard.

Setup a Project with a JUnit Test Case

This section describes how to create a new JUnit Test Case starting from a new MicroEJ library project.

First create anew module project usingthe microej-javalib skeleton. Anew projectnamed mylibrary iscreated
in the workspace.

Right-click on the src/test/java folderand select New > Other... menuitem.

Selectthe Java > JUnit > New JUnit Test Case wizard. Enter a test name and press Finish . A new JUnit
test case class is created with a default failing test case.

Build and Run a JUnit Testsuite

Right-click on the mylibrary project and select Build Module . After the library is built, the testsuite engine
launches available test cases and the build process fails in the console view.

Onthe mylibrary project, right-click and select Refresh .

A target~  folder appears with intermediate build files. The JUnit report is available at
target~\test\xmlI\TEST-test-report.xml.

Double-click on the file to open the JUnit testsuite report.

Modify the test case by replacing
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fail(”"Not yet implemented”);
with
Assert.assertTrue(true);

Right-click again on the mylibrary project and select Build Module . The test is now successfully executed on
the target platform so the MicroEJ Add-On Library is fully built and published without errors.

Double-click on the JUnit testsuite report to see the test has been successfully executed.

Testsuite Reports

Once a testsuite is completed, a testsuite report is generated:

+ in HTML format in module project location target~/test/html/test/junit-noframes.html . At the be-
ginning of the file a summary is displayed, then all execution traces for each test executed are available.

Testsuite Results:

Summary
‘ Tests ‘ Failures ‘ Errors | Ignored ‘ Tried Again ‘ Success rate ‘ Time ‘
|54 [15 lo lo lo [72.22% |3788.653 |
‘ i Failures ‘ Success ‘ Success Rate ‘
963 [35 928 |96.:37% |

Note: failures are anticipated and checked for with assertions while errors are unanticipated
Note: ignored tests are executed but not counted on the success rate.

Note: fried again tests are executed but not counted on the success rate

Packages

Note: package statistics are not computed recursively, they only sum up all of its testsuites numbers.

Name Tests il Tried | Time(s) | Time Stamp |Host|
Again

134,660 | 1598001204286 local
274.761 | 1598001339008 local
194.437 1598001613793 local
66.171 |1598001808250|local
2181.600| 1598001874436 local
65.519 | 1598004056327 | local
871505 |1598004121855|local

S

SS(al=o[sm
EEEEEEE
SNENEEEE
Slololo|olole
BEEEEEE

S

com.microej.fs.tests.scenarios

Fig. 26: Example of MicroEJ Testsuite HTML Report

« in JUnit XML format, in module project location target~/test/xml/TEST-test-report.xml.

% TEST-test-reportxml =

i 1 < version="1.0" encoding="UTF-8" standalone="no"?>

ite errors="0" failures="1" hostname="" ignored="0" name="testsuite-hai
classname=" SingleTest MathTest testFact" name=" SingleTest MathTest
.[CL...'ﬁnable to locate toois.jar. Expected to find it in C:\Prc

Buildfile: C:\Users\ARM 2016\.ivy2\cache\com.is2t.easyant.plugins\microej-test

10 buildTest:
Fig. 27: Example of MicroEJ Testsuite XML Report

XML report file can also be open in the JUnit View. Right-click on the file> Open With > JUnit View :
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& main

dv JUnit &
& platform
‘& test testsuite-harness-demo test
& classes Runs: 2/2 ® Errors: 0 o Failures: 1 ]
& html , —
| + @l testsuite-harness-demo test (48.128 s = Failure Trace
4 = xm

e _SingleTest_MathTest_testFact (27.337 s)
g _SingleTest_MathTest_testFact2 (20.791 s)

= test
3ul TEST-test-report.xml

Fig. 28: Example of MicroEJ Testsuite XML Report in JUnit View

If executed on device, the Firmware binary produced for each test is available in module project location target~/
test/xml/<TIMESTAMP>/bin/<FULLY-QUALIFIED-CLASSNAME>/application.out.

Advanced Configurations

Autogenerated Test Classes

The JUnit processor generates test classes into the src-adpgenerated/junit/java folder. This folder contains:

_AllTestClasses.java file Asingle classwith a mainenty pointthatsequentially calls all declared test methods
of all JUnit test case classes.

_AllTests_[TestCase].java files For each JUnit test case class, a class with a main entry point that sequen-
tially calls all declared test methods.

_SingleTest_[TestCase]_[TestMethod].java files For each test method of each JUnit test case class, a class
with a main entry point that calls the test method.

JUnit Test Case to MicroEJ Test Case

The Testsuite Engine allows to select the classes that will be executed, by setting the following property in the
project module.ivy file.

<ea:property name="test.run.includes.pattern” value="[MicroEJ Test Case Include Pattern]”/>

Thefollowingline consider all JUnit test methods of the same class as a single MicroEJ test case (default behaviour).
If at least one JUnit test method fails, the whole test case fails in the JUnit report.

<ea:property name="test.run.includes.pattern” value="#*/_AllTests_x%.class"/>

The following line consider each JUnit test method as a dedicated MicroEJ test case. Each test method is viewed
independently in the JUnit report, but this may slow down the testsuite execution because a new deployment is
done for each test method.

<ea:property name="test.run.includes.pattern” value="#x/_SingleTest_x*.class"/>

Run a Single Test Manually

Each test can be run independently as each class contains a main entry point.

In the src-adpgenerated/junit/java folder, right-click on the desired autogenerated class (
_SingleTest_[TestCase]_[TestMethod].java)and select RunAs > MicroEJ Application .
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The test is executed on the selected Platform and the output result is dumped into the console.

Testsuite Options

The Testsuite Engine can be configured with specific options which can be added to the module.ivy file of the
project running the testsuite, within the <ea:build> XML element.

« Application Option Injection

It is possible to inject an Application Option for all the tests, by adding to the original option the microej.
testsuite.properties. prefix:

<ea:property name="microej.testsuite.properties.[application_option_name]"” value="[application_
—option_value]”/>
+ Retry Mechanism

A test execution may not be able to produce the success trace for an external reason, for example an unre-
liable harness script that may lose some trace characters or crop the end of the trace. For all these unlikely
reasons, it is possible to configure the number of retries before a test is considered to have failed:

<ea:property name="microej.testsuite.retry.count” value="[nb_of_retries]"/>

By default, when a test has failed, it is not executed again (option value is set to 0 ).

Test Specific Options

The Testsuite Engine allows to define Application Options specific to each test case. This can be done by defining
a file with the same name as the generated test case file with the .properties extension instead of the .java
extension. The file must be putinthe src/test/resources folder and within the same package than the test case
file.

3.10.2 Stack Trace Reader
Principle

Stack Trace Reader is a MicroEJ tool which reads and decodes the MicroEJ stack traces. When an exception occurs,
the MicroEJ Core Engine prints the stack trace on the standard output System.out. The class names, non required
types (see Types) names and method names obtained are encoded with a MicroEJ internal format. This internal
format prevents the embedding of all class names and method names in the flash, in order to save some memory
space. The Stack Trace Reader tool allows you to decode the stack traces by replacing the internal class names and

method names with their real names. It also retrieves the line number in the MicroEJ Application.

Functional Description
The Stack Trace Reader reads the debug info from the fully linked ELF file (the ELF file that contains the MicroEJ

Core Engine, the other libraries, the BSP, the OS, and the compiled MicroEJ Application). It prints the decoded stack
trace.

Dependencies

No dependency.

3.10. Development Tools 929



MicroEJ Documentation, Revision bd708584

Installation

This tool is a built-in platform tool.

Use

Write a new line to dump the currently executed stack trace on the standard output.

public class MyBackgroundCode implements BackgroundSerwvice {
@verride

public void onStart() {
ff Auto-generated method stub

System.out.println("MyBackgroundCode: Hello Werld™);
[ new Throwable().printStackTrace(); |

¥
Fig. 29: Code to Dump a Stack Trace

Write a new line to dump the currently executed stack trace on the standard output.

by module.ivy [J] Testjava &2

package com.mycCompany;

“
-

public class Test {

poblic static void main (String[] args) {
Svztem.out.println("hello world!"™);
new Exceptinn(].pIintStackTIacei]d

Fig. 30: Code to Dump a Stack Trace

To be able to decode an application stack trace, the stack trace reader tool requires the application binary file with
debug information (application.fodbg in the output folder). Note that the file which is uploaded on the device

is application.fo (stripped version without debug information).
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4 ‘_?":‘Jf MySandboxedApp
» 4% src/main/java
» [ sro/main/resources
[ src/test/java
B src/test/resources
» E vy moduleivy [*]
4 (= __Myld__.generated.BackgroundServicesStandalone
= bon
=| application.fo
Eé applicatiun.fndhgj
applicaticn.map
= filesystem
a4 = META-INF
= certificate
== libraries

» [~ properties
== services
& MANIFEST.MF

Fig. 31: Application Binary File with Debug Information

On successful deployment, the application is started on the device and the following trace is dumped on standard
output.

MyBackgroundCode: Hello World

Exception in thread "ej.wadapps.app.default™ java.lang.Throwable
at java.lang.System.@M 334:0 344@
at java.lang.Throwabl 6b02
at java.lang.Throwabl 805a0 05al1ld@
at appEntry.MyBackgroundCode.@F:1d48b23d5b010000d37548E1e20224d0b8T75cb368936fb41:0xc03800e0@EM: OxcO380bE8: OXcO380c20R@

Fig. 32: Stack Trace Output

To create a new MicroEJ Tool configuration, right-click on the application project and click on RunAs... >
Run Configurations... .

In Execution tab, selectthe Stack Trace Reader tool.
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CEX B3~

Mame: Stack Trace Reader

type filter text

[T] C/C++ Application
Ju JUnit
= Launch Group
1» [T MicroE) Application
a [g MicroE) Tool

| 7 Stack Trace Reader|

In  Configuration

tion)

A Execution

fith Configuration} B JRE\I =] Common}

Target

Platform:

Execution

Settings: | Stack Trace Reader

Options

Clean intermediate files

Reads stack trace generated by MicroE) core engine.

Output folder:  ${workspace_locl/MySandboxedApp

[T Verbose

Fig. 33: Select Stack Trace Reader Tool

tab, browse the previously generated application binary file with debug information (
application.fodbg in case of a Sandboxed Application or application.out in case of a Standalone Applica-

CEX B3~

Mame: Stack Trace Reader

type filter text

[E] C/C++ Application
Ju JUnit
@ Launch Group
i+ [3] Microk) Application
a [Og MicroE) Tool
[ Stack Trace Reader

| Stack Trace Reader |

o Execution | M4 Configuration . =, JRI—j i=| Commorﬂ

Application

Executable filee _.generated.Ba ckgroundSer\.ricesStandanneEpplication.fodbgﬂ ’ Browse... ]

Additional ohject files:

"Trace port” interface for Eclipse

Add

Remove

Connection type: | Censole

Fart: | COMO Baudrate:

Port: | 5555 Address:

Stack trace file: Browse...
Filter matched 7 of 15 items fevert Apply
® Run ] ’ Close

Fig. 34: Stack Trace Reader Tool Configuration (Sandboxed Application)
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0 Run Configurations n

Create. manage. and run configurations

o

- —+l,
- X | E Mame: | Stack Trace Reader
type filter text s Execution |4} Configuration “_g, JRE| ] Common
[E] C/C++ Application Stack Trace Reader Application
Ju JUnit —
= Launch Group Executable file: | MyTest\com.mycempany.Test\application.out Browse...
> L Microk) Application Additional object files:
4 [g MicroB) Tool
4 Stack Trace Reader Add
Remove
"Trace port" interface for Eclipse
Connection type: | Consele v
COMD 115200
Browse
Revert Appl
Filter matched 21 of 28 items = -
':?3' Run Close

Fig. 35: Stack Trace Reader Tool Configuration (Standalone Application)

Click on Run button and copy/paste the trace into the Eclipse console. The decoded trace is dumped and the
line corresponding to the application hook is now readable.

3 Console 52 | Problems g JUnit
Stack Trace Reader_ [MicroE) Tool] C:\Program Files\Java\jrel B.0_25\bin'javaw.exe (5 avr, 2017 12:44:46)

==============c [ MicroEl Core Engine Trace ] ===============
[INFO] Paste the MicroE]l core engine stack trace here.

Exce

ang.Throwa

= 00 oo

o

Exception in

thread ej.wadapps.app.default
at java.lang.System.getStackTrace(Unknown Source)
at java.lang.Throwable.fillInStackTrace(Throwable.java:79)

at i cowgble . Jgvg:i2s)
at appEntry.MyBackgroundCode.onStart (MyBackgroundCode.java:18) |

Fig. 36: Read the Stack Trace

The stack trace reader can simultaneously decode heterogeneous stack traces with lines owned by different ap-
plications and the firmware. Other debug information files can be appended using the 'Additional object files

option. Lines owned by the firmware can be decoded with the firwmare debug information file (optionally made
available by your firmware provider).
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The following section explains MicroEJ tool options.

Category: Stack Trace Reader

Stack Trace Reader Application

Executable file: Browse...

Additional object files:

Add

Remove

"Trace port” interface for Eclipse

Connection type: | Console ~

COMOD 115200

Browse...

Group: Application
Option(browse): Executable file

Option Name: application.file
Default value: (empty)
Description:

Specify the full path of a full linked elf file.

Option(list): Additional object files

Option Name: additional.application.files

Default value: (empty)

Group: “Trace port” interface for Eclipse

Description:

This group describes the hardware link between the device and the PC.
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Option(combo): Connection type

Option Name: proxy.connection.connection.type
Default value: Console

Available values:

Uart (COM)

Socket

File

Console

Description:

Specify the connection type between the device and PC.

Option(text): Port

Option Name: pcboardconnection.usart.pc.port
Default value: COM0

Description:

Format: port name

Specifies the PC COM port:

Windows - COM1, COM2, ..., COMxn*

Linux- /dev/ttySe, /dev/ttyS1, ..., /dev/ttyS*nx

Option(combo): Baudrate

Option Name: pcboardconnection.usart.pc.baudrate
Default value: 115200

Available values:

9600

38400

57600

115200

Description:

Defines the COM baudrate for PC-Device communication.

Option(text): Port

Option Name: pcboardconnection.socket.port
Default value: 5555

Description:
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IP port.

Option(text): Address

Option Name: pcboardconnection.socket.address
Default value: (empty)
Description:

IP address, on the form A.B.C.D.

Option(browse): Stack trace file

Option Name: pcboardconnection.file.path

Default value: (empty)

3.10.3 Code Coverage Analyzer
Principle

The MicroEJ Simulator features an option to output .cc (Code Coverage) files that represent the use rate of functions
of an application. It traces how the opcodes are really executed.

Functional Description

The Code Coverage Analyzer scans the output .cc files, and outputs an HTML report to ease the analysis of methods
coverage. The HTML report is available in a folder named htmlReport in the same folder as the .cc files.
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Classpath

Code Code
Simulator Coverage Coverage
Files

Analyzer

*

Fig. 37: Code Coverage Analyzer Process

Dependencies
In order to work properly, the Code Coverage Analyzer should input the .cc files. The .cc files relay the classpath

used during the execution of the Simulator to the Code Coverage Analyzer. Therefore the classpath is considered
to be a dependency of the Code Coverage Analyzer.

Installation

This tool is a built-in platform tool.

Use

A MicroEJ tool is available to launch the Code Coverage Analyzer tool. The tool name is Code Coverage Analyzer.

Two levels of code analysis are provided, the Java level and the bytecode level. Also provided is a view of the fully
or partially covered classes and methods. From the HTML report index, just use hyperlinks to navigate into the
report and source / bytecode level code.
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Category: Code Coverage

Code Coverage

*.cc files folder: Browse...

Classes filter

Includes:

Add...

Edit...

Remove

Excludes:

Add...

Edit...

Remove

Option(browse): *.cc files folder

Option Name: cc.dir
Default value: (empty)
Description:

Specify a folder which contains the cc files to process (*.cc).

Group: Classes filter
Option(list): Includes

Option Name: cc.includes
Default value: (empty)
Description:

List packages and classes to include to code coverage report. If no package/class is specified, all classes found in
the project classpath will be analyzed.

Examples:
packageA.packageB. * : includes all classes which are in package packageA.packageB

packageA.packageB.className : includes the class packageA.packageB.className
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Option(list): Excludes

Option Name: cc.excludes
Default value: (empty)
Description:

List packages and classes to exclude to code coverage report. If no package/class is specified, all classes found in
the project classpath will be analyzed.

Examples:
packageA.packageB. * : excludes all classes which are in package packageA.packageB

packageA.packageB.className : excludes the class packageA.packageB.className

3.10.4 Heap Dumper & Heap Analyzer
Introduction

Heap Dumper is a tool that takes a snapshot of the heap. Generated files (with the .heap extension) are available
on the application output folder. Note that it works only on simulations. It is a built-in platform tool and has no
dependencies.

The Heap Analyzer is a set of tools to help developers understand the contents of the Java heap and find problems
such as memory leaks. For its part, the Heap Analyzer plug-in is able to open dump files. It helps you analyze their
contents thanks to the following features:

« memory leaks detection
« objects instances browse

+ heap usage optimization (using immortal or immutable objects)

The Heap

The heap is a memory area used to hold Java objects created at runtime. Objects persist in the heap until they are
garbage collected. An object becomes eligible for garbage collection when there are no longer any references to it
from other objects.

Heap Dump

A heap dump is an XML file that provides a snapshot of the heap contents at the moment the file is created. It
contains a list of all the instances of both class and array types that exist in the heap. For each instance it records:

« The time at which the instance was created
+ The thread that created it
« The method that created it
For instances of class types, it also records:
« Theclass
+ The values in the instance’s non-static fields

For instances of array types, it also records:
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« The type of the contents of the array

«+ The contents of the array

For each referenced class type it records the values in the static fields of the class.

Heap Analyzer Tools

The Heap Analyzer is an Eclipse plugin that adds three tools to the MicroEJ environment.

Tool name Number of | Purpose
input files
Heap Viewer 1 Shows what instances are in the heap, when they were created,
and attempts to identify problem areas
Progressive 10r more Shows how the number of instances in the heap has changed over
Heap Usage time
Compare 2 Compares two heap dumps, showing which objects were created,

or garbage collected, or have changed values

Heap Dumper

When the Heap Dumper option is activated, the garbage collector process ends by performing a dump file that
represent a snapshot of the heap at this moment. Thus, to generate such dump files, you must explicitly call the
System.gc() method in your code, or wait long enough for garbage collector activation.

The heap dump file contains the list of all instances of both class and array types that exist in the heap. For each

instance it records:

« the time at which the instance was created

« the thread that created it

« the method that created it

For instances of class types, it also records:

« theclass

« the valuesin the instance’s non-static fields

For instances of array types, it also records:

« the type of the contents of the array

« the contents of the array

For each referenced class type, it records the values in the static fields of the class.
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Category: Heap Dumper

Heap Dumper Application

Executable file: Browse...

Resident application files:

Add...

Remove

Memary

Heap memaory file: | Browse...

Output

Heap file name: | application.heap

Group: Application
Option(browse): Executable file

Option Name: application.filename
Default value: (empty)
Description:

Specify the full path of a full linked ELF file.

Option(list): Resident application files

Option Name: additional.application.filenames
Default value: (empty)
Description:

Specify the full path of resident applications .out files linked by the Firmware Linker.

Group: Memory
Option(browse): Heap memory file

Option Name: heap.filename

Default value: (empty)
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Description:

Specify the full path of heap memory dump, in Intel Hex format.

Group: Output
Option(text): Heap file name

Option Name: output.name

Default value: application.heap

Heap Viewer

To open the Heap Viewer tool, select a heap dump XML file in the Package Explorer , right-click on it and select

Open With > Heap Viewer

Alternatively, right-click on it and select Heap Analyzer > Open heap viewer

This will open a Heap Viewer tool window for the selected heap dump' .
The Heap Viewer works in conjunction with two views:

1. The Outline view

2. The Instance Browser view
These views are described below.

The Heap Viewer tool has three tabs, each described below.

Outline View

The Outline view shows a list of all the types in the heap dump, and for each type shows a list of the instances of
that type. When an instance is selected it also shows a list of the instances that refer to that instance. The Outline
view is opened automatically when an Heap Viewer is opened.

! Although this is an Eclipse ‘editor’, it is not possible to edit the contents of the heap dump.
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E Console |[21 Problems [ 0= Outline &3 @ ¥ =0
33 types - 70 instances (from first to last time stamp)

Type name Instances  Referenced instances Method Thread i
. char(] 1 0
@ com.is2t.cldec.s3.DefaultSystemOut 0
» @ com.is2t.test HeapDumpTest 1
PRC) com.isZt.test. HeapDumpTest5TestOhbj 2
<p #99
<p £100
. (@ com.is2t.test.HeapDumpTest$ TestObj2
@ &jbonlmmutables
> @ gj.bonImmutablesFile
. int[]
» L& int(]l]
@ ist.support.lang.Systools

m

@ corm.is2ttest HeapDumpTest.start() : void 3 main
@ com.is2ttest HeapDumpTest.start() : void 5 main

=R = R R R R UV )

D= R -
(=N )

References ’ Type
<&p #98 (C] com.is2ttest. HeapDumpTest

Fig. 38: Outline View

Instance Browser View

The Instance Browser view opens automatically when a type or instance is selected in the Outline view. It has two
modes, selected using the buttons in the top right corner of the view. In ‘Fields’ mode it shows the field values for
the selected type or instance, and where those fields hold references it shows the fields of the referenced instance,
and so on. In ‘Reference’ mode it shows the instances that refer to the selected instance, and the instances that
refer to them, and so on.

El Conzole [3_ Problems EE Cutline LEEE Fields and Reference Hierarchy &2 g]-oe = B
Fields - heap file name: Ch\Users\Jehn\.microgfworkspaces\CM_ARMCC-DEV-1.0.0%HeapDumpT est\ com.isz
Field Type Value
a @ this C com.isZt.test. HeapDumpTest5TestOhbj #100
@ a © int 1
@b O int 0
F I- © int 0

Fig. 39: Instance Browser View - Fields mode
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&l Console (21 Problems EE Cutline T;EE Fields and Reference Hierarchy &2 o[:g =08
References - heap file name : ChUsers'John'umicroefweorkspaces\CM_ARMCC-DEV-1.0.00HeapDumpTest\co
Field Type Value
a @ this C com.isZt.test.HeapDumpTest5TestOhj #100
4 @ testObj C) com.is2t.test.HeapDurmpTest #98
<no references>  <nonex <none:

Fig. 40: Instance Browser View - References mode

Heap Usage Tab

The Heap usage page of the Heap Viewer displays four bar charts. Each chart divides the total time span of the heap
dump (from the time stamp of the earliest instance creation to the time stamp of the latest instance creation) into a
number of periods along the x axis, and shows, by means of a vertical bar, the number of instances created during
the period.

The top-left chart shows the total number of instances created in each period, and is the only chart displayed
when the Heap Viewer is first opened.

When a type or instance is selected in the Outline view the top-right chart is displayed. This chart shows the
number of instances of the selected type created in each time period.

When an instance is selected in the Outline view the bottom-left chart is displayed. This chart shows the
number of instances created in each time period by the thread that created the selected instance.

When an instance is selected in the Outline view the bottom-right chart is displayed. This chart shows the
number of instances created in each time period by the method that created the selected instance.
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[ heap-Oaml 52 =
Instance creation over time, by type, creating thread and creating method Generate graphViz file
Heap usage - Total Instances of type 'com.is2t.test. HeapDumpTest5TestOhy'
Heap usage : 569/569 instance(s) Heap usage: 500/569 instancels)
Instances Instances
489 489
326 326
163 163
0 0
47 94 141 188 235 282 329 376 423 470 47 94 141 188 235 282 329 376 423 470
Time stamp Time stamp
Created by thread 'main’ Created by method 'com.is2t.test HeapDumpTest.start() « void'
Heap usage: 503/589 instance(s) Heap usage : 500/569 instance(s)
Instances Instances
489 489
326 326
163 163
0 0
47 94 141 188 235 282 329 376 423 470 47 94 141 188 235 282 329 376 423 470
Time stamp Time stamp

Heap usage | Dominator tree | Leak suspects

Fig. 41: Heap Viewer - Heap Usage Tab

Clicking on the graph area in a chart restricts the Outline view to just the types and instances that were created
during the selected time period. Clicking on a chart but outside of the graph area restores the Outline view to
showing all types and instances” .

The button Generate graphViz file in the top-right corner of the Heap Usage page generates a file compatible with
graphviz (www.graphviz.org).

Dominator Tree Tab

The Dominator tree page of the Heap Viewer allows the user to browse the instance reference tree which contains
the greatest number of instances. This can be useful when investigating a memory leak because this tree is likely
to contain the instances that should have been garbage collected.

The page contains two tree viewers. The top viewer shows the instances that make up the tree, starting with the
root. The left column shows the ids of the instances - initially just the root instance is shown. The Shallow instances
column shows the number of instances directly referenced by the instance, and the Referenced instances column
shows the total number of instances below this point in the tree (all descendants).

2 The Outline can also be restored by selecting the All types and instances option on the drop-down menu at the top of the Outline view.
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The bottom viewer groups the instances that make up the tree either according to their type, the thread that created
them, or the method that created them.

Double-clicking an instance in either viewer opens the Instance Browser view (if not already open) and shows de-
tails of the instance in that view.

[0 heap-0xml 2 =0
?;EE Dominator tree : Instance hierarchy that contains greatest number of instances

Dominator tree instances Type

» [ 298 C] com.is2t.test.HeapDumpTest

4 L

Deorminator tree instances grouped by 1ype, thread or method | Types hd

-
Top consumers Instances

C com.isZt.test.HeapDumpTestSTestObj 500
|= java.lang.Object(]

@ java.utilVector

(@ com.is2t.test.HeapDumpTest

=

Heap usage | Dominator tree | Leak suspects

Fig. 42: Heap Viewer - Dominator Tree Tab

Leak Suspects Tab

The Leak suspects page of the Heap Viewer shows the result of applying heuristics to the relationships between
instances in the heap to identify possible memory leaks.

The page is in three parts.

« The top part lists the suspected types (classes). Suspected types are classes which, based on numbers of
instances and instance creation frequency, may be implicated in a memory leak.

+ The middle part lists accumulation points. An accumulation point is an instance that references a high num-
ber of instances of a type that may be implicated in a memory leak.

« The bottom part lists the instances accumulated at an accumulation point.
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[0 heap-Oaml 22

19 Types suspected

C] com.is2t.test.HeapDumpTestSTestOhbj

Accumulation points

Instance

) #381

Type
java.lang.Object(]

Accumulated instances

Instance
dp#123
<y #124
Ep #125
Ep#126
< #130
dp#3
Ep#132
<p#133
dp#134
Jp#135

B i mem

Type

pjojojojojolofolofolo)

com.isZt.test. HeapDumpTest5TestOhy
com.is2t.test. HeapDumpTestSTestOhbj
com.is2t.test.HeapDumpTestSTestObj
com.is2t.test. HeapDumpTestSTestOhbj
com.isZt.test. HeapDumpTest5TestOhy
com.is2t.test. HeapDumpTestSTestOhbj
com.is2t.test.HeapDumpTestSTestObj
com.is2t.test. HeapDumpTestSTestOhbj
com.isZt.test. HeapDumpTest5TestOhy
com.is2t.test. HeapDumpTestSTestOhbj

Heap usage | Dominator tree | Leak suspects

Progressive Heap Usage

Fig. 43: Heap Viewer - Leak Suspects Tab

To open the Progressive Heap Usage tool, select one or more heap dump XML filesin the Package Explorer , right-

click and select Heap Analyzer > Show progressive heap usage

This tool is much simpler than the Heap Viewer described above. It comprises three parts.

+ The top-right part is a line graph showing the total number of instances in the heap over time, based on the

creation times of the instances found in the heap dumps.

« The left part is a pane with three tabs, one showing a list of types in the heap dump, another a list of threads
that created instances in the heap dump, and the third a list of methods that created instances in the heap

dump.

+ The bottom-left is a line graph showing the number of instances in the heap over time restricted to those
instances that match with the selection in the left pane. If a type is selected, the graph shows only instances
of that type; if a thread is selected the graph shows only instances created by that thread; if a method is
selected the graph shows only instances created by that method.
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E”| Progressive Heap Usage %

FProgressive heap usage by type, creating thread and creating method

Types | Threads | Methods|

Mame

char[]

C com.is2t.cldc,s3.DefaultSystem Out
C com.is2t.test.HeapDumpTest

C com.is2t.test. HeapDumpTestSTestObj
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C) gj.bonImmutablesFile

int[]

int{][]

@ ist.support.lang.Systools

3 ist.support.util EncUS_ASCI

C) ist.suppert.util EncodingConversion
(C] java.io.FileDescriptor

C java.io.FileQutputStream

C java.io.OutputStream

C) java.o. OutputStreamWriter

C) java.ic.Print5stream

C) java.ioWriter

(C] java.lang.Exception

C java.langIndexOutOfBoundsException
@ java.lang.MullPointerException

C) java.lang.Object

m

Type search

Compare Heap Dumps

Heap usage - Total
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190
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Time stamp

Heap usage - Type com.is2t.test HeapDumpTestiTestObj
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501

334
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Tirne stamp

Fig. 44: Progressive Heap Usage

The Compare tool compares the contents of two heap dump files. To open the tool select two heap dump XML files
in the Package Explorer, right-click and select Heap Analyzer > Compare

The Compare tool shows the types in the old heap on the left-hand side, and the types in the new heap on the
right-hand side, and marks the differences between them using different colors.

Typesin the old heap dump are colored red if there are one or more instances of this type which are in the old dump
but not in the new dump. The missing instances have been garbage collected.

Types in the new heap dump are colored green if there are one or more instances of this type which are in the new
dump but not in the old dump. These instances were created after the old heap dump was written.

Clicking to the right of the type name unfolds the list to show the instances of the selected type.
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[0 Oid heap : heap-0.xm 34 types - 570 instances [0 New heap : heap-1.xml 35 types - 471 instances
char|] - char[] -
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(& com.is2ttest.HeapDumpTest (® com.is2ttest HeapDumpTest
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@ &j.bonlmmutables (@ com.is2t.test.HeapDumpTestSTestObj3
@ gj.benImmutablesFile @ gjbonImmutables
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Fig. 45: Compare Heap Dumps

The combo box at the top of the tool allows the list to be restricted in various ways:

« Allinstances - no restriction.

Garbage collected and new instances - show only the instances that exist in the old heap dump but notin the
new dump, or which exist in the new heap dump but not in the old dump.

Persistent instances - show only those instances that exist in both the old and new dumps.

Persistentinstances with value changed - show only those instances that exist in both the old and new dumps
and have one or more differences in the values of their fields.

Instance Fields Comparison View

The Compare toolworksin conjunction with the Instance Fields Comparison view, which opens automatically when
an instance is selected in the tool.

The view shows the values of the fields of the instance in both the old and new heap dumps, and highlights any
differences between the values.
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£9 Heap Comparator &1

=8
Show ’Persistent instances with value changed vl Array type @ Class type
[0 OId heap : heap-0.xml 34 types - 570 instances [0 New heap : heap-1.xml 35 types - 471 instances
3 com.ist.testHeapDumpTest (@ com.is?t.test.HeapDumpTest
& com.is?ttestHeapDumpTestSTestObj3 (& com.is?t.test. HeapDumpTestSTestObj3
dp #625 <dp #625
java.ang.Object[] java.lang. Object[]
(& javalang.Thread (& javalang.Thread
@ java.utilVector (@ java.util.Vector
Type com.is2t.test. HeapDumpTestSTestObj3 : 0 instances garbage collected, 0 new instances, 1 persistent instances.
El Console (E_L‘ Problems EE Outline (E Fields and Reference Hierarchy (Eﬁ Instance Fields Comparison 2 =
Fields Type Old value  New value
a @this © com.is2ttest. HeapDumpTestiTestOhbj3 #5625 #6525
@a int 0 0
Gb int 0 3
@c int 0 0

Fig. 46: Instance Fields Comparison view

3.10.5 ELF to Map File Generator

Principle

The ELF to Map generator takes an ELF executable file and generates a MicroEJ compliant .map file. Thus, any ELF
executable file produced by third party linkers can be analyzed and interpreted using the Memory Map Analyzer.

Functional Description

ELF Executable file

Execute
ELF to Map
Tool

Fig. 47: ELF To Map Process
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Installation

This tool is a built-in platform tool.

Use

This chapter explains MicroEJ tool options.

Category: ELF to Map

ELF to Map Input
ELF file: ‘ | Browse...
Output
Map file: ‘ | Browse...

Group: Input

Option(browse): ELF file

Option Name: input.file

Default value: (empty)

Group: Output

Option(browse): Map file

Option Name: output.file

Default value: (empty)
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3.10.6 Serial to Socket Transmitter
Principle

The MicroEJ serialToSocketTransmitter is a piece of software which transfers all bytes from a serial port to a tcp
client or tcp server.

Installation

This tool is a built-in platform tool.

Use

This chapter explains MicroEJ tool options.

Category: Serial to Socket

Serial to Socket Serial Options

Port: | COMD Baudrate: | 115200 v

Server Options

Port: | 5555

Group: Serial Options

Option(text): Port

Option Name: serail.to.socket.comm.port
Default value: COM0

Description: Defines the COM port:

Windows - COM1, COM2, ..., COM#n*

Linux- /dev/ttySo, /dev/ttyUSBo, ..., /dev/ttyS*nx, /dev/ttyUSBxnx
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Option(combo): Baudrate

Option Name: serail.to.socket.comm.baudrate
Default value: 115200

Available values:

9600

38400

57600

115200

Description: Defines the COM baudrate.

Group: Server Options
Option(text): Port

Option Name: serail.to.socket.server.port
Default value: 5555

Description: Defines the server IP port.

3.10.7 Memory Map Analyzer
Principle
When a MicroEJ Application is linked with the MicroEJ Workbench, a Memory MAP file is generated. The Memory

Map Analyzer (MMA) is an Eclipse plug-in made for exploring the map file. It displays the memory consumption of
different features in the RAM and ROM.
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Functional Description

MicroEJ
Application

Platform

1. Build the MicroEJ
Application

Map file Executable file

2. Open Memory
Map Analyzer

Fig. 48: Memory Map Analyzer Process

In addition to the executable file, the MicroEJ Platform generates a map file. Double click on this file to open the
Memory Map Analyzer.

Dependencies

No dependency.

Installation

This tool is a built-in platform tool.

Use

The map file is available in the MicroEJ Application project output directory.
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= & v 2® * Javall .
. 55} MyHelloWorldSample ; package com.microej.example.hello;
4 4% src/main/java 16% import java.io.Filej[]
4 [ com.microej.example.hello 24
> 47| HelloWorld.java 258
. (™ src/main/resources 26 * Prints the message "Hello World !" an displays MicroE] splash
. 27 */
g fn“ Refe.ranced Libraries 28 public class HelloWorld extends Displayable implements EventHandler{
» [ .settings 29
4 [= commicroej.example.hello.HelloWorld 38 private static final int PADDING TEXT =5;
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SOAR.0 a2 } catch (IOException &) {
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X] project 47 File f = mew File("/s55");

&

Fig. 49: Retrieve Map File

Select an item (or several) to show the memory used by this item(s) on the right. Select “All” to show the memory
used by all items. This special item performs the same action as selecting all items in the list.

[# Pa.. 57 FgMy.. EjTe. = [0 | [0S0ARmap i = B8
< 7 ’ Image 5 Runtime Si
- . ame mage Size untime Size e
“ r" T,,yjrij,:nv:‘o;“;as\fample @ All 1899 KB 51.9 KB =
) L‘“ erc/main/resources . @ ApplicationCode 27KB 0B IMAGE: 49.3 KB /189.9 KB
S @ ApplicationFonts 24.2 KB 0B [ 26.00% ]
» =% Referenced Libraries
. @ Applicationlmages 3.2KB 0B :
g L/ settings > @ Applicationlmmutables 264 B 0B _Ap...l ArplicationSirings l
4= fum.mlcmej.examp\E‘heIIU.HeIIuWurld I 0E 0B
.V,_I/ ben > O ApplicationStrings 189 KB 0B (s
L . @ BSP 600 B 3.7KB
(& fonts . @ ClassesNames 71KB 0B
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SOARo » & LibFoundationBOMN 856 B 0B
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|%] .classpath . = 5
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Fig. 50: Consult Full Memory

Select an item in the list, and expand it to see all symbols used by the item. This view is useful in understanding
why a symbol is embedded.
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Fig. 51: Detailed View

3.10.8 Event Tracing
Description

Event Tracing allows to record integer based events for debugging and monitoring purposes without affecting ex-
ecution performance too heavily. Basically, it gives access to Tracer objects that are named and can produce a
limited number of different event types.

Arecord is an event type identified by an eventID and can have a list of values. It can be a single event or a period
of time with a start and an end.

Event Tracing can be accessed from two APIs:

+ A Java API, provided by the Trace APl module. The following dependency must be added to the module.ivy
of the MicroEJ Application project:

<dependency org="ej.api" name="trace" rev="1.1.0"/>

« ACAPI, provided by the Platform header file named LLTRACE_impl.h.
Events are recorded if and only if:

« the MicroEJ Core Engine trace system is enabled,

« and trace recording is started.

To enable the MicroEJ Core Engine trace system, set the Application Option named core. trace.enabled to true
(see also launch configuration).

Then, multiple ways are available to start and stop the trace recording:
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+ by setting the Application Option named core.trace.autostart to true to automatically start at startup
(see also launch configuration),

« using the Java APl methods ej.trace.Tracer.startTrace() and ej.trace.Tracer.stopTrace(),

+ using the C API functions LLTRACE_IMPL_start(void) and LLTRACE_IMPL_stop(void).

Java APl Usage

The detailed Trace APl documentation is available here.

First, you need to instantiate a Tracer object by calling its constructor with two parameters. The first parameter,
name, is a String that will represent the Tracer object group’s name. The second parameter, nbEventTypes,isan
integer representing the maximum number of event types available for the group.

Tracer tracer = new Tracer("MyGroup”, 10);

Then, you can record an event by calling the recordEvent(int eventId) method. The event ID needs to be in
the range 0 to nbEventTypes-1 with nbEventTypes the maximum number of event types set when initializing
the Tracer object. Methods named recordEvent(...) always needs the event ID as the first parameter and can
have up to ten integer parameters as custom values for the event.

To record the end of an event, call the method recordEventEnd(int eventID) . It will trace the duration of an
event previously recorded with one of the recordEvent(int) methods. The recordEventEnd(...) method can
also have another integer parameter for a custom value for the event end. One can use it to trace the returned value
of a method.

The Trace API also provides a String constant Tracer. TRACE_ENABLED_CONSTANT_PROPERTY representing the Con-
stant value of core.trace.enabled option. This constant can be used to remove at build time portions of code
when the trace system is disabled. To do that, just surround tracer record calls with a if statement that checks the
constant’s state. When the constant is set to false, the code inside the if statement will not be embedded with
the application and thus will not impact the performances.

if(Constants.getBoolean(Tracer.TRACE_ENABLED_CONSTANT_PROPERTY)) {
// This code is not embedded if TRACE_ENABLED_CONSTANT_PROPERTY is set to false.
tracer.recordEventEnd(0);

}

Examples:

+ Trace asingle event:

private static final Tracer tracer = new Tracer("Application”, 100);

public static void main(String[] args) {
Tracer.startTrace();
tracer.recordEvent(0);

}

Standard Output:

VM START
[TRACE] [1] Declare group "Application”
[TRACE] [1] Event 0x0

«+ Trace a method with a start event showing the parameters of the method and an end event showing the
result:
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private static final Tracer tracer = new Tracer("Application”, 100);

public static void main(String[] args) {
Tracer.startTrace();

int a = 14;
int b = 54;
add(a, b);

}

public static int add(int a, int b) {
tracer.recordEvent(1, a, b);
int result = a + b;
tracer.recordEventEnd(1, result);
return result;

3

Standard Output:

VM START

[TRACE] [1] Declare group "Application”
[TRACE] [1] Event ox1 (14 [@OxE],54 [0x36])
[TRACE] [1] Event End 0x1 (68 [0x44])

Platform Implementation
By default, when enabled, the Trace API displays a message in the standard output for every recordevent(...)
and recordEventEnd(...) method calls.

It does not print a timestamp when displaying the trace message because it can drastically affect execution perfor-
mances. It only prints the ID of the recorded event followed by the values given in parameters.

A Platform can connect its own implementation by overriding the functions defined in the LLTRACE_impl.h file.

MicroEJ provides an implementation that redirects the events to SystemView tool, the real-time recording and
visualization tool from Segger. It is perfect for a finer understanding of the runtime behavior by showing events
sequence and duration.

A implementation example for the NXP OM13098 development board with SystemView support is available here.
Please contact MicroEJ Support for more information about how to integrate this Platform module.

3.11 Advanced Tools

3.11.1 MicroEJ Linker
Overview

MicroEJ Linker is a standard linker that is compliant with the Executable and Linkable File format (ELF).

MicroEJ Linker takes one or several relocatable binary files and generates an image representation using a descrip-
tion file. The process of extracting binary code, positioning blocks and resolving symbols is called linking.

Relocatable object files are generated by SOAR and third-party compilers. An archive file is a container of Relocat-
able object files.
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The description file is called a Linker Specific Configuration file (Isc). It describes what shall be embedded, and how
those things shall be organized in the program image. The linker outputs :

« An ELF executable file that contains the image and potential debug sections. This file can be directly used by
debuggers or programming tools. It may also be converted into a another format (Intel* hex, Motorola* s19,
rawBinary, etc.) using external tools, such as standard GNU binutils toolchain (objcopy, objdump, etc.).

« A map file, in XML format, which can be viewed as a database of what has been embedded and resolved by
the linker. It can be easily processed to get a sort of all sizes, call graphs, statistics, etc.

« The linker is composed with one or more library loaders, according to the platform’s configuration.

ELF Overview

An ELF relocatable file is split into several sections:
« allocation sections representing a part of the program
« control sections describing the binary sections (relocation sections, symbol tables, debug sections, etc.)

An allocation section can hold some image binary bytes (assembler instructions and raw data) or can refer to an
interval of memory which makes sense only at runtime (statics, main stack, heap, etc.). An allocation section is an
atomic block and cannot be split. A section has a name that by convention, represents the kind of data it holds.
For example, .text sections hold binary instructions, .bss sections hold read-write static data, .rodata hold
read-only data, and . data holds read-write data (initialized static data). The nameis used in the .Isc file to organize
sections.

A symbol is an entity made of a name and a value. A symbol may be absolute (link-time constant) or relative to a
section: Its value is unknown until MicroEJ Linker has assigned a definitive position to the target section. A symbol
can be local to the relocatable file or global to the system. All global symbol names should be unique in the system
(the name is the key that connects an unresolved symbol reference to a symbol definition). A section may need the
value of symbols to be fully resolved: the address of a function called, address of a static variable, etc.

Linking Process

The linking process can be divided into three main steps:

1. Symbols and sections resolution. Starting from root symbols and root sections, the linker embeds all sec-
tions targeted by symbols and all symbols referred by sections. This process is transitive while new symbols
and/or sections are found. At the end of this step, the linker may stop and output errors (unresolved symbols,
duplicate symbols, unknown or bad input libraries, etc.)

2. Memory positioning. Sections are laid out in memory ranges according to memory layout constraints de-
scribed by the Isc file. Relocations are performed (in other words, symbol values are resolved and section
contents are modified). At the end of this step, the linker may stop and output errors (it could not resolve
constraints, such as not enough memory, etc.)

3. Anoutput ELF executable file and map file are generated.

A partial map file may be generated at the end of step 2. It provides useful information to understand why the link
phase failed. Symbol resolution is the process of connecting a global symbol name to its definition, found in one of
the linker input units. The order the units are passed to the linker may have an impact on symbol resolution. The
rules are :

+ Relocatable object files are loaded without order. Two global symbols defined with the same name result in
an unrecoverable linker error.

+ Archivefiles are loaded on demand. When a global symbol must be resolved, the linker inspects each archive
unitin the order it was passed to the linker. When an archive contains a relocatable object file that declares
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the symbol, the object file is extracted and loaded. Then the first rule is applied. It is recommended that you
group object files in archives as much as possible, in order to improve load performances. Moreover, archive
files are the only way to tie with relocatable object files that share the same symbols definitions.

« Asymbol name is resolved to a weak symbol if - and only if - no global symbol is found with the same name.

Linker Specific Configuration File Specification

Description

A Linker Specific Configuration (Lsc) file contains directives to link input library units. An Isc file is written in an XML
dialect, and its contents can be divided into two principal categories:

« Symbols and sections definitions.

« Memory layout definitions.

Listing 5: Example of Relocation of Runtime Data from FLASH to RAM

<?xml version="1.0" encoding="UTF-8"7?>
<l--
An example of linker specific configuration file
-—>
<lsc name="MyAppInFlash">
<include name="subfile.lscf"/>
<l--
Define symbols with arithmetical and logical expressions
-—>
<defSymbol name="FlashStart” value="0"/>
<defSymbol name="FlashSize" value="0x10000"/>
<defSymbol name="FlashEnd” value="FlashStart+FlashSize-1"/>
<l--
Define FLASH memory interval
-—>
<defSection name="FLASH" start="FlashStart"” size="FlashSize"/>

Kl==
Some memory layout directives

-=>

<memorylLayout ranges ="FLASH">
<sectionRef name ="x*.text"/>
<sectionRef name ="x.data"/>

</memorylLayout>

</1sc>

File Fragments

An lsc file can be physically divided into multiple Isc files, which are called lsc fragments. Lsc fragments may be
loaded directly from the linker path option, or indirectly using the include tagin an Isc file.

Lsc fragments start with the root tag 1scFragment . By convention the Isc fragments file extensionis .1scf. From
here to the end of the document, the expression “the Isc file” denotes the result of the union of all loaded (directly
and indirectly loaded) Isc fragments files.
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Symbols and Sections

A new symbol is defined using defSymbol tag. A symbol has a name and an expression value. All symbols defined
in the lsc file are global symbols.

A new section is defined using the defSection tag. A section may be used to define a memory interval, or define
a chunk of the final image with the description of the contents of the section.

Memory Layout

A memory layout contains an ordered set of statements describing what shall be embedded. Memory positioning
can be viewed as moving a cursor into intervals, appending referenced sections in the order they appear. A symbol
can be defined as a “floating” item: Its value is the value of the cursor when the symbol definition is encountered.
In the example below, the memory layout sets the FLASH section. First, all sections named . text are embedded.
The matching sections are appended in a undefined order. To reference a specific section, the section shall have a
unique name (for example a reset vector is commonly called .reset or .vector,etc.). Then, the floating symbol
dataStart is set to the absolute address of the virtual cursor right after embedded .text sections. Finally all
sections named .data are embedded.

A memory layout can be relocated to a memory interval. The positioning works in parallel with the layout ranges,
as if there were two cursors. The address of the section (used to resolve symbols) is the address in the relocated
interval. Floating symbols can refer either to the layout cursor (by default), or to the relocated cursor, using the
relocation attribute. A relocation layout is typically used to embed data in a program image that will be used
at runtime in a read-write memory. Assuming the program image is programmed in a read only memory, one of
the first jobs at runtime, before starting the main program, is to copy the data from read-only memory to RAM,
because the symbols targeting the data have been resolved with the address of the sections in the relocated space.
To perform the copy, the program needs both the start address in FLASH where the data has been put, and the
start address in RAM where the data shall be copied.

Listing 6: Example of Relocation of Runtime Data from FLASH to RAM

<memorylLayout ranges="FLASH"” relocation="RAM" image="true">
<defSymbol name="DataFlashStart"” value="."/>
<defSymbol name="DataRamStart” value=" ." relocation="true"/>
<sectionRef name=".data"/>
<defSymbol name="DataFlashLimit"” value="."/>

</memorylLayout>

Note: the symbol DataRamStart is defined to the start address where .data sections will be inserted in RAM
memory.

Tags Specification

Here is the complete syntactical and semantical description of all available tags of the .1sc file.
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Table 6: Linker Specific Configuration Tags

Tags Attributes Description
Defines a new section. A floating section only holds a declared size
attribute. A fixed section declares at least one of the start / end at-
tributes. When this tag is empty, the section is a runtime section, and
must define at least one of the start, end or size attributes. When
this tag is not empty (when it holds a binary description), the section
is an image section.
name Name of the section. The section name may not be unique. However,
it is recommended that you define a unique name if the section must
be referred separately for memory positioning.
start Optional. Expression defining the absolute start address of the sec-
tion. Must be resolved to a constant after the full load of the Isc file.
end Optional. Expression defining the absolute end address of the section.
Must be resolved to a constant after the full load of the lsc file.
size Optional. Expression defining the size in bytes of the section. Invari-
ant: (end-start)+1=size . Must be resolved to a constant after the
full load of the Isc file.
align Optional. Expression defining the alignment in bytes of the section.
rootSection | Optional. Boolean value. Sets this section as a root section to be em-
bedded even if it is not targeted by any embedded symbol. See also
rootSection tag.
symbolPrefix | Optional. Used in collaboration with symbolTags . Prefix of symbols
embedded in the auto-generated section. See Auto-generated Sec-
tions.
symbolTags Optional. Used in collaboration with symbolPrefix . Comma sepa-
rated list of tags of symbols embedded in the auto-generated section.
See Auto-generated Sections.
Defines a new global symbol. Symbol name must be unique in the
linker context
name Name of the symbol.
type Optional. Type of symbol usage. This may be necessary to set the type
of a symbol when using third party ELF tools. There are three types: -
none : default. No special type of use. - function: symbol describes
a function. - data: symbol describes some data.
value The value ".” defines a floating symbol that holds the current cur-
sor position in a memory layout. (This is the only form of this tag that
can be used as a memorylLayout directive) Otherwise value is an ex-
pression. A symbol expression must be resolved to a constant after
memory positioning.
relocation Optional. The only allowed value is true . Indicates that the value
of the symbol takes the address of the current cursor in the memory
layout relocation space. Only allowed on floating symbols.
rootSymbol Optional. Boolean value. Sets this symbol as a root symbol that must
be resolved. See also rootSymbol tag.
weak Optional. Boolean value. Sets this symbol as a weak symbol.
memorylLayout directive. Defines a named group of sections. Group
name may be used in expression macros START, END, SIZE.All mem-
oryLayout directives are allowed within this tag (recursively).
name The name of the group.
Includes an lsc fragment file, semantically the same as if the fragment
contents were defined in place of the include tag.

Continued on next page

defSection

defSymbol

group

include
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Table 6 - continued from previous page
Tags Attributes Description
name Name of the file to include. When the name is relative, the file sepa-
rator is /, and the file is relative to the directory where the current
[sc file or fragment is loaded. When absolute, the name describes a
platform-dependent filename.
Root tag for an .Isc file.
name Name of the Isc file. The ELF executable output will be {name}.out,
and the map file will be {name}.map
1scFragment Root tag for an Isc file fragment. Lsc fragments are loaded from the
linker path option, or included from a master file using the include
tag.
Describes the organization of a set of memory intervals. The memory
layouts are processed in the order in which they are declared in the
file. The same interval may be organized in several layouts. Each lay-
out starts at the value of the cursor the previous layout ended. The fol-
lowing tags are allowed within a memoryLayout directive: defSymbol
(under certain conditions), group, memoryLayoutRef, padding,and
sectionRef .
ranges Exclusive with default. Comma-separated ordered list of fixed sections
to which the layout is applied. Sections represent memory segments.
image Optional. Boolean value. false if not set. If true, the layout de-
scribes a part of the binary image: Only image sections can be embed-
ded. If false, only runtime sections can be embedded.
relocation Optional. Name of the section to which this layout is relocated.
name Exclusive with ranges. Defines a named memorylLayout directive in-
stead of specifying a concrete memory location. May be included in a
parent memoryLayout using memoryLayoutRef.
memorylLayout directive. Provides an extension-point mechanism to
include memorylLayout directives defined outside the current one.
name All directives of memoryLayout defined with the same name are in-
cluded in an undefined order.
memorylLayout directive. Append padding bytes to the current cursor.
Either size or align attributes should be provided.
size Optional. Expression must be resolved to a constant after the full load
of the Isc file. Increment the cursor position with the given size.
align Optional. Expression must be resolved to a constant after the full load
of the lsc file. Move the current cursor position to the next address that
matches the given alignment. Warning: when used with relocation,
the relocation cursor is also aligned. Keep in mind this may increase
the cursor position with a different amount of bytes.
address Optional. Expression must be resolved to a constant after the full load
of the Isc file. Move the current cursor position to the given absolute
address.
fill Optional. Expression must be resolved to a constant after the full load
of the Isc file. Fill padding with the given value (32 bits).
References a section name that must be embedded. This tagis not a
definition. It forces the linker to embed all loaded sections matching
the given name.
name Name of the section to be embedded.
References a symbol that must be resolved. This tag is not a definition.
It forces the linker to resolve the value of the symbol.
name Name of the symbol to be resolved.

1sc

memorylLayout

memorylLayoutRef

padding

rootSection

rootSymbol

Continued on next page
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Table 6 - continued from previous page
Tags Attributes Description
Memory layout statement. Embeds all sections matching the given
name starting at the current cursor address.
file Select only sections defined in a linker unit matching the given file
name. Thefile nameis the simple name without any file separator, e.g.
bsp.o or mylink.lsc. Link units may be object files within archive
units.
name Name of the sections to embed. When the name ends with *, all sec-
tions starting with the given name are embedded (name completion),
except sections that are embedded in another sectionRef using the ex-
act name (without completion).
symbol Optional. Only embeds the section targeted by the given symbol. This
is the only way at link level to embed a specific section whose name is
not unique.
force Optional. Deprecated. Replaced by the rootSection tag. The only
allowed value is true. By default, for compaction, the linker embeds
only what is needed. Setting this attribute will force the linker to em-
bed all sections that appear in all loaded relocatable files, even sec-
tions that are not targeted by a symbol.
sort Optional. Specifies that the sections must be sorted in memory. The
value can be: - order : the sections will be in the same order as the
input files - name : the sections are sorted by their file names - unit
: the sections declared in an object file are grouped and sorted in the
order they are declared in the object file
Binary section statement. Describes the four next raw bytes of the
section. Bytes are organized in the endianness of the target ELF ex-
ecutable.
value Expression must be resolved to a constant after the full load of the Isc
file (32 bits value).
Binary section statement. Fills the section with the given expression.
Bytes are organized in the endianness of the target ELF executable.
size Expression defining the number of bytes to be filled.
value Expression must be resolved to a constant after the full load of the Isc
file (32 bits value).

sectionRef

u4

file

Expressions

An attribute expression is a value resulting from the computation of an arithmetical and logical expression. Sup-
ported operators are the same operators supported in the Java language, and follow Java semantics:

« Unaryoperators: + , - , ~ | |

« Binaryoperators: + , -, %, / | %, <<, >>> 0>> <> <= >= === & |0
&& , ||

« Ternary operator: cond ? ifTrue : ifFalse
« Built-in macros:

- START(name) : Get the start address of a section or a group of sections

END(name) : Get the end address of a section or a group of sections

SIZE(name) : Get the size of a section or a group of sections. Equivalent to END(name)-START (name)

TSTAMPH() , TSTAMPL () : Get 32 bits linker time stamp (high/low part of system time in milliseconds)
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- SUM(name, tag) : Get the sum of an auto-generated section (Auto-generated Sections) column. The col-
umn is specified by its tag name.

An operand is either a sub expression, a constant, or a symbol name. Constants may be written in decimal (127) or
hexadecimal form (@x7F ). There are no boolean constants. Constant value @ means false, and other constants’
values mean true . Examples of use:

value="symbol+3"
value="((symbol1%4)-(symbol2%3)"

Note: Ternary expressions can be used to define selective linking because they are the only expressions that may
remain partially unresolved without generating an error. Example:

<defSymbol name="myFunction” value="condition ? symbl : symb2"/>

No error will be thrown if the condition is true and symb1 is defined, or the condition is false and symb2 is
defined, even if the other symbol is undefined.

Auto-generated Sections

The MicroEJ Linker allows you to define sections that are automatically generated with symbol values. This is com-
monly used to generate tables whose contents depends on the linked symbols. Symbols eligible to be embedded
in an auto-generated section are of the form: prefix_tag_suffix.Anauto-generated section isviewed as a table
composed of lines and columns that organize symbols sharing the same prefix. On the same column appear sym-
bols that share the same tag. On the same line appear symbols that share the same suffix. Lines are sorted in the
lexical order of the symbol name. The next line defines a section which will embed symbols starting with zeroinit
. The first column refers to symbols starting with zeroinit_start_;the second column refers to symbols starting
with zeroinit_end_.

<defSection
name=".zeroinit"
symbolPrefix="zeroInit"
symbolTags="start,end”
/>

Consider there are four defined symbols named zeroinit_start_xxx |, zeroinit_end_xxx ,
zeroinit_start_yyy and zeroinit_end_yyy . The generated section is of the form:

0x00: zeroinit_start_xxx
0x04: zeroinit_end_xxx
0x08: zeroinit_start_yyy
0x0C: zeroinit_end_yyy

If there are missing symbols to fill a line of an auto-generated section, an error is thrown.

Execution

MicroEJ Linker can be invoked through an ANT task. The task is installed by inserting the following code in an ANT
script

<taskdef
name="1linker"
classname="com.is2t.linker.GenericLinkerTask"
classpath="[LINKER_CLASSPATH]"

/>

3.11. Advanced Tools 135



MicroEJ Documentation, Revision bd708584

[LINKER_CLASSPATH] is a list of path-separated jar files, including the linker and all architecture-specific library
loaders.

The following code shows a linker ANT task invocation and available options.

<linker
doNotLoadAlreadyDefinedSymbol="[true|false]"
endianness="[little|big|none]”
generateMapFile="[true|false]”
ignoreWrongPositioningForEmptySection="[true|false]”
lsc="[filename]”
linkPath="[path1:...pathN]"
mergeSegmentSections="[true|false]”
noWarning="[true|false]"
outputArchitecture="[tag]"
outputName="[name]"”
stripDebug="[true|false]”
toDir="[outputDir]”
verboselLevel="[0...9]"

>
<!-- ELF object & archives files using ANT paths / filesets -->
<fileset dir="xxx" includes="*.0">
<fileset file="xxx.a">
<fileset file="xxx.a">
<!-- Properties that will be reported into .map file -->
<property name="myProp"” value="myValue"/>

</linker>
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Table 7: Linker Options Details

Option

Description

doNotLoadAlreadyDefinedSymbol

Silently skip the load of a global symbol if it has already
been loaded before. ( false by default. Only the first
loaded symbol is taken into account (in the order input
files are declared). This option only affects the load se-
mantic for global symbols, and does not modify the se-
mantic for loading weak symbols and local symbols.

Explicitly declare linker endianness [little, big] or

endianness [none] for auto-detection. All input files must declare
the same endianness or an error is thrown.
Generate the .map file ( true by default).
generateMapFile

ignoreWrongPositioningForEmptySection

Silently ignore wrong section positioning for zero size
sections. ( false by default).

Provide a master Iscfile. This optionis mandatory unless

lsc the linkPath option is set.
) Provide a set of directories into which to load link file
linkPath fragments. Directories are separated with a platform-
path separator. This option is mandatory unless the 1sc
option is set.
Silently skip the output of warning messages.
noWarning

mergeSegmentSections

(experimental). Generate a single section per segment.
This may speed up the load of the output executable file
into debuggers or flasher tools. ( false by default).

outputArchitecture

Set the architecture tag for the output ELF file (ELF ma-
chineid).

outputName

Specify the output name of the generated files. By de-
fault, take the name provided in the Isc tag. The output
ELF executable filename will be name.out. The map file-
name will be name.map.

stripDebug

Remove all debug information from the output ELF file.
A stripped output ELF executable holds only the binary
image (no remaining symbols, debug sections, etc.).

toDir

Specify the output directory in which to store generated
files. Output filenames are inthe form: od + separator
+ value of the 1lsc name attribute + suffix.
By default, without this option, files are generated in the
directory from which the linker was launched.

verboselLevel

Print additional messages on the standard output about
linking process.

Error Messages

This section lists MicroEJ Linker error messages.

Table 8: Linker-Specific Configuration Tags

Message ID Description
0 The linker has encountered an unexpected internal error. Please contact the support hot-
line.

Continued on next page
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Table 8 - continued from previous page

1 A library cannot be loaded with this linker. Try verbose to check installed loaders.

2 No sc file provided to the linker.

3 Afile could not be loaded. Check the existence of the file and file access rights.

4 Conflictinginput libraries. Aglobal symbol definition with the same name has already been
loaded from a previous object file.

5 Completion (*) could not be used in association with the force attribute. Must be an exact
name.

6 Arequired section refers to an unknown global symbol. Maybe input libraries are missing.

7 A library loader has encountered an unexpected internal error. Check input library file in-
tegrity.

8 Floating symbols can only be declared inside memorylLayout tags.

9 Invalid value format. For example, the attribute relocation in defSymbol must be a
boolean value.

10 Missing one of the following attributes: address, size, align.

1 Too many attributes that cannot be used in association.

13 Negative padding. Memory layout cursor cannot decrease.

15 Not enough space in the memory layout intervals to append all sections that need to be
embedded. Check the output map file to get more information about what is required as
memory space.

16 A block is referenced but has already been embedded. Most likely a block has been espe-
cially embedded using the force attribute and the symbol attribute.

17 A block that must be embedded has no matching sectionRef statement.

19 An 10 error occurred when trying to dump one of the output files. Check the output direc-
tory option and file access rights.

20 size attribute expected.

21 The computed size does not match the declared size.

22 Sections defined in the Isc file must be unique.

23 One of the memory layout intervals refers to an unknown Isc section.

24 Relocation must be done in one and only one contiguous interval.

25 force and symbol attributes are not allowed together.

26 XML char data not allowed at this position in the Isc file.

27 A section which is a part of the program image must be embedded in an image memory
layout.

28 A section which is not a part of the program image must be embedded in a non-image
memory layout.

29 Expression could not be resolved to a link-time constant. Some symbols are unresolved.

30 Sections used in memory layout ranges must be sections defined in the Isc file.

31 Invalid character encountered when scanning the lsc expression.

32 Arecursive include cycle was detected.

33 An alignment inconsistency was detected in a relocation memory layout. Most likely one
of the start addresses of the memory layout is not aligned on the current alignment.

34 An error occurs in a relocation resolution. In general, the relocation has a value that is out
of range.

35 symbol and sort attributes are not allowed together.

36 Invalid sort attribute value is not one of order, name,or no.

37 Attribute start or end in defSection tagis notallowed when defining a floating section.

38 Autogenerated section can build tables according to symbol names (see Auto-generated
Sections). A symbol is needed to build this section but has not been loaded.

39 Deprecated feature warning. Remains for backward compatibility. It is recommended that
you use the new indicated feature, because this feature may be removed in future linker
releases.

Continued on next page
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Table 8 - continued from previous page
40 Unknown output architecture. Either the architecture ID is invalid, or the library loader has
not been loaded by the linker. Check loaded library loaders using verbose option.
41...43 Reserved.

44 Duplicate group definition. A group name is unique and cannot be defined twice.

45 Invalid endianness. The endianness mnemonic is not one of the expected mnemonics (
little,big,none).

46 Multiple endiannesses detected within loaded input libraries.

47 Reserved.

48 Invalid type mnemonic passed to a defSymbol tag. Must be one of none, function, or
data.

49 Warning. A directory of link path is invalid (skipped).

50 No linker-specific description file could be loaded from the link path. Check that the link
path directories are valid, and that they contain .1sc or .1scf files.

51 Exclusive options (these options cannot be used simultaneously). For example,

-linkFilename and -linkPath are exclusive; either select a master Isc file or a path from
which to load .1scf files.

52 Name given to a memorylLayoutRef ora memoryLayout isinvalid. It must not be empty.

53 A memorylLayoutRef with the same name has already been processed.

54 A memorylLayout must define ranges orthe name attribute.

55 No memory layout found matching the name of the current memoryLayoutRef .

56 Anamed memorylLayout is declared with a relocation directive, but the relocation interval
is incompatible with the relocation interval of the memoryLayout that referenced it.

57 A named memorylLayout has not been referenced. Every declared memorylLayout must
be processed. Anamed memorylLayout must be referenced by a memorylLayoutRef state-
ment.

58 SUM operator expects an auto-generated section.

59 SUM operator tag is unknown for the targetted auto-generated section.

60 SUM operator auto-generated section name is unknown.

61 An option is set for an unknown extension. Most likely the extension has not been set to
the linker classpath.

62 Reserved.

63 ELF unit flags are inconsistent with flags set using the -forceFlags option.

64 Reserved.

65 Reserved.

66 Found an executable object file as input (expected a relocatable object file).

67 Reserved.

68 Reserved.

69 Reserved.

70 Not enough memory to achieve the linking process. Try to increase JVM heap that is run-

ning the linker (e.g. by adding option -Xmx1024M to the JRE command line).

Map File Interpretor

The map file interpretor is a tool that allows you to read, classify and display memory information dumped by
the linker map file. The map file interpretor is a graph-oriented tool. It supports graphs of symbols and allows
standard operations on them (union, intersection, subtract, etc.). It can also dump graphs, compute graph total
sizes, list graph paths, etc.

The map file interpretor uses the standard Java regular expression syntax.

Itis used internally by the graphical Memory Map Analyzer tool.

Commands:
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e createGraph graphName symbolRegExp ... section=regexp

createGraph all section=.*

Recursively create a graph of symbols from root symbols and sections described as regular expressions. For
example, to extract the complete graph of the application:

e createGraphNoRec symbolRegExp ... section=regexp

The above line is similar to the previous statement, but embeds only declared symbols and sections (without
recursive connections).

¢ removeGraph graphName

Removes the graph for memory.

¢ listGraphs

Lists all the created graphs in memory.

¢ listSymbols graphName

Lists all graph symbols.

e listPadding

Lists the padding of the application.

* listSections graphName

Lists all sections targeted by all symbols of the graph.

e inter graphResult g1 ... gn
Creates a graph which is the intersection of g1/\ ... /\gn.
e union graphResult g1 ... gn

Creates a graph which is the union of g1\/ ...\/ gn.

e substract graphResult g1 ... gn

Creates a graph which is the substract of g1\ ... \ gn.

* reportConnections graphName

Prints the graph connections.

e totalImageSize graphName

Prints the image size of the graph.

* totalDynamicSize graphName

Prints the dynamic size of the graph.
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¢ accessPath symbolName

The above line prints one of the paths from a root symbol to this symbol. This is very useful in helping you
understand why a symbol is embedded.

¢ echo arguments

Prints raw text.

¢« exec commandFile

Execute the given commandFile. The path may be absolute or relative from the current command file.

3.11.2 Testsuite Engine
3.11.3 MicroEJ Testsuite Engine

Introduction

The MicroEJ Testsuite Engineis a generic tool made for validating any development project using automatic testing.
This section details advanced configuration for users who wish to integrate custom testsuites in their build flow.

The MicroEJ Testsuite Engine allows the user to test any kind of projects within the configuration of a generic Ant
file.

TESTSUITE ENGINE

FOR EACH TEST CASE
-

Test Build & Link
Test Deployment Trace Redirection

13

(5

Trace Analysis

Test Execution

The MicroEJ Testsuite Engine is already pre-configured for running testsuites on a MicroEJ Platform (either on Sim-
ulator or on Device).
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« For Application and Libraries, refer to Testsuite with JUnit section.

« For Foundation Libraries Testsuites, refer to Platform Testsuite section.

Using the MicroEJ Testsuite Ant Tasks

Multiple Ant tasks are available in the testsuite-engine. jar provided in the Build Kit:

+ testsuite allowsthe usertoruna given testsuite and to retrieve an XML report document in a JUnit format.

« javaTestsuite isasubtask ofthe testsuite task, used to run aspecialized testsuite for Java (will only run

Java classes).

« htmlReport is atask which will generate an HTML report from a list of JUnit report files.

The testsuite Task

The following attributes are mandatory:

Table 9: testsuite task mandatory attributes

Attribute Name | Description
. The output folder of the testsuite. The final report will be generated at [outputDirl/
outputDir [label]/[reportName].xml , see the testsuiteReportFileProperty and
testsuiteReportDirProperty attributes.
The harness script must be an Ant script and it is the script which will be called for each test
harnessScript

by the testsuite engine. It is called with a basedir located at output location of the current
test.

The testsuite engine provides the following properties to the harness script giving all the informations to start the

test:

Table 10: harnessScript properties

Attribute Name | Description

' The output name of the current test in the report. Default value is the relative path of the
testsuite. test. It can be manually set by the user. More details on the output name are available in the
test.name section Specific Custom Properties.

' The current test absolute path in the filesystem.
testsuite.
test.path

. The absolute path to the custom properties of the current test (see the property
testsuite. customPropertiesExtension)
test.
properties

. The absolute path to the common properties of all the tests (see the property
testsuite. commonProperties )
common.
properties

. The absolute path to the directory of the final report.
testsuite.
report.dir

The following attributes are optional:
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Table 11: testsuite task optional attributes

Attribute | Description Default value
Name
) The time in seconds before any test is considerated as un-
timeOut | knhown. Setitto ¢ to disable the time-out. 60
The required level to output messages from the testsuite.
verboselevedan be one of those values: error , warning , info, | 1NfO
verbose, debug.
The final report name (without extension).
reportName testsuite-report
The extension of the custom properties for each test. For in-
customPropegifestifitis s8tto .options , a test named xxx/Testl. | -Properties
class will be associated with xxx/Test1.options. If afile
exists for a test, the property testsuite.test.properties
is set with its absolute path and given to the harnessScript
If the test path references a directory, then the custom
properties path is the concatenation of the test path and the
customPropertiesExtension value.
The properties to apply to every test of the testsuite. Those | no common properties
commonPropedtibas might be overridden by the custom properties of
each test. If this option is set and the file exists, the prop-
erty testsuite.common.properties is set to the absolute
path of the harnessScript file
The build label. timestamp of when the testsuite
label was invoked.
The name of the current tested product.
productName TestSuite
The location of your Java VM to start the testsuite (the o
jvm harnessScript is called asis: [jvm] [...1 -buildfile | Java.home locationif the property
[harnessScript]). is set, java otherwise.
_ The arguments to pass to the Java VM started for each test. | None.
jvmargs
The name of the Ant property in which the path of the
teStSUiteRqﬂ?‘aﬂtﬁéﬂJSP{‘?é’eﬁWed. Path is [outputDir]/[label]/ | testsuite. report.file
[reportName].xml
The name of the Ant property in which is store the path of the
testsulteRefpedtoty ortheTial report. Pathis [outputDir]/[label]. | testsuite.report.dir
_ The name of the Ant property in which you want to have the | None
testsuite

RGeel T SPHE testsuite (true or false ), depending if every
tests successfully passed the testsuite or not. Ignored tests
do not affect this result.

Finally, you have to give as nested element the path containing the tests.

Table 12: testsuite task nested elements

Element Name

Description

Containing all the file of the tests which will be launched by the testsuite.

testPath

Any test in the intersection between testIgnoredPath and testPath will be executed by
testignoredPath the testsuite, but will not appear in the JUnit final report. It will still generate a JUnit re-
(optional) port for each test, which will allow the HTML report to let them appears as “ignored” if it is

enough to appears on the HTML report.

generated. Mostly used for known bugs which are not considered as failure but still relevant
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Listing 7: Example of testsuite task invocation

<!-- Launch the testusite engine -->

<testsuite:testsuite
timeOut="${microej.kf.testsuite.timeout}”
outputDir="${target.test.xml}/testkf”
harnessScript="${com.is2t.easyant.plugins#microej-kf-testsuite.microej-kf-testsuite-harness-jpf-emb.

—xml.file}"”
commonProperties="${microej.kf.launch.propertyfile}"
testsuiteResultProperty="testkf.result"
testsuiteReportDirProperty="testkf.testsuite.report.dir”
productName="${module.name} testkf"”
jvmArgs="${microej.kf.testsuite.jvmArgs}"
lockPort="${microej.kf.testsuite.lockPort}"
verboselLevel="${testkf.verbose.level}"

>
<testPath refid="target.testkf.path"/>

</testsuite:testsuite>

The javaTestsuite Task

This task extends the testsuite task, specializing the testsuite to only start real Java class. This task retrieves the
classname of the tests from the classfile and provides new properties to the harness script:

Table 13: javaTestsuite task properties

Property Name | Description

) The classname of the current test. The value of the property testsuite.test.name isalso
testsuite. set to the classname of the current test.
test.class

) The classpath of the current test.
testsuite.
test.
classpath

Listing 8: Example of javaTestsuite task invocation
<!-- Launch test suite -->

<testsuite:javaTestsuite
verboselLevel="${microej.testsuite.verboselLevel}”
timeOut="${microej.testsuite.timeout}"
outputDir="${target.test.xml}/@{prefix}"
harnessScript="${harness.file}"
commonProperties="${microej.launch.propertyfile}"
testsuiteResultProperty="@{prefix}.result”
testsuiteReportDirProperty="@{prefix}.testsuite.report.dir”
productName="${module.name} @{prefix}"
jvmArgs="${microej.testsuite.jvmArgs}”
lockPort="${microej.testsuite.lockPort}"
retryCount="${microej.testsuite.retry.count}”
retryIf="${microej.testsuite.retry.if}"
retryUnless="${microej.testsuite.retry.unless}"”

<testPath refid="target.@{prefix}.path"/>

(continues on next page)
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(continued from previous page)

<testIgnoredPath refid="tests.@{prefix}.ignored.path” />
</testsuite:javaTestsuite>

The htmlReport Task

This task allow the user to transform a given path containing a sample of JUnit reports to an HTML detailed report.
Here is the attributes to fill:

« Anested fileset element containing all the JUnit reports of each test. Take care to exclude the final JUnit
report generated by the testsuite.

« Anested element report:

- format : The format of the generated HTML report. Must be noframes or frames. When noframes
format is choosen, a standalone HTML file is generated.

- todir: The output folder of your HTML report.

- The report tagaccepts the nested tag param with name and expression attributes. These tags can
pass XSL parameters to the stylesheet. The built-in stylesheets support the following parameters:

* PRODUCT : the product name that is displayed in the title of the HTML report.
* TITLE :the comment thatis displayed in the title of the HTML report.

Note: Itis advised to set the format to noframes if your test suite is not a Java testsuite. If the format is set to
frames , with a non-Java MicroEJ Testsuite, the name of the links will not be relevant because of the non-existency
of packages.

Listing 9: Example of htmlReport task invocation

<!-- Generate HTML report -->
<testsuite:htmlReport>
<fileset dir="${@{prefix}.testsuite.report.dir}">
<include name="x*/x.xml"/> <!-- include unary reports -->
<exclude name="*x/bin/*x*/%*.xml"/> <!-- exclude test bin files -->
<exclude name="x.xml"/> <!-- exclude global report -->
</fileset>
<report format="noframes” todir="${target.test.html}/@{prefix}"/>
</testsuite:htmlReport>

Using the Trace Analyzer

This section will shortly explains how to use the Trace Analyzer . The MicroEJ Testsuite comes with an archive
containing the Trace Analyzer which can be used to analyze the output trace of an application. It can be used
from different forms;

« The FileTraceAnalyzer will analyze a file and research for the given tags, failing if the success tag is not
found.

« The SerialTraceAnalyzer will analyze the data from a serial connection.
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The TraceAnalyzer Tasks Options

Here is the common options to all TraceAnalyzer tasks:
+ successTag: the regular expression which is synonym of success when found (by default . *PASSED. x ).
« failureTag: the regular expression which is synonym of failure when found (by default . *FAILED.*).
« verboselLevel :int value between 0 and 9 to define the verbose level.
« waitingTimeAfterSuccess : waiting time (in s) after success before closing the stream (by default 5).

« noActivityTimeout : timeout (in s) with no activity on the stream before closing the stream. Set it to 0 to
disable timeout (default value is 0).

« stopEOFReached: boolean value. Setto true to stop analyzing when input stream EOF is reached. If false
, continue until timeout is reached (by default false).

« onlyPrintableCharacters:booleanvalue. Setto true toonly dump ASCII printable characters (by default
false).

The FileTraceAnalyzer Task Options

Here is the specific options of the FileTraceAnalyzer task:

« traceFile: path to the file to analyze.

The SerialTraceAnalyzer Task Options

Here is the specific options of the SerialTraceAnalyzer task:
+ port:the comm port to open.
« baudrate : serial baudrate (by default 9600).
« databits: databits (5]6|7|8) (by default 8).
+ stopBits: stopbits (0[1|3 for (1_5)) (by default 1).

« parity: none | odd | event (bydefault none).

Appendix

The goal of this section is to explain some tips and tricks that might be useful in your usage of the testsuite engine.

Specific Custom Properties

Some custom properties are specifics and retrieved from the testsuite engine in the custom properties file of a test.

« The testsuite.test.name property is the output name of the current test. Here are the steps to compute
the output name of a test:

- If the custom properties are enabled and a property named testsuite.test.name isfind on the cor-
responding file, then the output name of the current test will be set to it.

- Otherwise, if the running MicroEJ Testsuite is a Java testsuite, the output name is set to the class name
of the test.
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- Otherwise, from the path containing all the tests, a common prefix will be retrieved. The output name
will be set to the relative path of the current test from this common prefix. If the common prefix equals
the name of the test, then the output name will be set to the name of the test.

- Finally, if multiples tests have the same output name, then the current name will be followed by _XXX
, an underscore and an integer.

« The testsuite.test.timeout property allow the userto redefine the time out for each test. If it is negative
or not an integer, then global timeout defined for the MicroEJ Testsuite is used.

3.12 Graphical User Interface

This section presents libraries relative to the user interface.

The following schema shows the overall architecture and modules:

Widget Examples Applications
1

ADD-ON LIBRARIES

pe
ARRRRAT Graphics Engine

OO )
LU L
) .

N ¢ Abstraction Layers

S MEJ3)
ARRRRRE! m Drivers I Drivers I Drivers ]

RTOS

HARDWARE
ELECTRONICS

Touch Buttons

Fig. 52: Graphical User Interface Overview

Note: This chapter describes the current Graphical User Interface version 3, provided by Ul Pack version 13.0.0
or higher. If you are using the former Graphical User Interface version 2 (provided by MicroEJ Ul Pack version up
to 12.4.x), please refer to this MicroEJ Documentation Archive.
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3.12.1 MicroUl

Introduction

MicroUl Foundation Library provides access to a pixel-based display and inputs.
The aim of this library is to enable the creation of user interface in Java by reifying hardware capabilities.

To use the MicroUl Foundation Library, add MicroUl APl module to a module description file:

<dependency org="ej.api” name="microui” rev="3.0.0"/>

Drawing Foundation Library extends MicroUI drawing APIs' with more complex ones such as:
« thick line, arc, circle and ellipse
+ polygon
+ image deformation and rotation

To use the Drawing Foundation Library, add Drawing AP| module to a module description file:

<dependency org="ej.api” name="drawing"” rev="1.0.0"/>

Images

Overview

Images are graphical resources that can be accessed with a call to ej.microui.display.lmage.getimage() or
ej.microui.display.Resourcelmage.loadlmage() . To be displayed, these images have to be converted from their
source format to the display raw format. The conversion can either be done at:

« build-time (using the image generator tool),
+ run-time (using the relevant decoder library).

Images that must be processed by the image generator tool are declared in MicroEJ Classpath * . images. list files.
The file format is a standard Java properties file, each line representing a / separated resource path relative to the
MicroEJ classpath root referring to a standard image file (e.g. .png, .jpg). The resource may be followed by an
optional parameter (separated by a : ) which defines and/or describes the image output file format (raw format).
When no option is specified, the image is embedded as-is and will be decoded at run-time (although listing files
without format specifier has no impact on the image generator processing, it is advised to specify them in the *.
images.list files anyway, as it makes the run-time processing behavior explicit). Example:

# The following image is embedded
# as a PNG resource (decoded at run-time)
com/mycompany/MyImagel.png

# The following image is embedded
# as a 16 bits format without transparency (decoded at build-time)
com/mycompany/MyImage2.png:RGB565

# The following image is embedded
# as a 16 bits format with transparency (decoded at build-time)
com/mycompany/MyImage3.png:ARGB1555

1 These APIs were formerly included in MicroUl 2.x
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Configuration File

Here is the format of the *.images.list files.

ConfigFile ::= Line [ 'EOL' Line Jx*

Line ::= ImagePath [ ':' ImageOption J]*
ImagePath ::= Identifier [ '/' Identifier Jx
ImageOption ci= [ ]x

Identifier ::= Letter [ LetterOrDigit 1*
Letter ::= 'a-zA-Z_$'

LetterOrDigit ::= 'a-zA-Z_%$0-9'

Images Heap

The images heap is used to allocate the pixel data of:
« mutable images (i.e. Bufferedimage instances)
+ images which are not byte-addressable, such as images opened with an input stream
« images which are byte-addressable but converted to a different output format
In other words, every image which can not be retrieved using Image.getimage() is saved on the images heap.

The size of the images heap can be configured with the ej.microui.memory.imagesheap.size property.

Output Formats
Without Compression

When no output format is set in the images list file, the image is embedded without any conversion / compression.
This allows you to embed the resource as well, in order to keep the source image characteristics (compression, bpp,
etc.). This option produces the same result as specifiying an image as a resource in the MicroEJ launcher.

Advantages:

+ Preserves the image characteristics;

+ Preserves the original image compression.
Disadvantages:

+ Requires an image runtime decoder;

+ Requires some RAM in which to store the decoded image;

+ Requires execution time to decode the image.

imagel

Standard Output Formats

Depending on the target hardware, several generic output formats are available. Some formats may be directly
managed by the BSP display driver. Refer to the platform specification to retrieve the list of natively supported
formats.

Advantages:
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« The pixels layout and bits format are standard, so it is easy to manipulate these images on the C-side;

« Drawing an image is very fast when the display driver recognizes the format (with or without transparency);

« Supports or not the alpha encoding: select the most suitable format for the image to encode.
Disadvantages:

+ No compression: the image size in bytes is proportional to the number of pixels, the transparency, and the
bits-per-pixel;

« Slower than display format when the display driver does not recognize the format: a pixel conversion is
required at runtime.

Select one the following format to use a generic format among this list: ARGB8888, RGB888, ARGB4444 , ARGB1555
, RGB565, A8, A4, A2, A1, C4, C2, C1, AC44, AC22 and AC11. The following snippets describe the color
conversion for each format:

« ARGB8888: 32 bits format, 8 bits for transparency, 8 per color.

int convertARGB8888toRAWFormat(int c){
return c;

3

« RGB888: 24 bits format, 8 per color. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return c & Oxffffff;

3

« ARGB4444: 16 bits format, 4 bits for transparency, 4 per color.

int convertARGB8888toRAWFormat(int c){
return 0

| ((c & 0xf000E00) >> 16)

| ((c & 0x00f00000) >> 12)

| ((c & 0x0000f000) >> 8)

| ((c & 0x000000f0) >> 4)

3

« ARGBI1555: 16 bits format, 1 bit for transparency, 5 per color.

int convertARGB8888toRAWFormat(int c){
return @
| (((c & Oxff00000R0) == Oxff0O000RR) ? 0x8000 : 0)
| ((c & 0xf80000) >> 9)
| ((c & 0x00f800) >> 6)
| ((c & 0x0000f8) >> 3)

’

« RGB565: 16 bits format, 5 or 6 per color. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return @
| ((c & 0xf80000) >> 8)
| ((c & 0x00fco0) >> 5)
| ((c & 0x0000f8) >> 3)

)
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A8: 8 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return oxff - (toGrayscale(c) & 0xff);
}

A4: 4 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return (Oxff - (toGrayscale(c) & oxff)) / ox11;
}

A2: 2 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return (Oxff - (toGrayscale(c) & 0Oxff)) / 0x55;
}

Al: 1 bit format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return (Oxff - (toGrayscale(c) & 0xff)) / oxff;
3

C4: 4 bits format with grayscale conversion. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return (toGrayscale(c) & 0Oxff) / 0x11;

3

C2: 2 bits format with grayscale conversion. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return (toGrayscale(c) & 0xff) / 0x55;
3

C1: 1 bit format with grayscale conversion. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return (toGrayscale(c) & 0xff) / oOxff;
}

AC44: 4 bits for transparency, 4 bits with grayscale conversion.

int convertARGB8888toRAWFormat(int c){
return @
| ((color >> 24) & 0xf0)
| ((toGrayscale(color) & oxff) / ox11)

’

3

AC22: 2 bits for transparency, 2 bits with grayscale conversion.
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int convertARGB8888toRAWFormat(int c){
return 0
| ((color >> 28) & 0xc0)
| ((toGrayscale(color) & 0xff) / 0x55)

’

3

« ACT1: 1 bit for transparency, 1 bit with grayscale conversion.

int convertARGB8888toRAWFormat(int c){
return 0
| ((c & 0xff000000) == 0xff000000 ? 0x2 : 0x0)
| ((toGrayscale(color) & 0Oxff) / @Oxff)

’

}

Examples:

image1:ARGB8888
image2:RGB565
image3:A4

Display Output Format

This format encodes the image into the exact display memory representation. If the image to encode contains
some transparent pixels, the output file will embed the transparency according to the display’s implementation
capacity. When all pixels are fully opaque, no extra information will be stored in the output file in order to free up
some memory space.

Note: When the display memory representation is standard, the display output format is automatically replaced
by a standard format.

Advantages:
+ Drawing an image is very fast because no pixel conversion is required at runtime;
« Supports alpha encoding when display pixel format allow it.

Disadvantages:

« No compression: the image size in bytes is proportional to the number of pixels.

imagel:display

RLE1 Output Format

Theimage engine can display embedded images that are encoded into a compressed format which encodes several
consecutive pixels into one or more 16-bit words. This encoding manages a maximum alpha level of 2 (alpha level
is always assumed to be 2, even if the image is not transparent).

« Several consecutive pixels have the same color (2 words):

- First 16-bit word specifies how many consecutive pixels have the same color (pixels colors converted in
RGB565 format, without opacity data).
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- Second 16-bit word is the pixels’ color in RGB565 format.

« Several consecutive pixels have their own color (1 +n words):

- First 16-bit word specifies how many consecutive pixels have their own color;

- Next 16-bit word is the next pixel color.

« Several consecutive pixels are transparent (1 word):

- 16-bit word specifies how many consecutive pixels are transparent.

Advantages:

« Supports fully opaque and fully transparent encoding.

« Good compression when several consecutive pixels respect one of the three previous rules.

Disadvantages:

+ Drawing an image is slightly slower than when using Display format.

+ Notdesigned forimages with many different pixel colors: in such case, the output file size may be larger than
the original image file.

imagel:RLE1

Image Generator Error Messages

These errors can occur while preprocessing images.

Table 14: Static Image Generator Error Messages

ID | Type Description

0 | Error The image generator has encountered an unexpected internal error.

1 Error The images list file has not been specified.

2 | Error The image generator cannot create the final, raw file.

3 | Error The image generator cannot read the images list file. Make sure the system allows reading of
this file.

4 | Warning The image generator has found no image to generate.

5 | Error The image generator cannot load the images list file.

6 | Warning The specified image path is invalid: The image will be not converted.

7 | Warning There are too many or too few options for the desired format.

8 | Error The display format is not generic; a MicroUIRawlmageGeneratorExtension implementation is
required to generate the MicroUl raw image.

9 | Error The image cannot be read.

10 | Error The image generator has encountered an unexpected internal error (invalid endianness).

11 | Error The image generator has encountered an unexpected internal error (invalid bpp).

12 | Error The image generator has encountered an unexpected internal error (invalid display format).

13 | Error The image generator has encountered an unexpected internal error (invalid pixel layout).

14 | Error The image generator has encountered an unexpected internal error (invalid output folder).

15 | Error The image generator has encountered an unexpected internal error (invalid memory
alignment).

16 | Warning The specified format is not managed by the image generator: The image will be not converted.

17 | Warning The image has been already loaded with another output format. The image will be not
converted.
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Fonts

Overview

Fonts are graphical resources that can be accessed with a call to ej.microui.display.Font.getFont(). To be displayed,
these fonts have to be converted at build-time from their source format to the display raw format by the font gener-
ator tool. Fonts that must be processed by the font generator tool are declared in MicroEJ Classpath *. fonts.list
files. The file format is a standard Java properties file, each line representing a / separated resource path relative
to the MicroEJ classpath root referring to a MicroEJ font file (usually witha .ejf file extension). The resource may
be followed by optional parameters which define :

« some ranges of characters to embed in the final raw file;
« the required pixel depth for transparency.

By default, all characters available in the input font file are embedded, and the pixel depthis 1 (i.e 1 bit-per-pixel).
Example:

# The following font is embedded with all characters
# without transparency
com/mycompany/MyFont1.ejf

# The following font is embedded with only the latin
# unicode range without transparency
com/mycompany/MyFont2.ejf:latin

# The following font is embedded with all characters

# with 2 levels of transparency
com/mycompany/MyFont2.ejf::2

MicroEJ font files conventionally end with the .ejf suffix and are created using the Font Designer (see Font De-
signer).

Configuration File

Here is the format of the *.fonts.list files.

ConfigFile ::= Line [ 'EOL' Line Jx*

Line ::= FontPath [ ':' [ Ranges 1 [ ':' BitsPerPixel ] ]
FontPath ::= Identifier [ '/' Identifier 1%
Ranges ::= Range [ ';' Range J*

Range ::= CustomRangelList | KnownRange
CustomRangelist ::= CustomRange [ ',' CustomRange Jx
CustomRange ::= Number | Number '-' Number
KnownRange ::= Name [ SubRangelList ]1?
SubRangelList ::= "(' SubRange [ ',' SubRange Jx ')'
SubRange ::= Number | Number - Number
Identifier c:= 'a-zA-Z_$' [ 'a-zA-Z_$0-9' J*
Number ::= Number16 | Number10@

Number16 ::= 'ox' [ Digit16 1+

Number10@ ::= [ Digitio J+

Digitl16 ::= 'a-fA-Fo-9'

Digit10 1:= '0-9'

BitsPerPixel ci= "1 "2t ] 4t | '8!
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Font Range

The first parameter is for specifying the font ranges to embed. Selecting only a specific set of characters to embed
reduces the memory footprint. If unspecified, all characters of the font are embedded.

Several ranges can be specified, separated by ; . There are two ways to specify a character range: the custom range

and the known range.

Custom Range

Allows the selection of raw Unicode character ranges.

Examples:

« myfont:0x21-0x49 : Defines one range: embed all characters from 0x21 to 0x49 (included);

« myfont:0x21-0x49,0x55-0x75 : Defines a set of two ranges: embed all characters from 0x21 to 0x49 and

from 0x55 to 0x75.

« myfont:0x21-0x49,0x55 : Defines a set of one range and one character: embed all characters from 0x21 to

0x49 and character 0x55.

Known Range

A known range is a range available in the following table.

Examples:

« myfont:basic_latin:Embed all Basic Latin characters;

« myfont:basic_latin;arabic:Embed all Basic Latin characters, and all Arabic characters.

The following table describes the available list of ranges and sub-ranges (processed from the “Unicode Character
Database” version 9.0.0 available on the official unicode website https://www.unicode.org).

Table 15: Ranges

Name Tag Start End

Basic Latin basic_latin 0x0 ox7f

Latin-1 Supplement latin-1_supplement 0x80 Oxff

Latin Extended-A latin_extended-a 0x100 ox17f
Latin Extended-B latin_extended-b 0x180 0x24f
IPA Extensions ipa_extensions 0x250 ox2af
Spacing Modifier Letters spacing_modifier_letters 0x2b0 | Ox2ff
Combining Diacritical Marks combining_diacritical_marks 0x300 | Ox36f
Greek and Coptic greek_and_coptic 0x370 | Ox3ff
Cyrillic cyrillic 0x400 | Ox4ff
Cyrillic Supplement cyrillic_supplement 0x500 | 0x52f
Armenian armenian 0x530 | 0x58f
Hebrew hebrew 0x590 | Ox5ff
Arabic arabic 0x600 | Oxo6ff
Syriac syriac 0x700 | Oxv4f
Arabic Supplement arabic_supplement 0x750 | Ox77f
Thaana thaana 0x780 | Ox7bf
NKo nko 0x7cO | Ox7ff

Continued on next page
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Table 15 - continued from previous page

Name Tag Start End
Samaritan samaritan 0x800 | 0x83f
Mandaic mandaic 0x840 | 0x85f
Arabic Extended-A arabic_extended-a 0x8a0 | Ox8ff
Devanagari devanagari 0x900 | 0x97f
Bengali bengali 0x980 | Ox9ff
Gurmukhi gurmukhi 0xa00 | OxaT7f
Gujarati gujarati 0xa80 | Oxaff
Oriya oriya 0xb00 | Oxb7f
Tamil tamil 0xb80 | Oxbff
Telugu telugu 0xc00 | Oxc7f
Kannada kannada 0xc80 | Oxcff
Malayalam malayalam 0xd00 | Oxd7f
Sinhala sinhala 0xd80 | Oxdff
Thai thai 0xe00 | OxeTf
Lao lao 0xe80 | Oxeff
Tibetan tibetan 0xf00 Oxfff
Myanmar myanmar 0x1000 | 0x109f
Georgian georgian 0x10a0 | Ox10ff
Hangul Jamo hangul_jamo 0x1100 | ox11ff
Ethiopic ethiopic 0x1200 | 0x137f
Ethiopic Supplement ethiopic_supplement 0x1380 | 0x139f
Cherokee cherokee 0x13a0 | Ox13ff
Unified Canadian Aboriginal Syllabics | unified_canadian_aboriginal_syllabics 0x1400 | Ox167f
Ogham ogham 0x1680 | 0x169f
Runic runic 0x16a0 | Ox16ff
Tagalog tagalog 0x1700 | ox171f
Hanunoo hanunoo 0x1720 | 0x173f
Buhid buhid 0x1740 | 0x175f
Tagbanwa tagbanwa 0x1760 | Ox177f
Khmer khmer 0x1780 | Ox17ff
Mongolian mongolian 0x1800 | Ox18af
Unified Canadian Aboriginal Syllabics | unified_canadian_aboriginal_syllabics_extended| 0x18b0 | 0x18ff
Extended

Limbu limbu 0x1900 | 0x194f
Tai Le tai_le 0x1950 | Ox197f
New Tai Lue new_tai_lue 0x1980 | Ox19df
Khmer Symbols khmer_symbols 0x19e0 | 0x19ff
Buginese buginese 0x1a00 | Oxlalf
Tai Tham tai_tham 0x1a20 | Oxlaaf
Combining Diacritical Marks Extended | combining_diacritical_marks_extended Ox1ab0 | Oxlaff
Balinese balinese 0x1b00 | Ox1b7f
Sundanese sundanese 0x1b80 | Ox1bbf
Batak batak 0x1bcO | Ox1bff
Lepcha lepcha 0x1c00 | Ox1c4f
Ol Chiki ol_chiki 0x1c50 | Ox1c7f
Cyrillic Extended-C cyrillic_extended-c 0x1c80 | Ox1c8f
Sundanese Supplement sundanese_supplement 0x1ccO | Oxlccf
Vedic Extensions vedic_extensions 0x1cd0 | Oxlcff
Phonetic Extensions phonetic_extensions 0x1d00 | ox1d7f

Continued on next page
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Table 15 - continued from previous page

Name Tag Start End
Phonetic Extensions Supplement phonetic_extensions_supplement 0x1d80 | 0x1dbf
Combining Diacritical Marks Supple- | combining_diacritical_marks_supplement 0x1dcO | oxidff
ment

Latin Extended Additional latin_extended_additional 0x1e00 | Oxleff
Greek Extended greek_extended 0x1f00 | Oxifff
General Punctuation general_punctuation 0x2000 | Ox206f
Superscripts and Subscripts superscripts_and_subscripts 0x2070 | 0x209f
Currency Symbols currency_symbols 0x20a0 | 0x20cf
Combining Diacritical Marks for Sym- | combining_diacritical_marks_for_symbols 0x20d0 | Ox20ff
bols

Letterlike Symbols letterlike_symbols 0x2100 | 0x214f
Number Forms number_forms 0x2150 | Ox218f
Arrows arrows 0x2190 | Ox21ff
Mathematical Operators mathematical_operators 0x2200 | Ox22ff
Miscellaneous Technical miscellaneous_technical 0x2300 | 0x23ff
Control Pictures control_pictures 0x2400 | 0x243f
Optical Character Recognition optical_character_recognition 0x2440 | 0x245f
Enclosed Alphanumerics enclosed_alphanumerics 0x2460 | 0x24ff
Box Drawing box_drawing 0x2500 | 0x257f
Block Elements block_elements 0x2580 | 0x259f
Geometric Shapes geometric_shapes 0x25a0 | 0x25ff
Miscellaneous Symbols miscellaneous_symbols 0x2600 | 0x26ff
Dingbats dingbats 0x2700 | 0x27bf
Miscellaneous Mathematical | miscellaneous_mathematical_symbols-a 0x27c0 | Ox27ef
Symbols-A

Supplemental Arrows-A supplemental_arrows-a 0x27f0 | ox27ff
Braille Patterns braille_patterns 0x2800 | 0x28ff
Supplemental Arrows-B supplemental_arrows-b 0x2900 | 0x297f
Miscellaneous Mathematical | miscellaneous_mathematical_symbols-b 0x2980 | 0x29ff
Symbols-B

Supplemental Mathematical Opera- | supplemental_mathematical_operators 0x2a00 | Ox2aff
tors

Miscellaneous Symbols and Arrows miscellaneous_symbols_and_arrows 0x2b00 | Ox2bff
Glagolitic glagolitic 0x2c00 | 0x2c5f
Latin Extended-C latin_extended-c 0x2c60 | Ox2cTf
Coptic coptic 0x2c80 | Ox2cff
Georgian Supplement georgian_supplement 0x2d00 | 0x2d2f
Tifinagh tifinagh 0x2d30 | 0x2d7f
Ethiopic Extended ethiopic_extended 0x2d80 | 0x2ddf
Cyrillic Extended-A cyrillic_extended-a 0x2de0 | Ox2dff
Supplemental Punctuation supplemental_punctuation 0x2e00 | Ox2e7f
CJK Radicals Supplement cjk_radicals_supplement 0x2e80 | Ox2eff
Kangxi Radicals kangxi_radicals 0x2f00 | Ox2fdf
Ideographic Description Characters ideographic_description_characters 0x2ff0 | Ox2fff
CJK Symbols and Punctuation cjk_symbols_and_punctuation 0x3000 | 0x303f
Hiragana hiragana 0x3040 | 0x309f
Katakana katakana 0x30a0 | 0x30ff
Bopomofo bopomofo 0x3100 | Ox312f
Hangul Compatibility Jamo hangul_compatibility_jamo 0x3130 | 0x318f

Continued on next page
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Table 15 - continued from previous page

Name Tag Start End
Kanbun kanbun 0x3190 | 0x319f
Bopomofo Extended bopomofo_extended 0x31a0 | 0x31bf
CJK Strokes cjk_strokes 0x31c0 | Ox31ef
Katakana Phonetic Extensions katakana_phonetic_extensions 0x31f0 | Ox31ff
Enclosed CJK Letters and Months enclosed_cjk_letters_and_months 0x3200 | Ox32ff
CJK Compatibility cjk_compatibility 0x3300 | 0x33ff
CJK Unified Ideographs Extension A cjk_unified_ideographs_extension_a 0x3400 | Ox4dbf
Yijing Hexagram Symbols yijing_hexagram_symbols 0x4dcO | 0x4dff
CJK Unified Ideographs cjk_unified_ideographs 0x4e00 | 0xofff
Yi Syllables yi_syllables 0xa000 | Oxa48f
Yi Radicals yi_radicals 0xa490 | Oxa4cf
Lisu lisu 0xa4d0 | Oxa4ff
Vai vai 0xa500 | Oxa63f
Cyrillic Extended-B cyrillic_extended-b 0xa640 | 0xa69f
Bamum bamum Oxa6al | Oxa6ff
Modifier Tone Letters modifier_tone_letters 0xa700 | OxaT7if
Latin Extended-D latin_extended-d 0xa720 | OxaTff
Syloti Nagri syloti_nagri 0xa800 | 0xa82f
Common Indic Number Forms common_indic_number_forms 0xa830 | Oxa83f
Phags-pa phags-pa 0xa840 | 0xa87f
Saurashtra saurashtra 0xa880 | Oxa8df
Devanagari Extended devanagari_extended 0xa8e0 | Oxa8ff
Kayah Li kayah_li 0xa900 | Oxa92f
Rejang rejang 0xa930 | 0xa95f
Hangul Jamo Extended-A hangul_jamo_extended-a 0xa960 | 0xa97f
Javanese javanese 0xa980 | 0xa9df
Myanmar Extended-B myanmar_extended-b 0xa9e0 | Oxaoff
Cham cham 0xaa00 | Oxaa5f
Myanmar Extended-A myanmar_extended-a Oxaa60 | OxaaT7f
Tai Viet tai_viet O0xaa80 | Oxaadf
Meetei Mayek Extensions meetei_mayek_extensions Oxaae0 | Oxaaff
Ethiopic Extended-A ethiopic_extended-a 0xab00 | Oxab2f
Latin Extended-E latin_extended-e 0xab30 | Oxabé6f
Cherokee Supplement cherokee_supplement 0xab70 | Oxabbf
Meetei Mayek meetei_mayek OxabcO | Oxabff
Hangul Syllables hangul_syllables Oxac00 | Oxd7af
Hangul Jamo Extended-B hangul_jamo_extended-b 0xd7b0 | Oxd7ff
High Surrogates high_surrogates 0xd800 | 0xdb7f
High Private Use Surrogates high_private_use_surrogates 0xdb80 | Oxdbff
Low Surrogates low_surrogates 0xdc00 | Oxdfff
Private Use Area private_use_area 0xe000 | Oxf8ff
CJK Compatibility Ideographs cjk_compatibility_ideographs 0xf900 | Oxfaff
Alphabetic Presentation Forms alphabetic_presentation_forms 0xfb00 | Oxfb4f
Arabic Presentation Forms-A arabic_presentation_forms-a 0xfb50 | Oxfdff
Variation Selectors variation_selectors 0xfe00 | OxfeOf
Vertical Forms vertical_forms Oxfel0 | Oxfelf
Combining Half Marks combining_half_marks 0xfe20 | Oxfe2f
CJK Compeatibility Forms cjk_compatibility_forms 0xfe30 | Oxfe4f
Small Form Variants small_form_variants 0xfe50 | Oxfe6f

Continued on next page
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Table 15 - continued from previous page

Name Tag Start End

Arabic Presentation Forms-B arabic_presentation_forms-b Oxfe70 | Oxfeff

Halfwidth and Fullwidth Forms halfwidth_and_fullwidth_forms 0xffo0 | Oxffef

Specials specials Oxfff0 | Oxffff
Transparency

The second parameter is for specifying the font transparency level (1, 2, 4 or 8). If unspecified, the encoded
transparency levelis 1 (does not depend on transparency level encoded in EJF file).

Examples:

« myfont:latin:4:Embed all latin characters with 16 levels of transparency

« myfont::2:Embed all characters with 4 levels of transparency

Font Generator Error Messages

Table 16: Static Font Generator Error Messages

ID | Type Description

0 | Error The font generator has encountered an unexpected internal error.

1 Error The Fonts list file has not been specified.

2 Error The font generator cannot create the final, raw file.

3 Error The font generator cannot read the fonts list file.

4 | Warning The font generator has found no font to generate.

5 Error The font generator cannot load the fonts list file.

6 | Warning The specified font path is invalid: The font will be not converted.

7 Warning There are too many arguments on a line: The current entry is ignored.

8 Error The font generator has encountered an unexpected internal error (invalid output format).

9 Error The font generator has encountered an unexpected internal error (invalid endianness).

10 | Warning The specified entry is invalid: The current entry is ignored.

11 | Warning The specified entry does not contain a list of characters: The current entry is ignored.

12 | Warning The specified entry does not contain a list of identifiers: The current entry is ignored.

13 | Warning The specified entry is an invalid width: The current entry is ignored.

14 | Warning The specified entry is an invalid height: the current entry is ignored.

15 | Warning The specified entry does not contain the characters’ addresses: The current entry is ignored.

16 | Warning The specified entry does not contain the characters’ bitmaps: The current entry is ignored.

17 | Warning The specified entry bits-per-pixel value is invalid: The current entry is ignored.

18 | Warning The specified range is invalid: The current entry is ignored.

19 | Error There are too many identifiers. The output RAW format cannot store all identifiers.

20 | Error The font’s name is too long. The output RAW format cannot store all name characters.

21 | Error There are too many ranges. The output RAW format cannot store all ranges.

22 | Error Output list files cannot be created.

23 | Warning Dynamic styles are not supported. Only a PLAIN font can be encoded. The current entry is
ignored.

24 | Warning Underlined style is not supported. Only a BOLD and ITALIC font can be set. The current entry
isignored.

Font Designer
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Principle

The Font Designer module is a graphical tool (Eclipse plugin) that runs within the MicroEJ IDE used to build and
edit MicroUl fonts. It stores fonts in a platform-independent format.

Functional Description

font
* o

Font font
Designer .

jf [H .ejf

font

*

font
-pnglr

Fig. 53: Font Generation

Font Management
Create a MicroEJ Font

To create a MicroEJ font, follow the steps below:
1. Open the Eclipse wizard: File > New > Other... > MicroEJ > MicroEJ Font .
2. Select a directory and a name.
3. Click Finish.

Once the font is created, a new editor is opened: the MicroEJ Font Designer.

Edit a MicroEJ Font

You can edit your font with the MicroEJ Font Designer (by double-clickingona *.ejf file or after running the new
MicroEJ Font wizard).

This editor is divided into three main parts:
+ The top left part manages the main font properties.
« The top right part manages the character to embed in your font.

« The bottom part allows you to edit a set of characters or an individual character.
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Main Properties

The main font properties are:
« fontsize: height and width (in pixels).
« baseline (in pixels).
« space character size (in pixels).
« styles and filters.
« identifiers.

Refer to the following sections for more information about these properties.

Font Height

A font has a fixed height. This height includes the white pixels at the top and at the bottom of each character
simulating line spacing in paragraphs.

N height
[ ]

Fig. 54: Font Height

Font Width: Proportional and Monospace Fonts

A monospace font is a font in which all characters have the same width. For example a ‘!’ representation will be
the same width as a ‘w’ (they will be in the same size rectangle of pixels). In a proportional font, a ‘w’ will be wider
thana ‘"

A monospace font usually offers a smaller memory footprint than a proportional font because the Font Designer
does not need to store the size of each character. As a result, this option can be useful if the difference between the
size of the smallest character and the biggest one is small.

Baseline

Characters have a baseline: an imaginary line on top of which the characters seem to stand. Note that characters
can be partly under the line, for example, ‘g’ or ‘}.

[ [1] L[] L] L] (1] 1 (1]
| | - = - [} [} [} - = | ] 1] L -
| . amE n = _IN [LL1] N um N (wEE . ..
L L] LL L] | - L LIl - | L1l - - L L]
| . L ] [ ] | L1l . = N EEEE (111} .
] L L L L] [ | u N | [ | u
=== aE = = e e

Fig. 55: The Baseline

3.12. Graphical User Interface 161



MicroEJ Documentation, Revision bd708584

Space Character

The Space character (0x20) is a specific character because it has no filled pixels. From the Main Properties Menu
you can fix the space character size in pixels.

Note: When the font is monospace, the space size is equal to the font width.

Styles

Font Designer allows to create a font file which holds several combinations of built-in styles (styles hardcoded in
pixels map) and runtime styles (styles rendered dynamically at runtime). However, since MicroUl 3, a MicroUI font
holds only one style: PLAIN, BOLD, ITALIC or BOLD + ITALIC.Byconsequence,the styles option must be left to
the default option.

Font Designer features three drop-downs, one for each of BOLD, ITALIC and UNDERLINED.Each drop-down has
three options: None, Built-in and Dynamic. Use only None option. Otherwise an error at MicroEJ application
compiletime will occur (incompatible font file).

Identifiers

A number of identifiers can be attached to a MicroUl font. At least one identifier is required to specify the font.
Identifiers are a mechanism for specifying the contents of the font - the set or sets of characters it contains. The
identifier may be a standard identifier (for example, LATIN) or a user-defined identifier. Identifiers are numbers,
but standard identifiers, which are in the range 0 to 80, are typically associated with a handy name. A user-defined
identifier is an identifier with a value of 81 or higher.

Character List

The list of characters can be populated through the import button, which allows you to import characters from
system fonts, images or another MicroEJ font.

Import from System Font

This page allows you to select the system font to use (left part) and the range of characters. There are predefined
ranges of characters below the font selection, as well as a custom selection picker (for example 0x21 to Oxfe for
Latin characters).

The right part displays the selected characters with the selected font. If the background color of a displayed char-
acter is red, it means that the character is too large for the defined height, or in the case of a monospace font, it
means the character is too high or too wide. You can then adjust the font properties (font size and style) to ensure
that characters will not be truncated.

When your selection is done, click the Finish button to import this selection into your font.

Import from Images

This page allows the loading of images from a directory. The images must be named as follows: 0x[UTF-8].
[extension].
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When your selection is done, click the Finish button to import the images into your font.

Character Editor

When a single character is selected in the list, the character editor is opened.

Preview Character Pixmap (11 * 20)
& ]
.
N EE
N EE
Character Properties H-a
mE EeEm
Index: (2B ] 1]
"= mmmm
Left space: ] =
Right space: ] =

Pixel Properties
Bits per pixel for preview and editing
1 2 4 @ 3

Current alpha

Alpha to use for input

100% ]

Fig. 56: Character Editor

You can define specific properties, such as left and right space, or index. You can also draw the character pixel by
pixel - a left-click in the grid draws the pixel, a right-click erases it.

The changes are not saved until you click the Apply button. When changes are applied to a character, the editor
shows that the font has changed, so you can now save it.

The same part of the editor is also used to edit a set of characters selected in the top right list. You can then edit
the common editable properties (left and right space) for all those characters at the same time.

Working With Anti-Aliased Fonts

By default, when characters are imported from a system font, each pixel is either fully opaque or fully transparent.
Fully opaque pixels show as black squares in the character grid in the right-hand part of the character editor; fully
transparent pixels show as white squares.
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However, the pixels stored inan ejf file can take one of 256 grayscale values. A fully-transparent pixel has the value
255 (the RGB value for white), and a fully-opaque pixel has the value 0 (the RGB value for black). These grayscale
values are shown in parentheses at the end of the text in the Current alpha field when the mouse cursor hovers over
a pixel in the grid. That field also shows the transparency level of the pixel, as a percentage, where 100% means
fully opaque.

It is possible to achieve better-looking characters by using a combination of fully-opaque and partially-transparent
pixels. Thistechniqueis called anti-aliasing. Anti-aliased characters can be imported from system fonts by checking
the anti aliasing box in the import dialog. The ‘&’ character shown in the screenshot above was imported using anti
aliasing, and you can see the various gray levels of the pixels.

When the Font Generator converts an ejf file into the raw format used at runtime, it can create fonts with char-
acters that have 1, 2, 4 or 8 bits-per-pixel (bpp). If the raw font has 8 bpp, then no conversion is necessary and the
characters will render with the same quality as seen in the character editor. However, if the raw font has less than
8 bpp (the default is 1 bpp) any gray pixels in the input file are compressed to fit, and the final rendering will be of
lower quality (but less memory will be required to hold the font).

Itis usefulto be able to see the effects of this compression, so the character editor provides radio buttons that allow
the user to preview the character at 1, 2, 4, or 8 bpp. Furthermore, when 2, 4 or 8 bpp is selected, a slider allows the
user to select the transparency level of the pixels drawn when the left mouse button is clicked in the grid.

Previewing a Font

You can preview your font by pressing the Preview... button, which opens the Preview wizard. In the Preview
wizard, press the Select File button, and select a text file which contains text that you want to see rendered using
your font. Characters that are in the selected text file but not available in the font will be shown as red rectangles.
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Fig. 57: Font Preview
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Removing Unused Characters

In order to reduce the size of a font file, you can reduce the number of characters in your font to be only those char-
acters used by your application. To do this, create a file which contains all the characters used by your application
(for example, concatenating all your NLS files is a good starting point). Then open the Preview wizard as described
above, selecting that file. If you select the check box Delete unused on finish, then those characters that are in the
font but not in the text file will be deleted from the font when you press the Finish button, leaving your font contain-
ing the minimum number of characters. As this font will contain only characters used by a specific application, it is
best to prepare a “complete” font, and then apply this technique to a copy of that font to produce an application
specific cut-down version of the font.

Use a MicroEJ Font

A MicroEJ Font must be converted to a format which is specific to the targeted platform. The Font Generator tool
performs this operation for all fonts specified in the list of fonts configured in the application launch.

Dependencies

No dependency.

Installation

The Font Designer module is already installed in the MicroEJ environment.

Use

Create anew ejf fontfile or open an existing one in order to open the Font Designer plugin.

Application Options

MicroUl libraries and its tools provide a set of options. See Application Options to have more information about the
application options.
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Category: Libraries

w Libraries
w Micrell
Font
Image

Category: MicroUl

w Libraries Memary
v Microll
Font Pump events (inputs and display) queue size (in number of events): | 100 ‘
Image

Pump events thread priority: |3

Images heap size (in bytes): | 131072

Group: Memory
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Option(text): Pump events (inputs and display) queue size (in number of events)

Option Name: ej.microui.memory.queue.size
Default value: 100
Description:

Specifies the size of the pump events queue.

Option(combo): Pump events thread priority

Option Name: com.microej.library.microui.pump.priority
Default value: 5

Available values: 1 to 10

Description:

Specifies the priority of the pump events queue.

Option(text): Images heap size (in bytes)

Option Name: ej.microui.memory.imagesheap.size
Default value: 131072
Description:

Specifies the size of the images heap. This heap is used to store the dynamic user images, the decoded images
and the working buffers of embedded image decoders (for instance the PNG decoder). A too small value can cause
OutOfMemory errors and incomplete drawings.
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Category: Font

v Libraries Fonts to Process
~ Micrell X i i i X
Font List the fonts for the font pre-processing tool. This tool will convert them into
an internal memory format at build time,
Image

Activate the font pre-processing step

Fonts list file which will be linked (after pre-processing step) into the CPU
address space range (internal device memories, external parallel memories).

[[] Define an explicit list file

m
a
e

Group: Fonts to Process

Description:

This group allows to select a file describing the font files which need to be converted into a RAW format. At Mi-
croUl runtime, the pre-generated fonts will be read from the flash memory without any modifications (see MicroUl
specification).

Option(checkbox): Activate the font pre-processing step

Option Name: ej.microui.fontConverter.uselt
Default value: true
Description:

When checked, enables the next option Fonts 1list file. When the next option is disabled, there is no check on
the file path validity.

Option(checkbox): Define an explicit list file

Option Name: ej.microui.fontConverter.file.enabled
Default value: false
Description:

By default, list files are loaded from the classpath. When checked, only the next option Fonts list fileis processed.
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Option(browse):

Option Name: ej.microui.fontConverter.file
Default value: (empty)
Description:

Browse to select a font list file. Refer to Font Generator chapter for more information about the font list file format.

Category: Image

v Libraries Images to Process
~ Micrall X X X i i i X
Font List the images for the image pre-processing tool. This tool will convert them into
| the display memory format (BPP, layout) at build time.
mage

Activate the image pre-processing step

Images list file which will be linked (after pre-processing step) into the CPU
address space range (internal device memories, external parallel memories).

[] Define an explicit list file

m
a
e

Group: Images to Process

Description:

This group allows to select a file describing the image files which need to be converted into a RAW format. At
MicroUl runtime, the pre-generated images will be read from the flash memory without any modifications (see
MicroUl specification).

Option(checkbox): Activate the image pre-processing step

Option Name: ej.microui.imageConverter.uselt
Default value: true
Description:

When checked, enables the next option Images list file. When the next option is disabled, there is no check on
the file path validity.
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Option(checkbox): Define an explicit list file

Option Name: ej.microui.imageConverter.file.enabled
Default value: false
Description:

By default, list files are loaded from the classpath. When checked, only the next option Images list fileis pro-
cessed.

Option(browse):

Option Name: ej.microui.imageConverter.file
Default value: (empty)
Description:

Browse to select an image list file. Refer to Image Generator chapter for more information about the image list file
format.

Debug Traces
MicroUl logs several actions when traces are enabled. This chapter explains the traces identifiers. Some events
data are described in next tables.
[TRACE: MicroUI] Event AA(BBLCC],DDLEE])
where:
« AAis the event identifier. See next table.
+ BBis the first event data.
« CCisthefirst event data number (0x0).
+ DD is the second event data.
« EE isthe second event data number (0x1).

« etc.
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Table 17: MicroUl Traces

Event | Description End of event
ID
0x0 Execute EventGenerator event %0% (see Event Type). Generatoridis | End of %0% (see Event Type).
(0) %1% and datais %2%.
0x1(1) | Drop event %0%.
0x2 (2) | Execute native inputevent %0% (see Event Type). Generatoridis %1% | End of %0% (see Event Type).
and datais %2%.
0x3 (3) | Execute display event %0% (see Event Type). Eventis %1%. End of %0% (see Event Type).
0x4 (4) | Execute user event %0%. End of %0%.
0x5 (5) | Create new image using %0% algorithm (see Create Image). Image created, image identi-
fieris %0%.
0x6 (6) | New image characteristics %0% (see Image Type), identifier is %1%
and memory size is %2% .
Oxa Flush back buffer; position ( %0%, %1% ) size ( %2% * %3%).
(10)
Oxb Flush done.
(1)
0xc Start internal drawing operation %0% (see Drawing Type). End of drawing %0% (see
(12) Drawing Type)
0xd Start drawing operation %0% (see Drawing Type). End of drawing %0% (see
(13) Drawing Type)
Oxe Unknown event.
(14)
oxf Asynchronous drawing operation done.
(15)
0x14 Invalid input event %0%.
(20)
0x15 Event queue is full, cannot add event %0%.
(21)
0x16 Add event %0% atindex %1% ; queue length is %2%.
(22)
0x17 Replace event %0% by %1% atindex %2%; queue length is %3%.
(23)
0x18 Read event %0% atindex %1%.
(24)
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Table 18: Event Type

Event ID | Description
0x0 (0) Event “Command”
0x1 (1) Event “Button”
0x2 (2) Event “Pointer”
0x3 (3) Event “State”
0x4 (4) Event “Unknwon”
0x5 (5) Event “Call Serially”
0x6 (6) Event “MicroUl Stop”
0x7 (7) Event “Input”
0x8 (8) Event “Show Displayable”
0x9 (9) Event “Hide Displayable”
Oxb (11) Event “Pending Flush”
Oxc (12) | Event “Force Flush”
0xd (13) | Event “Repaint Displayable”
Oxe (14) | Event “Repaint Current Displayable”
0xf (15) Event “KF Stop Feature”
Table 19: Create Image
Event ID | Description
0x0 (0) Create Bufferedlmage
0x1(1) Create Image from path
0x2 (2) Create Image from InputStream
Table 20: Image Type
EventID | Description
0x0 (0) New Bufferedimage
0x1 (1) Load MicroEJ Image from RAW file
0x2 (2) New MicroEJ Image from encoded image
0x3 (3) New MicroEJ Image from RAW image in external memory
0x4 (4) New MicroEJ Image from encoded image in external memory
0x5 (5) New MicroEJ Image from memory InputStream
0x6 (6) New MicroEJ Image from byte array InputStream
Ox7 (7) New MicroEJ Image from generic InputStream
0x8 (8) Link Image

Table 21: Drawing Type

Event ID Description

0x1 (1) Write pixel

0x2 (2) Draw line

0x3 (3) Draw horizontal line
0x4 (4) Draw vertical line

0x5 (5) Draw rectangle

0x6 (6) Fill rectangle

0x7 (7) Unknown

0x8 (8) Draw rounded rectangle
0x9 (9) Fill rounded rectangle

Continued on next page
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Table 21 - continued from previous page

EventID Description

Oxa (10) Draw circle arc

Oxb (11) Fill circle arc

0xc (12) Draw ellipse arc

0xd (13) Fill ellipse arc

Oxe (14) Draw ellipse

0xf (15) Fill ellipse

0x10 (16) Draw circle

0x11 (17) Fill circle

0x12 (18) Draw ARGB array

0x13 (19) Draw image

0x32 (50) Draw polygon

0x33 (51) Fill polygon

0x34 (52) Get ARGB image data

0x35 (53) Draw string

0x36 (54) Draw deformed string

0x37 (55) Draw deformed image

0x38 (56) Draw character with rotation (bilinear)
0x39 (57) Draw character with rotation (simple)
0x3a (58) Get string width

0x3b (59) Get pixel

0x64 (100) | Draw thick faded point

0x65 (101) | Draw thick faded line

0x66 (102) | Draw thick faded circle

0x67 (103) | Draw thick faded circle arc

0x68 (104) | Draw thick faded ellipse

0x69 (105) | Draw thick line

0x6a (106) | Draw thick circle

0x6b (107) | Draw thick ellipse

0x6¢ (108) | Draw thick circle arc

0xc8 (200) | Draw image with fli

0xc9 (201) | Draw image with rotation (simple)
Oxca (202) | Draw image with rotation (bilinear)
Oxcb (203) | Draw image with scalling (simple)
Oxcc (204) | Draw image with scalling (bilinear)

The traces are SystemView compatible. The following text can be copied in a file called SYSVIEW_MicroUI.txt and
copied in SystemView installation folder.

NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType

UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent
UIEvent

0=COMMAND

1=BUTTON

2=POINTER

3=STATE

4=UNKNOWN
5=CALLSERIALLY
6=STOP

7=INPUT
8=SHOW_DISPLAYABLE
9=HIDE_DISPLAYABLE
11=PENDING_FLUSH
12=FORCE_FLUSH
13=REPAINT_DISPLAYABLE

(continues on next page)
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NamedType UIEvent 14=REPAINT_CURRENT_DISPLAYABLE
NamedType UIEvent 15=KF_STOP_FEATURE

NamedType UINewImage 0=MUTABLE_IMAGE
NamedType UINewImage 1=IMAGE_FROM_PATH
NamedType UINewImage 2=IMAGE_FROM_INPUTSTREAM

NamedType UIImageData O=NEW_IMAGE

NamedType UIImageData 1=LOAD_MICROEJ
NamedType UIImageData 2=NEW_ENCODED

NamedType UIImageData 3=NEW_MICROEJ_EXTERNAL
NamedType UIImageData 4=NEW_ENCODED_EXTERNAL
NamedType UIImageData 5=MEMORY_INPUTSTREAM
NamedType UIImageData 6=BYTEARRAY_INPUTSTREAM
NamedType UIImageData 7=GENERIC_INPUTSTREAM
NamedType UIImageData 8=LINK_IMAGE

NamedType GEDraw 1=WRITE_PIXEL

NamedType GEDraw 2=DRAW_LINE

NamedType GEDraw 3=DRAW_HORIZONTALLINE
NamedType GEDraw 4=DRAW_VERTICALLINE
NamedType GEDraw 5=DRAW_RECTANGLE
NamedType GEDraw 6=FILL_RECTANGLE
NamedType GEDraw 7=UNKNOWN

NamedType GEDraw 8=DRAW_ROUNDEDRECTANGLE
NamedType GEDraw 9=FILL_ROUNDEDRECTANGLE
NamedType GEDraw 10=DRAW_CIRCLEARC
NamedType GEDraw 11=FILL_CIRCLEARC
NamedType GEDraw 12=DRAW_ELLIPSEARC
NamedType GEDraw 13=FILL_ELLIPSEARC
NamedType GEDraw 14=DRAW_ELLIPSE
NamedType GEDraw 15=FILL_ELLIPSE
NamedType GEDraw 16=DRAW_CIRCLE
NamedType GEDraw 17=FILL_CIRCLE
NamedType GEDraw 18=DRAW_ARGB

NamedType GEDraw 19=DRAW_IMAGE

NamedType GEDraw 50=DRAW_POLYGON

NamedType GEDraw 51=FILL_POLYGON

NamedType GEDraw 52=GET_IMAGEARGB

NamedType GEDraw 53=DRAW_STRING

NamedType GEDraw 54=DRAW_DEFORMED_STRING
NamedType GEDraw 55=DRAW_IMAGE_DEFORMED
NamedType GEDraw 56=DRAW_CHAR_ROTATION_BILINEAR
NamedType GEDraw 57=DRAW_CHAR_ROTATION_SIMPLE
NamedType GEDraw 58=STRING_WIDTH

NamedType GEDraw 59=GET_PIXEL

NamedType GEDraw 100=DRAW_THICKFADEDPOINT
NamedType GEDraw 101=DRAW_THICKFADEDLINE
NamedType GEDraw 102=DRAW_THICKFADEDCIRCLE
NamedType GEDraw 103=DRAW_THICKFADEDCIRCLEARC
NamedType GEDraw 104=DRAW_THICKFADEDELLIPSE
NamedType GEDraw 105=DRAW_THICKLINE

NamedType GEDraw 106=DRAW_THICKCIRCLE
NamedType GEDraw 107=DRAW_THICKELLIPSE

(continued from previous page)

(continues on next page)
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NamedType GEDraw 108=DRAW_THICKCIRCLEARC

NamedType GEDraw 200=DRAW_FLIPPEDIMAGE

NamedType GEDraw 2071=DRAW_ROTATEDIMAGENEARESTNEIGHBOR
NamedType GEDraw 202=DRAW_ROTATEDIMAGEBILINEAR
NamedType GEDraw 203=DRAW_SCALEDIMAGENEARESTNEIGHBOR
NamedType GEDraw 204=DRAW_SCALEDIMAGEBILINEAR

#

# MicroUI

#

0 UI_EGEvent (MicroUI) Execute EventGenerator event %UIEvent (generatorID = %u,.
—data = %p) | (MicroUI) EventGenerator event %UIEvent done

1 UI_DROPEvent (MicroUI) Drop event %p

2 UI_InputEvent (MicroUI) Execute native input event %UIEvent (generatorID = %u, event =
—%p) | (MicroUI) Native input event %UIEvent done

3 UI_DisplayEvent (MicroUI) Execute display event %UIEvent (event = %p) o
< | (MicroUI) Display event %UIEvent done

4 UI_UserEvent (MicroUI) Execute user event %p o
— | (MicroUI) User event %p done

5 UI_OpenImage (MicroUI) Create %UINewImage -
. | (MicroUI) Image created; id = %p

6 UI_ImageData (MicroUI) %UINewImage ( %UIImageData ): id = %p; size = %d*%d

#

# MicroUI Graphics Engine

#

10 GE_FlushStart (MicroUI GraphicalEngine) Flush back buffer (%u,%u) (%u*%u)

11 GE_FlushDone (MicroUI GraphicalEngine) Flush done

12 GE_DrawInternal (MicroUI GraphicalEngine) Drawing operation %GEDraw [
—(MicroUI GraphicalEngine) Drawing operation %GEDraw done

13 GE_Draw (MicroUI GraphicalEngine) Drawing operation %GEDraw [
<»(MicroUI GraphicalEngine) Drawing operation %GEDraw done

14 GE_Unknown (MicroUI GraphicalEngine) Unknown event

15 GE_GPUDrawDone (MicroUI GraphicalEngine) Asynchronous drawing operation done

#

# MicroUI Input Engine

#

20 IE_InvalidEvent (MicroUI Input Engine) Invalid event: %p

21 IE_QueueFull (MicroUI Input Engine) Queue full, cannot add event %p

22 IE_AddEvent (MicroUI Input Engine) Add event %p (index = %u / queue length = %u)

23 IE_ReplaceEvent (MicroUI Input Engine) Replace event %p by %p (index = %u / queue length =
<~>%U)

24 IE_ReadEvent (MicroUI Input Engine) Read event %p (index %u)

Error Messages

When an exception is thrown by the implementation of the MicroUl API, the exception MicroUlException with the
error message MicroUI:E=<messageld> is issued, where the meaning of <messagelId> is defined in following
table:
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Table 22: MicroUl Error Messages

Message ID Description

1 Another EventGenerator cannot be added into the system pool (max 254).

0 [platform issue] Result of MicroUl static initialization step seems invalid. MicroUl cannot
start. Please fix MicroUl static initialization step (see Static Initialization) and rebuild the
platform.

-1 MicroUl is not started; call MicroUl.start() before using a MicroUl API.

-2 Unknown event generator class name.

-3 Deadlock. Cannot wait for an event in the same thread that runs events. Display.
waitFlushCompleted() must not be called in the MicroUl thread (for example in render
method).

-4 Resource’s path must be relative to the classpath (start with ‘/’) or resource is not available.

-5 The resource data cannot be read for unknown reason.

-6 The resource has been closed and cannot be used anymore.

-7 Out of memory. Not enough memory to allocate the Image ’s buffer. Try to close some
uselessimages and retry opening the new image, orincrease the size of the MicroUl images
heap.

-8 The platform cannot decode this kind of image, because the required runtime image de-
coder is not available in the platform.

-9 This exception is thrown when the FIFO of the internal MicroUl thread is full. In this case,
no more event (such as requestRender , input events, etc.) can be added into it.

Most of time this error occurs when:
« Thereis a user thread which performs too many calls to the method requestRender
without waiting for the end of the previous drawing.
« Too many input events are pushed from an input driver to the MicroUl thread (for
example some touch events).
-10 There is no display on the platform.
-n There is no font (platform and application).

3.12.2 MWT (Micro Widget Toolkit)
Introduction

MWT is a toolkit that simplifies the creation and use of graphical user interface widgets on a pixel-based display.

The aim of this library is to be sufficient to create complex applications with a minimal framework. It provides the
main concepts without managing particular needs. Specific needs can be met by a MWT expert by creating new
widgets, adding more complex concepts, etc. The flexibility of the MWT open framework allows the selection of
only what is necessary for the application in order to guarantee lightweight applications and fast execution.

To use the MWT library, add the following line to a module description file:

<dependency org="ej.library.ui” name="mwt" rev="3.1.0"/>

Concepts
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Graphical Elements

C Displayable

C Desktop

@ EventDispatcher getEventDispatcher()
@ void requestLayut()

@ boolean handleEvent|int event)

@ Stylesheet getStylesheet(}

widget
A Widget
O intx
2 inty
o intwidth
© int height

< woid onLaidOut()

< woid onAttached()

<* void onDetached()

<* void onShown()

“» woid onHidden()

@ woid requestLayOut()

< void computeCantentOptimalSize[Size size)
@ void requestRender()

© boolean handleEvent(int event)

> void renderContent(GraphicsContext g, Size size)
@ Style getStyle()

boolean hasClassSelector(int classSelector)

]
@ boolean isinstateint state)

children

A Container

——————————————<yeidlayOutChildrenfint contentifiathint contentHeight)
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Widget

Awidget is an object that is intended to be displayed on a screen. A widget occupies a specific region of the display
and holds a state. A user may interact with a widget (using a touch screen or a button for example).

Widgets are arranged on a desktop. A widget can be part of only one desktop hierarchy, and can appear only once
on that desktop.

Container

A container follows the composite pattern: it is a widget composed of other widgets. It also defines the layout
policy of its children (defining their bounds). The children’s positions are relative to the position of their parent.
Containers can be nested to design elaborate user interfaces.

By default, the children are rendered in the order in which they have been added in the container. And thus if the
container allows overlapping, the widgets added last will be on top of the widgets added first. A container can also
modify how its children are rendered.

Desktop

A desktop is a displayable intended to be shown on a display (cf. MicroUl). At any time, only one desktop can be
displayed per display.

A desktop contains a widget (or a container). When the desktop is shown, its widget (and all its hierarchy for a
container) is drawn on the display.

Rendering

Anew rendering of a widget on the display can be requested by calling its requestRender () method. The render-
ing is done asynchronously in the MicroUl thread.

When a container is rendered, all its children are also rendered.

A widget can be transparent, meaning that it does not draw every pixel within its bounds. In this case, when this
widget is asked to be rendered, its parent is asked to be rendered in the area of the widget (recursively if the parent
is also transparent). Usually a widget is transparent when its background (from the style) is transparent.

A widget can also be rendered directly in a specific graphics context by calling its render(GraphicsContext)
method. It can be useful to render a widget (and its children) in an image for example.

Render Policy

Arender policy is a strategy that MWT uses in order to repaint the entire desktop or to repaint a specific widget.

The most naive render policy would be to render the whole hierarchy of the desktop whenever a widget has
changed. However DefaultRenderPolicy is smarter than that: it only repaints the widget, and its ances-
tors if the widget is transparent. The result is correct only if there is no overlapping widget, in which case
OverlapRenderPolicy should be used instead. This policy repaints the widget (or its non-transparent ancestor),
then it repaints all the widgets that overlap it.

When using a partial buffer, these render policies can not be used because they render the entire screen in a single
pass. Instead, a custom render policy which renders the screen in multiple passes has to be used. Refer to the
partial buffer demo for more information on how to implement this render policy and how to use it.
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The render policy can be changed by overridding Desktop.createRenderPolicy() .

Lay Out

All widgets are laid out at once during the lay out process. This process can be started by Desktop.
requestlLayOut (), Widget.requestlLayOut() . The layoutis also automatically done when the desktop is shown (
Desktop.onShown() ). This process is composed of two steps, each step browses the hierarchy of widgets following
a depth-first algorithm:

« compute the optimal size for each widget and container (considering the constraints of the lay out),
+ set position and size for each widget.

Once the position and size of a widget is set, the widget is notified by a call to onLaidOut() .

Event Dispatch

Events generated in the hardware (touch, buttons, etc.) are sent to the event dispatcher of the desktop. It is then
responsible of sending the event to one or several widgets of the hierarchy. A widget receives the event through
its handleEvent(int) method. This method returns a boolean that indicates whether or not the event has been
consumed by the widget.

Widgets are disabled by default and don’t receive the events.

Pointer Event Dispatcher

By default, the desktop proposes an event dispatcher that handles only pointer events.

Pointer events are grouped in sessions. A session starts when the pointer is pressed, and ends when the pointer is
released or when it exits the pressed widget.

While no widget consumes the events, they are sent to the widget that is under the pointer (see Desktop.
getWidgetAt(int, int)),then sentto allits parent hierarchy recursively.

Once a widget has consumed an event, it will be the only one to receive the next events during the session.

Pointer released within widget bounds - DRAGGED event

< Pointer dragged or released consumed by another widget - EXITED event | ——
NOT PRESSED STATE g3 PRESSED STATE __ Pointer dragged within widget bounds - DRAGGED event
< Pointer dragged or released outside widget bounds - EXITED event

H“-\-\.

~—___ Pointer pressed within widget bounds - PRESSED event 7_;_-/

A widget can redefine its reactive area by subclassing the contains(int x, int y) method. Itis useful when a
widget does not fill fully its bounds.

Style

A style describes how widgets must be rendered on screen. The attributes of the style are strongly inspired from
CSS.
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Dimension

The dimension is used to constrain the size of the widget.
MWT provides multiple implementations of dimensions:

+ NoDimension does not constrain the dimension of the widget, so the widget will take all the space granted
by its parent container.

« OptimalDimension constrains the dimension of the widget to its optimal size, which is given by the
computeContentOptimalSize() method of the widget.

« FixedDimension constrains the dimension of the widget to a fixed absolute size.

« RelativeDimension constrains the dimension of the widget to a percentage of the size of its parent con-
tainer.

Alignment

The horizontal and vertical alignments are used to position the content of the widget within its bounds.

The alignment is used by the framework to position the widget within its available space if the size of the widget
has been constrained with a Dimension.

The alignment can also be used in the renderContent() method in order to position the drawings of the widget
(such as a text or an image) within its content bounds.

Outlines

The margin, border and padding are the 3 outlines which wrap the content of the widget. The widget is wrapped
in the following sequence: first the padding, then the border, and finally the margin.

Margin

Border
Padding

Content

MWT provides multiple implementations of invisible outlines which are usually used for margin and padding:
« NoOutline does notwrap the widgetin an outline.
« UniformOutline wraps the widget in an outline which thickness is equal on all sides.
« FlexibleOutline wraps the widgetin an outline which thickness can be configured for each side.

MWT also provides multiple implementations of visible outlines which are usually used for border:
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+ RectangularBorder draws a plain rectangle around the widget.

+ RoundedBorder draws a plain rounded rectangle around the widget.

Background

The background is used to render the background of the widget. The background covers the border, the padding
and the content of the widget, but not its margin.

MWT provides multiple implementations of backgrounds:
« NoBackground leaves a transparent background behind the widget.
+ RectangularBackground draws a plain rectangle behind the widget.
« RoundedBackground draws a plain rounded rectangle behind the widget.

« ImageBackground draws animage behinds the widget.

Color

The color is not used by the framework itself, but it may be used in the renderContent () to select the color of the
drawings.

Font

The fontis not used by framework itself, but it may be used in the renderContent() to selectthe fontto use when
drawing strings.

Extra fields

Extra fields are not used by framework itself, but they may be used in the renderContent() to customize the
behavior and the appearance of the widget.

See chapter How to Define an Extra Style Field for more information on extra fields.

Stylesheet

A stylesheet allows to customize the appearance of all the widgets of a desktop without changing the code of the
widget subclasses.

MWT provides multiple implementations of stylesheets:
« VoidStylesheet assigns the same default style for every widget.
« CascadingStylesheet assigns styles to widgets using selectors, similarly to CSS.

For example, the following code customizes the style of every Label widget of the desktop:

CascadingStylesheet stylesheet = new CascadingStylesheet();

EditableStyle labelStyle = stylesheet.getSelectorStyle(new TypeSelector(Label.class));
labelStyle.setColor(Colors.RED);
labelStyle.setBackground(new RectangularBackground(Colors.WHITE));

(continues on next page)
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desktop.setStylesheet(stylesheet);

Animations

MWT provides a utility class in order to animate widgets: Animator. When a widget is being animated by an anima-
tor, the widget is notified each time that the display is flushed. The widget can use this interrupt in order to update
its state and request a new rendering.

See chapter How to Animate a Widget for more information on animating a widget.

Partial buffer considerations

Rendering a widget in partial buffer mode may require multiple cycles if the buffer is not big enough to hold all the
pixels to update in a single shot. This means that rendering is slower in partial buffer mode, and this may cause
performance being significantly affected during animations.

Besides, the whole screen is flushed in multiple times instead of a single one, which means that the user may see
the display at a time where every part of the display has not been flushed yet.

Due to these limitations, it is not recommended to repaint big parts of the screen at the same time. For example, a
transition on a small part of the screen will look better than a transition affecting the whole screen. A transition will
look perfect if the partial buffer can hold all the lines to repaint. Since the buffer holds a group of lines, a horizontal
transition may not look the same as a vertical transition.

Desktop and widget states

Desktop and widgets pass through different states. Once created, they can be attached, then they can be shown.

Adesktop is attached automatically as soon asitis shown on the display. It can also be attached manually by calling
Desktop.setAttached() . It could be used to render the desktop (and its widgets) on an image for example.

A widget is considered as attached when it is contained by a desktop that is attached.

In the same way, by default, a widget is shown when its desktop is shown. But for optimization purpose, a container
can control when its children are shown or hidden. A typical use case is when the widgets are moved outside the
display.

Once awidgetis attached, it means that it is ready to be shown (for instance, the necessary resources are allocated).
In other words, once attached a widget is ready to be rendered (on an image or on the display).

Once a widget is shown, it means that it is intended to be rendered on the display. While shown, it may start a
periodic refresh or an animation.
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The following sections will present several ways to customize and extend the framework to better fit your needs.

How to Create a Widget

A widget is the main way to render information on the display. A set of pre-defined widgets is described in the
Widgets and Examples section.

If the needed widget does not already exist, it is possible to create it from scratch (or by derivating another one).

To create a custom widget, a new class should be created, extending the Widget class. Widget subclasses have to
implement two methods and may override optional methods, as explained in the following sections.

Implementing the mandatory methods
Computing the optimal size of the widget

The computeContentOptimalSize() method is called by the MWT framework in order to know the optimal size
of the widget. The optimal size of the widget should be big enough to contain all the drawings of the widget.

The Size parameter of the computeContentOptimalSize() method initially contains the size available for the
widget. An available width or height equal to Widget.NO_CONSTRAINT means that the optimal size should be
computed without considering any restriction on the respective axis. Before the method returns, the size object
should be set to the optimal size of the widget.

When implementing this method, the getStyle() method may be called in orderto retrieve the style of the widget.

For example, the following snippet computes the optimal size of a label:

@0verride

protected void computeContentOptimalSize(Size size) {
Font font = getStyle().getFont();
int width = font.stringWidth(this.text);
int height = font.getHeight();
size.setSize(width, height);

Rendering the content of the widget

The renderContent() method is called by the MWT framework in order to render the content of the widget.
When implementing this method, the getStyle() method may be called in orderto retrieve the style of the widget.

For example, the following snippet renders the content of a label:

@0verride

protected void renderContent(GraphicsContext g, int contentWidth, int contentHeight) {
Style style = getStyle();
g.setColor(style.getColor());
Painter.drawString(g, style.getFont(), this.text, 0, 0);
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Handling events

When a widget is created, it is disabled and it will not receive any event. A widget may be enabled or disabled by
calling setEnabled() . Acommon practice is to enable the widget in its constructor.

Enabled widgets can handle events by overriding handleEvent() . MicroUl event APIs may be used in order to
know more information on the event, such as its type. The handleEvent () method should return whether or not
the event was consumed by the widget.

For example, the following snippet prints a message when the widget receives an event:

@0verride

public boolean handleEvent(int event) {
System.out.println("Event type:
return false;

"

+ Event.getType(event));

Listening to the life-cycle hooks

Widget subclasses may override the following methods in order to allocate and free the necessary resources:
* onAttached()
» onDetached()
e onLaidOut()
« onShown()
» onHidden()

For example, the onAttached() may be overridden to load an image:

@Override
protected void onAttached() {
this.image = Resourcelmage.loadImage(this.imagePath);

}

Likewise, the onDetached() method may be overridden to close the image:

@Override
protected void onDetached() {
this.image.close();

}

For example, the onShown() may be overridden to start an animation:

@Override

protected void onShown() {
Animator animator = ServiceFactory.getService(Animator.class);
animator.startAnimation(this);

Likewise, the onHidden() method may be overridden to stop an animation:

@0verride
protected void onHidden() {
Animator animator = ServiceFactory.getService(Animator.class);
(continues on next page)
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animator.stopAnimation(this);

How to Create a Container

To create a custom container, a new class should be created, extending the Container class. This new class may
define a constructor and setter methods in order to provide a way for the user to configure the container, such
as its orientation. Container subclasses have to implement two methods and may override optional methods, as
explained in the following sections.

Implementing the mandatory methods

This section explains how to implement the two mandatory methods of a container subclass.

Computing the optimal size of the container

The computeContentOptimalSize() method is called by the MWT framework in order to know the optimal size
of the container. The optimal size of the container should be big enough so that each child can be laid out with a
size at least as big as its own optimal size.

The container is responsible for computing the optimal size of every child. To do so, the
computeChildOptimalSize() method should be called for every child. After this method is called, the opti-
mal size of the child can be retrieved by calling getWidth() and getHeight() on the child widget.

The Size parameter of the computeContentOptimalSize() method initially contains the size available for the
container. An available width or height equal to Widget.NO_CONSTRAINT means that the optimal size should be
computed without considering any restriction on the respective axis. Before the method returns, the size object
should be set to the optimal size of the container.

For example, the following snippet computes the optimal size of a simple wrapper:

@0verride

protected void computeContentOptimalSize(Size size) {
Widget child = getChild(0);
computeChildOptimalSize(child, size.getWidth(), size.getHeight());
size.setSize(child.getWidth(), child.getHeight());

Laying out the children of the container

The layOutChildren() method is called by the MWT framework in order to lay out every child of the container,
i.e. to set the position and size of the children. If a child is laid out outside the bounds of the container (partially or
fully), only the part of the widget which is within the container bounds will be visible.

The container is responsible for laying out each child. To do so, the layOutChild() method should be called for
every child. Before this method is called, the optimal size of the child can be retrieved by calling getWidth() and
getHeight() on the child widget.

When laying out a child, its bounds have to be passed as parameter. The position will be interpreted as relative to
the position of the container content. This means that the position should not include the outlines of the con-
tainer. This means that the (0, ©) coordinates represent the top-left pixel of the container content and the
(contentWidth-1, contentHeight-1) coordinates represent the bottom-right pixel of the container content.
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For example, the following snippet lays out the children of a simple wrapper:

@0verride

protected void layOutChildren(int contentWidth, int contentHeight) {
Widget child = getChild(0);
layOutChild(child, @, @, contentWidth, contentHeight);

Managing the visibility of the children of the container

By default, when a container is shown, each of its children is shown too. This behavior can be changed by over-
riding the setShownChildren() method of Container.Whenimplementing this method, the setShownChild()
method should be called for each child which should be shown when the container is shown.

At any time while the container is visible, children may be shown or hidden by calling setShownChild() or
setHiddenChild() .

When a container is hidden, each of its children is hidden too (unless it is already hidden). It is not necessary to
override setHiddenChildren() , except for optimization.

Providing APIs to change the children list of the container

The Container classintroduces protected APlsin orderto manipulate the list of children of the container. These
methods may be overridden in the container subclass and set as public in order to make these APIs available for
the user.

Each of the following methods may be overridden individually:
« addChild()
o removeChild()
o removeAllChildren()
e insertChild()
e replaceChild()
o changeChildIndex()

For example, the following snippet allows the user to call the addChild() method on the container:

@Override

public void addChild(Widget child) {
super.addChild(child);

3

How to Animate a Widget

Starting and stopping the animation

To animate awidget,an Animator instanceisrequired. Thisinstance can be passed in the constructor of the widget
or be fetched from a service provider. Make sure that your widget subclass implements the Animation interface
so that it can be used with an Animator.

An animation can be started at any moment, provided that the widget is shown. For example, the animation can
start on a click event. Likewise, an animation can be stopped at any moment, for example a few seconds after the
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animation has started. Once the widget is hidden, its animation should always be stopped to avoid memory leaks
and unnecessary operations.

To start the animation of the widget, callthe startAnimation() method of the Animator instance. To stop it, call
the stopAnimation() method of the same Animator instance.

For example, the following snippet starts the animation as soon as the widget is shown and stops it once the widget
is hidden:

public class MyAnimatedWidget extends Widget implements Animation {
private final Animator animator;

private long startTime;
private long elapsedTime;

public MyAnimatedWidget(Animator animator) {
this.animator = animator;

b

@Override

protected void onShown() {
this.startTime = System.currentTimeMillis();
this.animator.startAnimation(this);

b

@override
protected void onHidden() {
this.animator.stopAnimation(this);

3

Performing an animation step

The tick() method is called by the animator in order to update the widget. It is called in the Ul thread once the
display has been flushed. This method should not render the widget but should update its state and request a new
render if necessary. The tick() method should return whether or not the animation should continue after this
increment.

For example, the following snippet updates the state of the widget when it is ticked, requests a new render and
keeps the animation going until 5 seconds have passed:

@Override

public boolean tick(long currentTimeMillis) {
// update widget state
this.elapsedTime = currentTimeMillis - this.startTime;
// request new render
requestRender();
// return whether to continue or to stop the animation
return (this.elapsedTime < 5_000);

The renderContent() method should render the widget by using its current state (saved in the fields of the wid-
get). This method should not call methods such as System.currentTimeMillis() because the widget could be
rendered in multiple passes, for example if a partial buffer is used.

For example, the following snippet renders the current state of the widget by displaying the time elapsed since the
start of the animation:
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@0verride

protected void renderContent(GraphicsContext g, int contentWidth, int contentHeight) {
Style style = getStyle();
g.setColor(style.getColor());
Painter.drawString(g, Long.toString(this.elapsedTime), style.getFont(), 0, 0);

How to Define an Outline or Border

To create a custom outline or border, a new class should be created, extending the Outline class. Outline sub-
classes have to implement two methods, as explained in the following sections.

Applying the outline on an outlineable object

The apply(Outlineable) method is called by the MWT framework in order to subtract the outline from a Size
or Rectangle object.

The Outlineable parameter of the method initially contains the size or bounds of the box, including the outline.
Before the method returns, the outlineable object should be modified by subtracting the outline. In order to remove
the outline from the object, the removeOutline() method of Outlineable should be used, passing as argument
the thickness on each side.

For example, the following snippet applies an outline of 1 pixel on every side:

@0verride
public void apply(Outlineable outlineable) {
outlineable.removeOutline(1, 1, 1, 1);

}

Applying the outline on a graphics context

The apply(GraphicsContext, Size) method is called by the MWT framework in order to render the outline (only
relevant if it is a border) and to update the translation and clip of a graphics context.

The Size parameter of the method initially contains the size of the box, including the outline. Before the method
returns, the size object should be modified by subtracting the outline. In order to remove the outline from the
object, the removeOutline() method of Outlineable should be used, passing as argument the thickness on
each side.

For example, the following snippet applies an outline of 1 pixel on every side:

@Override

public void apply(GraphicsContext g, Size size) {
size.removeOutline(1, 1, 1, 1);
g.translate(1, 1);
g.setClip(0@, 0, size.getWidth(), size.getHeight());

How to Define a Background

To create a custom background, a new class should be created, extending the Background class. Background
subclasses have to implement two methods, as explained in the following sections.
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Informing whether the background is transparent

The isTransparent() method is called by the MWT framework in order to know whether or not the background is
transparent. A background is considered as transparent if it does not draw every pixel with maximal opacity when
itis applied.

For example, the following snippet informs that the background is completely opaque regardless of its size:

@Override
public boolean isTransparent(int width, int height) {
return false;

3

Applying the background on a graphics context

The apply(GraphicsContext g, Size size) method is called by the MWT framework in order to render the
background and to set or remove the background color of subsequent drawings.

For example, the following snippet applies a white background:

@Override

public void apply(GraphicsContext g, Size size) {
g.setColor(Colors.WHITE);
Painter.fillRectangle(g, 0, 0, size.getWidth(), size.getHeight());
g.setBackgroundColor(Colors.WHITE);

How to Create a Desktop Event Dispatcher

Creating a custom event dispatcher can help you address two use cases:

« [Dispatch] Extending an EventDispatcher is used to dispatch the events. For example, the FocusEventDis-
patcher will send the events to the widget owning the focus.

« [Handle] Overriding the desktop is used to directly trigger a behavior. For example “BACK” command shows
the previous page.

To create a custom event dispatcher, a new class should be created, extending the EventDispatcher class. Event
dispatcher subclasses have to implement a method and may override optional methods, as explained in the fol-
lowing sections.

Dispatching the events to the widgets

The dispatchEvent() methodis called by the MWT framework in order to dispatch a MicroUl event to the widgets
of the desktop. The getDesktop() method may be called in order to retrieve the desktop with which the event
dispatcher is associated. This is useful in order to browse the widget hierarchy of the desktop, for example by using
the getWidget() and getWidgetAt() methods of Desktop.

In order to send an event to one of the widgets of the hierarchy, the sendEventToWidget() method should be
used. The dispatchEvent() method should return whether or not the event was dispatched and consumed by a
widget.

For example, the following snippet dispatches every event to the widget of the desktop:
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@0verride
public boolean dispatchEvent(int event) {
Widget desktopWidget = getDesktop().getWidget();
if (desktopWidget != null) {
return sendEventToWidget(desktopWidget, event);
} else {
return false;
}
3

In addition to dispatching the provided events, an event dispatcher may generate custom events. This may be done
by using a DesktopEventGenerator . Its buildEvent() method allows to build an event which may be sentto a
widget using the sendEventToWidget() method.

Initializing and disposing the dispatcher

EventDispatcher subclasses may override the initialize() and dispose() methods in order to allocate and
free the necessary resources.

Forexample,the initialize() method maybeoverriddento create an event generatorand to add it to the system
pool of MicroUl:

@Override

public void initialize() {
this.eventGenerator = new DesktopEventGenerator();
this.eventGenerator.addToSystemPool();

3

Likewise, the dispose() method may be overridden to remove the event generator from the system pool of Mi-
croUl:

@Override
public void dispose() {
this.eventGenerator.removeFromSystemPool();

}

How to Define an Extra Style Field

Extra style fields allow to customize a widget by configuring graphical elements of the widget from the stylesheet.
Extra fields are only relevant to a specific widget type and its subtypes. A widget type can support up to 7 extra
fields. The value of an extra field may be represented asan int,a float orany object, and it can not be inherited
from parent widgets.

Defining an extra field ID

The recommended practice is to add a public constant for the ID of the new extra field in the widget subtype. This
ID should be an integer with a value between ¢ and 6.

Every extra field ID has to be unique within the widget type. However, two unrelated widget types may define an
extra field with the same ID.

For example, the following snippet defines an extra field for a secondary color:
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public static final int SECONDARY_COLOR_FIELD = 0;

Setting an extra field in the stylesheet

The value of an extra field may be set in the stylesheet in a similar fashion to built-in style fields, using one of the
setExtraxxX() methodsof EditableStyle.

For example, the following snippet sets the value of an extra field for all the instances of a widget subtype:

EditableStyle style = stylesheet.getSelectorStyle(new TypeSelector(MyWidget.class));
style.setExtraInt(MyWidget.SECONDARY_COLOR_FIELD, Colors.RED);

Getting an extra field during rendering

The value of an extra field may be retrieved from the style of a widget in a similar fashion to built-in style fields,
using one of the getExtraxxX() methodsof Style.When calling one of these methods, a default value has to be
given in case the extra field is not set for this widget.

For example, the following snippet gets the value of an extra field of the widget:

Style style = getStyle();

int secondaryColor = style.getExtralnt(SECONDARY_COLOR_FIELD, Colors.BLACK);
3.12.3 Widgets and Examples

Widget library

The widget library provides very common widgets with basic implementations. These simple widgets may not
provide every desired feature, but they can easily be forked since their implementation is very simple.

The widget library does not provide any example. However, the widget demo provides examples for these widgets.

Source

To use the widgets provided by the widget library, add the following line to a module description file:

<dependency org="ej.library.ui"” name="widget"” rev="3.1.0"/>

To fork one of the provided widgets, duplicate the associated Java class from the widget library JAR into the source
code of your application. It is recommended to move the duplicated class to an other package and to rename the
class in order to avoid confusion between your forked class and the original class.

Provided widgets

Widgets:
« Label : displays a text.
« ImageWidget : displays an image which is loaded from a resource.

« Button: displays a text and reacts to click events.

3.12. Graphical User Interface 193



MicroEJ Documentation, Revision bd708584

+ ImageButton: displays animage which is loaded from a resource and reacts to click events.
Containers:

« List:lays out any number of children horizontally or vertically.

+ Flow: lays out any number of children horizontally or vertically, using multiple rows if necessary.

+ Grid:lays out any number of children in a grid.

« Dock : lays out any number of children by docking each child one by one on a side.

« SimpleDock : lays out three children horizontally or vertically.

« OverlapContainer: lays out any number of children by stacking them.

+ Canvas: lays out any number of children freely.

Widget demo

The widget demo provides some widget implementations as well as usage examples for these widgets and for the
widgets of the Widget library. The widgets and usage examples are intended to be duplicated by the developers in
order to be adapted to their use-case.

Source

To use the widgets provided by the widget demo, clone the following GitHub repository: https://github.com/
MicroEJ/Demo-Widget. You can then import the com.microej.demo.widget projectinto your workspace to see
the source of the widgets and their associated examples.

Each subpackage contains the source code for a specific widget and for a page which showcases the widget. For ex-
ample, the com.microej.demo.widget.checkbox package containsthe Checkbox widgetand the CheckboxPage

Provided widgets

Widgets:
« Checkbox : displays a text and a square which can be checked or unchecked.
« RadioButton: displays a text and a circle which can be checked or unchecked.

+ ProgressBar : displays an animated bar indicating that the user should wait for an estimated amount of
time.

« IndeterminateProgressBar : displays an animated bar indicating that the user should wait for an indeter-
minate amount of time.

« Toggle: displays a text and a switch that can be checked or unchecked.
Containers:
« Split:laysouttwo children horizontally or vertically, by giving each child a portion of the available space.

« Scrollablelist : lays out its widgets the same way as a regular list, but provides an optimization when
added to a scroll.
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MWT examples

The MWT Examples repository provides various examples which extend or customize the MWT framework.

Source

To run the examples and read the source code of these examples, clone the following GitHub repository: https:
//github.com/MicroEJ/ExampleJava-MWT. You can then import the multiple project into your workspace to see
the source of each example and to run it on Simulator or on your board.

Provided examples

« com.microej.example.mwt.attribute: showshow to customize the style of widgets using attributes selec-
tors, similar to CSS.

« com.microej.example.mwt. focus :shows how to introduce focus management in your project.

« com.microej.example.mwt.lazystylesheet : shows how to use a lazy stylesheet rather than the default
stylesheet implementation.

« com.microej.example.mwt.mvc: shows how to develop responsive widgets using a MVC design pattern and
how to display a cursor image representing the pointer.
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CHAPTER

FOUR

PLATFORM DEVELOPER GUIDE

4.1 Introduction

4.1.1 Scope

This document explains how the core features of MicroEJ Architecture are accessed, configured and used by the
MicroEJ Platform builder. It describes the process for creating and augmenting a MicroEJ Architecture. This doc-
ument is concise, but attempts to be exact and complete. Semantics of implemented Foundation Libraries are
described in their respective specifications. This document includes an outline of the required low level drivers
(LLAPI) for porting the MicroEJ Architectures to different real-time operating systems (RTOS).

MicroEJ Architecture is state-of-the-art, with embedded MicroEJ runtimes for MCUs. They also provide simulated
runtimes that execute on workstations to allow software development on “virtual hardware.”

4.1.2 Intended Audience

The audience for this document is software engineers who need to understand how to create and configure a Mi-
croEJ Platform using the MicroEJ Platform builder. This document also explains how a MicroEJ Application can
interoperate with C code on the target, and the details of the MicroEJ Architecture modules, including their APIs,
error codes and options.

4.1.3 MicroEJ Architecture Modules Overview

MicroEJ Architecture features the MicroEJ Core Engine: a tiny and fast runtime associated with a Garbage Collector.
It provides four built-in Foundation Libraries :

.+ [BON]
« EDC
. [SNI]
. [sP]

The following figure shows the components involved.
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Fig. 1: MicroEJ Architecture Runtime Modules: Tools, Libraries and APIs

Three APIs allow the device architecture runtime to link with (and port to) external code, such as any kind of RTOS
or legacy C libraries. These three APIs are

+ Simple Native Interface ([SN/])
+ Low Level MicroEJ Core Engine (LLMJVM)
« Low Level Shielded Plug (LLSP)
MicroEJ Architecture features additional Foundation Libraries and modules to extend the kernel:
« serial communication,
« Ul extension (User Interface)
+ networking
« file system
. etc.

Each additional module is optional and selected on demand during the MicroEJ Platform configuration.
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4.2 MicroEJ Platform

4.2.1 Process Overview

This section summarizes the steps required to build a MicroEJ Platform and obtain a binary file to deploy on a

board.

The following figure shows the overall process. The first three steps are performed within the MicroEJ Platform
builder. The remaining steps are performed within the C IDE.

MicroEJ

Architecture

MicroEJ Workbench

CIDE

The steps are as follow:

configuration project project

1. Create a new MicroEJ Platform .

MicroEJ Platform Configuration 2. Select and configure

— additiocnal modules

'

3. Build the MicroEJ
Platform

Microf MicroEJ Platform

Application code

l

4. Build the MicroEJ
Application

{

Application
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C application Architecture

code and Board
Support Package

library file

(microejapp.o) (microejruntime.a)

|

5. Build and link the full
application

|

Executable

application

!

6. Program and test the
application on the
board

Fig. 2: Overall Process
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1. Create a new MicroEJ Platform configuration project. This project describes the MicroEJ Platform to build
(MicroEJ Architecture, metadata, etc.).

2. Select which modules provided by the MicroEJ Architecture will be installed in the MicroEJ Platform.
3. Build the MicroEJ Platform according to the choices made in steps 1and 2.

4. Compile a MicroEJ Application against the MicroEJ Platform in order to obtain an application file to link in
the BSP.

5. Compile the BSP and link it with the MicroEJ Application that was built previously in step 4 to produce a
MicroEJ Firmware.

6. Final step: Deploy MicroEJ Firmware (i.e. the binary application) onto a board.

4.2.2 Concepts

MicroEJ Platform

A MicroEJ Platform includes development tools and a runtime environment.
The runtime environment consists of:

« A MicroEJ Core Engine.

« Some Foundation Libraries.

« Some C libraries.
The development tools are composed of:

« Java APIs to compile MicroEJ Application code.

« Documentation: this guide, library specifications, etc.

+ Tools for development and compilation.

« Launch scripts to run the simulation or build the binary file.

+ Eclipse plugins.

MicroEJ Platform Configuration
A MicroEJ Platform is described by a .platform file. This file is usually called [name].platform,and isstored at
the root of a MicroEJ Platform configuration project called [name]-configuration.

The configuration file is recognized by the MicroEJ Platform builder. The MicroEJ Platform builder offers a visual-
ization with two tabs:
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Device: STM3IZFTA6GDISCO €2 Environment: select the architecture,

Name: example ‘¥ Modules: select modules to import in the platform.

fersion: - 72057

Version: 2.1,0-RC201604072057 Platform Configuration

Provider : Microk) Once the content of the platform is chosen, it can be configured.
Vendor URL:

#2| Configuration

Each module can be configured creating a folder with its name along
the .platform file. It could contain:

* an optional [module]. properties file,
* opticnal module specific files and folders.

Meodifying one these files requires to build the platform again,

Build
Generate and test the platform.

X Build Plstform: The new platform is now available and visible in
Available Platforms

Owverview | Content
Fig. 3: MicroEJ Platform Configuration Overview Tab

This tab groups the basic platform information used to identify it: its name, its version, etc. These tags can be
updated at any time.
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Fig. 4: MicroEJ Platform Configuration Content Tab

This tab shows all additional modules (see Modules) which can be installed into the platform in order to augment
its features. The modules are sorted by groups and by functionality. When a module is checked, it will be installed
into the platform during the platform creation.

Modules

The primary mechanism for augmenting the capabilities of a MicroEJ Platform is to add modules to it.

A MicroEJ module is a group of related files (Foundation Libraries, scripts, link files, C libraries, Simulator, tools,
etc.) that together provide all or part of a platform capability. Generally, these files serve a common purpose. For
example, providing an API, or providing a library implementation with its associated tools.

The list of modules is in the second tab of the platform configuration tab. A module may require a configuration
step to be installed into the platform. The Modules Detail view indicates if a configuration file is required.

Low Level API Pattern
Principle

Each time the user must supply C code that connects a platform component to the target, a Low Level APl is defined.
There is a standard pattern for the implementation of these APIs. Each interface has a name and is specified by two
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header files:

« [INTERFACE_NAMET.h specifies the functions that make up the public API of the implementation. In some
cases the user code will never act as a client of the API, and so will never use this file.

o [INTERFACE_NAME]_impl.h specifies the functions that must be coded by the user in the implementation.

The user creates implementations of the interfaces, each captured in a separate C source file. In the simplest form
of this pattern, only one implementation is permitted, as shown in the illustration below.

Low Level API

LLXXX.h LLXXX_implL.h
void LLXXX init(); void LLXXX _TMPL init();
application.c MYIMPL.c
#tinclude "LLXXX.h" #include "LLXXX_impl.h"
Main() { Void LLXXX IMPL init() {

LLXXX_init(); // implementation code
¥ }

Fig. 5: Low Level API Pattern (single implementation)

The following figure shows a concrete example of an LLAPI. The C world (the board support package) has to imple-
ment a send function and must notify the library using a receive function.
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MicroEJ Application

Java communication library (ECOM Comm)

MicroEJ world call LLAPI
LLAPI notify library
LLCOM.h LLCOM_impl.h
void LLCOM dataReceived(..); void LLCOM IMPL sendData(..);
LLAPI
C world call LLAP! implement LLAPI
driver_interrupt.c driver.c
#include "LLCOM.h™ #include "LLCOM_IMPL.h"
IRQ data received(..) { void LLCOM IMPL sendData(..) {
LLCOM_dataReceived(..); // implementation code
1 1
J J

Fig. 6: Low Level APl Example

Multiple Implementations and Instances

When a Low Level API allows multiple implementations, each implementation must have a unique name. At run-
time there may be one or more instances of each implementation, and each instance is represented by a data struc-
ture that holds information about the instance. The address of this structure is the handle to the instance, and that
address is passed as the first parameter of every call to the implementation.

The illustration below shows this form of the pattern, but with only a single instance of a single implementation.
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Low Level API
LLXXX.h LLXXX_implL.h
void LLXXX init(LLXXX* env); void LLXXX TMPL init(LLXXX* env);

/4 /4

MYIMPL.h
#include "LLXXX.h™

typedef struct MYIMPL {
struct LLXXX header;
//specific fields defined here
} MYIMPL;
void MYIMPL_new(MYIMP* env);

application.c MYIMPL.c
#include "MYIMPL.h" #include "MYIMPL.h"
#define LLXXX_ IMPL MYIMPL
MYIMPL instance; #include "LLXXX impl.h"
Main() {
MYIMPL_new(&instance); Void LLXXX_IMPL_init(LLXXX* env) {
LLXXX init(&instance); // implementation code
} 7 } 7

Fig. 7: Low Level API Pattern (multiple implementations/instances)

The #define statementin MYIMPL.c specifies the name given to this implementation.

4.2.3 MicroEJ Platform Creation

This section describes the steps to create a new MicroEJ Platform in MicroEJ SDK, and options to connect it to an
external Board Support Package (BSP) as well as a third-party C toolchain.

MicroEJ SDK must be started on a new empty workspace.

MicroEJ Architecture Import

The first step is to choose and import a MicroEJ Architecture. MicroEJ Architectures for most common microcon-
troller instructions sets and compilers can be downloaded from https://repository.microej.com/architectures/‘_.

MicroEJ Architecture files ends with the . xpf extension, and are classified using the following folder naming con-
vention:

com/microej/architecture/[ISA]/[TOOLCHAIN]/[UID]/[VERSION]/[UID]-[VERSION]-[USAGE].xpf

« ISA:instruction set architecture (e.g. CM4 for Arm® Cortex®-M4, ESP32 for Espressif ESP32,...).
+ TOOLCHAIN : C compilation toolchain (e.g. CM4hardfp_GCC48).

! MicroEJ Architectures for production can be retrieved from the license server.
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+ VERSION:module version (e.g. 7.12.0).
+ UID:Architecture unique ID (e.g. flopi4G25).
« USAGE = eval forevaluation Architectures, prod for production Architectures.

For example, MicroEJ Architecture versions for Arm® Cortex®-M4 microcontrollers compiled with GNU CC toolchain
is available at https://repository.microej.com/architectures/com/microej/architecture/CM4/CM4hardfp_GCC48/
flopi4G25/.

Once you downloaded a MicroEJ Architecture file, proceed with the following steps to import it in MicroEJ SDK:
« Select File > Import > MicroEJ > Architectures .
« Browse an .xpf file or afolder that contains one or more an . xpf files.

+ Check the |agree and accept the above terms and conditions... box to accept the license.

« Clickon Finish button.

Note: A MicroEJ Architecture can be imported using MicroEJ Module Manager, by adding the following line in a
module description file:

<dependency org="com.microej.architecture.[ISA].[TOOLCHAIN]" name="[UID]" rev="[VERSION]" conf="default
>

<artifact name="[UID]"” m:classifier="[USAGE]" ext="xpf"/>
</dependency>

MicroEJ Platform Configuration

The next step is to create a MicroEJ Platform configuration:

« Select File > New > MicroEJ Platform Project... .

+ Clickon Next button. The Configure Target Architecture page allows to select the MicroEJ Architecture that
contains a minimal MicroEJ Platform and a set of compatible modules targeting a processor architecture and
a compilation toolchain. This environment can be changed later.

- Clickon Browse... button to select one of the installed MicroEJ Architecture.

- Check the Create from a platform reference implementation box to use one of the available imple-

mentation. Uncheck it if you want to provide your own implementation or if no reference implementa-
tion is available.

+ Click on Next button. The Configure platform properties page contains the identification of the
MicroEJ Platform to create. Most fields are mandatory, you should therefore set them. Note that their values
can be modified later on.

+ Click on Finish button. A new project [device]-[name]-[toolchain] is being created containing a
[name].platform file. The Platform Editor shall then open.

« Install Platform Configuration Additions. Files within the content folder have to be copied to
the configuration project folder, by following instructions described at https://github.com/MicroEJ/
PlatformQualificationTools/blob/master/framework/platform/README.rst.

You should get a MicroEJ Platform configuration project that looks like:
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v = mydevice-myplatform-mytoolchain
v = bsp
bsp.properties
w [= dropins
w [ scripts
w [ init-bsp
| initacml
| deploylnBSP.xml
=| deployToclB5PRun.microgjTool
s fulllink.microgjLaunch
fulllink.microgjLaunch.properties
| £ workbenchExtension_launchScriptFramework,jar
¥| .project
| configurationxml
X myplatform.platform

Fig. 8: MicroEJ Platform Configuration Project Skeleton

Groups [ Modules Selection
From the Platform Editor, select the Content tab to access the Platform modules selection. Modules can be se-
lected/deselected from the Modules frame.

Modules are organized into groups. When a group is selected, by default, all its modules are selected. To view the
modules making up a group, click on the Show/Hide modules icon on the top-right of the frame. This will let you
select/deselect on a per module basis. Note that individual module selection is not recommended.

The description and contents of an item (group or module) are displayed beside the list on item selection.

All the checked modules will be installed in the Platform.
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Fig. 9: MicroEJ Platform Configuration Modules Selection

Modules Customization
Each selected module can be customized by creating a [module] folder named after the module beside the [name].
platform definition. It may contain:

« An optional [module].properties file named after the module name. These properties will be injected in the
execution context prefixed by the module name. Some properties might be needed for the configuration of
some modules. Please refer to the modules documentation for more information.

« Optional module specific files and folders.

Modifying one of these files requires to build the Platform again.

Platform Customization

Platforms can be customized by creating a configuration.xml Ant file beside the [name].platform file. This
Ant script can extend one or several of the extension points available. By default, you should not have to change
the default configuration script.

Here is a template fora configuration.xml Ant file:
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<?xml version="1.0" encoding="UTF-8"?>
<project name="configuration">

<!--
Define "project.dir” property that references the directory
where this file is located.

-—>

<dirname property="project.dir” file="${ant.file.configuration}"/>

</project>

Configuration project (the project which contains the [name].platform file) can contain an optional dropins
folder. The contents of this folder will be copied integrally into the final Platform. This feature allows to add some
additional libraries, tools etc. into the Platform.

The dropins folder organization should respect the final Platform files and folders organization. For instance, the
tools are located in the sub-folder tools. Launch a Platform build without the dropins folder to see how the
Platform files and folders organization is. Then fill the dropins folder with additional features and build again the
Platform to obtain an advanced Platform.

The dropins folder files are kept in priority. If one file has the same path and name as another file already installed
into the Platform, the dropins folder file will be kept.

Modifying one of these files requires to build the Platform again.

BSP Connection

Principle

Using a MicroEJ Platform, the user can compile a MicroEJ Application on that Platform. The result of this compila-
tionisa microejapp.o file.

This file has to be linked with the MicroEJ Platform runtime file (microejruntime.a) and a third-party C project,
called the Board Support Package (BSP) , to obtain the final binary file (MicroEJ Firmware). For more information,
please consult the MicroEJ build process overview.

The BSP connection can be configured by defining 4 folders where the following files are located:
« MicroEJ Application file (microejapp.o).
« MicroEJ Platform runtime file (microejruntime. a, also available in the Platform 1ib folder).
« MicroEJ Platform header files ( . h, also available in the Platform include folder).
« BSP project build script file (build.bat or build.sh).

Once the MicroEJ Application file ( microejapp.o ) is built, the files are then copied to these locations and the
build.bat or build.sh fileis executed to produce the final executable file (application.out).

Note: The final build stage to produce the executable file can be done outside of MicroEJ SDK, and thus the BSP
connection configuration is optional.

BSP connection configuration is only required in the following cases:
« Use MicroEJ SDK to produce the final executable file of a Mono-Sandbox Firmware (recommended).
« Use MicroEJ SDK to run a MicroEJ Testsuite on device.

« Build a Multi-Sandbox Firmware.
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MicroEJ provides a flexible way to configure the BSP connection to target any kind of projects, teams organizations
and company build flows. To achieve this, the BSP connection can be configured either at MicroEJ Platform level
or at MicroEJ Application level (or a mix of both).

The 3 most common integration cases are:
+ Case 1: No BSP connection
The MicroEJ Platform does not know the BSP at all.

BSP connection can be configured when building the MicroEJ Application (absolute locations).

C application

MicroEJ code and Board

. MicroEJ Platform
Application code S

BSP absolute locations

MicroEJ Firmware

Fig. 10: MicroEJ Platform with no BSP connection

This case is recommended when:
- the MicroEJ Firmware is built outside MicroEJ SDK.

- the same MicroEJ Platform is intended to be reused on multiple BSP projects which do not share the
same structure.

« Case 2: Partial BSP connection
The MicroEJ Platform knows how the BSP is structured.

BSP connection is configured when building the MicroEJ Platform (relative locations within the BSP), and the
BSP root location is configured when building the MicroEJ Application (absolute directory).

C application

MicrorJ code and Board

MicroEJ Platform

Application code

Support Package

BSP relativie locations
BSP roofidirectory

MicroEJ Firmware

Fig. 11: MicroEJ Platform with partial BSP connection

This case is recommended when:

- the MicroEJ Platform is used to build one MicroEJ Application on top of one BSP.
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- the Application and BSP are slightly coupled, thus making a change in the BSP just require to build the
firmware again.

« Case 3: Full BSP connection
The MicroEJ Platform includes the BSP.

BSP connection is configured when building MicroEJ Platform (relative locations within the BSP), as well as
the BSP root location (absolute directory). No BSP connection configuration is required when building the
MicroEJ Application.

C application
code and Board
Support Package

Micrord MicroEJ Platform

Application code

BSP relative locations
BSP root directory

MicroEJ Firmware

Fig. 12: MicroEJ Platform with full BSP connection

This case is recommended when:
- the MicroEJ Platform is used to build various MicroEJ Applications.
- the MicrokEJ Platform is validated using MicroEJ testsuites.

- the MicroEJ Platform and BSP are delivered as a single standalone module (same versioning), perhaps
subcontracted to a team or a company outside the application project(s).

Options

BSP connection options can be specified as Platform options or as Application options or a mix of both.

The following table describes Platform options, configured in bsp > bsp.properties file of the Platform config-
uration project.

4.2. MicroEJ Platform 210



MicroEJ Documentation, Revision bd708584

Table 1: MicroEJ Platform Options for BSP Connection

Option Description Example
Name
) | The path relative to BSP root.dir where to deploy the Mi- ) )
M1Croejapp croEJ Application file (microejapp.o). MicroEJ/1lib
relative.
dir
The path relative to BSP root.dir where to deploy the Mi-
microejlib eroE Platform runtime file (microejruntime. a). MicroEJ/1lib
relative.
dir
The path relative to BSP root.dir where to deploy the Mi-
microejint ¢roE) Platform headerfiles (*.h). MicrokJ/inc
relative.
dir
] | Thepathrelativeto BSP root.dir whereto execute the BSP . ]
microejsciyiitd script file (build.bat or build.sh). Project/MicrotJ
relative.
dir
The 3rd-party BSP project absolute directory, to be included )
root. to the Platform. c:\\Users\\user\\mybsp onWin-
dir dows systems or /home/user/bsp
on Unix systems.

The following table describes Application options, configured as regular MicroEJ Application Options.

Table 2: MicroEJ Application Options for BSP Connection

Option Name Description

Deploy the MicroEJ Application file (microejapp. o) to the location defined by the Platform
deploy.bsp. (defaults to true when Platform option microejapp.relative.dir isset).
microejapp

Deploy the MicroEJ Platform runtime file ( microejruntime.a ) to the location defined by
deploy.bsp. the Platform (defaults to true when Platform option microejlib.relative.dir is set).
microejlib

Deploy the MicroEJ Platform header files ( *.h ) to the location defined by the Platform (de-
deploy.bsp. faults to true when Platform option microejinc.relative.dir isset).
microejinc

Execute the BSP build script file (build.bat or build.sh) present at the location defined
dgploy ..bsp: by the Platform. (defaults to false and requires microejscript.relative.dir Platform
microejscript | gption to be set).

The 3rd-party BSP project absolute directory. This option is required if at least one the 4
deploé’ -bsp. options described above is set to true and the Platform does not includes the BSP.
root.dir

) Deploy the MicroEJ Application file ( microejapp.o ) to this absolute directory. An empty
deploy.dir. value means no deployment.
microejapp

) Deploy the MicroEJ Platform runtime file (microejruntime.a)to this absolute directory. An
deploy.dir. empty value means no deployment.
microejlib

) Deploy the MicroEJ Platform header files ( *.h ) to this absolute directory. An empty value
deploy.dir. means no deployment.
microejinc

Execute the BSP build scriptfile (build.bat or build.sh) presentin this absolute directory.
deploy.bsp. An empty value means no deployment.
microejscript
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Note: Itisalso possible to configure the BSP root directory using the build option named toolchain.dir,instead
of the application option deploy.bsp.root.dir . This allow to configure a MicroEJ Firmware by specifying both
the Platform (using the target.platform.dir option) and the BSP at build level, without having to modify the
application options files.

For each Platform BSP connection case, here is a summary of the options to set:

No BSP connection, executable file built outside MicroEJ SDK

Platform Options:
[NONE]

Application Options:
[NONE]

No BSP connection, executable file built using MicroEJ SDK

Platform Options:
[NONE]

Application Options:
deploy.dir.microejapp=[absolute_path]
deploy.dir.microejlib=[absolute_path]
deploy.dir.microejinc=[absolute_path]
deploy.bsp.microejscript=[absolute_path]

Partial BSP connection, executable file built outside MicroEJ SDK

Platform Options:
microejapp.relative.dir=[relative_path]
microejlib.relative.dir=[relative_path]
microejinc.relative.dir=[relative_path]

Application Options:
deploy.bsp.root.dir=[absolute_path]

Partial BSP connection, executable file built using MicroEJ SDK

Platform Options:
microejapp.relative.dir=[relative_path]
microejlib.relative.dir=[relative_path]
microejinc.relative.dir=[relative_path]
microejscript.relative.dir=[relative_path]

Application Options:
deploy.bsp.root.dir=[absolute_path]
deploy.bsp.microejscript=true

Full BSP connection, executable file built using MicroEJ SDK

Platform Options:
microejapp.relative.dir=[relative_path]
microejlib.relative.dir=[relative_path]
microejinc.relative.dir=[relative_path]
microejscript.relative.dir=[relative_path]
root.dir=[absolute_path]

(continues on next page)
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(continued from previous page)

Application Options:
deploy.bsp.microejscript=true

Build Script File

The BSP build script file is responsible to invoke the third-party C toolchain (compiler and linker) to produce the
final executable file (application.out)

The build script must implement the following specification:
« On Windows operating system, it is a Windows batch file named build.bat.

« On Mac OS X or Linux operating systems, it is a shell script named build.sh, with execution permission
enabled.

« On build error, the script must end with a non zero exit code.
« Onsuccess

- The executable must be copied to the file application.out in the folder from where the script has
been executed.

- The script must end with zero exit code.

Many build script templates are available for most commonly used C toolchains in the Platform Qualification Tools
repository.

Low Level APIs Implementation Files

Some MicroEJ Architecture modules require some additional information about the BSP implementation of Low
Level APIs.

This information must be stored in each module’s configuration folder, in a file named bsp.xml .

This file must start with the node <bsp>. It can contain several lines like this one: <nativeName="A_LLAPI_NAME"
nativeImplementation name="AN_IMPLEMENTATION_NAME"/> where:

o A_LLAPI_NAME refersto a Low Level APl native name. It is specific to the MicroEJ C library which provides the
Low Level API.

+ AN_IMPLEMENTATION_NAME refers to the implementation name of the Low Level APL. It is specific to the BSP;
and more specifically, to the C file which does the link between the MicroEJ C library and the C driver.

Example:

<bsp>
<nativeImplementation name="COMM_DRIVER" nativeName="LLCOMM_BUFFERED_CONNECTION"/>
</bsp>

These files will be converted into an internal format during the MicroEJ Platform build.

MicroEJ Platform Build

To build the MicroEJ Platform, click on the Build Platform link on the Platform configuration Overview tab.
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It will create a MicroEJ Platform in the workspace available for the MicroEJ Application project to run on. The
MicroEJ Platform will be available in: Window > Preferences > MicroEJ > Platformsin workspace .

4.2.4 Platform Qualification

Introduction
Platform Qualification is the process of validating implementations of Low Level APIs provided by a Platform con-
nected to a custom Board Support Package.
Such validation is performed by running tests at two-levels:
« In C, by calling Low Level APIs (usually manually).

« In Java, by calling Foundation Library APIs (usually automatically using Platform Testsuite).

MicroEJ provides a set of tools and pre-defined projects aimed at simplifying the steps for validating Platforms.
Please refer to https://github.com/MicroEJ/PlatformQualificationTools.

Platform Testsuite
The purpose of a MicroEJ Platform Testsuite is to validate an implementation of a Low Level API by automatically
running Java tests on the device.
The Testsuite Engine is used for building, running a Testsuite, and providing a report.
A Platform Testsuite contains one or more tests. For each test, the Testsuite Engine will:
1. Build a MicroEJ Firmware for the test.
. Program the MicroEJ Firmware onto the device.
. Retrieve the execution traces.

2
3
4. Analyze the traces to determine whether the test has PASSED or FAILED.
5. Append the result to the Test Report.

6

. Repeat until all tests of the Testsuite have been executed.
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Fig. 13: Platform Testsuite on Device Overview

4.3 MicroEJ Core Engine

The MicroEJ Core Engine (also called the platform engine) and its components represent the core of the platform.
It is used to compile and execute at runtime the MicroEJ Application code.

4.3.1 Functional Description

The following diagram shows the overall process. The first two steps are performed within the MicroEJ Workbench.
The remaining steps are performed within the C IDE.
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Fig. 14: MicroEJ Core Engine Flow

1. Step1consists in writing a MicroEJ Application against a set of Foundation Libraries available in the platform.

2. Step 2 consists in compiling the MicroEJ Application code and the required libraries in an ELF library, using
the SOAR.

3. Step 3 consistsin linking the previous ELF file with the MicroEJ Core Engine library and a third-party BSP (OS,
drivers, etc.). This step may require a third-party linker provided by a C toolchain.

4.3.2 Architecture

The MicroEJ Core Engine and its components have been compiled for one specific CPU architecture and for use
with a specific C compiler.

The architecture of the platform engine is called green thread architecture, it runs in a single RTOS task. Its be-
havior consists in scheduling MicroEJ threads. The scheduler implements a priority preemptive scheduling policy
with round robin for the MicroEJ threads with the same priority. In the following explanations the term “RTOS
task” refers to the tasks scheduled by the underlying OS; and the term “MicroEJ thread” refers to the Java threads
scheduled by the MicroEJ Core Engine.
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Fig. 15: A Green Threads Architecture Example

The activity of the platform is defined by the MicroEJ Application. When the MicroEJ Application is blocked (when
all MicroEJ threads are sleeping), the platform sleeps entirely: The RTOS task that runs the platform sleeps.

The platform is responsible for providing the time to the MicroEJ world: the precision is 1 millisecond.

4.3.3 Capabilities

MicroEJ Core Engine defines 3 exclusive capabilities:
« Mono-sandbox : capability to produce a monolithic firmware (default one).

« Multi-Sandbox : capability to produce a extensible firmware on which new applications can be dynamically
installed. See section Multi-Sandbox.

« Tiny application : capability to produce a compacted firmware (optimized for size). See section Tiny applica-
tion.
All MicroEJ Core Engine capabilities may not be available on all architectures. Refer to section Supported MicroEJ
Core Engine Capabilities by Architecture Matrix for more details.

4.3.4 Implementation

The platform implements the [SNI] specification. It is created and initialized with the C function SNI_createVM
. Then it is started and executed in the current RTOS task by calling SNI_startVM. The function SNI_startVM
returns when the MicroEJ Application exits. The function SNI_destroyVM handles the platform termination.

The file LLMJVM_impl.h that comes with the platform defines the API to be implemented. The file LLMJVM.h that
comes with the platform defines platform-specific exit code constants. (See LLMJVM: MicroEJ Core Engine.)
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Initialization

The Low Level MicroEJ Core Engine API deals with two objects: the structure that represents the platform, and the
RTOS task that runs the platform. Two callbacks allow engineers to interact with the initialization of both objects:

o LLMJVM_IMPL_initialize: Called once the structure representing the platform is initialized.

o LLMJVM_IMPL_vmTaskStarted : Called when the platform starts its execution. This function is called within
the RTOS task of the platform.

Scheduling

To support the green thread round-robin policy, the platform assumes there isan RTOS timer or some other mecha-
nism that counts (down) and fires a call-back when it reaches a specified value. The platform initializes the timer us-
ing the LLMJVM_IMPL_scheduleRequest function with one argument: the absolute time at which the timer should
fire. When the timer fires, it must call the LLMJVM_schedule function, which tells the platform to execute a green
thread context switch (which gives another MicroEJ thread a chance to run).

Idle Mode

When the platform has no activity to execute, it calls the LLMJVM_IMPL_idleVM function, which is assumed to put
the RTOS task of the platform into a sleep state. LLMJVM_IMPL_wakeupVM is called to wake up the platform task.
When the platform task really starts to execute again, it calls the LLMJVM_IMPL _ackWakeup function to acknowledge
the restart of its activity.

Time

The platform defines two times:

« the application time: The difference, measured in milliseconds, between the current time and midnight, Jan-
uary 1,1970, UTC.

« the system time: The time since the start of the device. This time is independent of any user considerations,
and cannot be set.

The platform relies on the following C functions to provide those times to the MicroEJ world:

o LLMJVM_IMPL_getCurrentTime : Depending on the parameter ( true / false ) must return the application
time or the system time. This function is called by the MicroEJ method System.currentTimeMillis(). Itis
also used by the platform scheduler, and should be implemented efficiently.

o LLMJVM_IMPL_getTimeNanos : must return the system time in nanoseconds.

o LLMJVM_IMPL_setApplicationTime : must set the difference between the current time and midnight, Jan-
uary 1,1970, UTC.

Example

The following example shows how to create and launch the MicroEJ Core Engine from the C world. This function (
mjvm_main ) should be called from a dedicated RTOS task.

#include <stdio.h>
#include "mjvm_main.h"
#include "LLMJVM.h"
#include "sni.h"”
(continues on next page)
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void mjvm_main(void)

(continued from previous page)

{
void* vm;
int32_t err;
int32_t exitcode;
// create VM
vm = SNI_createVM();
if(vm == NULL)
{
printf("VM initialization error.\n");
}
else
{
printf(”VM START\n");
err = SNI_startVM(vm, 0, NULL);
if(err < 0)
{
// Error occurred
if(err == LLMJVM_E_EVAL_LIMIT)
{
printf("Evaluation limits reached.\n");
3
else
{
printf("VM execution error (err = %d).\n", err);
}
}
else
{
// VM execution ends normally
exitcode = SNI_getExitCode(vm);
printf("VM END (exit code = %d)\n", exitcode);
}
// delete VM
SNI_destroyVM(vm);
3
3
Debugging

Theinternal MicroEJ Core Engine function called LLMJVM_dump allows you to dump the state of all MicroEJ threads:
name, priority, stack trace, etc. This function can be called at any time and from an interrupt routine (for instance
from a button interrupt).

This is an example of a dump:

s WY Dump SESSSsSSssss

Java Thread[3]

(continues on next page)
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name="SYSINpmp" prio=5 state=WAITING

java/lang/Thread:

(continued from previous page)

at com/is2t/microbsp/microui/natives/NSystemInputPump.@134261800

[0x0800AC32]

at com/is2t/microbsp/microui/io/SystemInputPump.@134265968

[0x0800BC80]
at ej/microui/Pump.@134261696
[0x0@800ABCC]
at ej/microui/Pump.@134265872
[0x0800BC24]
at java/lang/Thread.@134273964
[0x0800DBC4]
at java/lang/Thread.@134273784
[0x0800DB04]
at java/lang/Thread.@134273892
[0x0800DB6F ]
Java Thread[2]
name="DISPLpmp"” prio=5 state=WAITING

java/lang/Thread:

at java/lang/Object.@134256392
[0x08009719]

at ej/microui/FIFOPump.@134259824
[0x0800A48E]

at ej/microui/io/DisplayPump.134263016
[0x0800B0OF8]

at ej/microui/Pump.@134261696
[0x0800ABCC]

at ej/microui/Pump.@134265872
[0x0800BC24]

at ej/microui/io/DisplayPump.@134262868
[0x0800B064]

at java/lang/Thread.@134273964
[0x0800DBC4]

at java/lang/Thread.@134273784
[0x0800DB04]

at java/lang/Thread.@134273892
[0x0800DB6F ]

See Stack Trace Reader for additional info related to working with VM dumps.

4.3.5 Generic Output

The System.err stream is connected to the System.out print stream. See below for how to configure the desti-

nation of these streams.

4.3.6 Link

Several sections are defined by the MicroEJ Core Engine. Each section must be linked by the third-party linker.
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Table 3: Linker Sections

Section name Aim Location Alignment (in bytes)
) Resident applications statics RW 4
.bss.features.installed
Application static RW 8
.bss.soar PP
) Application threads stack blocks RW 8
.bss.vm.stacks. java
ICETEA_HEAP MicroEJ Core Engine internal heap Internal RW | 8
Application hea RW 4
_Jjava_heap PP P
Application immortal hea RW 4
_java_immortals PP P
Application resources RO 16
.rodata.resources
Resident applications code and resources | RO 4
.rodata.soar.features
Shielded Plug data RO 4
.shieldedplug &
Ctext soar Application and library code RO 16

Note: Sections ICETEA_HEAP, _java_heap and _java_immortals are zero-initialized at MicroEJ Core Engine
startup.

4.3.7 Dependencies

The MicroEJ Core Engine requires an implementation of its low level APIs in order to run. Refer to the chapter
Implementation for more information.

4.3.8 Installation

The MicroEJ Core Engine and its components are mandatory. In the platform configuration file, check
Multi Applications to install the MicroEJ Core Engine in “Multi-Sandbox” mode. Otherwise, the “Single appli-
cation” mode is installed.

4.3.9 Use

The EDC API Module must be added to the module.ivy of the MicroEJ Application Project. This MicroEJ module is
always required in the build path of a MicroEJ project; and all others libraries depend on it. This library provides a
set of options. Refer to the chapter Application Options which lists all available options.

<dependency org="ej.api"” name="edc" rev="1.3.3"/>

The BON API Module must also be added to the module.ivy of the MicroEJ Application project in order to access the
[BON] library.

<dependency org="ej.api” name="bon" rev="1.4.0"/>
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4.4 Multi-Sandbox

4.4.1 Principle
The Multi-Sandbox capability of the MicroEJ Core Engine allows a main application (called Standalone Application)
to install and execute at runtime additional applications (called sandboxed applications).

The MicroEJ Core Engine implements the [KF] specification. A Kernel is a Standalone Application generated on a
Multi-Sandbox-enabled platform. A Feature is a sandboxed application generated against a Kernel.

A sandboxed application may be dynamically downloaded at runtime or integrated at build-time within the exe-
cutable application.

Note that the Multi-Sandbox is a capability of the MicroEJ Core Engine. The MicroEJ Simulator always runs an
application as a Standalone Application.

4.4.2 Functional Description

The Multi-Sandbox process extends the overall process described in the overview of the platform process.

MicroEJ

Application code

4. Build the MicroEJ
Application

MicroEJ Platform

Binary

application
(application fo)

6. Program and test the
application on the
board

5. Build and link the full
application

Fig. 16: Multi-Sandbox Process

Once a Kernel has been generated, additional MicroEJ Application code (Feature) can be built against the Kernel
by :

« Creating one launch configuration per feature.
+ Setting the  Settings field in the Execution tab of each feature launch configuration to

Build Dynamic Feature .

+ Settingthe Kernel fieldinthe Configuration tab of each feature launch configuration tothe ... .
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using the MicroEJ Application launch named Build Dynamic Feature. The binary application file produced (
application.fo)is compatible only for the Kernel on which it was generated. Generating a new Kernel requires
that you generate the Features again on this Kernel.

The Features built can be deployed in the following ways:

« Downloaded and installed at runtime by software. Refer to the [KF] specification for ej.kf.Kernel install
APls.

« Linked at build-time into the executable application. Features linked this way are then called Installed Fea-
tures. The Kernel should have been generated with options for dimensioning the maximum size (code, data)
for such Installed Features. Features are linked within the Kernel using the Firmware linker tool.

4.4.3 Firmware Linker

A MicroEJ tool is available to link Features as Installed Features within the executable application. The tool name
is Firmware Linker. It takes as input the executable application file and the Feature binary code into which to be
linked. It outputs a new executable application file, including the Installed Feature. This tool can be used to append
multiple Features, by setting as the input file the output file of the previous pass.

4.4.4 Memory Considerations

Multi-Sandbox memory overhead of MicroEJ Core Engine runtime elements are described in the table below.

Table 4: Multi-Sandbox Memory Overhead

Runtime element | Memory | Description
Object RW 4 bytes
Thread RW 24 bytes
Stack Frame RW 8 bytes
Class Type RO 4 bytes
Interface Type RO 8 bytes

4.4.5 Dependencies

o LLKERNEL_impl.h implementation (see LLKERNEL: Multi-Sandbox).

4.4.6 Installation

Multi-Sandbox is an additional module, disabled by default.

To enable Multi-Sandbox of the MicroEJ Core Engine, in the platform configuration file, check Multi Applications

4.4.7 Use

The KF APl Module must be added to the module.ivy of the MicroEJ Application project in order to allow access to
[KF] library.

<dependency org="ej.api"” name="kf" rev="1.4.4"/>

This library provides a set of options. Refer to the chapter Application Options which lists all available options.
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4.5 Tiny application

4.5.1 Principle

The Tiny application capability of the MicroEJ Core Engine allows to build a main application optimized for size.
This capability is suitable for environments requiring a small memory footprint.

4.5.2 Installation

Tiny application is an option disabled by default. To enable Tiny application of the MicroEJ Core Engine, set the
property mjvm.standalone.configuration in configuration.xml file as follows:

<property name="mjvm.standalone.configuration” value="tiny"/>

See section Platform Customization for more info on the configuration.xml file.

4.5.3 Limitations

In addition to general Limitations:

« The maximum application code size (classes and methods) cannot exceed 256KB . This does not include
application resources, immutable objects and internal strings which are not limited.

« The option SOAR > Debug > Embed alltype names has no effect. Only the fully qualified names of
types marked as required types are embedded.

4.6 Native Interface Mechanisms

The MicroEJ Core Engine provides two ways to link MicroEJ Application code with native C code. The two ways are
fully complementary, and can be used at the same time.

4.6.1 Simple Native Interface (SNI)

Principle

[SNI] provides a simple mechanism for implementing native Java methods in the C language.
[SNI] allows you to:
« Call a C function from a Java method.

« Access an Immortal array in a C function (see the [BON] specification to learn about immortal objects).

[SNI] does not allow you to:
« Access or create a Java object in a C function.
« Access Java static variablesin a C function.
« Call Java methods from a C function.

[SNI] provides some Java APIs to manipulate some data arrays between Java and the native (C) world.
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Functional Description

[SNI] defines how to cross the barrier between the Java world and the native world:
« Call a Cfunction from Java.
« Pass parameters to the C function.
+ Return a value from the C world to the Java world.

« Manipulate (read & write) shared memory both in Java and C : the immortal space.

Java WOFId Java methods C functions Cwo r[d
Java C
objects structs
access access

Java Object

Java memory C memory

Array of basetypes

Immortal memory

Fig.17: [SNI] Processing

The above illustration shows both Java and C code accesses to shared objects in the immortal space, while also
accessing their respective memory.

Example

package example;

(continues on next page)
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(continued from previous page)

import java.io.IOException;

VEZ

* Abstract class providing a native method to access sensor value.
* This method will be executed out of virtual machine.

*/

public abstract class Sensor {

public static final int ERROR = -1;

public int getValue() throws IOException {
int sensorID = getSensorID();
int value = getSensorValue(sensorlID);
if (value == ERROR) {
throw new IOException("Unsupported sensor”);

}
return value;
}
protected abstract int getSensorID();

public static native int getSensorValue(int sensorlID);

3

class Potentiometer extends Sensor {

protected int getSensorID() {
return Constants.POTENTIOMETER_ID; // POTENTIOMETER_ID is a static final

// File providing an implementation of native method using a C function
#include <sni.h>
#include <potentiometer.h>

#define SENSOR_ERROR (-1)
#define POTENTIOMETER_ID (3)

jint Java_example_Sensor_getSensorValue(jint sensor_id){

if (sensor_id == POTENTIOMETER_ID)

{
return get_potentiometer_value();
}
return SENSOR_ERROR;
3
Synchronization

A call to a native function uses the same RTOS task as the RTOS task used to run all Java green threads. So during
this call, the MicroEJ Core Engine cannot schedule other Java threads.

[SNI] defines C functions that provide controls for the green threads’ activities:

o int32_t SNI_suspendCurrentJavaThread(int64_t timeout) : Suspends the execution of the Java thread
thatinitiated the current C call. This function does not block the C execution. The suspension is effective only
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at the end of the native method call (when the C call returns). The green thread is suspended until either an
RTOS task calls SNI_resumeJavaThread, or the specified number of milliseconds has elapsed.

e int32_t SNI_getCurrentJavaThreadID(void) : Permits retrieval of the ID of the current Java thread within
the C function (assuming it is a “native Java to C call”). This ID must be given to the SNI_resumeJavaThread
function in order to resume execution of the green thread.

o int32_t SNI_resumeJavaThread(int32_t id) : Resumes the green thread with the given ID. If the thread
is not suspended, the resume stays pending.

T peaiy3 usaln
T peaiy3 usalin
€ peaiy3 usalg

SNI_getCurrentlavaThreadID() : 3

sy

SNI_suspendCurrentJavaThread(..)

SNI_resumelavaThread(3)

The Java Another C
RTOS task RTOS task

Fig. 18: Green Threads and RTOS Task Synchronization

The above illustration shows a green thread (GT3) which has called a native method that executes in C. The C code

suspends the thread after having provisioned its ID (e.g. 3). Another RTOS task may later resume the Java green
thread.

Dependencies

No dependency.

Installation

The [SN/] library is a built-in feature of the platform, so there is no additional dependency to call native code from

Java. In the platform configuration file, check Javato CInterface > SNIAPI to install the additional Java APIs
in order to manipulate the data arrays.

Use

The SNI APl module must be added to the module.ivy of the MicroEJ Application project, in order to allow access
to the [SN/] library.

4.6. Native Interface Mechanisms 227


https://repository.microej.com/artifacts/ej/api/sni/

MicroEJ Documentation, Revision bd708584

<dependency org="ej.api” name="sni" rev="1.3.1"/>

4.6.2 Shielded Plug (SP)
Principle

The Shielded Plug [SP] provides data segregation with a clear publish-subscribe API. The data-sharing between
modules uses the concept of shared memory blocks, with introspection. The database is made of blocks: chunks
of RAM.

Module 1 ) Module 2
ShieldedPlug (written in

Database JavaorC)

(written in
JavaorC)

Fig. 19: A Shielded Plug Between Two Application (Java/C) Modules.

Functional Description

The usage of the Shielded Plug (SP) starts with the definition of a database. The implementation of the [SP] for the
MicroEJ Platform uses an XML file description to describe the database; the syntax follows the one proposed by the

[SP] specification.

Once this database is defined, it can be accessed within the MicroEJ Application or the C application. The [SP]
Foundation Library is accessible from the [SP] APl Module. This library contains the classes and methods to read
and write data in the database. See also the Java documentation from the MicroEJ Workbench resources center
(“Javadoc” menu). The C header file sp.h available in the MicrokJ Platform source/MICROJVM/include folder
contains the C functions for accessing the database.

To embed the /SP] database in your binary file, the XML file description must be processed by the [SP] compiler. This
compiler generates a binary file ( .o ) that will be linked to the overall application by the linker. It also generates
two descriptions of the block ID constants, one in Java and one in C. These constants can be used by either the Java
or the C application modules.

Shielded Plug Compiler

A MicroEJ tool is available to launch the [SP] compiler tool. The tool name is Shielded Plug Compiler. It outputs:

« Adescription of the requested resources of the database as a binary file ( . 0 ) that will be linked to the over-
all application by the linker. It is an ELF format description that reserves both the necessary RAM and the
necessary Flash memory for the Shielded Plug database.

« Twodescriptions,onein Javaandonein C, of the block ID constants to be used by either Java or Capplication
modules.
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SPfile SP ShieldedPlug

(-xml) Compiler Database
MicroEJ User
classpath Application
(*.class)

Fig. 20: Shielded Plug Compiler Process Overview

Example

Below is an example of using a database [SP]. The code that publishes the data is written in C, and the code that
receives the data is written in Java. The data is transferred using two memory blocks. TEMP is a scalar value,
THERMOSTAT is a boolean.

Database Description

The database is described as follows:

<shieldedPlug>
<database name="Forecast” id="0" immutable="true" version="1.0.0">
<block id="1" name="TEMP" length="4" maxTasks="1"/>
<block id="2" name="THERMOSTAT" length="4" maxTasks="1"/>
</database>
</shieldedPlug>

Java Code

From the database description we can create an interface.

public interface Forecast {
public static final int ID = 0;
public static final int TEMP = 1;
public static final int THERMOSTAT = 2;

Below is the task that reads the published temperature and controls the thermostat.

public void run(){
ShieldedPlug database = ShieldedPlug.getDatabase(Forecast.ID);
while (isRunning) {
//reading the temperature every 30 seconds
//and update thermostat status
try {
int temp = database.readInt(Forecast.TEMP);
print(temp);
//update the thermostat status
(continues on next page)
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database.writeInt(Forecast.THERMOSTAT, temp>tempLimit ? 0 :

3
catch(EmptyBlockException e){
print("Temperature not available");

}
sleep(30000);

C Code

(continued from previous page)

15

Here is a C header that declares the constants defined in the XML description of the database.

#define Forecast_ID @
#define Forecast_TEMP 1
#define Forecast_THERMOSTAT 2

Below, the code shows the publication of the temperature and thermostat controller task.

void temperaturePublication() {
ShieldedPlug database = SP_getDatabase(Forecast_ID);
int32_t temp = temperature();
SP_write(database, Forecast_TEMP, &temp);

3

void thermostatTask(){
int32_t thermostatOrder;
ShieldedPlug database = SP_getDatabase(Forecast_ID);
while(1){
SP_waitFor(database, Forecast_THERMOSTAT);
SP_read(database, Forecast_THERMOSTAT, &thermostatOrder);
if(thermostatOrder == 0) {
thermostatOFF();
3
else {
thermostatON();

}

Dependencies

« LLSP_impl.h implementation (see LLSP: Shielded Plug).

Installation

The[SP] library and its relative tools are an optional feature of the platform. In the platform configuration file, check
Java to C Interface > Shielded Plug to install the library and its relative tools.
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Use

The Shielded Plug API Module must be added to the module.ivy of the MicroEJ Application project in order to allow
access to the [SP] library.

<dependency org="ej.api"” name="sp" rev="2.0.2"/>

This library provides a set of options. Refer to the chapter Application Options which lists all available options.

4.6.3 MicroEJ Java H
Principle
This MicroEJ tool is useful for creating the skeleton of a C file, to which some Java native implementation func-

tions will later be written. This tool helps prevent misses of some #include files, and helps ensure that function
signatures are correct.

Functional Description

MicroEJ Java H tool takes as input one or several Java class files (*.class) from directories and / or JAR files. It looks
for Java native methods declared in these class files, and generates a skeleton(s) of the C file(s).

*.class

Fig. 21: MicroEJ Java H Process

Dependencies

No dependency.

Installation

This is an additional tool. In the platform configuration file, check Javato CInterface > MicroEJJavaH to
install the tool.

Use

This chapter explains the MicroEJ tool options.
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4.7 External Resources Loader

4.7.1 Principle

A resource is, for a MicroEJ Application, the contents of a file. This file is known by its path (its relative path from
the MicroEJ Application classpath) and its name. The file may be stored in RAM, flash, or external flash; and it is the
responsibility of the MicroEJ Core Engine and/or the BSP to retrieve and load it.

MicroEJ Platform makes the distinction between two kinds of resources:

« Internal resource: The resource is taken into consideration during the MicroEJ Application build. The SOAR
step loads the resource and copies it into the same C library as the MicroEJ Application. Like the MicroEJ Ap-
plication, the resourceis linked into the CPU address space range (internal device memories, external parallel
memories, etc.).

The available list of internal resources to embed must be specified in the MicroEJ Application launcher (Mi-
croEJ launch). Under the “Resources” tab, select all internal resources to embed in the final binary file.

« External resource: The resource is not taken into consideration by MicroEJ. It is the responsibility of the BSP
project to manage this kind of resource. The resource is often programmed outside the CPU address space
range (storage media like SD card, serial NOR flash, EEPROM, etc.).

The BSP must implement some specific Low Level API (LLAPI) C functions: LLEXT_RES_impl.h. These func-
tions allow the MicroEJ Application to load some external resources.

4.7.2 Functional Description

The External Resources Loader is an optional module. When not installed, only internal resources are available
for the MicroEJ Application. When the External Resources Loader is installed, the MicroEJ Core Engine tries first to
retrieve the expected resource from its available list of internal resources, before asking the BSP to load it (using
LLEXT_RES_impl.h functions).

4.7.3 Implementations

External Resources Loader module provides some Low Level API (LLEXT_RES) to let the BSP manage the external
resources.

Open a Resource

The LLAPI to implement in the BSP are listed in the header file LLEXT_RES_impl.h. First, the framework tries to
open an external resource using the open function. This function receives the resources path as a parameter. This
path is the absolute path of the resource from the MicroEJ Application classpath (the MicroEJ Application source
base directory). For example, when the resource is located here: com.mycompany.myapplication.resource.
MyResource. txt ,the given pathis: com/mycompany/myapplication/resource/MyResource. txt.

Resource Identifier

This open function has to return a unique ID (positive value) for the external resource, or returns an error code
(negative value). This ID will be used by the framework to manipulate the resource (read, seek, close, etc.).

Several resources can be opened at the same time. The BSP does not have to return the same identifier for two
resources living at the same time. However, it can return this ID for a new resource as soon as the old resource is
closed.
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Resource Offset

The BSP must hold an offset for each opened resource. This offset must be updated after each call to read and
seek.

Resource Inside the CPU Address Space Range

An external resource can be programmed inside the CPU address space range. This memory (or a part of memory)
is not managed by the SOAR and so the resources inside are considered as external.

Most of time the content of an external resource must be copied in a memory inside the CPU address space range
in order to be accessible by the MicroEJ algorithms (draw an image etc.). However, when the resource is already
inside the CPU address space range, this copy is useless. The function LLEXT_RES_getBaseAddress must return
a valid CPU memory address in order to avoid this copy. The MicroEJ algorithms are able to target the external
resource bytes without using the other LLEXT_RES APIs such as read, mark etc.

4.7.4 External Resources Folder
The External Resource Loader module provides an option (MicroEJ launcher option) to specify a folder for the ex-
ternal resources. This folder has two roles:

« Itis the output folder used by some extra generators during the MicroEJ Application build. All output files
generated by these tools will be copied into this folder. This makes it easier to retrieve the exhaustive list of
resources to program on the board.

« Thisfolderistakeninto consideration by the Simulatorin order to simulate the availability of these resources.
When the resources are located in another computer folder, the Simulator is not able to load them.

If not specified, this folder is created (if it does not already exist) in the MicroEJ project specified in the MicroEJ
launcher. Its name is externalResources.

4.7.5 Dependencies

o LLEXT_RES_impl.h implementation (see LLEXT RES: External Resources Loader).

4.7.6 Installation

The External Resources Loader is an additional module. In the platform configuration file, check
External Resources Loader to install this module.

4.7.7 Use

The External Resources Loader is automatically used when the MicroEJ Application tries to open an external re-
source.

4.8 Serial Communications

MicroEJ provides some Foundation Libraries to instantiate some communications with external devices. Each com-
munication method has its own library. A global library called ECOM provides support for abstract communication
streams (communication framework only), and a generic devices manager.
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4.8.1 ECOM

Principle

The Embedded COMmunication Foundation Library (ECOM) is a generic communication library with abstract com-
munication stream support (a communication framework only). It allows you to open and use streams on commu-
nication devices such as a COMM port.

Thislibrary also provides a device manager, including a generic device registry and a notification mechanism, which
allows plug&play-based applications.

This library does not provide APIs to manipulate some specific options for each communication method, but it
does provide some generic APIs which abstract the communication method. After the opening step, the MicroEJ
Application can use every communications method (COMM, USB etc.) as generic communication in order to easily
change the communication method if needed.

Functional Description

The diagram below shows the overall process to open a connection on a hardware device.

1. Open a new
connection using the Connection
connection string

Connection

String

2.Open a new input 4. Open a new output
stream on the stream on the
connection connection

InputStream OutputStream

3. Read some data from 5. Write some data to
hardware device hardware device

Fig. 22: ECOM Flow

1. Step 1 consists of opening a connection on a hardware device. The connection kind and its configuration are
fixed by the parameter String connectionString of the method Connection.open.

2. Step 2 consists of opening an InputStream on the connection. This stream allows the MicroEJ Application
to access the “RX” feature of the hardware device.

3. Step 3 consists of using the InputStream APIs to receive in the MicroEJ Application all hardware device data.

4. Step 4 consists of opening an OutputStream on the connection. This stream allows the MicroEJ Application
to access the “TX” feature of the hardware device.

5. Step 5 consists of using the OutputStream APIs to transmit some data from the MicroEJ Application to the
hardware device.
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Note that steps 2 and 4 may be performed in parallel, and do not depend on each other.

Device Management API

A device is defined by implementing ej.ecom.Device . It is identified by a name and a descriptor ( ej.ecom.
HardwareDescriptor ), which is composed of a set of MicroEJ properties. A device can be registered/unregistered
inthe ej.ecom.DeviceManager.

A device registration listener is defined by implementing ej.ecom.RegistrationListener.When a device is reg-
istered to or unregistered from the device manager, listeners registered for the device type are notified. The notifi-
cation mechanism is done in a dedicated Java thread. The mechanism can be enabled or disabled (see Application
Options).

Dependencies

No dependency.

Installation

ECOM Foundation Library is an additional library. In the platform configuration file, check ' Serial Communication
> ECOM toinstall the library.

Use

The ECOM APl Module must be added to the module.ivy of the MicroEJ Application project in order to allow access
to the ECOM library.

<dependency org="ej.api” name="ecom” rev="1.1.4"/>

This foundation library is always required when developing a MicroEJ Application which communicates with some
external devices. It is automatically embedded as soon as a sub communication library is added in the classpath.

4.8.2 ECOM Comm

Principle

The ECOM Comm Java library provides support for serial communication. ECOM Comm extends ECOM to al-
low stream communication via serial communication ports (typically UARTs). In the MicroEJ Application, the
connection is established using the Connector.open() method. The returned connection is a ej.ecom.io.
CommConnection , and the input and output streams can be used for full duplex communication.

The use of ECOM Comm in a custom platform requires the implementation of an UART driver. There are two differ-
ent modes of communication:

+ In Buffered mode, ECOM Comm manages software FIFO buffers for transmission and reception of data. The
driver copies data between the buffers and the UART device.

« In Custom mode, the buffering of characters is not managed by ECOM Comm. The driver has to manage its
own buffers to make sure no data is lost in serial communications because of buffer overruns.

This ECOM Comm implementation also allows dynamic add or remove of a connection to the pool of available
connections (typically hot-plug of a USB Comm port).
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Functional Description

The ECOM Comm process respects the ECOM process. Please refer to the illustration “ECOM flow”.

Component Architecture

The ECOM Comm C module relies on a native driver to perform actual communication on the serial ports. Each port
can be bound to a different driver implementation, but most of the time, it is possible to use the same implemen-
tation (i.e. same code) for multiple ports. Exceptions are the use of different hardware UART types, or the need for
different behaviors.

Five C header files are provided:
o LLCOMM_impl.h

Defines the set of functions that the driver must implement for the global ECOM comm stack, such as syn-
chronization of accesses to the connections pool.

o LLCOMM_BUFFERED_CONNECTION_impl.h
Defines the set of functions that the driver must implement to provide a Buffered connection
o LLCOMM_BUFFERED_CONNECTION.h

Defines the set of functions provided by ECOM Comm that can be called by the driver (or other C code) when
using a Buffered connection

e LLCOMM_CUSTOM_CONNECTION_impl.h
Defines the set of functions that the driver must implement to provide a Custom connection
o LLCOMM_CUSTOM_CONNECTION.h

Defines the set of functions provided by ECOM Comm that can be called by the driver (or other C code) when
using a Custom connection

The ECOM Comm drivers are implemented using standard LLAPI features. The diagram below shows an example
of the objects (both Java and C) that exist to support a Buffered connection.

:ej.ecom.io.CommConnection

Driver Connection
LLCOMM_BUFFERED_CONNECTION_impl.h

-
-

LLCOMM_BUFFERED_CONNECTION.h

Fig. 23: ECOM Comm components

The connection is implemented with three objects' :
« The Java object used by the application; an instance of ej.ecom.io.CommConnection
+ The connection object within the ECOM Comm C module

« The connection object within the driver

! Thisis aconceptual description to aid understanding - the reality is somewhat different, although that is largely invisible to the implementor
of the driver.

4.8. Serial Communications 236



MicroEJ Documentation, Revision bd708584

Each driver implementation provides one or more connections. Each connection typically corresponds to a physi-
cal UART.

Comm Port Identifier

Each serial port available for use in ECOM Comm can be identified in three ways:

« An application port number. This identifier is specific to the application, and should be used to identify the
data stream that the port will carry (for example, “debug traces” or “GPS data”).

« Aplatform port number. This is specific to the platform, and may directly identify an hardware device’ .

+ A platform port name. This is mostly used for dynamic connections or on platforms having a file-system
based device mapping.

When the Comm Port is identified by a number, its string identifier is the concatenation of “com” and the number
(e.g. com1l).

Application Port Mapping

The mapping from application port numbers to platform ports is done in the application launch configuration.
This way, the application can refer only to the application port number, and the data stream can be directed to the
matching 1/O port on different versions of the hardware.

Ultimately, the application port number is only visible to the application. The platform identifier will be sent to the
driver.

Opening Sequence

The following flow chart explains Comm Port opening sequence according to the given Comm Port identifier.

Comm Port Identifier yes Aﬁgl‘czgigf yes Open from mapped
is coml[id] ppedic id
platform id
no no
error
Open from name Open from id
success
success success
Connection opened
error error

Connection Error

Unknown Comm Port

Fig. 24: Comm Port Open Sequence

2 Some drivers may reuse the same UART device for different ECOM ports with a hardware multiplexer. Drivers can even treat the platform
port number as a logical id and map the ids to various I/O channels.
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Dynamic Connections

The ECOM Comm stack allows to dynamically add and remove connections from the Driver APl. When a connection
is added, it can be immediately open by the application. When a connection is removed, the connection cannot be
open anymore and java.io.IOException isthrown in threads that are usingit.

In addition, a dynamic connection can be registered and unregistered in ECOM device manager (see Device Manage-
ment API). The registration mechanism is done in dedicated thread. It can be enabled or disabled, see Application

Options.
A removed connection is alive until it is closed by the application and, if enabled, unregistered from ECOM device

manager. A connection is effectively uninstalled (and thus eligible to be reused) only when it is released by the
stack.

The following sequence diagram shows the lifecycle of a dynamic connection with ECOM registration mechanism
enabled.

Hotplug: Task | ‘ Connection | ‘ ECCOM Comm Stackl ‘ Comm Pump: Thread | ‘ DeviceManagerl ‘ Application
T

add

add connection

‘ ‘notify Connection added

v

register Cormm Port

i
i
i
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|

e

I I 1 I 1
remov J/ X X X X X
| | |  read() i i i
| remove Connect|on - | X
X X java.io.lCException ) X
| N || ......................... )
! ! notify Connection removed ! !
! ! ' close() ! '
! ! ! I unregister Comm Port_! !
! ! | _ Comm Port unregistered ! !
| 1 released() ' [ '
T I-\ T T T T
Hotplug: Task | ‘ Connection | ‘ ECCOM Comm Stackl ‘ Comm Pump:Thread | ‘ DeviceManagerl ‘ Application |

Fig. 25: Dynamic Connection Lifecycle
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Java API

Opening a connection is done using ej.ecom.io.Connector.open(String name) . The connection string (the
name parameter) must start with “comm:”, followed by the Comm port identifier, and a semicolon-separated list of
options. Options are the baudrate, the parity, the number of bits per character, and the number of stop bits:

« baudrate=n (9600 by default)

« bitsperchar=n where nis in the range 5 to 9 (8 by default)
« stopbits=n where nis 1,2, or 1.5 (1 by default)

« parity=x where x is odd, even or none (none by default)

All of these are optional. Illegal or unrecognized parameters cause an I1legalArgumentException .

Driver API

The ECOM Comm Low Level API is designed to allow multiple implementations (e.g. drivers that support different
UART hardware) and connection instances (see Low Level API Pattern chapter). Each ECOM Comm driver defines a
data structure that holds information about a connection, and functions take an instance of this data structure as
the first parameter.

The name of the implementation must be set at the top of the driver C file, for example’:

#define LLCOMM_BUFFERED_CONNECTION MY_LLCOMM

This defines the name of this implementation of the LLCOMM_BUFFERED_CONNECTION interface to be MY_LLCOMM.

The data structure managed by the implementation must look like this:

typedef struct MY_LLCOMM{
struct LLCOMM_BUFFERED_CONNECTION header;
// extra data goes here

} MY_LLCOMM;

void MY_LLCOMM_new(MY_LLCOMM* env);

In this example the structure contains only the default data, in the header field. Note that the header must be the
first field in the structure. The name of this structure must be the same as the implementation name ( MY_LLCOMM
in this example).

The driver must also declare the “new” function used to initialize connection instances. The name of this function
must be the implementation name with _new appended, and it takes as its sole argument a pointer to an instance
of the connection data structure, as shown above.

The driver needs to implement the functions specified in the LLCOMM_imp1.h file and for each kind of connection,
the LLCOMM_BUFFERED_CONNECTION_impl.h (or LLCOMM_CUSTOM_CONNECTION_impl.h) file.

The driver defines the connections it provides by adding connection objects using LLCOMM_addConnection
Connections can be added to the stack as soon as the LLCOMM_initialize function is called. Connec-
tions added during the call of the LLCOMM_impl_initialize function are static connections. A static con-
nection is registered to the ECOM registry and cannot be removed. When a connection is dynamically added
outside the MicroJVM task context, a suitable reentrant synchronization mechanism must be implemented (see
LLCOMM_IMPL_syncConnectionsEnter and LLCOMM_IMPL_syncConnectionsExit ).

3 The following examples use Buffered connections, but Custom connections follow the same pattern.
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When opening a port from the MicroEJ Application, each connection declared in the connections pool will be asked
about its platform port number (using the getPlatformId method) or its name (using the getName method)
depending on the requested port identifier. The first matching connection is used.

The life of a connection starts with the call to getPlatformId() or getName() method. If the the connection
matches the port identifier, the connection will be initialized, configured and enabled. Notifications and interrupts
are then used to keep the stream of data going. When the connection is closed by the application, interrupts are
disabled and the driver will not receive any more notifications. It is important to remember that the transmit and
receive sides of the connection are separate Java stream objects, thus, they may have a different life cycle and one
side may be closed long before the other.

The Buffered Comm Stream

In Buffered mode, two buffers are allocated by the driver for sending and receiving data. The ECOM Comm C module
will fill the transmit buffer, and get bytes from the receive buffer. There is no flow control.

When the transmit buffer is full, an attempt to write more bytes from the MicroEJ Application will block the Java
thread trying to write, until some characters are sent on the serial line and space in the buffer is available again.

When the receive buffer is full, characters coming from the serial line will be discarded. The driver must allocate a
buffer big enough to avoid this, according to the UART baudrate, the expected amount of data to receive, and the
speed at which the application can handle it.

The Buffered C module manages the characters sent by the application and stores them in the transmit buffer. On
notification of available space in the hardware transmit buffer, it handles removing characters from this buffer and
putting them in the hardware buffer. On the other side, the driver notifies the C module of data availability, and
the C module will get the incoming character. This character is added to the receive buffer and stays there until the
application reads it.

The driver should take care of the following:

« Setting up interrupt handlers on reception of a character, and availability of space in the transmit buffer. The
C module may mask these interrupts when it needs exclusive access to the buffers. If no interrupt is available
from the hardware or underlying software layers, it may be faked using a polling thread that will notify the C
module.

Initialization of the 1/0 pins, clocks, and other things needed to get the UART working.

Configuration of the UART baudrate, character size, flow control and stop bits according to the settings given
by the C module.

Allocation of memory for the transmit and receive buffers.

Getting the state of the hardware: is it running, is there space left in the TX and RX hardware buffers, is it busy
sending or receiving bytes?

The driver is notified on the following events:
+ Opening and closing a connection: the driver must activate the UART and enable interrupts for it.

+ Anew byte is waiting in the transmit buffer and should be copied immediately to the hardware transmit unit.
The C module makes sure the transmit unit is not busy before sending the notification, so it is not needed to
check for that again.

The driver must notify the C module on the following events:

+ Data has arrived that should be added to the receive buffer (using the
LLCOMM_BUFFERED_CONNECTION_dataReceived function)

+ Space available in the transmit buffer (using the LLCOMM_BUFFERED_CONNECTION_transmitBufferReady
function)
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The Custom Comm Stream

In custom mode, the ECOM Comm C module will not do any buffering. Read and write requests from the application
are immediately forwarded to the driver.

Since there is no buffer on the C module side when using this mode, the driver has to define a strategy to store
received bytes that were not handed to the C module yet. This could be a fixed or variable side FIFO, the older
received but unread bytes may be dropped, or a more complex priority arbitration could be set up. On the transmit
side, if the driver does not do any buffering, the Java thread waiting to send something will be blocked and wait
for the UART to send all the data.

In Custom mode flow control (eg. RTS/CTS or XON/XOFF) can be used to notify the device connected to the serial
line and so avoid losing characters.

BSP File

The ECOM Comm C module needs to know, when the MicroEJ Application is built, the name of the implementation.
This mapping is defined in a BSP definition file. The name of this file must be bsp.xml and must be written in the
ECOM comm module configuration folder (near the ecom-comm.xml file). In previous example the bsp.xml file
would contain:

Listing 1: ECOM Comm Driver Declaration (bsp.xml)

<bsp>
<nativeImplementation
name="MY_LLCOMM"
nativeName="LLCOMM_BUFFERED_CONNECTION"
/>
</bsp>

where nativeName is the name of the interface, and name is the name of the implementation.

XML File

The Java platform has to know the maximum number of Comm ports that can be managed by the ECOM Comm
stack. It also has to know each Comm port that can be mapped from an application port number. Such Comm port
is identified by its platform port number and by an optional nickname (The port and its nickname will be visible in
the MicroEJ launcher options, see Application Options ).

A XML file is so required to configure the Java platform. The name of this file must be ecom-comm.xml . It has to be
stored in the module configuration folder (see /nstallation).

This file must start with the node <ecom> and the sub node <comms>. It can contain several time this kind of line:
<comm platformId="A_COMM_PORT_NUMBER" nickname="A_NICKNAME"/> where:
« A_COMM_PORT_NUMBER refers the Comm port the Java platform user will be able to use (see Application Port
Mapping).

« A_NICKNAME is optional. It allows to fix a printable name of the Comm port.

The maxConnections attribute indicates the maximum number of connections allowed, including static and dy-
namic connections. This attribute is optional. By default, it is the number of declared Comm Ports.

Example:
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Listing 2: ECOM Comm Module Configuration (ecom-comm.xml)

<ecom>
<comms maxConnections="20">
<comm platformId="2"/>
<comm platformId="3" nickname="DB9"/>
<comm platformId="5"/>
</comms>
</ecom>

First Comm port holds the port 2, second “3” and last “5”. Only the second Comm port holds a nickname “DB9”.

ECOM Comm Mock
In the simulation environment, no driver is required. The ECOM Comm mock handles communication for all the
serial ports and can redirect each port to one of the following:

« An actual serial port on the host computer: any serial port identified by your operating system can be used.
The baudrate and flow control settings are forwarded to the actual port.

« ATCP socket. You can connect to a socket on the local machine and use netcat or telnet to see the output, or
you can forward the data to a remote device.

« Files. You can redirect the input and output each to a different file. This is useful for sending precomputed
data and looking at the output later on for offline analysis.

When using the socket and file modes, there is no simulation of an UART baudrate or flow control. On a file, data
will always be available for reading and will be written without any delay. On a socket, you can reach the maximal
speed allowed by the network interface.

Dependencies

« ECOM (see Serial Communications).

o LLCOMM_impl.h and LLCOMM_xxx_CONNECTION_impl.h implmentations (see LLCOMM: Serial Communica-
tions).

Installation

ECOM-Comm Java library is an additional library. In the platform configuration file, check ' Serial Communication

> ECOM-COMM to install it. When checked, the xml file "ecom-comm > ecom-comm.xml is required during
platform creation to configure the module (see XML File).

Use

The ECOM Comm APl Module must be added to the module.ivy of the MicroEJ Application project in order to allow
access to the ECOM Comm library.

<dependency org="ej.api"” name="ecom-comm” rev="1.1.4"/>

This Foundation Library is always required when developing a MicroEJ Application which communicates with some
external devices using the serial communication mode.

This library provides a set of options. Refer to the chapter Application Options which lists all available options.
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4.9 Graphical User Interface

Note: This chapter describes the current Graphical User Interface version 3, provided by Ul Pack version 13.0.0
or higher. If you are using the former Graphical User Interface version 2 (provided by MicroEJ Ul Pack version up
to 12.1.x), please refer to this MicroEJ Documentation Archive.

4.9.1 Principle

The User Interface Extension features one of the fastest graphics engines, associated with a unique int-based event
management system.

This chapter describes the Ul3 notions, available since MicroEJ Architecture Ul pack 13.0.0 and higher: MicroUl 3.0,
Front Panel v6, Low Level APIs LLUI_xxx, etc.

The diagram below shows a simplified view of the components involved in the provisioning of User Interface Ex-
tension.

MicroEJ Application

MicroUl and Drawing Libraries

l Platform l

Display Front Panel

Front Panel Widgets

Simulator I

Front Panel

Drivers(Board SupportPackage) defirition

HARDWARE

. Provided by user . Provided by platform

Fig. 26: Overview

The modules responsible to manage the Display, the Input and the LED are respectively called Display module,
Input module and LED module. These three Low Level parts connect MicroUl library to the user-supplied drivers
code (coded in C). The drivers can use hardware accelerators like DMA and GPU to perform specific actions (buffers
copy, drawings, etc.).

The MicroEJ Simulator provides all features of MicroUl library. The three modules are grouped togetherin a module
called Front Panel. The Front Panel is supplied with a set of software widgets that generically support a range of
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input devices such as buttons, joysticks and touchscreens, and output devices such as displays and LEDs. With the
help of the Front Panel Designer tool that forms part of the MicroEJ Workbench the user must define a Front Panel
mock-up using these widgets.

The Display module also manages fonts and images. The fonts and images are pre-processed before compiling the
MicroEJ application. The following diagram depicts the components involved in its design, along with the provided
tools:

Font

Designer

Java class Java class
file files resource
* * K
".class .

l

SOAR Font Image
(smart linker) Generator Generator
[ MicroEJ Application executable file ]

MicroEJ platform Ul engines (C modules)

(runtime) Display /Input /LED

Fig. 27: The User Interface Extension Components along with a Platform

4.9.2 MicroUl
Principle

MicroUl library defines a Low Level Ul framework for embedded devices. This module allows the creation of basic
Human-Machine-Interfaces (HMI), with output on a pixel-based screen.
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Architecture

MicroUl library is the entry point to perform some drawings on a display and to interact with user input events. This
library contains only a minimal set of basic APIs. High-level libraries can be used to have more expressive power,
such as MIWT (Micro Widget Toolkit) . In addition to this restricted set of APIs, the MicroUl implementation has been
designed so that the EDC and BON footprint is minimal.

At MicroEJ application startup all MicroUl objects relative to the I/O devices are created and accessible. The follow-
ing MicroUl methods allow you to access these objects:

« Display.getDisplay() : returns the instance of the display which drives the main display screen.
« Leds.getNumberOfLeds(): returns the numbers of available LEDs.

MicroUl is not a standalone library. It requires a configuration step and several extensions to drive I/O devices
(display, inputs, LEDs).

First, MicroUl requires a configuration step in order to create these internal objects before the call to the main()
method. The chapter Static Initialization explains how to perform the configuration step.

Note: This configuration step is the same for both embedded and smulated platforms.

The embedded platform requires some additional C libraries to drive the I/O devices. Each C library is dedicated to
a specific kind of 1/0 device. A specific chapter is available to explain each kind of I/0O device.

Table 5: MicroUl C libraries

I/O devices Extension Name | Chapter
Graphical / pixel-based display Display Display
Inputs (buttons, joystick, touch, pointers, etc.) | Input Input
LEDs LED LED

The simulation platform uses a mock which simulates all I/O devices. Refer to the chapter Simulation.

Thread

Principle

The MicroUl implementation for MicroEJ uses one internal thread. This thread is created during the MicroUl initial-
ization step, and is started by a call to MicroUl.start().

Role

This thread has several roles:
+ It manages all display events (requestRender(), requestShow(), etc.).

« It reads the I/O devices inputs and dispatches them into the event generators’ listeners. See input section:
Input.

« It allows to run some piece of code using the callSerially() method.
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Memory

The thread is always running. The user has to count it to determine the number of concurrent threads the MicroEJ
Core Engine can run (see Memory options in Application Options).

Exceptions

The thread cannot be stopped with a Java exception: the exceptions are always checked by the framework.

When an exception occurs in a user method called by the internal thread (for instance render()), the current
UncaughtExceptionHandler receives the exception. When no exception handler is set, a default handler prints
the stack trace.

Native Calls

The MicroUl implementation for MicroEJ uses native methods to perform some actions (read input devices events,
perform drawings, turn on LEDs, etc.). The library implementation has been designed to not use blocking native
methods (wait input devices, wait end of drawing, etc.) which can lock the full MicroEJ Core Engine execution.

The specification of the native methods is to perform the action as fast as possible. The action execution may be
sequential or parallel because an action is able to use a third-party device (software or hardware). In this case,
some callbacks are available to notify the end of this kind of parallel actions.

However some actions have to wait the end of a previous parallel action. By consequence the caller thread is
blocked until the previous action is done; in other words, until the previous parallel action has called its callback.
In this case, only the current Java thread is locked (because it cannot continue its execution until both actions are
performed). All other Java threads can run, even a thread with a lower priority than current thread. If no thread
has to be run, MicroEJ Core Engine goes in sleep mode until the native callback is called.

Transparency

MicroUl provides several policies to use the transparency. These policies depend on several factors, including the
kind of drawing and the display pixel rendering format. The main concept is that MicroUl does not allow you to
draw something with a transparency level different from 255 (fully opaque). There are two exceptions: the images
and the fonts.

Images

Drawing an image (a pre-generated image or an image decoded at runtime) which contains some transparency
levels does not depend on the display pixel rendering format. During the image drawing, each pixel is converted
into 32 bits by pixel format.

This pixel format contains 8 bits to store the transparency level (alpha). This byte is used to merge the foreground
pixel (image transparent pixel) with the background pixel (buffer opaque pixel). The formula to obtain the pixel is:

aMult = («FG x aBG) /255
aOut = aFG + aBG — aMult

COut = (CFG x aFG + CBG * aBG — CBG x aMult) /aOut

The destination buffer is always opaque, so:

COut = (CFG * aFG + CBG x (255 — aMult))/255
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where:
+ aFGisthe alpha level of the foreground pixel (layer pixel),
« aBG is the alpha level of the background pixel (working buffer pixel),
« Cxxis acolor component of a pixel (Red, Green or Blue),

« aOutis the alpha level of the final pixel.

Fonts

Afont holds only a transparency level (alpha). This fixed alpha level is defined during the pre-generation of a font
(see Fonts).

« 1 means 2 levels are managed: fully opaque and fully transparent.
+ 2 means 4 levels are managed: fully opaque, fully transparent and 2 intermediate levels.
+ 4 means 16 levels are managed: fully opaque, fully transparent and 14 intermediate levels.

« 8 means 256 levels are managed: fully opaque, fully transparent and 254 intermediate levels.

Installation

The MicroUl library is an additional module. In the platform configuration file, check Ul > MicroUl to install

the library. When checked, the XML file microui > microui.xml is required during platform creation in order
to configure the module. This configuration step is used to extend the MicroUl library. Refer to the chapter Static
Initialization for more information about the MicroUl Initialization step.

Use

See MicroUl chapter in Application Developer Guide.

4.9.3 Static Initialization
Principle

The MicroUl implementation for MicroEJ requires a configuration step (also called extension step) to customize
itself before MicroEJ application startup (see Architecture). This configuration step uses an XML file. In order to save
both runtime execution time and flash memory, the file is processed by the Static MicroUl Initializer tool, avoiding
the need to process the XML configuration file at runtime. The tool generates appropriate initialized objects directly
within the MicroUl library, as well as Java and C constants files for sharing MicroU| event generator IDs.

This XML file (also called the initialization file) defines:

« The MicroUl event generators that will exist in the application in relation to Low Level drivers that provide
data to these event generators (see Input).

+ Whether the application has a display; and if so, it provides its logical name.
« Which fonts will be provided to the application.

The next chapters describe succinctly the XML file. For more information about grammar, please consult appendix
MicroUl Static Initializer.
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Functional Description

The Static MicroUl Initializer tool takes as entry point the initialization file which describes the MicroUl library ex-
tension. This tool is automatically launched during the MicroEJ platform build (see Installation ).

The Static MicroUl Initializer tool is able to generate two files:

« A Java library which extends MicroUl library. This library is automatically added to the MicroEJ Application
classpath when MicroUl API library is fetched. This library is used at MicroUl startup to create all instances of
1/0 devices (Display, EventGenerator, etc.) and contains the fonts described into the configuration file (these
fonts are also called “system fonts”).

Warning: This MicroUl extension library is always generated and MicroUl library cannot run without this exten-
sion.

« A C header file ( x.h ). This header file contains some IDs which are used to make a link between an input
device (buttons, touch) and its MicroUl event generator (see Input).

Note: The Front Panel project does not need a configuration file (like C header file for embedded platform).

system_ ) . .
microui MicroUl Extension Java library
Jjar

microui

xml

StaticMicroUl

Initializer

microui_

constants BSP Event Generator identifiers

.h

Fig. 28: Static MicroUl Initializer Process

XML File

The XML file must be created in platform configuration project, in folder microui and called microui.xml .

v & platform-configuration

Fig. 29: Static MicroUl Initializer XML File

The XML file grammar is detailed here. The following list gives a short description of each element:

+ Root element: The initialization file root elementis <microui> and contains component-specific elements.

4.9. Graphical User Interface 248


https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html
https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/event/EventGenerator.html

MicroEJ Documentation, Revision bd708584

<microui>
[ component specific elements ]
</microui>

+ Display element: The display elementaugments the initialization file with the configuration of the display.
The following snippet is an example of display element:

<display name="DISPLAY"/>

+ Fontselement: The fonts element augments the initialization file with the fonts that are implicitly embed-
ded within the application (also called system fonts). Applications can also embed their own fonts.

Note: The system fonts are optional, in which case application has to provide some fonts to be
able to draw characters.

The following snippet is an example of fonts element:

<fonts>
<font file="resources\fonts\myfont.ejf">
<range name="LATIN" sections="0-2"/>
<customrange start="0x21" end="0x3f"/>
</font>
<font file="C:\data\myfont.ejf"/>
</fonts>

« Event generators element: The eventgenerators element augments the initialization file with:

- the configuration of the predefined MicroUl Event Generator: Command, Buttons, States,
Pointer and Touch.

- the configuration of the generic MicroUl Event Generator.

The following snippet is an example of eventgenerators element:

<eventgenerators>
<!-- Generic Event Generators -->
<eventgenerator name="GENERIC" class="foo.bar.Zork">
<property name="PROP1" value="3"/>
<property name="PROP2" value="aaa"/>
</eventgenerator>

<!-- Predefined Event Generators -->

<command name="COMMANDS" />

<buttons name="BUTTONS" extended="3"/>

<buttons name="JOYSTICK" extended="5"/>

<pointer name="POINTER" width="1200" height="1200"/>
<touch name="TOUCH" display="DISPLAY"/>

<states name="STATES" numbers="NUMBERS" values="VALUES"/>

</eventgenerators>

<array name="NUMBERS">
<elem value="3"/>
<elem value="2"/>
<elem value="5"/>
</array>
(continues on next page)
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(continued from previous page)

<array name="VALUES">
<elem value="2"/>
<elem value="0"/>
<elem value="1"/>
</array>

XML File Example

This common MicroUl initialization file initializes MicroUl with:
« aDisplay,
« aCommand event generator,
+ a Buttons event generator which targets n buttons (3 first buttons having extended features),
+ a Buttons event generator which targets the buttons of a joystick,
« a Pointer event generator which targets a touch panel,

« a Font whose path is relative to this file.
<microui>
<display name="DISPLAY"/>
<eventgenerators>
<command name="COMMANDS" />
<buttons name="BUTTONS" extended="3"/>
<buttons name="JOYSTICK" extended="5"/>
<touch name="TOUCH" display="DISPLAY"/>
</eventgenerators>
<fonts>
<font file="resources\fonts\myfont.ejf"/>

</fonts>

</microui>

Dependencies

No dependency.

Installation
The Static Initialization tool is part of the MicroUl module (see MicroU]). Install the MicroUl module to install the

Static Initialization tool and fill all properties in MicroUl module configuration file (which must specify the name of
the initialization file).

Use

The Static MicroUl Initializer tool is automatically launched during the MicroEJ platform build.
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4.9.4 Low Level API

Principle

The MicroUl implementation for MicroEJ requires a Low Level implementation. This Low Level implementation
finalizes the MicroUl implementation started with the static initialization step (see Static Initialization) for a given
MicroEJ platform.

The Low Level implementation consists of a set of headers files to implement in C to target the hardware drivers.
Some functions are mandatory, others are not. Some other headersfiles are also available to call Ul enginesinternal

functions.

For the simulator, some Front Panel interfaces and classes allow to specify the simulated platform characteristics.

Embedded Platform

MICROUI-3.0 DRAWING-1.0

Software Algorithms LLUI_PAINTER_impl.h LLUI_LED_impl.h LLDW_PAINTER_impl.h

LLUI_DISPLAY_impl.h LLUL_INPUT_impl.h

CCO - com.microej.clibrary.llimpl#microui-drawings BSP

LLUI_PAINTER_impl.c LLDW_PAINTER_impl.c LLUI_INPUT _impl.c LLUI_DISPLAY_impl.c LLUI_LED_impl.c

O Foundation library
. C/H file (.c, .h)
. Archive file (.a)

Fig. 30: MicroUl Embedded Low Level API

The specification of header files names is:
+ Name starts with LLUT_.
+ Second part name refers the Ul engine: DISPLAY, INPUT, LED.
« Files whose name ends with _impl list functions to implement over hardware.
+ Files whose name has no suffix list internal Ul engines functions.

There are some exceptions :

o LLUI_PAINTER_impl.h and LLDW_PAINTER_impl.h list a subpart of Ul Graphics Engine functions to imple-
ment (all MicroUl native drawing methods).

« ui_drawing.h and dw_drawing.h list all drawing methods the platform can implement.

« ui_drawing_soft.h and dw_drawing_soft.h list all drawing methods implemented by the Graphics En-
gine.

« microui_constants.h isthe file generated by the MicroUl Static Initializer (see Static Initialization).

All header files and their aims are described in next Ul engines chapters: LED, Input and Display.
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Simulator

MICROUI-3.0 DRAWING-1.0

Graphics Engine Software Algorithms LLUIPainter Event Engine LLUILed_impl.h LLDWPainter
LLUDisplay UiDrswing LLUinput oWorawin
LLUIDisplaylmpl

ej.tool.frontpanel#widget Front panel Platform project

Widgets (Display, LED etc.) .fp file and resources Widgets

O Foundation library
. Java file (class & interface)

. Archive file (jar)

Fig. 31: MicroUl Simulator Low Level API

In the simulator the three Ul engines are grouped in a mock called Front Panel. The Front Panel comes with a set
of classes and interfaces which are the equivalent of headers file ( *.h ) of Embedded Platform .

The specification of class names is:

+ Package are the same than the MicroUl library (ej.microui.display, ej.microui.event, ej.microui.
led).

« Name start with LLUT .
+ Second part name refers the Ul engine: Display, Input, Led
« Files whose name ends with Impl list methods to implement like embedded platform.
+ Files whose name has no suffix list internal Ul engines functions.
There are some exceptions:

« LLUIPainter.java and LLDWPainter. java lista subpart of Ul Graphics Engine functions (all MicroUl native
drawing methods).

« UIDrawing.java and DWDrawing. java list all drawing methods the platform can implement (and already
implemented by the Graphics Engine).

« EventXxX list methods to create input events compatible with MicroUl implementation.

All files and their aims are described in Simulation.

4.9.5 LED

Principle

The LED module contains the C part of the MicroUl implementation which manages LED devices. This module is
composed of only one element: an implementation of the Low Level APIs for the LEDs which must be provided by
the BSP (see LU/ _LED: LEDs).
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Functional Description
The LED module implements the MicroUl Leds framework. LLUI_LED specifies the Low Level APIs that receive
orders from the Java world.

The Low Level APIs are the same for the LED which is connected toa GPIO (@ or 1),toa PWM,toabus (I2C, SPI
), etc. The BSP has the responsibility of interpreting the MicroEJ Application parameter intensity.

Typically, when the LED is connected to a GPI0,the intensity “0” means “OFF” and all other values “ON”. When
the LED is connected viaa PWM, the intensity “0” means “OFF”, and all other values must configure the PWM duty
cycle signal.

The BSP should be able to return the state of an LED. If it is not able to do so (for example GPIO is not accessible
in read mode), the BSP has to save the LED state in a global variable. If not, the returned value may be wrong and
the MicroEJ Application may not be able to know the LEDs states.

Low Level API

The LED module provides Low Level APIs that allow the BSP to manage the LEDs. The BSP has to implement these
Low Level APIs, making the link between the MicroUl library and the BSP LEDs drivers.

The Low Level APIstoimplement are listed in the header file LLUI_LEDS_impl.h. First,intheinitialization function,
the BSP must return the available number of LEDs the board provides. The other functions are used to turn the LEDs
on and off.

Platform

MICROUI-3.0

BSP

LLUI_LED impl.c

hardware

Fig. 32: Led Low Level API

When there is no LED on the board, a stub implementation of C library is available. This C library must be linked
by the third-party C IDE when the MicroUl module is installed in the MicroEJ Platform. This stub library does not
provide any Low Level API files.

4.9. Graphical User Interface 253


https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/led/Leds.html

MicroEJ Documentation, Revision bd708584

Dependencies

« MicroUl module (see MicroUl).

o LLUI_LED_impl.h implementation if standard implementation is chosen (see Functional Description and
LLUI_LED: LEDs).

Installation

LEDs is a sub-part of MicroUl library. When the MicroUl module is installed, the LED module must be installed in
order to be able to connect physical LEDs with MicroEJ Platform. If not installed, the stub module will be used.

In the platform configuration file, check Ul > LEDs toinstall LEDs.

Use

The MicroUIl LEDs APIs are available in the class ej.microui.led.Leds.

4.9.6 Input

Principle

The Input module contains the C part of the MicroUl implementation which manages input devices. This module
is composed of two elements:

« the C part of MicroUl input API (a built-in C archive) called Input Engine,

« an implementation of a Low Level APIs for the input devices that must be provided by the BSP (see
LLUI_INPUT: Input).

Functional Description

The Input module implements the MicroUl int -based event generators’ framework. LLUI_INPUT specifies the
Low Level APIs that send events to the Java world.

Drivers for input devices must generate events that are sent, via a MicroUl Event Generator, to the MicroEJ Appli-
cation. An event generator accepts notifications from devices, and generates an event in a standard format that
can be handled by the application. Depending on the MicroUl configuration, there can be several different types of
event generator in the system, and one or more instances of each type.

Each MicroUl Event Generator represents one side of a pair of collaborative components that communicate using
a shared buffer:

+ The producer: the C driver connected to the hardware. As a producer, it sends its data into the communica-
tion buffer.

« The consumer: the MicroUl Event Generator. As a consumer, it reads (and removes) the data from the com-
munication buffer.
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Fig. 33: Drivers and MicroUl Event Generators Communication

The LLUI_INPUT APl allows multiple pairsof <driver - event generator> to usethe same buffer, and associates
drivers and event generators using an int ID. The ID used is the event generator ID held within the MicroUl global
registry. Apartfrom sharingthe ID used to “connect” one driver’s data to its respective event generator, both entities
are completely decoupled.

The MicroUl thread waits for data to be published by drivers into the “input buffer”, and dispatches to the correct
(according to the ID) event generator to read the received data. This “driver-specific-data” is then transformed into
MicroUl events by event generators and sent to objects that listen for input activity.

. Listeners
Native world I Java world (application objects)
(€, asm,...) | )
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! of event generators
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Fig. 34: MicroUl Events Framework

Driver Listener

Drivers may either interface directly with event generators, or they can send their notifications to a Listener, also
written in C, and the listener passes the notifications to the event generator. This decoupling has two major bene-
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fits:
+ The drivers are isolated from the MicroEJ libraries - they can even be existing code.

« The listener can translate the notification; so, for example, a joystick could generate pointer events.

Static Initialization

The event generators available on MicroUl startup (after the callto MicroUl.start()) are the event generators listed in
the MicroUl description file (XML file). This file is a part of the MicroUl Static Initialization step (Static Initialization).

The order of event generators defines the unique identifier for each event generator. These identifiers are generated
in a header file called microui_constants.h. Theinputdriver (or its listener) has to use these identifiers to target
a specific event generator.

If an unknown identifier is used or if two identifiers are swapped, the associated event may be never received by
MicroEJ application or may be misinterpreted.

Standard Event Generators

MicroUl provides a set of standard event generators: Command, Buttons , Pointer and States. For each standard
generator, the Input Engine proposes a set of functions to create and send an event to this generator.

Static Initialization proposes an additional event generator: Touch . A touch event generator is a Pointer event
generator whose area size is the display size where the touch panel is placed. Furthermore, contrary to a pointer,
a press action is required to be able to have a move action (and so a drag action). The Input Engine proposes a set
of functions to target a touch event generator (equal to a pointer event generator but with some constraints). The
touch event generator is identified as a standard Pointer event generator, by consequence the Java application has
to use the Pointer API to deal with a touch event generator.

According to the event generator, one or several parameters are required. The parameter format is event generator
dependant. Forinstance a Pointer X-coordinate is encoded on 16 bits (0-65535 pixels).

Generic Event Generators

MicroUl provides an abstract class GenericEventGenerator (package ej.microui.event ). The aim of a generic
event generator is to be able to send custom events from native world to MicroEJ application. These events may
be constituted by only one 32-bit word or by several 32-bit words (maximum 255).

Onthe application side, a subclass must be implemented by clients who want to define their own event generators.
Two abstract methods must be implemented by subclasses:

« eventReceived : The event generator received an event from a C driver through the Low Level APIs
sendevent function.

+ eventsReceived: The event generator received an event made of several ints.

The event generator is responsible for converting incoming data into a MicroUl event and sending the event to its
listener. It should be defined during MicroUl Static Initialization step (in the XML file, see Static Initialization). This
allows the MicroUl implementation to instantiate the event generator on startup.

If the event generator is not available in the application classpath, a warning is thrown (with a stack trace) and the
application continues. In this case, all events sent by BSP to this event generator are ignored because no event
generator is able to decode them.
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Low Level API

The implementation of the MicroUl Event Generator APIls provides some Low Level APIs. The BSP has to im-
plement these Low Level APIs, making the link between the MicroUl C library inputs and the BSP input devices
drivers.

The Low Level APIs to implement are listed in the header file LLUT_INPUT_impl.h. It allows events to be sent to the
MicroUl implementation. The input drivers are allowed to add events directly using the event generator’s unique
ID (see Static Initialization). The drivers are fully dependent on the MicroEJ framework (a driver or a driver listener
cannot be developed without MicroEJ because it uses the header file generated during the MicroUl initialization
step).

To send an event to the MicroEJ application, the driver (or its listener) has to call one of the event engine function,
listed in LLUI_INPUT.h . These functions take as parameter the MicroUl EventGenerator to target and the data.
The event generator is represented by a unique ID. The data depends on the type of the event. To run correctly, the
event engine requires an implementation of functions listed in LLUI_INPUT_impl.h.When an eventis added, the
event engine notifies MicroUl library.

MICROUI-3.0 Platform

Event Engine
7/ LLUI_INPU UI_INPUT_impI.h

BSP
Input_listener.c

Input_listener.h

Fig. 35: Input Low Level API

optional

When there is no input device on the board, a stub implementation of C library is available. This C library must be
linked by the third-party C IDE when the MicroUl module is installed in the MicroEJ Platform. This stub library does
not provide any Low Level APl files.

Dependencies

« MicroUl module (see MicroUl)
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« Static MicroUl initialization step (see Static Initialization). This step generates a header file which contains
some unique event generator IDs. These IDs must be used in the BSP to make the link between the input
devices drivers and the MicroUl Event Generators.

o LLUI_INPUT_impl.h implementation (see LLU/ INPUT: Input).

Installation

Input module is a sub-part of the MicroUl library. The Input module is installed at same time than MicroUl module.

Use

The MicroUl Input APIs are available in the classes of packages ej.microui.event and ej.microui.event.
generator.

4.9.7 Display

Principle

The Display module contains the C part of the MicroUl implementation which manages graphical displays. This
module is composed of three elements:

« the C part of MicroUl Display API (a built-in C archive) called Graphics Engine,

« an implementation of a Low Level APIs for the displays (LLUI_DISPLAY) that the BSP must provide (see
LLUI_DISPLAY: Display),

« an implementation of a Low Level APIs for MicroUl drawings.

Functional Description

The Display module implements the MicroUl graphics framework. This framework is constituted of several notions:
the display characteristics (size, format, backlight, contrast, etc.), the drawing state machine (render, flush, wait
flush completed), the images life cycle, the fonts and drawings. The main part of the Display module is provided by
a built-in Carchive called Graphics Engine. This library manages the drawing state machine mechanism, theimages
and fonts. The display characteristics and the drawings are managed by the LLUI_DISPLAY implementation.

The Graphics Engine is designed to let the BSP use an optional graphics processor unit (GPU) or an optional third-
party drawing library. Each drawing can be implemented independently. If no extra framework is available, the
Graphics Engine performs all drawings in software. In this case, the BSP has to perform a very simple implementa-
tion (four functions) of the Graphics Engine low-level APIs.

MicroUl library also gives the possibility to perform some additional drawings which are not available as APl in
MicroUl library. The Graphics Engine gives a set of functions to synchronize the drawings between them, to get the
destination (and sometimes source) characteristics, to call internal software drawings, etc.

Front Panel (simulator Graphics Engine part) gives the same possibilities. Same constraints can be applied, same
drawings can be overridden or added, same software drawing rendering is performed (down to the pixel).

Display Configurations

The Graphics Engine provides a number of different configurations. The appropriate configuration should be se-
lected depending on the capabilities of the screen and other related hardware, such as display controllers.
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The modes can vary in three ways:
« the buffer mode: double-buffer, simple buffer (also known as direct),
« the memory layout of the pixels,

« pixel format or depth.

Buffer Modes

Overview

When using the double buffering technique, the memory into which the application draws (called graphics buffer
or back buffer) is not the memory used by the screen to refresh it (called frame buffer or display buffer). When
everything has been drawn consistently from the application point of view, the back buffer contents are synchro-
nized with the display buffer. Double buffering avoids flickering and inconsistent rendering: it is well suited to high
quality animations.

For more static display-based applications, and/or to save memory, an alternative configuration is to use only one
buffer, shared by both the application and the screen.

Displays addressed by one of the standard configurations are called generic displays. For these generic displays,
there are three buffer modes: switch, copy and direct. The following flow chart provides a handy guide to selecting
the appropriate buffer mode according to the hardware configuration.
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Fig. 36: Buffer Modes

Implementation

The Graphics Engine does not depend on the type of buffer mode. The implementation of Display.flush() calls
the Low Level APl LLUI_DISPLAY_IMPL_flush to let the BSP to update the display data. This function should be
atomic and the implementation has to return the new graphics buffer address (back buffer address). In direct and
copy modes, this address never changes and the implementation has always to return the back buffer address. In
switch mode, the implementation has to return the old display frame buffer address.

The next sections describe the work to do for each mode.
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Switch

The switch mode is a double-buffered mode where two buffers in RAM alternately play the role of the back buffer
and the display buffer. The display source is alternatively changed from one buffer to the other. Switching the
source address may be done asynchronously. The synchronize function is called before starting the next set of
draw operations, and must wait until the driver has switched to the new buffer.

Synchronization steps are described below.

« Step 1: Drawing

MicroUl is drawing in buffer 0 (back buffer) and the display is reading its contents from buffer 1 (display
buffer).

MicroUl

U
d aw

read

Display

« Step 2: Switch
The drawing is done. Set that the next read will be done from buffer 0.
Note that the display “hardware component” asynchronously continues to read data from buffer 1.

MicroUl

read

Display

» Step 3: Copy
A copy from the buffer 0 (new display buffer) to the buffer 1 (new back buffer) must be done to keep the

contents of the current drawing. The copy routine must wait until the display has finished the switch, and
start asynchronously by comparison with the MicroUl drawing routine (see next step).

This copy routine can be done in a dedicated RTOS task or in an interrupt routine. The copy should start
after the display “hardware component” has finished a full buffer read to avoid flickering.

Usually a tearing signal from the display at the end of the read of the previous buffer (buffer 1) or at the
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beginning of the read of the new buffer (buffer 0) throws an interrupt. The interrupt routine starts the copy
using a DMA.

If it is not possible to start an asynchronous copy, the copy must be performed in the MicroUl drawing
routine, at the beginning of the next step.

Note that the copy is partial: only the parts that have changed need to be copied, lowering the CPU load.

MicroUl

copy

read

Display

« Step 4: Synchronisation
Waits until the copy routine has finished the full copy.

If the copy has not been done asynchronously, the copy must start after the display has finished the switch.
Itis a blocking copy because the next drawing operation has to wait until this copy is done.

« Step 5: Next draw operation
Same behavior as step 1 with buffers reversed.

MicroUl

d raw

read

Display

Copy

The copy mode is a double-buffered mode where the back buffer is in RAM and has a fixed address. To update the
display, data is sent to the display buffer. This can be done either by a memory copy or by sending bytes using a
bus, such as SPl or I12C.

Synchronization steps are described below.

« Step 1: Drawing
MicroUl is drawing in the back buffer and the display is reading its content from the display buffer.
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MicroUl
draw

Back Buffer Display Buffer

read
Display

« Step 2: Copy
The drawing is done. A copy from the back buffer to the display buffer is triggered.

Note that the implementation of the copy operation may be done asynchronously - it is recommended to
wait until the display “hardware component” has finished a full buffer read to avoid flickering. At the
implementation level, the copy may be done by a DMA, a dedicated RTOS task, interrupt, etc.

MicroUl

Back Buffer Display Buffer

read
Display

« Step 3: Synchronization
The next drawing operation waits until the copy is complete.

MicroUl

Back Buffer Display Buffer

read
Display
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Direct

The direct mode is a single-buffered mode where the same memory area is used for the back buffer and the display
buffer (See illustration below). Use of the direct mode is likely to result in “noisy” rendering and flickering, but saves
one buffer in runtime memory.

MicroUl
draw

read
Display

Partial Buffer

In the case where RAM usage is not a constraint, the graphics buffer is sized to store all the pixel data of the screen.
However, when the RAM available on the device is very limited, a partial buffer can be used instead. In that case,
the buffer is smaller and can only store a part of the screen (one third for example).

When this technique is used, the application draws in the partial buffer. To flush the drawings, the content of the
partial buffer is copied to the display (to its internal memory or to a complete buffer from which the display reads).

If the display does not have its own internal memory and if the device does not have enough RAM to allocate a
complete buffer, then it is not possible to use a partial buffer. In that case, only the Direct buffer mode can be used.

Workflow

A partial buffer of the desired size has to be allocated in RAM. If the display does not have its own internal memory,
a complete buffer also has to be allocated in RAM, and the display has to be configured to read from the complete
buffer.

The implementation should follow these steps:
1. First, the application draws in the partial buffer.

2. Then, to flush the drawings on the screen, the data of the partial buffer is sent to the display (either copied
to its internal memory or to the complete buffer in RAM).

3. Finally, a synchronization is required before starting the next drawing operation.

Dual Partial Buffer

A second partial buffer can be used to avoid the synchronization delay before between two drawing cycles. While
one of the two partial buffers is being copied to the display, the application can start drawing in the second partial
buffer.
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This technique is interesting when the copy time is long. The downside is that it requires more RAM or to reduce
the size of the partial buffers.

Using a dual partial buffer has no impact on the application code.

Application Limitations

Using a partial buffer rather than a complete buffer may require adapting the code of the application, since render-
ing a graphical element may require multiple passes. If the application uses MWT, a custom render policy has to be
used.

Besides, the GraphicsContext.readPixel() and the GraphicsContext.readPixels() APIs can not be used on the graph-
ics context of the display in partial buffer mode. Indeed, we cannot rely on the current content of the back buffer
as it doesn’t contain what is seen on the screen.

Likewise, the Painter.drawDisplayRegion() APl can not be used in partial buffer mode. Indeed, this API reads the
content of the back buffer in order to draw a region of the display. Instead of relying on the drawings which were
performed previously, this APl should be avoided and the drawings should be performed again.

Using a partial buffer can have a significant impact on animation performance. Refer to Animations for more infor-
mation on the development of animations in an application.

Implementation Example

The partial buffer demo provides an example of partial buffer implementation. This example explains how to im-
plement partial buffer support in the BSP and how to use it in an application.

Byte Layout

This chapter concerns only display with a number of bits-per-pixel (BPP) smaller than 8. For this kind of display, a
byte contains several pixels and the Graphics Engine allows to customize how to organize the pixels in a byte.
Two layouts are available:

« line: The byte contains several consecutive pixels on same line. When the end of line is reached, a padding is
added in order to start a new line with a new byte.

« column: The byte contains several consecutive pixels on same column. When the end of column is reached,
a padding is added in order to start a new column with a new byte.

When installing the Display module, a property bytelLayout is required to specify the kind of pixels representation
(see Installation).

Table 6: Byte Layout: line

BPP | MSB | \ \ \ \ | LsB
4 pixel 1 pixel 0

2 pixel 3 pixel 2 pixel1 pixel 0

1 pixel 7 | pixel 6 | pixel5 [ pixel4 | pixel3 | pixel2 | pixel1 | pixel0
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Memory Layout

Table 7: Byte Layout: column

BPP | 4 2 1
MSB | pixel1 | pixel3 | pixel7
pixel 6
pixel2 | pixel 5
pixel 4
pixel 0 | pixel1 | pixel3
pixel 2
pixel 0 | pixel1
LSB pixel 0

For the display with a number of bits-per-pixel (BPP) higher or equal to 8, the Graphics Engine supports the line-by-
line memory organization: pixels are laid out from left to right within a line, starting with the top line. For a display
with 16 bits-per-pixel, the pixel at (0,0) is stored at memory address 0, the pixel at (1,0) is stored at address 2, the
pixel at (2,0) is stored at address 4, and so on.

Table 8: Memory Layout for BPP >=8

BPP [ @+0 @+1 @+2 @+3 @+4

32 pixel 0 [7:0] | pixel 0[15:8] | pixel 0[23:16] | pixel 0 [31:24] | pixel1[7:0]
24 pixel 0 [7:0] | pixel 0 [15:8] | pixel 0[23:16] | pixel1[7:0] pixel 1[15:8]
16 pixel 0 [7:0] | pixel 0[15:8] | pixel1[7:0] pixel1[15:8] pixel 2 [7:0]
8 pixel 0 [7:0] | pixel1[7:0] pixel 2 [7:0] pixel 3 [7:0] pixel 4 [7:0]

For the display with a number of bits-per-pixel (BPP) lower than 8, the Graphics Engine supports the both memory
organizations: line by line (pixels are laid out from left to right within a line, starting with the top line) and column
by column (pixels are laid out from top to bottom within a line, starting with the left line). These byte organizations
concern until 8 consecutive pixels (see Byte Layout). When installing the Display module, a property memoryLayout
is required to specify the kind of pixels representation (see Installation).

Table 9: Memory Layout ‘line’ for BPP < 8 and byte layout ‘line’

BPP [ @+0 @+1 @+2 @+3 @+4
4 (0,0)to (1,0) | (2,0)to (3,0) | (4,0)to (5,0) (6,0) to (7,0) (8,0) to (9,0)

2 (0,0)to (3,0) | (4,0)to (7,0) | (8,0)to (11,0) (12,0) to (15,0) | (16,0) to (19,0)
1 (0,0)to (7,0) | (8,0)to (15,0) | (16,0 to (23,0) | (24,0) to (31,0) | (32,0) to (39,0)
Table 10: Memory Layout ‘line’ for BPP < 8 and byte layout ‘column’

BPP | @+0 @+1 @+2 @+3 @+4

4 (0,0)to (0,1) | (1,0)to (1,1) | (2,0)to(2,1) | (3,0) to(3,1) | (4,0)to (4,1)

2 (0,0) to (0,3) | (1,0)to (1,3) | (2,0)to (2,3) | (3,0) to (3,3) | (4,0) to (4,3)

1 (0,0)to (0,7) | (1,0) to (1,7) | (2,0)to (2,7) | (3,0)to (3,7) | (4,0)to (4,7)
Table 11: Memory Layout ‘column’ for BPP < 8 and byte layout ‘line’

BPP [ @+0 @+1 @+2 @+3 @+4

4 (0,0) to (1,0) | (0,1)to (1,1) | (0,2)to (1,2) | (0,3)to (1,3) | (0,4)to (1,4)

2 (0,0)to (3,0) | (0,1)to(3,1) | (0,2)to(3,2) | (0,3)to(3,3) | (0,4)to (3,4)

1 (0,0)to (7,0) | (0,1)to (7,1) | (0,2)to(7,2) | (0,3)to(7,3) | (0,4)to(7,4)
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Table 12: Memory Layout ‘column’ for BPP < 8 and byte layout ‘column’

BPP | @+0 @+1 @+2 @+3 @+4

4 (0,0)t0 (0,1) | (0,2)t0 (0,3) | (0,4)t0 (0,5) | (0,6)t0 (0,7) | (0,8)to (0,9)

2 (0,0) to (0,3) | (0,4) to (0,7) (0,8) to (0,11) (0,12) to (0,15) | (0,16) to (0,19)
1 (0,0)t0 (0,7) | (0,8)to (0,15) | (0,16) to (0,23) | (0,24)to (0,31) | (0,32) to (0,39)

Pixel Structure

The Display module provides pre-built display configurations with standard pixel memory layout. The layout of
the bits within the pixel may be standard or driver-specific. When installing the Display module, a property bpp is
required to specify the kind of pixel representation (see Installation).

When the value is one among this list: ARGB8888 | RGB888 | RGB565 | ARGB1555 | ARGB4444 | C4 | C2 | C1
, the Display module considers the pixels representation as standard. According to the chosen format, some color
data can be lost or cropped.

+ ARGB8888: the pixel uses 32 bits-per-pixel (alpha[8], red[8], green[8] and blue[8]).

u32 convertARGB8888tolLCDPixel(u32 c){
return c;

3

u32 convertLCDPixeltoARGB8888(u32 c){
return c;

3

« RGB888: the pixel uses 24 bits-per-pixel (alpha[0], red[8], green[8] and blue[8]).

u32 convertARGB8888toLCDPixel(u32 c){
return c & Oxffffff;

3

u32 convertLCDPixeltoARGB8888(u32 c){
return @
| 0xff000000
| ¢

3

« RGB565: the pixel uses 16 bits-per-pixel (alpha[0], red[5], green[6] and blue[5]).

u32 convertARGB8888toLCDPixel(u32 c){
return 0
| ((c & 0xf80000) >> 8)
| ((c & 0x00fce0) >> 5)
| ((c & 0x0000f8) >> 3)

’

u32 convertLCDPixeltoARGB8888(u32 c){
return 0
| oxff000000
| ((c & 0xf800) << 8)
| ((c & 0x07e0) << 5)
| ((c & 0x001f) << 3)

(continues on next page)
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(continued from previous page)

3

« ARGBI1555: the pixel uses 16 bits-per-pixel (alpha[1], red[5], green[5] and blue[5]).

u32 convertARGB8888toLCDPixel(u32 c){
return @
| (((c & 0xff00000R0) == Oxff0O0V0RR) ? Ox8000 : 0)
| ((c & 0xf80000) >> 9)
| ((c & 0x00f800) >> 6)
| ((c & 0x0000f8) >> 3)

’

}

u32 convertLCDPixeltoARGB8888(u32 c){
return @
| ((c & 0x8000) == 0x8000 ? 0xff00VV00 : 0x00000000)
| ((c & @x7c00) << 9)
| ((c & 0x03e0@) << 6)
| ((c & 0x001f) << 3)

’

}

« ARGB4444: the pixel uses 16 bits-per-pixel (alpha[4], red[4], green[4] and blue[4]).

u32 convertARGB8888tolLCDPixel(u32 c){
return @

| ((c & 0xf0000000) >> 16)

| ((c & 0x00f00000) >> 12)

| ((c & 0x0000f000) >> 8)

| ((c & 0x000000f0) >> 4)

’

((c & 0x000f) << 0)

3
u32 convertLCDPixeltoARGB8888(u32 c){
return 0

| ((c & 0xf000) << 16)
| ((c & 0xf00O) << 12)
| ((c & 0x0f00) << 12)
| ((c & 0x0f00) << 8)
| ((c & 0x00f0) << 8)
| ((c & 0x00f0) << 4)
| ((c & 0x000f) << 4)
| &

)

« C4: the pixel uses 4 bits-per-pixel (grayscale[4]).

u32 convertARGB8888toLCDPixel(u32 c){
return (toGrayscale(c) & 0Oxff) / 0x11;
}

u32 convertLCDPixeltoARGB8888(u32 c){
return 0xff000000 | (c * Ox111111);

}
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+ C2: the pixel uses 2 bits-per-pixel (grayscale[2]).

u32 convertARGB8888toLCDPixel(u32 c){
return (toGrayscale(c) & 0xff) / 0x55;
}

u32 convertLCDPixeltoARGB8888(u32 c){
return 0xffQ00000 | (c * 0x555555);
}

+ C1: the pixel uses 1 bit-per-pixel (grayscale[1]).

u32 convertARGB8888tolLCDPixel(u32 c){
return (toGrayscale(c) & 0xff) / oOxff;
}

u32 convertLCDPixeltoARGB8888(u32 c){
return 0xff000000 | (c * Oxffffff);

3

When the value is one among thislist: 1 | 2 | 4 | 8 | 16 | 24 | 32,the Display module considers the
pixel representation as driver-specific. In this case, the driver must implement functions that convert MicroUl’s
standard 32 bits ARGB colors to display color representation (see LLUI_DISPLAY: Display). This mode is often used
when the pixel representation is not ARGB or RGB but BGRA or BGR instead. This mode can also be used when
the number of bits for a color component (alpha, red, green or blue) is not standard or when the value does not
represent a color but anindexina CLUT .

Low Level API
Overview

Platform

MICROUI-3.0 DRAWING-1.0

Graphics Engine Software Algorithms LLUI_PAINTER_impl.h LLDW_PAINTER_impl.h
LLUI_DISPLAY_impl.h LLUI_DISPLAY.h ui_drawing_s\oq.h dw_drawing_soft.n

BSP

LLUI_PAINTER_impl.c LLDW_PAINTER _impl.c

T EEE T
LLUI_DISPLAY_impl.c Drawings in BSP (GPU etc.)

optional

hardware

Fig. 37: Display Low Level API

+ MicroUl library calls the BSP functions through the Graphics Engine and header file LLUI_DISPLAY_impl.h.

+ Implementation of LLUI_DISPLAY_impl.h can call Graphics Engine functions through LLUI_DISPLAY.h.
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+ To perform some drawings, MicroUl uses LLUI_PAINTER_impl.h functions.

+ The drawing native functions are implemented in the CCO com.microej.clibrary.llimpl#microui ; this
CCO must be included in BSP.

« This CCO redirects drawings the implementation of ui_drawing.h.
« ui_drawing.h is already implemented by software algorithms library (not represented in previous picture).
« ui_drawing.h can be too implemented in BSP to use a GPU for instance.

« This Implementation is allowed to call software algorithms through ui_drawing_soft.h header file.

MicroEJ library Drawing performs same operations with header files LLDW_PAINTER_impl.h ,
dw_drawing_impl.h and dw_drawing.h;and with Cfile LLDW_PAINTER_impl.c also availablein CCO com.
microej.clibrary.llimpl#microui.

Required Low Level API

Some four Low Level APIs are required to connect the Graphics Engine on the display driver. The functions are listed
in LLUI_DISPLAY_impl.h.

o LLUI_DISPLAY_IMPL_initialize : The initialization function is called when MicroEJ application is calling
MicroUI.start() . Before this call, the display is useless and don’t need to be initialized. This function con-
sists in initializing the LCD driver and in filling the given structure LLUI_DISPLAY_SInitData. This structure
has to contain pointers on two binary semaphores (see after), the back buffer address (see Display Configu-
rations), the display virtual size in pixels and optionally the display physical size in pixels. The display virtual
size is the size of the area where the drawings are visible. The display physical size is the required memory
size where the area is located. Virtual memory size is: display_width = display_height * bpp / 8.
On some devices the memory width (in pixels) is higher than virtual width. In this way, the graphics buffer
memory size is: memory_width * memory_height = bpp / 8.

LLUI_DISPLAY_IMPL_binarySemaphoreTake and LLUI_DISPLAY_IMPL_binarySemaphoreGive: The Graph-
ics Engine requires two binary semaphores to synchronize its internal states. The binary semaphores must
be configured in a state such that the semaphore must first be given before it can be taken (this initializa-
tion must be performed in LLUI_DISPLAY_IMPL_initialize function). Two distinct functions have to be
implemented to take and give a binary semaphore.

LLUI_DISPLAY_IMPL_flush:Accordingthe display buffer mode (see Display Configurations), the flush func-
tion has to be implemented. This function must not be blocking and not performing the copy directly. An-
other OS task or a dedicated hardware must be configured to perform the buffer copy.

Optional Low Level API

Several optional Low Level APl are available in LLUI_DISPLAY_impl.h. They are already implemented as weak
functions in the Graphics Engine and return no error. These optional features concern the display backlight and
constrast, display characteristics (is colored display, double buffer), colors conversions (see Pixel Structure and
CLUT), etc. Refer to each function comment to have more information about the default behavior.

Painter Low Level API

AllMicroUl drawings (availablein Painter class) are calling a native function. The MicroUl native drawing functions
arelistedin LLUI_PAINTER_impl.h. Theimplementation must take care about a lot of constraints: synchronization
between drawings, Graphics Engine notification, MicroUl GraphicsContext clip and colors, flush dirty area, etc.
The principle of implementing a MicroUl drawing function is described in the chapter Drawing Native.
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An implementation of LLUI_PAINTER_impl.h is already available on MicroEJ Central Repository. This implemen-
tation respects the synchronization between drawings, the Graphics Engine notification, reduce (when possible)
the MicroUl GraphicsContext clip constraints and update (when possible) the flush dirty area. This implementa-
tion does not perform the drawings. It only calls the equivalent of drawing available in ui_drawing.h. This allows
to simplify how to use a GPU (or a third-party library) to perform a drawing: the ui_drawing.h implementation has
just to take in consideration the MicroUl GraphicsContext clip and colors and flush dirty area. Synchronization
with the Graphics Engine is already performed.

In addition to the implementation of LLUI_PAINTER_impl.h , an implementation of ui_drawing.h is already
available in Graphics Engine (in weak mode). This allows to implement only the functions the GPU is able to per-
form. For a given drawing, the weak function implementation is calling the equivalent of drawing available in
ui_drawing_soft.h . Thisfile lists all drawing functions implemented by the Graphics Engine.

The Graphics Engine implementation of ui_drawing_soft.h is performing the drawings in software. However
some drawings can call another ui_drawing.h function. For instance UI_DRAWING_SOFT_drawHorizontalline
is calling UT_DRAWING_fillRectangle inorderto use a GPU if available. If not available, the weak implementation
of UI_DRAWING_fillRectangle is calling UI_DRAWING_SOFT_fillRectangle and so on.

The BSP implementation is also allowed to call ui_drawing_soft.h algorithms, one or several times per function
to implement. For instance, a GPU may be able to draw an image whose format is RGB565. But if the image format
is ARGB1555, BSP implementation can call UT_DRAWING_SOFT_drawImage function.

Graphics Engine API

The Graphics Engine provides a set of functions to interact with the C archive. The functions allow to retrieve some
drawing characteristics, synchronize drawings between them, notify the end of flush and drawings, etc.

The functions are availablein LLUI_DISPLAY.h.

Drawing Native

As explained before, MicroUl implementation provides a dedicated header file which lists all MicroUl Painter draw-
ings native function. The implementation of these functions has to respect several rules to not corrupt the MicroUl
execution (flickering, memory corruption, unknown behavior, etc.). These rules are already respected in the CCO
available in MicroEJ Central Repository. In addition, MicroUl allows to add some custom drawings. The implemen-
tation of MicroUl Painter native drawings should be used as model to implement the custom drawings.

All native functions must have a MICROUI_GraphicsContext* as parameter (often first parameter). This identi-
fies the destination target: the MicroUl GraphicsContext. This target is retrieved in MicroEJ application calling the
method GraphicsContext.getSNIContext() . This method returns a byte array which is directly mapped on the
MICROUI_GraphicsContext structurein MicroUl native drawing function declaration.

A graphics context holds a clip and the drawer is not allowed to perform a drawing outside this clip (otherwise the
behavior is unknown). Note the bottom-right coordinates might be smaller than top-left (in x and/or y) when the
clip width and/or height is null. The clip may be disabled (when the current drawing fits the clip); this allows to
reduce runtime. See LLUI_DISPLAY_isClipEnabled().

Note: Several clip functions are available in LLUI_DISPLAY.h to check if a drawing fits the clip.

The Graphics Engine requires the synchronization between the drawings. To do that, it requires a call to
LLUI_DISPLAY_requestDrawing at the beginning of native function implementation. This function takes as pa-
rameter the graphics context and the pointer on the native function itself. This pointer must be casted in a
SNI_callback.
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The drawing function must update the next Display.flush() area (dirty area). If not performed, the next call to Dis-
play.flush() will not call LLUI_DISPLAY_IMPL_flush() function.

The native function implementation pattern is:

void Java_com_mycompany_MyPainterClass_myDrawingNative (MICROUI_GraphicsContext* gc, ...)

{
// tell to the Graphics Engine if drawing can be performed

if (LLUI_DISPLAY_requestDrawing(gc, (SNI_callback)&Java_com_mycompany_MyPainterClass_
—myDrawingNative))

{
DRAWING_Status status;

// perform the drawings (respecting clip if not disabled)
[...]

// update new flush dirty area
LLUI_DISPLAY_setDrawinglLimits(gc, ...);

// set drawing status
LLUI_DISPLAY_setDrawingStatus(DRAWING_DONE); // or DRAWING_RUNNING;

}

// else: refused drawing

Display Synchronization

Overview

The Graphics Engine is designed to be synchronized with the display refresh rate by defining some pointsin the ren-
dering timeline. Itis optional; however it is mainly recommanded. This chapter explains why to use display tearing
signal and its consequences. Some chronograms describe several use cases: with and without display tearing sig-
nal, long drawings, long flush time, etc. Times are in milliseconds. To simplify chronograms views, the display
refresh rate is every 16ms (62.5Hz).

Captions definition:

« Ul: Itis the Ul task which performs the drawings in the back buffer. At the end of the drawings, the examples
consider that the Ul thread calls Display.flush() 1 millisecond after the end of the drawings. At this moment,
a flush can start (the call to Display.flush() is symbolized by a simple peak in chronograms).

« Flush: In copy mode, it is the time to transfer the content of back buffer to display buffer. In switch mode, it
is the time to swap back and display buffers (often instantaneous) and the time to recopy the content of new
display buffer to new back buffer. During this time, the back buffer is in use and Ul task has to wait the end of
copy before starting a new drawing.

+ Tearing: The peaks show the tearing signals.

+ Rendering frequency: the frequency between the start of a drawing to the end of flush.

Tearing Signal

In this example, the drawing time is 7ms, the time between the end of drawing and the call to Display.flush() is
Tms and the flush time is 6ms. So the expected rendering frequency is 7 + 1+ 6 = 14ms (71.4Hz). Flush starts just
after the call to Display.flush() and the next drawing starts just after the end of flush. Tearing signal is not taken in

4.9. Graphical User Interface 272


https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Display.html#flush--

MicroEJ Documentation, Revision bd708584

consideration. By consequence the display content is refreshed during the display refresh time. The content can
be corrupted: flickering, glitches, etc. The rendering frequency is faster than display refresh rate.

ol L | L | L | L | L | L
Fust| | | | | I | I | | |

TearIngI I I I I I
T T T T T

0 5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80

Inthis example, the times are identical to previous example. The tearing signalis used to start the flush in respecting
the display refreshing time. The rendering frequency becomes smaller: it is cadenced on the tearing signal, every
16ms (62.5Hz). During 2ms, the CPU can schedule other tasks or goes in idle mode. The rendering frequency is
equal to display refresh rate.

! L | LI I L | L I L
- | I I I | |

|
TearIngI I I I I I
N DA R I A R R I R I R

0 5 10 15 20 25 30 35 40 a5 50 55 60 65 70 75 80

In this example, the drawing time is 14ms, the time between the end of drawing and the call to Display.flush() is
Ims and the flush time is 6ms. So the expected rendering frequency is 14 + 1+ 6 = 21ms (47.6Hz). Flush starts just
after the call to Display.flush() and the next drawing starts just after the end of flush. Tearing signal is not taken in
consideration.

ol L | L | L I L
rust] I | I | | |

TearIngI I I I I I
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0 5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80

Inthis example, the times are identical to previous example. The tearing signalis used to start the flush in respecting
the display refreshing time. The drawing time + flush time is higher than display tearing signal period. So the flush
cannot start at every tearing peak: it is cadenced on two tearing signals, every 32ms (31.2Hz). During 11ms, the CPU
can schedule other tasks or goes in idle mode. The rendering frequency is equal to display refresh rate divided by
two.

ol L I i |
FIushI | | | I
TearIngI I I I I I
(I)IIIILIIIIlI[)IIIIlISIIIIZIOIIIIZISIIIISIOIIII35IIII4I()IIII4I5IIII50IIII5I5IIII6I()III 65 70 7I5 - SI()
Additional Buffer

Some devices take a lot of time to send back buffer content to display buffer. The following examples demonstrate
the consequence on rendering frequency. The use of an additional buffer optimizes this frequency, however it uses
a lot of RAM memory.

In this example, the drawing time is 7Tms, the time between the end of drawing and the call to Display.flush() is
Ims and the flush time is 12ms. So the expected rendering frequency is 7 + 1+ 12 = 20ms (50Hz). Flush starts just
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after the call to Display.flush() and the next drawing starts just after the end of flush. Tearing signal is not taken in
consideration. The rendering frequency is cadenced on drawing time + flush time.

ui L | L | L I L
FIushI I I I I I I I

Tear\ngI I I I I I
[N R A A N A LR R A A A A I T I

0 5 10 15 20 25 30 35 40 a5 50 55 60 65 70 75 80

As mentionned above, the idea is to use two back buffers. First, Ul task is drawing in back buffer A. Just after the
call to Display.flush(), the flush can start. At same moment, the content of back buffer A is copied in back buffer
B (use a DMA, copy time is Ims). During the flush time (copy of back buffer A to display buffer), the back buffer
B can be used by Ul task to continue the drawings. When the drawings in back buffer B are done (and after call
to Display.flush()), the DMA copy of back buffer B to back buffer A cannot start: the copy can only start when the
flush is fully done because the flush is using the back buffer A . As soon as the flush is done, a new flush (and DMA
copy) can start. The rendering frequency is cadenced on flush time, ie 12ms (83.3Hz).

ol L i - i [ I - i L
o [1 [ [ [1 [ [
P | I | I I I
TearIngI I I I I I
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The previous example doesn’t take in consideration the display tearing signal. With tearing signal and only one
back buffer, the frequency is cadenced on two tearing signals (see previous chapter). With two back buffers, the
frequency is now cadenced on only one tearing signal, despite the long flush time.

u L L I L I L | L | |
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Time Sum-up

The following table resumes the previous examples times:
« It consider the display frequency is 62.5Hz (16ms).

+ Drawing time is the time let to the application to perform its drawings and call Display.flush(). In our exam-
ples, the time between the last drawing and the call to Display.flush() is Ims.

« FPS and CPU load are calculated from examples times.

+ Max drawing time is the maximum time let to the application to perform its drawings, without overlapping
next display tearing signal (when tearing is enabled).
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Tear- | Nb Drawing time | Flush time | DMA copy time | FPS CPU load | Maxdrawingtime

ing buffers | (ms) (ms) (ms) (Hz) (%) (ms)

no 1 T7+1 6 .4 57.1

yes 1 7+1 6 625 | 50 10

no 1 14+1 6 47.6 .4

yes 1 14+1 6 312 46.9 20

no 1 T7+1 12 50 40

yes 1 7+ 12 31.2 25 8

no 2 T+1 12 1 83.3 66.7

yes 2 T7+1 12 1 62.5 50 n
GPU Synchronization

When a GPU is used to perform a drawing, the caller (MicroUl painter native method) returns immediately. This
allows the MicroEJ application to perform other operations during the GPU rendering. However, as soon as the
MicroEJ application is trying to perform another drawing, the previous drawing made by the GPU must be done.
The Graphics Engine is designed to be synchronized with the GPU asynchronous drawings by defining some points
in the rendering timeline. It is not optional: MicroUl considers a drawing is fully done when it starts a new one. The
end of GPU drawing must notify the Graphics Engine calling LLUI_DISPLAY_drawingDone() .

Antialiasing

Fonts

The antialiasing mode for the fonts concerns only the fonts with more than 1 bit per pixel (see Font Generator).

Background Color

For each pixel to draw, the antialiasing process blends the foreground color with a background color. This back-
ground color can be specified or not by the application:

» specified: The background color is fixed by the MicroEJ Application (GraphicsContext.setBackgroundColor()).

« not specified: The background color is the original color of the destination pixel (a “read pixel” operation is
performed for each pixel).

CLUT

The Display module allows to target display which uses a pixel indirection table (CLUT). This kind of display are
considered as generic but not standard (see Pixel Structure). It consists to store color indices in image memory
buffer instead of colors themselves.

Color Conversion

The driver must implement functions that convert MicroUl’s standard 32 bits ARGB colors (see LLU/_DISPLAY: Dis-
play) to display color representation. For each application ARGB8888 color, the display driver has to find the cor-
responding color in the table. The Graphics Engine will store the index of the color in the table instead of using the
color itself.
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When an application color is not available in the display driver table (CLUT), the display driver can try to find the
closest color or return a default color. First solution is often quite difficult to write and can cost a lot of time at
runtime. That’s why the second solution is preferred. However, a consequence is that the application has only to
use a range of colors provided by the display driver.

Alpha Blending

MicroUl and the Graphics Engine use blending when drawing some texts or anti-aliased shapes. For each pixel to
draw, the display stack blends the current application foreground color with the targeted pixel current color or with
the current application background color (when enabled). This blending creates some intermediate colors which
are managed by the display driver.

Most of time the intermediate colors do not match with the palette. The default color is so returned and
the rendering becomes wrong. To prevent this use case, the Graphics Engine offers a specific Low Level API
LLUI_DISPLAY_IMPL_prepareBlendingOfIndexedColors(void* foreground, void* background) .

This APl is only used when a blending is required and when the background color is enabled. The Graphics Engine
calls the API just before the blending and gives as parameter the pointers on the both ARGB colors. The display
driver should replace the ARGB colors by the CLUT indices. Then the Graphics Engine will only use between both
indices.

For instance, when the returned indices are 20 and 27, the display stack will use the indices 20 to 27, where all
indices between 20 and 27 target some intermediate colors between both the original ARGB colors.

This solution requires several conditions:
« Background color is enabled and it is an available color in the CLUT.

« Application can only use foreground colors provided by the CLUT. The platform designer should give to the
application developer the available list of colors the CLUT manages.

« The CLUT must provide a set of blending ranges the application can use. Each range can have its own size
(different number of colors between two colors). Each range is independent. For instance if the foreground
color RED ( 0xFFFF0000 ) can be blended with two background colors WHITE ( 0xFFFFFFFF)and BLACK (
0xFFO00000 ), two ranges must be provided. Both the ranges have to contain the same index for the color
RED.

Application can only use blending ranges provided by the CLUT. Otherwise the display driver is not able to
find the range and the default color will be used to perform the blending.

Rendering of dynamic images (images decoded at runtime) may be wrong because the ARGB colors may be
out of CLUT range.

Image Pixel Conversion

Overview

The Graphics Engine is built for a dedicated display pixel format (see Pixel Structure). For this pixel format, the
Graphics Engine must be able to draw images with or without alpha blending and with or without transformation.
In addition, it must be able to read all image formats.

The MicroEJ application may not use all MicroUl image drawings options and may not use all images formats. It is
not possible to detect what the application needs, so no optimization can be performed at application compiletime.
However, for a given application, the platform can be built with a reduced set of pixel support.

All pixel format manipulations (read, write, copy) are using dedicated functions. It is possible to remove some
functions or to use generic functions. The advantage is to reduce the memory footprint. The inconvenient is that
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some features are removed (the application should not use them) or some features are slower (generic functions
are slower than the dedicated functions).

Functions

There are five pixel conversion modes:

« Draw an image without transformation and without global alpha blending: copy a pixel from a format to the
destination format (display format).

+ Draw animage without transformation and with global alpha blending: copy a pixel with alpha blending from
a format to the destination format (display format).

« Draw an image with transformation and with or without alpha blending: draw an ARGB8888 pixel in destina-
tion format (display format).

« Load a Resourcelmage with an output format: convert an ARGB8888 pixel to the output format.

+ Read a pixel from an image (Image.readPixel() or to draw an image with transformation or to convert an
image): read any pixel formats and convert it in ARGB8888.

Table 13: Pixel Conversion

Nb input formats | Nb output formats | Number of combinations
Draw image without global alpha | 22 1 22
Draw image with global alpha 22 1 22
Draw image with transformation | 2 1 2
Load a Resourcelmage 1 6 6
Read an image 22 1 22

There are 22x1 + 22x1 + 2x1 + 1x6 + 22x1 = 74 functions. Each function takes between 50 and 200 bytes
depending on its complexity and the C compiler.

Linker File

All pixel functions are listed in a platform linker file. It is possible to edit this file to remove some features or to share
some functions (using generic function).

How to get the file:
1. Build platform as usual.

2. Copy platform file [platform]/source/link/display_image_x.lscf in platform configuration project:
[platform configuration project]/dropins/link/. x isa number which characterizes the display
pixel format (see Pixel Structure). See next warning.

3. Perform some changes into the copied file (see after).

4. Rebuild the platform: the dropins file is copied in the platform instead of the original one.

Warning: When the display formatin [platform configuration project]/display/display.properties
changes, the linker file suffix changes too. Perform again all operations in new file with new suffix.

The linker file holds five tables, one for each use case, respectively IMAGE_UTILS_TABLE_COPY ,
IMAGE_UTILS_TABLE_COPY_WITH_ALPHA , IMAGE_UTILS_TABLE_DRAW , IMAGE_UTILS_TABLE_SET and
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IMAGE_UTILS_TABLE_READ . For each table, a comment describes how to remove an option (when possible)
or how to replace an option by a generic function (if available).

Library ej.api.Drawing

This library is a Foundation Library which provides additional drawings API. This library is fully integrated in Dis-
play module. It requires an implementation of its Low Level APl: LLDW_PAINTER_impl.h . These functions are
implemented in the same CCO as LLUI_PAINTER_impl.h: com.microej.clibrary.llimpl#microui-drawings.
Like MicroUl painter’s natives, the functions are redirected to dw_drawing.h . A default implementation of these
functions is available in Software Algorithms module (in weak). This allows the BSP to override one or several APIs.

Dependencies

« MicroUl module (see MicroUl)

o LLUI_DISPLAY_impl.h implementation if standard or custom implementation is chosen (see Dependencies
and LLUI_DISPLAY: Display).

Installation

The Display module is a sub-part of the MicroUl library. When the MicroUl module is installed, the Display module
must be installed in order to be able to connect the physical display with the MicroEJ Platform. If not installed, the
stub module will be used.

In the platform configuration file, check Ul > Display to install the Display module. When checked, the prop-

erties file display > display.properties is required during platform creation to configure the module. This
configuration step is used to choose the kind of implementation (see Dependencies).

The properties file must / can contain the following properties:

+ bpp [mandatory]: Defines the number of bits per pixels the display device is using to render a pixel. Expected
value is one among these both list:

Standard formats:

- ARGB8888 : Alpha 8 bits; Red 8 bits; Green 8 bits; Blue 8 bits,

RGB888 : Alpha 0 bit; Red 8 bits; Green 8 bits; Blue 8 bits (fully opaque),

RGB565 : Alpha 0 bit; Red 5 bits; Green 6 bits; Blue 5 bits (fully opaque),

ARGB1555 : Alpha 1 bit; Red 5 bits; Green 5 bits; Blue 5 bits (fully opaque or fully transparent),

ARGB4444 : Alpha 4 bits; Red 4 bits; Green 4 bits; Blue 4 bits,

C4: 4 bits to encode linear grayscale colors between 0xff000000 and Oxffffffff (fully opaque),

C2: 2 bits to encode linear grayscale colors between 0xff000000 and 0xffffffff (fully opaque),

C1:1bitto encode grayscale colors 0xff000000 and Oxffffffff (fully opaque).

Custom formats:

32 : up to 32 bits to encode Alpha, Red, Green and Blue (in any custom arrangement),

24 up to 24 bits to encode Alpha, Red, Green and Blue (in any custom arrangement),

16 : up to 16 bits to encode Alpha, Red, Green and Blue (in any custom arrangement),

8 : up to 8 bits to encode Alpha, Red, Green and Blue (in any custom arrangement),
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- 4:upto 4 bits to encode Alpha, Red, Green and Blue (in any custom arrangement),
- 2:upto 2 bits to encode Alpha, Red, Green and Blue (in any custom arrangement),
- 1:1bitto encode Alpha, Red, Green or Blue.

All other values are forbidden (throw a generation error).

« bytelLayout [optional, default value is “line”]: Defines the pixels data order in a byte the display device is
using. A byte can contain several pixels when the number of bits-per-pixels (see ‘bpp’ property) is lower than
8. Otherwise this property is useless. Two modes are available: the next bit(s) on the same byte can target
the next pixel on the same line or on the same column. In first case, when the end of line is reached, the next
byte contains the first pixels of next line. In second case, when the end of column is reached, the next byte
contains the first pixels of next column. In both cases, a new line or a new column restarts with a new byte,
even if it remains some free bits in previous byte.

- line:the next bit(s) on current byte contains the next pixel on same line (x increment),

- column: the next bit(s) on current byte contains the next pixel on same column (y increment).

Note:
- Default value is ‘line’.
- All other modes are forbidden (throw a generation error).

- When the number of bits-per-pixels (see ‘bpp’ property) is higher or equal than 8, this property is useless
and ignored.

memoryLayout [optional, default value is “line”]: Defines the pixels data order in memory the display device
is using. This option concerns only the display with a bpp lower than 8 (see ‘bpp’ property). Two modes are
available: when the byte memory address is incremented, the next targeted group of pixels is the next group
on the same line or the next group on same column. In first case, when the end of line is reached, the next
group of pixels is the first group of next line. In second case, when the end of column is reached, the next
group of pixels is the first group of next column.

- line:the next memory address targets the next group of pixels on same line (x increment),

- column: the next memory address targets the next group of pixels on same column (y increment).

Note:
- Default valueis ‘line’.
- All other modes are forbidden (throw a generation error).

- Whenthe number of bits-per-pixels (see ‘bpp’ property) is higher or equal than 8, this property is useless
and ignored.

+ imageBuffer.memoryAlignment [optional, default value is “4”]: Defines the image memory alignment to
respect when creating an image. This notion is useful when images drawings are performed by a third party
hardware accelerator (GPU): it can require some constraints on the image to draw. This value is used by the
Graphics Engine when creating a dynamic image and by the image generator to encode a RAW image. See
MicroEJ Format: GPU and Custom MicroEJ Format. Allowed values are 1, 2, 4, 8, 16, 32, 64,128 and 256.

+ imageHeap.size [optional, default value is “not set”]: Defines the images heap size. Useful to fix a platform
heap size when building a firmware in command line. When using a MicroEJ launcher, the size set in this
launcher is priority to the platform value.

4.9. Graphical User Interface 279



MicroEJ Documentation, Revision bd708584

Use

The MicroUl Display APIs are available in the class ej.microui.display.Display.

4.9.8 Images
Overview
Principle

The Image Engine is designed to make the distinction between three kinds of MicroUl images:
« the images which can be used by the application without a loading step: class Image,
« the images which requires a loading step before being usable by the application: class Resourcelmage,
« the buffered images where the application can draw into: class Bufferedimage.

The first kind of image requires the Image Engine to be able to use (get, read and draw) an image referenced by
its path without any loading step. The open step should be very fast: just have to find the image in the application
resources list and create an Image object which targets the resource. No RAM memory to store the image pixels is
required: the Image Engine directly uses the resource address (often in FLASH memory). And finally, closing step is
useless because there is nothing to free (except Image object itself, via the garbage collector).

The second kind of image requires the Image Engine to be able to use (load, read and draw) an image referenced
by its path with or without any loading step. When the image is understandable by the Image Engine without any
loading step, the image is considered like the first kind of image (fast open step, no RAM memory, useless closing
step). When a loading step is required (dynamic decoding, external resource loading, image format conversion),
the open state becomes longer and a buffer in RAM is required to store the image pixels. By consequence a closing
step is required to free the buffer when image becomes useless.

The third kind of image requires, by definition, a buffer to store the image pixels. Image Engine must be able to use
(create, read and draw) this kind of image. The open state consists in creating a buffer. By consequence a closing
step is required to free the buffer when the image becomes useless. Contrary to the other kinds of images, the
application will be able to draw into this image.

Functional Description

The Image Engine is composed of:

« An “Image Generator” module, for converting images into a MicroEJ format (known by the Image Engine
Renderer) or into a platform binary format (cannot be used by the Image Engine Renderer), before runtime
(pre-generated images).

+ The “Image Loader” module, for loading, converting and closing the images.

+ Aset of “Image Decoder” modules, for converting standard image formats into a MicroEJ format (known by
the Image Renderer) at runtime. Each Image Decoder is an additional module of the main module “Image
Loader”.

+ The “Image Renderer” module, for reading and drawing the images in MicroEJ format.
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Input Files
(png, xxx)

lpng | xxx

png | xxx Image Generator

png | xxx

png | xxx | mej | bin \png | xxx | mej | bin

External Flash Flash
(SDCard etc.) (internal ROM, NOR)

png | xxx | mej ﬁ\g | xxx | mej (to convert)

Image Loader
XXX Imej png
mej (byte @) XXX Decoder ME) Converter PNG Decoder mej
bin mej lmej mej bin
RAM

lmej

Image Renderer

lmej

BSP
’%ej \fj | bin
Software
Algorithms SRy

N/

Memory Buffer

« Colors:

blue: off-board elements (tools, files).

green: hardware elements (memory, processor).

orange: on-board Graphics Engine elements.

gray: BSP.

« Line labels:
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- png: symbolizes all standard image input formats (PNG, JPG, etc.).
- xxx : symbolizes a non-standard input format.

- mej : symbolizes the MicroEJ output format (MicroEJ Format: Standard).

- bin:symbolizes a platform binary format (Binary Format).
Process overview:

1. The user specifies the pre-generated images to embed (see Image Generator) and / or the images to embed
as regular resources (see Encoded Image).

2. The files are embedded as resources with the MicroEJ Application. The files’ data are linked into the FLASH
memory.

3. When the MicroEJ Application creates a MicroUl Image object, the Image Loader loads the image, calling the
right sub Image Engine module (see Image Generator and Encoded Image) to decode the specified image.

4. When the MicroEJ Application draws this MicroUl Image on the display (or on buffered image), the decoded
image data is used, and no more decoding is required, so the decoding is done only once.

5. When the MicroUl Image is no longer needed, it must be closed explicitly by the application. The Image
Engine Core asks the right sub Image Engine module (see Image Generator and Encoded Image) to free the
image working area.

Image Format

The Image Engine makes the distinction between the input formats (how an image is encoded) and the output
formats (how the image is used by the platform and/or the Image Renderer).The Image Engine manages several
standard formats in input: PNG, JPEG, BMP, etc. In addition, an input format may be custom (platform dependant,
unsupported image format by default). It manages two formats in output: the MicroEJ format (known by the Image
Renderer) and the binary format.

Each Image Engine can manage one or several input formats. However the Image Renderer manages only the
MicroEJ format (MicroEJ Format: Standard, MicroEJ Format: Display and MicroEJ Format: GPU). The binary output
format (Binary Format)is fully platform dependant and can be used to encode some images which are not usable
by MicroUl standard API.

MicroEJ Format: Standard

Several MicroEJ format encodings are available. Some encodings may be directly managed by the display driver.
Refers to the platform specification to retrieve the list of better formats.

Advantages:
+ The pixels layout and bits format are standard, so it is easy to manipulate these images on the C-side.
+ Drawing an image is very fast when the display driver recognizes the format (with or without transparency).
+ Supports or not the alpha encoding: select the better format according to the image to encode.
Disadvantages:

« No compression: the image size in bytes is proportional to the number of pixels, the transparency, and the
number of bits-per-pixel.

« Slower than display format when the display driver does not recognize the format: a pixel conversion is
required at runtime.
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This format requires a small header (around 20 bytes) to store the image size (width, height), format, flags
(is_transparent etc.), row stride etc. The required memory also depends on number of bits-per-pixels of MicroEJ
format:

required_memory = header + (image_width * image_height) * bpp / 8;

The pixels array is stored after the MicroEJ image file header. A padding between the header and the pixels array is
added to force to start the pixels array at a memory address aligned on number of bits-per-pixels.

I

Select one the following format to use a generic format among this list: ARGB8888, RGB888, ARGB4444 , ARGB1555
, RGB565, A8, A4, A2, A1, C4, C2, C1, AC44, AC22 and AC11. The following snippets describe the color
conversion for each format:

« ARGB8888: 32 bits format, 8 bits for transparency, 8 per color.

u32 convertARGB8888toRAWFormat (u32 c){
return c;

3

+ RGB888: 24 bits format, 8 per color. Image is always fully opaque.

u32 convertARGB8888toRAWFormat (u32 c){
return c & Oxffffff;
}

« ARGB4444: 16 bits format, 4 bits for transparency, 4 per color.

u32 convertARGB8888toRAWFormat (u32 c){
return @
| ((c & 0xf0000000) >> 16)
| ((c & 0x00f00000) >> 12)
| ((c & 0x0000f000) >> 8)
| ((c & 0x000000f0) >> 4)

’

3

« ARGBI1555: 16 bits format, 1 bit for transparency, 5 per color.

u32 convertARGB8888toRAWFormat (u32 c){
return 0
| (((c & Oxff000000) == Oxff00000Q) ? 0x8000 : 0)
| ((c & 0xf80000) >> 9)
| ((c & 0x00f800) >> 6)
| ((c & 0x0000f8) >> 3)

)

3

+ RGB565: 16 bits format, 5 or 6 per color. Image is always fully opaque.

u32 convertARGB8888toRAWFormat (u32 c){
return 0
| ((c & 0xf80000) >> 8)
| ((c & 0x00fce0) >> 5)
| ((c & 0x0000f8) >> 3)

(continues on next page)
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(continued from previous page)

3

« A8: 8 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat (u32 c){
return Oxff - (toGrayscale(c) & 0xff);
}

+ A4: 4 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat (u32 c){
return (Oxff - (toGrayscale(c) & 0Oxff)) / ox11;

3

+ A2: 2 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat (u32 c){
return (Oxff - (toGrayscale(c) & 0Oxff)) / 0x55;

3

+ Al: 1 bit format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

u32 convertARGB8888toRAWFormat (u32 c){
return (Oxff - (toGrayscale(c) & 0Oxff)) / oxff;

3

« C4: 4 bits format with grayscale conversion. Image is always fully opaque.

u32 convertARGB8888toRAWFormat (u32 c){
return (toGrayscale(c) & 0xff) / 0x11;

}

« C2: 2 bits format with grayscale conversion. Image is always fully opaque.

u32 convertARGB8888toRAWFormat (u32 c){
return (toGrayscale(c) & 0xff) / 0x55;
}

« C1:1bit format with grayscale conversion. Image is always fully opaque.

u32 convertARGB8888toRAWFormat (u32 c){
return (toGrayscale(c) & Oxff) / Oxff;

3

+ AC44: 4 bits for transparency, 4 bits with grayscale conversion.

u32 convertARGB8888toRAWFormat (u32 c){
return 0
| ((color >> 24) & 0xf0)
| ((toGrayscale(color) & oxff) / ox11)

(continues on next page)
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(continued from previous page)

3

« AC22: 2 bits for transparency, 2 bits with grayscale conversion.

u32 convertARGB8888toRAWFormat (u32 c){
return 0
| ((color >> 28) & 0xc0)
| ((toGrayscale(color) & oxff) / 0x55)

’

3

« AC11: 1 bit for transparency, 1 bit with grayscale conversion.

u32 convertARGB8888toRAWFormat (u32 c){
return @
| ((c & 0xff000000) == Oxff000R0d ? 0x2 : 0x0)
| ((toGrayscale(color) & Oxff) / Oxff)

’

3

The pixels order in MicroEJ file follows this rule:

pixel_offset = (pixel_Y * image_width + pixel_X) = bpp / 8;

MicroEJ Format: Display

The display can hold a pixel encoding which is not standard (see Pixel Structure). The MicroEJ format can be cus-
tomized to encode the pixelin same encoding than display. The number of bits-per-pixels and the pixel bits organi-
sation is asked during the MicroEJ format generation and when the drawImage algorithmsare running. Iftheimage
to encode contains some transparent pixels, the output file will embed the transparency according to the display’s
implementation capacity. When all pixels are fully opaque, no extra information will be stored in the output file in
order to free up some memory space.

Note: From Image Engine point of view, the format stays a MicroEJ format, readable by the Image Renderer.

Advantages:
« Encoding is identical to display encoding.

+ Drawing an image is often very fast (simple memory copy when the display pixel encoding does not hold the
opacity level).

Disadvantages:

« No compression: the image size in bytes is proportional to the number of pixels. The required memory is
similar to MicroEJ Format: Standard.

MicroEJ Format: GPU

The MicroEJ format may be customized to be platform’s GPU compatible. It can be extanded by one or several
restrictions on the pixels array:

« Its start address has to be aligned on a higher value than the number of bits-per-pixels.

4.9. Graphical User Interface 285



MicroEJ Documentation, Revision bd708584

+ Apadding has to be added after each line (row stride).

« The MicroEJ format can hold a platform dependant header, located between MicroEJ format header (start of
file) and pixels array. The MicroEJ format is designed to let the platform encodes and decodes this additional
header. For Image Engine software algorithms, this header is useless and never used.

Note: From Image Engine point of view, the format stays a MicroEJ format, readable by the Image Engine Renderer.

Advantages:
+ Encoding is recognized by the GPU.
+ Drawing an image is often very fast.
« Supports opacity encoding.
Disadvantages:

« No compression: the image size in bytes is proportional to the number of pixels. The required memory is
similar to MicroEJ Format: Standard when there is no custom header.

When MicroEJ format holds another header (called custom_header ), the required memory depends is:

required_memory = header + custom_header + (image_width * image_height) * bpp / 8;

The row stride allows to add some padding at the end of each line in order to start next line at an address with a
specific memory alignment; it is often required by hardware accelerators (GPU). The row stride is by default a value
in relation with theimage width: row_stride_in_bytes = image_width * bpp / 8.ltcanbe customized atimage
buffer creation thanks to the Low Level API LLUT_DISPLAY_IMPL_getNewImageStrideInBytes. The required RAM
memory becomes:

required_memory = header + custom_header + row_stride * image_height;
Custom .

MicroEJ Format: RLE1

Thelmage Engine can display embedded images that are encoded into a compressed format which encodes several
consecutive pixels into one or more 16-bit words. This encoding only manages fully opaque and fully transparent
pixels.

« Several consecutive pixels have the same color (2 words).

- First 16-bit word specifies how many consecutive pixels have the same color (pixels colors converted in
RGB565 format, without opacity data).

- Second 16-bit word is the pixels’ color in RGB565 format.

« Several consecutive pixels have their own color (1+n words).
- First 16-bit word specifies how many consecutive pixels have their own color.
- Next 16-bit word is the next pixel color.

« Several consecutive pixels are transparent (1 word).

- 16-bit word specifies how many consecutive pixels are transparent.
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- Notdesigned forimages with many different pixel colors: in such case, the output file size may be larger
than the original image file.

Advantages:

« Supports fully opaque and fully transparent encoding.

« Good compression when several consecutive pixels respect one of the three previous rules.
Disadvantages:

« Drawing an image is slightly slower than when using Display format.

The file format is quite similar to MicroEJ Format: Standard.

Binary Format

This format is not compatible with the Image Renderer and by MicroUl. It is can be used by MicroUl addon libraries
which provide their own images managements.

Advantages:

« Encoding is known by platform.

« Compression is inherent to the format itself.
Disadvantages:

« This format cannot be used to target a MicroUl Image (unsupported format).

Without Compression

An image can be embedded without any conversion / compression. This allows to embed the resource as it is, in
order to keep the source image characteristics (compression, bpp, etc.). This option produces the same result as
specifying an image as a resource in the MicroEJ launcher.

Advantages:

« Conserves the image characteristics.
Disadvantages:

+ Requires an image runtime decoder.

+ Requires some RAM in which to store the decoded image in MicroEJ format.

Image Generator

Principle

The Image Generator module is an off-board tool that generates image data that is ready to be displayed without
needing additional runtime memory. The two main advantages of this module are:

+ A pre-generated image is already encoded in the format known by the Image Renderer (MicroEJ format) or
by the platform (custom binary format). The time to create an image is very fast and does not require any
RAM (Image Loader is not used).

+ No extra support is needed (no runtime Image Decoder).
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Functional Description
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Fig. 38: Image Generator Principle

Process overview (see too Functional Description)

1. The user defines, in a text file, the images to load.
2. The Image Generator outputs a binary file for each image to convert.

3. The raw files are embedded as (hidden) resources within the MicroEJ Application. The binary files’ data are
linked into the FLASH memory.

4. When the MicroEJ Application creates a MicroUl Image object which targets a pre-generated image, the Image
Engine has only to create a link from the MicroUl image object to the data in the FLASH memory. Therefore,
the loading is very fast; only the image data from the FLASH memory is used: no copy of the image data is
sent to the RAM first.

5. When the MicroUl Image is no longer needed, it is garbage-collected by the platform, which just deletes the
useless link to the FLASH memory.

The image generator can run in two modes:

« Standalone mode: the image to convert (input files) are standard (PNG, JPEG, etc.), the generated binary
files are in MicroEJ format and do not depend on platform characteristics or restrictions (see MicroEJ Format:
Standard).

+ Extended mode: the image to convert (input files) may be custom, the generated binary files can be encoded
in customized MicroEJ format (can depend on several platform characteristics and restrictions, see MicroEJ
Format: Display and MicroEJ Format: GPU) or the generated files are encoded in another format than MicroEJ
format (binary format, see Binary Format).

Structure

The Image Generator module is constituted from several parts, the core part and services parts:

« “Core” part: it takes an images list file as entry point and generates a binary file (no specific format) for each
file. Toread afile, it redirects the reading to the available service loaders. To generate a binary file, it redirects
the encoding to the available service encoders.
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« “Service API” part: it provides some APIs used by the core part to load input files and to encode binary files.
It also provides some APIs to customize the MicroEJ format.

« “Standard input format loader” part: this service loads standard image files (PNG, JPEG, etc.).

+ “MicroEJ format generator” part: this service encodes an image in MicroEJ format.

Standalone Mode

The standalone Image Generator embeds all parts described above. By consequence, once installed in a platform,
the standalone image generator does not need any extended module to generate MicroEJ files from standard im-
ages files.

Extended Mode

Toincrease the capabilities of Image Generator, the extension must be builtand added in the platform. As described
above this extension will be able to:

+ read more input image file formats,
« extand the MicroEJ format with platform characteristics,
+ encode images in a third-party binary format.

To do that the Image Generator provides some services to implement. This chapter explain how to create and
include this extension in the platform. Next chapters explain the aim of each service.

1. Createa std-javalib project. The module name must start with the prefix imageGenerator (forinstance
imageGeneratorMyPlatform).

2. Addthe dependency:

<dependency org="com.microej.pack.ui” name="ui-pack” rev="x.y.z">
<artifact name="imageGenerator" type="jar"/>
</dependency>

Where x.y.z isthe Ul pack version used to build the platform (minimum 13.0.0). The module.ivy should
look like:

<ivy-module version="2.0" xmlns:ea="http://www.easyant.org” xmlns:m="http://www.easyant.org/ivy/
—maven” xmlns:ej="https://developer.microej.com” ej:version="2.0.0">

<info organisation="com.is2t.microui” module="imageGeneratorMyPlatform” status="integration”.

—revision="1.0.0">
<ea:build organisation="com.is2t.easyant.buildtypes” module="build-std-javalib"” revision="2.
o+ />
</info>

<configurations defaultconfmapping="default->default;provided->provided”>

<conf name="default” visibility="public"” description="Runtime dependencies to other_
—artifacts"/>

<conf name="provided” visibility="public" description="Compile-time dependencies to APIs_
—provided by the platform”/>

<conf name="documentation” visibility="public"” description="Documentation related to the.
—artifact (javadoc, PDF)"/>

<conf name="source"” visibility="public” description="Source code"/>

<conf name="dist"” visibility="public"” description="Contains extra files like README.md, .

—licenses”/>
(continues on next page)
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(continued from previous page)
<conf name="test"” visibility="private"” description="Dependencies for test execution. It is_
—not required for normal use of the application, and is only available for the test compilation.
—and execution phases."/>
</configurations>

<publications/>

<dependencies>
<dependency org="com.microej.pack.ui” name="ui-pack” rev="13.0.0">
<artifact name="imageGenerator"” type="jar"/>
</dependency>
</dependencies>
</ivy-module>

Create the folder META-INF/services in source folder src/main/resources (this folder will be filled in
later).
When a service is added (see next chapters), build the easyant project.

Copy the generated jar: target~/artifacts/imageGeneratorMyPlatform.jar in the platform configura-
tion project folder: MyPlatform-configuration/dropins/tools/

Rebuild the platform.

Warning: The dropins folder must be updated (and platform built again) after any changes in the image gen-
erator extension project.

Service Image Loader

The standalone Image Generator is not able to load all images formats, for instance SVG format. The service loader
can be used to add this feature in order to generate an image file in MicroEJ format.

1.
2.

Open image generator extension project.

Create an implementation of interface com.microej.tool.ui.generator.
MicroUIRawImageGeneratorExtension.

Create the file META-INF/services/com.microej.tool.ui.generator.
MicroUIRawImageGeneratorExtension and open it.

Note down the name of created class, with its package and classname.

Rebuild the image generator extension, copy it in platform configuration project and rebuild the platform
(see above).

Note: The class com.microej.tool.ui.generator.BufferedImagelLoader already implements the interface
This implementation is used to load standard images. It can be sub-classed to add some behavior.

Custom MicroEJ Format

As mentionned above (MicroEJ Format: Display and MicroEJ Format: GPU), the MicroEJ format can be extanded by
notions specific to the platform (and often to the GPU the platform is using). The generated file stays a MicroEJ file
format, usable by the Image Renderer. Additionally, the file becomes compatible with the platform constraints.
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—_

. Openimage generator extension project.

2. Create a subclass of com.microej.tool.ui.generator.BufferedImagelLoader (to be able to load
standard images) or create an implementation of interface com.microej.tool.ui.generator.
MicroUIRawImageGeneratorExtension (to load customimages).

3. Override method convertARGBColorToDisplayColor(int) if the platform’s display pixel encoding is not
standard (see Pixel Structure).

N

. Override method getStride(int) if a padding must be added after each line.

Ul

. Override method getOptionalHeader() if an additional header must be added between the MicroEJ file
header and pixels array. The header size is also used to align image memory address (custom header is
aligned on its size).

6. Create the file META-INF/services/com.microej.tool.ui.generator.
MicroUIRawImageGeneratorExtension and openit.

7. Note down the name of created class, with its package and classname.

8. Rebuild the image generator extension, copy it in platform configuration project and rebuild the platform
(see above).

If the only constraint is the pixels array aligment, the Image Generator extension is not useful:
1. Open platform configuration file display/display.properties.
2. Addthe property imageBuffer.memoryAlignment .
3. Build again the platform.

This alignment will be used by the Image Generator and also by the Image Loader.

Platform Binary Format

As mentionned above (Binary Format), the Image Generator is able to generate a binary file compatible with plat-
form (and not compatible with Image Renderer). This is very useful when a platform library offers the possibility
to use other kinds of images than MicroUl library. The binary file can be encoded according to the options the user
gives in the images list file.

1. Open image generator extension project.

2. Create an implementation of the interface com.microej.tool.ui.generator.ImageConverter.

3. Create the file META-INF/services/com.microej.tool.ui.generator.ImageConverter and openit.
4. Note down the name of created class, with its package and classname.
5

. Rebuild the image generator extension, copy it in platform configuration project and rebuild the platform
(see above).

Configuration File

The Image Generator uses a configuration file (also called the “list file”) for describing images that need to be pro-
cessed. The list file is a text file in which each line describes an image to convert. The image is described as a
resource path, and should be available from the application classpath.

Note: The list file must be specified in the MicroEJ Application launcher (see Application Options). However, all the
filesin the application classpath with suffix .images.list are automatically parsed by the Image Generator tool.
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Each line can add optional parameters (separated by a ‘:’) which define and/or describe the output file format (raw
format). When no option is specified, the image is not converted and embedded as well.

Note: See Configuration File to understand the list file grammar.

+ MicroEJ standard output format: to encode the image in a standard MicroEJ format, specify the MicroEJ
format:
Listing 3: Standard Output Format Examples

image1:ARGB8888
image2:RGB565
image3:A4

+ MicroEJ “Display” output format: to encode the image in the same format as the display (generic display or
custom display, see Pixel Structure), specify display as output format:

Listing 4: Display Output Format Example

imagel:display

MicroEJ “GPU” output format: this format declaration is identical to standard format. It is a format that is
also supported by the GPU.

Listing 5: GPU Output Format Examples

image1:ARGB8888
image2:RGB565
image3:A4

MicroEJ RLET output format: to encode the image in RLE1 format, specify RLE1 as output format:

Listing 6: RLE1 Output Format Example

imagel:RLE1
« Without Compression: to keep original file, do not specify any format:

Listing 7: Unchanged Image Example

image1l

+ Binary format: to encode the image in a format only known by the platform, refer to the platform documen-
tation to know which format are available.

Listing 8: Binary Output Format Example

image1 : XXX

Linker File

In addition to images binary files, the Image Generator module generates a linker file ( x.1scf ). This linker file
declares an image section called .rodata.images. This section follows the next rules:

« Thefiles are always listed in same order between two MicroEJ application builds.
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« The section is aligned on the value specified by the Display module property imageBuffer.
memoryAlignment (32 bits by default).

+ Eachfileis aligned on section alignment value.

External Resources

Thelmage Generator manages two configuration files when the External Resources Loader is enabled. The first con-
figuration file lists the images which will be stored as internal resources with the MicroEJ Application. The second
file lists the images the Image Generator must convert and store in the External Resource Loader output directory.
It is the BSP’s responsibility to load the converted images into an external memory.

Dependencies

+ Image Renderer module (see Image Renderer).

+ Display module (see Display): This module gives the characteristics of the graphical display that are useful to
configure the Image Generator.

Installation

The Image Generator is an additional module for the MicroUl library. When the MicroUl module is installed, also
install this module in order to be able to target pre-generated images.

In the platform configuration file, check Ul > Image Generator to install the Image Generator module. When
checked, the properties file imageGenerator > imageGenerator.properties is required to specify the Image
Generator extension project. When no extension is required (standalone mode only), this property is useless.

Use

The MicroUl Image APIs are available in the class ej.microui.display.Image ant its subclasses. There are no specific
APIs that use a pre-generated image. When an image has been pre-processed, the MicroUl Image APIs getImage
and loadImage will get/load the images.

Refer to the chapter Application Options (Libraries > MicroUI > Image ) for more information about specifying
the image configuration file.

Image Loader

Principle

The Image Loader module is an on-board engine that
« retrieves image data that is ready to be displayed without needing additional runtime memory,

« retrieves image data that is required to be converted into the format known by the Image Renderer (MicroEJ
format),

« retrieves image in external memories (external memory loader),
« converts images in MicroEJ format,

« creates a runtime buffer to manage MicroUl Bufferedimage,

4.9. Graphical User Interface 293


https://repository.microej.com/javadoc/microej_5.x/apis/ej/microui/display/Image.html

MicroEJ Documentation, Revision bd708584

« manages dynamic images life cycle.

Note: The Image Loader is managing images to be compatible with Image Renderer. It does manage image in
custom format (see Binary Format)

Functional Description

1. The application is using one of three ways to create a MicroUl Image object.

2. The Image Loader creates the image according the MicroUl API, image location, image input format and im-
age output format to be compatible with Image Renderer.

3. When the application closes the image, the Image Loader frees the RAM memory.

Memory

There are several ways to create a MicroUl Image. Except few specific cases, the Image Loader requires some RAM
memory to store the image content in MicroEJ format. This format requires a small header as explained here:
MicroEJ Format: Standard. 1t can be GPU compatible as explained here: MicroEJ Format: GPU.

The heap size is application dependant. In MicroEJ application launcher, set its size in Libraries >